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Chapter 1
Introduction

This chapter introduces the HDL Designer Series graphical design creation editors, their basic
user interface and features that are common to all of the graphical editors.
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Introduction
The Design Creation Editors

The Design Creation Editors

All of the HDL Designer Seriestoolsinclude an integrated language sensitive HDL text editor
and may also include one or more graphical editorsfor opening diagram editor and table editor
views.

DesignPad Text Editor

The built-in DesignPad HDL text editor can be used can be used for editing and viewing HDL
text views (or viewing the HDL generated from the graphical views). Thiseditor is described in
a separate DesignPad Text Editor User Guide.

Block Diagram and IBD View Editors

The block diagram editor represents the design structure by blocks and re-usable components
connected by signals, buses or bundles. The tabular IBD view editor represents the design
structure by describing the signal interfaces between the blocks and components in the design.
Blocks and components can be defined using state diagram, ASM chart, flow chart or truth
table or HDL text views and HDL generated or compiled for individual views or hierarchies.

Component Interface Editor

The tabular 10 view can be used to define component interfaces in the form of atable showing
its inputs and outputs. The symbol diagram view can be used for creating and updating the
graphical symbol used for a component on a block diagram.

State Diagram and Algorithmic State Machine Editors

The state diagram editor can be used to describe the behavior of ablock or component view asa
number of states and the transitions between them. The ASM chart editor describes an
algorithmic state machine (ASM) in terms of a sequence of operations represented by flow chart
style notation. Hierarchical or concurrent state machines are supported and HDL can be
generated for the active state machine. These editors are described in a separate Sate Machine
Editor User Manual.

Flow Chart Editor

The flow chart diagram editor can be used to describe a block or component view in terms of
standard flow chart symbolsincluding action boxes, decision boxes, loops, wait and case boxes.
Hierarchical or concurrent flow charts are supported and HDL can be generated for the active
flow chart.

18 Graphical Editors User Manual, V2008.1
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Truth Table Editor

A tabular truth table editor which can be used to represent a block or component view as a
spreadsheet defining output actions as a function of input conditions or expressions. Sequential
or combinatorial HDL can be generated for the truth table using Case or I1f-then-else style HDL.

Editor Windows

A new window is opened for each new graphical block diagram, IBD view, state diagram, ASM
chart, flow chart, truth table or symbol including separate windows for hierarchical, concurrent
or embedded views.

Each window can be moved, resized or iconized and has its own menu bar, one or more toolbars
and a status bar. Refer to the HDL Designer Series User Manual for general information about
the graphical user interface.

Y ou are prompted to save any changesto the active view when you close awindow which isthe
last open view of adiagram or table and prompted to exit from the tool if the window isthe last
open window.

The Menu Bar

The following pulldown menus are provided in most graphical editor windows although some
menus or commands may not always be available:

File Edit “iew HDL Diagram Table Toolz Flowes Simulation  Animation Add  Option:  Window Help

Note
D The Diagram menu is available in adiagram editor or the Table editor in atable editor.

A short message describing the associated command is displayed in the status bar when the
cursor is moved over any pulldown menu item or toolbar button. When tooltips are enabled, the
command name appears in asmall window beneath the button if the cursor isheld over atoolbar
button.

Many commands are also available in a context-sensitive popup menu which is displayed when
you press and release the Right mouse button.

All menu items can be accessed by a keyboard shortcut using the F10 key and the underlined

mnemonic letter. For example, to save the current view, you can use the keyboard shortcut: F10
FI0+F+S.

There are additional keyboard shortcuts defined for standard commands (such as saving aview)
using the Ctrl and Shift keys.
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Commands which add an object normally repeat for you to add another similar object until you
select another command or use the Right mouse button (or the Esc key) to terminate the
command. However, you can set apreferencein the Gener al tab of the Main settings dial og box
to remain active or activate only once or you can toggle this mode for the current command by
holding down the Ctrl key while selecting the button or menu option.

Toolbars

The most commonly used commands are available from toolbars. The toolbars are normally
docked against the upper or lower edge of the active window but each toolbar can be moved
independently to an alternative edge or allowed to float freely.

Refer to “Toolbars’ inthe HDL Designer Series User Manual for general information about the
toolbars including procedures for “Docking and Undocking Toolbars’.

Additional toolbars are defined for tasks, HDL tools, version management and for commands
specific to each editor window. Special simulation and animation toolbars are available in the
graphical editors when a supported simulator isinvoked. Refer to the HDL Designer Series
User Manual for information about the tasks, HDL tools and version management toolbars. The
other toolbars which are available in each graphical editor are described later in this manual.

Standard Toolbar
The standard toolbar in the graphical editors typically includes the buttons shown below:

Mesy Wiewy  Forvward HTML Export  Cut Copy Undo Find Expression Builder  “iew Area

/NN

Back OpenUp Save Diagram Prirt Paste Redo Ohiect Propetties Zoomin Zoom Out iewss Al

The following commands are usually available from the standard toolbar which is displayed in
the block diagram, IBD view, state diagram, flow chart, truth table, tabular 1O and symbol
windows:

Table 1-1. Standard Toolbar

Icon Description
=l Create anew view
Display the previous window when in same window mode
Display the next window when in same window mode
20 Graphical Editors User Manual, V2008.1
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Table 1-1. Standard Toolbar (cont.)
Description

Open the parent view

Save all changes made to the current view

Print the current window

Export the current view to create awebsite

Move selection to the clipboard

Copy selection to the clipboard

Paste the contents of the clipboard

Display the Object Properties dialog box

Build aVHDL or Verilog expression

Undo the last command

Redo the last undo command

Find a specified text string

Increase the magnification of the active diagram

Decrease the magnification of the active diagram

View aspecified diagram area

el () el el ) =) (=] ) (@) () (9] <] =[] ) 2] &

View the entire diagram

The button discloses a menu which allows you to choose the type of view to create. The
button is available in a state diagram or flow chart window only. The , , and
buttons are not available in truth table, tabular IO or IBD view windows.

Keyboard Shortcuts

Many commands are also available using keyboard shortcuts. Refer to “Keyboard Shortcuts’ in
the HDL Designer Series User Manual for general information about keyboard shortcuts
including menu accelerator keys, dialog box shortcuts and mouse buttons.

Refer to the Quick Reference Index in the Help and Manuals tab of the HDS InfoHub for lists
of the keyboard shortcuts supported in each window. To open the InfoHub, select Help and
Manuals from the Help menu.
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Mnemonic Keys

Single-press keys (which correspond to the underlined mnemonic character in the menu
command) are defined to add specific objects in diagram editor windows.

Note

D Note that mnemonic keys and shortcuts using the Shift key with an alphabetic character
are not available in the table editors where these keys are used to enter charactersin a
table cell.

Command Auto-repeat

After adding an object in agraphical editor window using atoolbar or menu command, the
command normally repeats until you use the Esc key (or Right mouse button) to terminate the
repeating command. However, you can set a preference for the command to Remain active or
Activate only oncein the General tab of the Main Settings dialog box which is displayed when
you choose M ain from the Options menu.

Alternatively, you can toggle this mode for the current command by using the Ctrl key. For
example, you can use CtrI+ to add asingle panel on adiagram when auto-repeat mode ison
or to add multiple panels when auto-repeat mode is off.

Strokes

Y ou can execute acommand in adiagram editor using a stroke by simply holding the Middle
mouse button down and dragging across the window. The command to be executed is shown on
the screen while the mouse button is held down and executed when you release the button.

A further set of strokes can be performed by holding down the Shift key while dragging the
Middle mouse button.

Y ou can cancel astroke by returning to the starting position before releasing the Middle mouse
button or by using the Esc key.

Strokes can be enabled or disabled by setting an option in the Main Settings dialog box as
described “ Setting Preferences for Diagram Views’ on page 48.

Refer to the Quick Reference Index in the Help and Manuals tab of the HDS InfoHub for lists
of the supported strokes. To open the InfoHub, select Help and M anuals from the Help menu.

Note
D If you use a mouse that has awheel scrolling device, it may be necessary to modify the
mouse setup to allow use of the wheel for strokes.
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Common Features

This section describes features that are available in all of the graphical editors.

Setting the Hardware Description Language

Y ou can set the default hardware description language (VHDL or Verilog) used for new
graphical editor views from the General tab of the Main Settings dialog box which can be
displayed by choosing Main from the Options menu.

Y ou can aso override the default language by choosing VHDL or Verilog in the File Creation
wizard when you create a new graphic editor view.

Refer to “ Using the Design Content Creation Wizard” inthe HDL Designer Series User Manual
for information about creating design views.

When VHDL is selected, a default package list is shown on all graphical diagramsand VHDL
syntax is used in port and signal declarations. VHDL generics can be defined on a symbol or
tabular 10 interface and individual generic values set for each instance in a block diagram, 1BD
view, state diagram, flow chart and truth table.

When Verilog is selected, default compiler directives are shown and Verilog syntax isused in
port and signal declarations. Verilog parameters can be defined on a symbol or tabular 10
interface and individual parameter values set for each instance in ablock diagram, IBD view,
state diagram, flow chart and truth table.

Setting Package References

When you are creating VHDL based designs, you can reference VHDL packages that define
VHDL types subtypes, functions, procedures or constants. These packages can be referenced at
any level of the design hierarchy and may be standard library packages containing pre-defined
VHDL type definitions or user-defined packages in your design data libraries.

The default shared project file (shared.hdp) contains mappings for all the standard packages
supplied with the HDL Designer Seriestool.

Y ou can also define your own standard packages or use an existing package supplied by another
vendor. Y ou can create your own local packages as HDL views stored with other block or
component design unit views in adesign data library or by referencing an existing external
package.

Graphical Editors User Manual, V2008.1 23
September 18, 2008



Introduction
Common Features

Y ou can set package references for a graphic editor view by double-clicking over the package
list on adiagram, or by choosing Package Refer ences from the Diagram, Table or popup
menu to display the Package List dialog box.

H[} Package List E3
— Package References
LIBRARY iese; =
IJ5E ieee.ztd_logic_1164.all;
IISE ieee.ztd_logic_arith. all;
— Preview
ieee.ztd_logic_arith Add
Library Fackage
cve_ghd_vhdl_lib | |MUMERIC_BIT “
ewernplar MUMERIC_ExTRA
hds package librar MUMERIC_SIGHED
MRS | [NUMERICSTD
lprn HUMERIC_UMSIGHED
[prr_w ztd logic 1164
modulevare IM
renoir_package_library ztd_logic_misc
SCRATCH_LIB STD_LOGIC_SIGHED
Sequencer_vhd STD_LOGIC_TEXTIO
Sequencer_vlg STD_LOGIC_UMSIGHED
zhd WITaL Primitives
ztd develnnerskit ;I VITAL Tirninn ;I
ak I Cancel | Help |

%

The dialog box displays any existing package references that are set for the current view (or the
default packages references set in your preferences for a new view).

Y ou can add references by selecting from the available libraries and choosing any of the
packages contained in them. The supplied package libraries include al the standard types
supported by Model Sm. Any packages contained in the currently mapped user-defined libraries
will also be available.

Library and use statements for the selected package are added to the list of package references
when you use the Add button and the updated list of referencesis applied to the active view
when you choose the Ok button.

Y ou can also add packages by entering any valid library or use statementsin the list or by
editing an existing library or use statement. For example, you could add a reference to the
package ieee.std _|logic_unsigned then replace the suffix .all by afunction name (such as
CONV_INTEGER) to explicitly add areference:

USE i eee. std_| ogi c_unsi gned. CONV_| NTEGER

Y ou can remove references from the package list by smply deleting the reference in the dialog
box.
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The package list can also be edited by direct text entry and may optionally include comments or
pragmas entered using the standard VHDL comment characters (--). The syntax isautomatically
checked on entry in adiagram editor unless syntax checking has been disabled in the master
diagram preferences.

Note
D Default package references can be set by choosing VHDL from the Options menu and

selecting the Default Package Refer ences tab of the VHDL Options dialog box. The
default packages are available on all editor views unless you have explicitly removed
them.

The referenced packages are parsed during VHDL generation to verify the type definitions used
in your design views.

Refer to “ Setting Default Package References’ in the HDL Designer Series User Manual for
information about setting default package references. The default references are included for al
views unless you have explicitly removed them.

Example VHDL Package List

The VHDL package list can be edited to include any valid LIBRARY and USE statements of
the form:

LI BRARY <l i brary_name>;

USE <l i brary_nane>. <package_nane>. <i t em nane>;
USE <l i brary_nanme>. <package_nane>. al | ;

USE <library_nane>. all;

The package list can aso include pragmas or comments prefixed by the VHDL comment
characters (--).

For example:

LI BRARY i eee;
-- Use the definition of std logic fromI|EEE std | ogic 1164
USE i eee.std | ogic_1164.std | ogic;

-- Use all contents of the | EEE std_logic_arith package
USE iee.std logic_arith.al

-- lgnore the foll owi ng package references for synthesis
-- pragnma synthesis_off

LI BRARY st d_devel operskit;

USE st d_devel operskit. menpak. al |

-- pragma synt hesis_al

LI BRARY ny_parts; -- declare ny library
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Setting Compiler Directives

When you are creating Verilog based designs, you can insert compiler directives for the HDL

generated from any graphic editor view.

In general, acompiler directive passesinformation to the VVerilog compiler or other downstream
tool and any directive recognized by your tools can be entered.

Y ou can set Verilog compiler directives by double-clicking over the compiler directiveslist ona
diagram or by choosing Compiler Directives from the Diagram, Table or popup menu to
display the Verilog Compiler Directives dialog box listing any existing compiler directives that

are set for the current view.

Note

D The Diagram menu is available in a diagram editor or the Table editor in atable editor.

The dialog box allows you to enter pre-modul e directives which are included in the generated
Verilog before the modul e keyword, post-modul e directives which are included after the module
keyword and end-module directives which are included at the end of the Verilog module.

Hla Yenlog Compiler Directives E3

Compiler Directives:

[ Wizible

— Pre-tModule Directives

“rezetall
“timezcale Tned10ps

|-

— Pozt-todule Directives

i

B ol

— End-Module Directives

i

N

0K

Cancel

The compiler directiveslist can also be edited by direct text entry and may optionally include
comments entered using the standard V erilog comment characters (//).
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The directive syntax is automatically checked on entry in adiagram editor unless syntax
checking has been disabled in the master diagram preferences.

Refer to “ Setting Default Compiler Directives’ inthe HDL Designer Series User Manual pr for
information about setting default compiler directives. The default directives are included for al
views unless you have explicitly removed them.

Formatting Text
Y ou can format text in the block diagram, state diagram, flow chart, symbol and truth table
editors using the Format Text toolbar.

Format Text Toolbar

The following commands are available from the Format Text toolbar or as shortcut keys:

Table 1-2. Format Text Toolbar

Button Shortcut Description

Ctrl+B Applies bold formatting to text
Ctrl + | Appliesitalic formatting to text
[u] Ctrl +U Underlines selected text

none Left aligns text

none Centerstext in cell

none Right aligns text

none Increases size of the selected text
none Decreases size of the selected text

Note
D The =], [£] and [=] buttons are disabled in multi-line truth table cells.
The|A| and | 4™ buttons are not available in atruth table.

If multiple cells are selected in atable, the formatting for each cell istoggled when you use the

[B], [Z] or [@] buttons.

The [&], [£] and [=] buttons are available to align the text when one or more cells are selected
in atable editor view and when embedded or comment text is selected on a diagram.

Y ou can increase the font size used for the selected text by using the button or decrease the
font size using the button. When scalable fonts are selected, the size isincreased (or
decreased) by one point size. For non-scalable fonts the next available font size is used.
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Y ou can change the text color used for any selected text object in a diagram editor window by
using the button in the Appearance toolbar.

The toolbar can be displayed or hidden by setting the Format Text option in the Toolbars
cascade of the View menu.

Refer to “ Toolbars’ on page 20 for more information about toolbars.

Opening the Parent View

Y ou can open up into the parent view using the button, Ctrl + Shift + o shortcut or by
choosing Open Up from the popup menu or the Open cascade of the File menu in any graphic
editor window.

If the active window is aview of ablock, the parent block diagram or IBD view is opened. If it
isaview of acomponent, the component interface is opened in the symbol or tabular 10 editor.

Note

D Y ou can choose whether the tabular 10 or symbol editor is used to open the component
interface by setting a preference in the Miscellaneous tab of the Symbol Master
Preferences dialog box.

In ahierarchical state machine or hierarchical flow chart, the parent state diagram or flow chart
is opened, unless you are already at the top level when the parent block diagram, IBD view,
tabular 10 or symbol editor view is opened.

Y ou cannot open up from a symbol although you can use the popup menu to open down into
any of itschild views.

Editing the Parent Interface

Y ou can edit the parent interface for any graphic editor view by choosing I nterface from the
Open cascade of the File menu.

If the view in the active window has a parent block diagram or IBD view, this view is opened.

If the parent view isablock diagram it is opened with the block representing the interface to the
child view in the middle of the window.

If the view in the active window describes a component, the component interface is opened in
the symbol or tabular 10 editor.
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Using the Same Window

Y ou can re-use the current window when you open up or open down into an existing view from
agraphic editor by setting the Use Same Window option in the Window menu. When this
option is checked, the related diagram or table is opened in the same window without changing
its position or size.

If the previous window has been edited and isthe |ast open view of the diagram or table, you are
prompted whether to save your changes before the view is closed. Note however, that a new tab
is always opened when you create a concurrent view or hierarchical view for a state diagram or
flow chart.

A new tab is also used when you display aternative block diagram and IBD views (or symbol
and tabular 1O views).

The window mode is saved as a preference and used as your default mode the next time you
invoke a HDL Designer Seriestool.

o Tip: You can temporarily change the window mode by holding down the Ctrl key when
you open the related view.
For example, Ctrl + to open up, Ctrl +double-click on object to open down or Ctrl +
menu option.

When same window mode is set, you can use the button to go back to the previous window
or the button to go forward to the next window (if aforward travel log exists).

Travel log information is only recorded when aview has been named. Therefore, if you create a
hierarchical state machine or flow chart and navigate around it without saving, no travel log
information is recorded.

If you have renamed a design unit or design unit view since it was last traversed, the travel log
will reference the old name and an error message isissued when you attempt to navigate into the
diagram or table.

Saving Graphic Editor Views

Y ou can save the active graphic editor view by using the button, choosing Save from the
File menu or using the Ctrl + S shortcut.

If the view has not been previously saved the Save As Design Unit View dialog box is displayed
for you to enter alibrary name, design unit name and design unit view name. Y ou can save an
existing view with anew library, unit or view name, by using the Save As command. However,
this option is not available in ablock diagram or IBD view.
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The current default library is automatically selected or you can choose from alist of other
Regular libraries in the active project.

H[} Save As Design Unit Yiew E3
Library: [rezign Unit; Wi
|SCRATCH_LIB [Test fstruct

eemplar

hds_package_library

[prin

[pr_v

renoir_package librar

SCRATCH LIE <=defau
Sequencer_vhd
Sequencer_vlg
TIMER_Vhdl
TIMER_¥log

1aRT

JART_TwT

ART_W

(] I Cancel | Help |

%

Y ou can choose from the existing design units within alibrary or the existing views of each
design unit. Alternatively, you can enter a new design unit or view name.

Y ou can use any name for alibrary, design unit or view name but all names must be valid
identifiers for the hardware description language you are using. A two or three character
extension (.bd for ablock diagram, .ibd for an IBD view, .smfor a state machine, .fc for aflow
chart or .tt for atruth table) is added automatically to identify the type of view you are saving.
For example: struct.bd or flow.fc.

If you do not specify aview name, the default names struct (for ablock diagram or IBD view)
or fsm (for a state machine view), flow for aflow chart view or tbl for atruth table view are
used. These defaults can be changed by setting preferences.

Thelibrary, design unit and view name of the view is shown in thetitle bar (or untitled for a
new view which has not been saved). An asterisk (*) after the namein the title bar indicates that
there are changes which need to be saved.

When you save a hierarchical state machine or flow chart, child views are named after the
parent diagram and the hierarchical state that represents the child on its parent diagram.

Many hierarchical operations (for example, opening a child view or generating HDL)
automatically perform a save on the parent design unit.
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Automatic Backup and Recovery

Y ou can set preferences to control whether backup and recovery files are saved for graphic
editor views. These preferences can be set from the Save tab of the Main Settings dialog box
which is displayed when you choose M ain from the Options menu in any window.

H[j Main Settings E3

Generall Te:-:tl Diagramsl Tal:ulesl Checks  Save | Llser"v"arial:ulesl

—Auto-zave

W iftomatically zave recovery file

Save eveny |-| i mirbes

™ Prompt befare performing autamatic save

¥ Create backup file

W Update HOL view when Symbol is saved

(] Cancel | Apply | Help

Y ou can choose to automatically save arecovery file (for example: struct.bd.$rec) at saved at a
specified time interval (minimum one minute) if the file has been edited since it was last saved.

Note
On aWindows workstation, you can also check an option to prompt before performing an
automatic save.

Y ou can choose to create abackup file by saving the existing version of each view (for example:
struct.bd.bak) when the view is edited. The backup files are not deleted but are overwritten each
time aview isexplicitly saved.

Y ou should not normally need to access a backup file, but it is possible to open these files after
renaming the normal file and removing the .bak extension from the backup file.

The temporary recovery files are automatically deleted when aview is saved or closed
normally. However, in the event of a power interruption or other system crash, the recovery file
is detected when you attempt to re-open the view and you can choose to open the recovery file
or to open the last normally saved file. (The unopened file is saved as a backup file in case the
chosen file has been corrupted and cannot be opened.)

Autosave for ablock diagram or IBD view does not update related interface data on disk and
you may need to reconcile interfaces after recovering these views.
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The save options are ignored for HDL text views. Save options for these views are determined

by the preferences or defaults set in the text editor. However, when atext view containing HDL
interface information exists, you can control whether the interface definition is updated when a
symbol is edited by setting Update HDL view when symboal is saved.

Unsetting this option may be useful if your text editor is not sensitive to an open file being
updated by another application. It can also be used to ensure that comments or code in the HDL
text view header are not overwritten when the symbol is saved. However, if this option is unset,
any interface changes must be made in the text file and propagated to the parent view by
updating the component instances on the parent view.

These options are saved in the master preferences file when you confirm the dialog box and are
used as default settings for the current and later sessions.

Note
D Note that no backup or recovery files are written until a view has been saved.

Saving the Window Position and Size

When you save any graphic editor view, the current view, window position and size is also
saved and used when the view is next opened.

Editing Object Properties

Y ou can edit the properties for objectsin ablock diagram, IBD view, state diagram, flow chart,
symbol, or tabular 10 view by using the [E&] button, Alt +{¢<=Retum | shortcut or by choosing
Object Propertiesfrom the Edit or popup menus when one or more objectsis selected.

An Object Properties dialog box is displayed which allows you to modify the properties of the
selected objects in the diagram. Objects that do not exist in the selection set are disabled.

The Object Properties Dialog box pages or tabs are described in the appropriate sections for
each editor later in this manual.

Redrawing a Window

A graphic editor window may sometimes become cluttered after moving text objects or when
the window has been partially obscured by another application. If this occurs, you can redraw
the window by choosing Refresh from the View menu.

Undo and Redo

At any time during an edit, you can reverse the previous command by using the Undo command
in the Edit menu, the | ¥2| toolbar button or the Ctrl + Z shortcut. The last command which can

32 Graphical Editors User Manual, V2008.1
September 18, 2008



Introduction
Common Features

be undone is shown on the menu (for example, after completing a move operation, the menu
option Undo (Move) isavailable.

If any command cannot be undone you are warned before it is executed.

The Redo command (which also available from the Edit menu, using the toolbar button or
the Ctrl + V shortcut) allows you to restore the most recent ‘undo’ command.

Successive commands can be used to undo or redo any previous operations since the application
was invoked.

Selecting Objects

Y ou can select objects in a diagram editor or table editor window by clicking the L eft mouse
button with the cursor over the object and extend the current selection set using Shift + L eft or
add objects to (or remove objects from) the selection by using Ctrl + L eft.

When an object is selected, small "handles' are displayed at each vertex. Solid handles are used
for resizable objects or unfilled handles for non-resizable objects.

When there are severa objects near the cursor in a diagram editor, the default select mode
selects the closest object. Typically, this means that when you click over an object with
associated text (for example, a block), the text (in this case the name text) is selected. To select
an object and its associated text, hold the L eft mouse button and drag a select rectangle around
one or more objects. Any objects within (or partially within) the rectangle are included in the
select set.

Note
D When you click over asignal, bus or bundle in ablock diagram (or atransition in a state

diagram) the connector lineis preferentially selected unless you explicitly click directly
over the associated name text.

All objectsin the active graphic editor window can be selected by choosing Select All from the
Edit menu or using the Ctrl + A shortcut.

Three different selection modes are available in a diagram editor window. The default mode
(indicated by the toolbar button and [;; cursor) selects any object.

Y ou can change the selection mode by using the El button to display a menu which allows you
to select text only (the button changesto and the cursor to ,J;) or select shapes only (the
button changes to and the cursor to [EF&)'

In ablock diagram or flow chart, you can use the Alt + L eft keysto select an individual
segment of a net or flow. This combination can also be used with the Shift and Ctrl keysto
select multiple segments. The selected segments can then be moved or deleted independently
from other connected segments.
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Copying and Pasting Objects

Y ou can copy any graphic or text object in a graphic editor using the toolbar button, the
Copy command from the Edit menu or the Ctrl + C shortcut.

Alternatively, usethe | & | toolbar button, the Cut command from the Edit menu or the Ctrl + X
shortcut to move the object to the clipboard.

If any graphics objects are copied, an internal paste buffer is used. However, if any text objects
are copied (or only text objects) they are copied to the system clipboard and can be pasted into
an external application.

On aWindows PC, you can also use the Copy Picture command from the Diagram or Table
menu to copy the entire window view into the system clipboard. This command can be used to
copy adiagram or table into an external application as a Windows bitmap or enhanced metafile.

Note
D The Diagram menu is available in adiagram editor or the Table editor in atable editor.

Y ou can paste any graphic or text object that has been cut or copied to another position on the
same graphic editor view (or in another window of the same type) using the toolbar button,
the Ctrl + V shortcut or the Paste command from the Edit menu or popup menu.

Graphic objects cannot be pasted using this command to diagrams of a different type or to
another application. However, text objects can normally be pasted into any other window.

Y ou can a so use the Paste from system clipboard option which is available as a cascade from
the Paste Special option in the popup menu to explicitly paste text objects into another text
object, ignoring any graphic objects in the internal paste buffer.

When you paste a named object (such as ablock or state) and the name already existsin the
diagram, the new object is given a unique name by adding an integer to the object name. (For
example: Block, Blockl, Block2...). In adiagram editor, a ghosted image of the pasted object is
attached to the cursor and can be placed by dragging the mouse and clicking at the required
location.

Y ou can also copy an object (or objects) by using the Ctrl key and dragging with the L eft
mouse button or by dragging with the Right mouse button and using the Copy Her e option
from the popup menu to paste a copy at the position of the cursor.

Deleting Objects

Y ou can delete an object (or set of selected objects) from a diagram editor or table editor
window by using the Del key or choosing the Delete command from the Edit or popup menus.
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Unlike the Cut command, the erased objects are not copied to the clipboard but the delete
operation can be undone during the current editing session.

When used in the All tab of an IBD view, the Del key deletes the selected row, column or text in
all tabs. When used in a partial interconnect table, it del etes the selected objects from the active
tab only. Alternatively, you can use the explicit Delete from thistable or Delete from all
tables commands.

Finding and Replacing Text Strings

Y ou can search for atext string by using the toolbar button, choosing Find from the Edit
menu or using the Ctrl + F shortcut in any graphical window. The Find and Replace dialog box
isdisplayed for you to specify a search string or choose from a dropdown list of text strings you
have searched for in the current session.

Hla Find and Replace - UART\uart_topistruct E3
Find | Replace |

Find Wwhat [k =] Find Next

Cloze

bore >

il

e

If atext string is selected, it is used as the default search string in the dialog box. If the text has
multiple lines, the first line is used. If the text string exceeds 40 characters, the search string is
ended by the last space character inside this limit.

When you use the Find Next button or the Enter key, the next visible or hidden text object
containing the specified string is selected.

More Search Options

Additional search options are disclosed when you use the M or e >> button on the dialog box or
can be hidden by using the << L ess button.

Y ou can choose the search depth from the pulldown options Current, Hierarchically or
Through Components, specify the search direction by choosing Up or Down and choose
whether to search Embedded Views.

These options apply to your design hierarchy. If aflow chart or state machine in the search
extent has hierarchical or concurrent views these are always searched. The Up or Down options
are only available when you have chosen to search Hierarchically. If you choose to search up,
the search stops when a symbol is reached.
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Y ou can choose to limit the search to one or more types of object by selecting from alist in the
dialog box. (Use the Clear Constraints button to clear all selections from the object list.)

If you choose to search hierarchically, the constraints list includes all possible object types. For
anon-hierarchical search, only object types for the active window are listed.

Hla Find and Replace - UART\wuart_top\struct E3
Find | Replace |
Fird What: |'.~< Clk_ j Fitud Mest

— General Cloze

— Search Depth/Direction

IHieraru:hiu:aII_l,l j [T Match caze << Less
= Up i+ Down

[ Embedded Views

™| Rtk whle wand|onl Find Al

[ “wiap search

Select All

H

— Search zelected objects ¥ Fegular expression

[~ Select related object

Block Instance

Block Library

Block Mame

Caze LI

Clear Conztraints Feqg. Exp. Syntax

e

If you set the Match case option in the dialog box, a case-sensitive search is performed. For
example, if you specified the string Clk, occurrences of CLK or clk would not be found.
However, words containing Clk (such as SysClk) would be found.

Y ou can aso choose M atch whole words only to restrict the search to occurrences where the
search string is a complete word.

Note
_lﬁ The M atch whole word option is not available when the Regular Expression optionis
set

If you set the Wrap sear ch option in the dialog box, the search repeats once all occurrences
have been found. If unset, an "End of search" message indicateswhen all occurrences have been
visited.

If you are searching hierarchically with wrap enabled, higher level views cannot be searched
and once the bottom level view has been reached, wrap will be performed within the leaf level
view only.

Find normally operates on simple text strings. However, if the Regular expression option is
set, you can search for aregular or class expression instead of atext string. For example, the
regular expression \<Clk _would find all strings starting with the characters CIk .
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Y ou can display information about the supported regular expression and class expression syntax
by using the Reg exp Syntax button.

If you set the Select related object option, the object related to the search string is selected
instead of the text string itself. For example, the signal which matches a specified search string
or the object associated with a comment text string.

When you use the Find All button, a scrollable list of matching text strings including the view
and object name is displayed in a preview window. The status indicates whether the view is
available for edit, read-only or locked by another user. Y ou can select the actual string by
double-clicking in the preview window and automatically opening the hierarchical view if
necessary.

Y ou can use the Select All button to select all the strings matching the specified string in the
current view. The preview window is not updated when you use this button and the search
hierarchically option isignored.

If the search string is found outside the current window view, the window is panned so that the
object containing the string isin the middle of the window. However, no panning is performed
when the string is found within the current window view.

If the search string is not currently visible, it is made visible. If the search string is an editable
characteristic which is not normally displayed (for example, the clock signal for a state
machine), a Found dialog box is displayed indicating the text and location where it can be
edited.

Replacing a Text String

Y ou can replace atext string by choosing Replace from the Edit menu or using the Ctrl + H
shortcut in any editor window. The Replace tab of the Find and Replace dialog box is displayed
for you to specify the search string and a new string to replace it with.

Hla Find and Replace - UART fuart_top/struct E3
Find FReplace |
Find what [cik || FindNest
Replace With: I':h:":k j Replace

Cloze

bore >

il

£

Y ou can choose from adrop down list of previoustext strings you have searched for or replaced
in the current session.
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The Replacetab provides similar facilities to the Find tab with additional controlsfor replacing
text strings. However, it only operates for replaceable text strings and any non-replaceable
strings are ignored.

Always usethe Find tab if you want to search for all occurrences of atext string. In general, any
string that can be edited in place or by using a dialog box can be replaced.

Y ou can choose to Replace the currently selected string or Replace All strings which match the
current search constraints.

Note
Although you can choose to search for any GNU regular expression, only aliteral text
string or tagged expression can be entered in the Replace With box.

If the search string is an editable characteristic which is not normally displayed (for example,
the clock signal for a state machine), a Found dialog box is displayed indicating the text and
location where it can be edited.

When the Found dialog is displayed as aresult of areplace operation, you can use the Confirm
button to confirm the replacement or Cancel button to leave it unchanged.

Object Linking and Embedding

The HDL Designer Series diagram editor views (block diagram, state diagram and flow chart)
support the Windows OL E (Object Linking and Embedding) standards and can beimported into
any OLE compatible PC documentation tool including the Microsoft Office applications and
Adobe FrameMaker.

Note
D The table editor views (truth table, tabular IO and IBD view) support OLE only for

documentation tools which recognize enhanced metafiles. These include the Microsoft
Office XP tools but not older versions of Word or FrameMaker. Enhanced metafiles are
also required to display vertical text in diagram editor views. If your documentation tool
does not support enhanced metafiles, you may want to rotate any vertical text in diagram
editor views to ensure that it will be correctly displayed in the documentation tool.

The interface used for importing OLE objects may vary between tools but is usually achieved
by an Insert Object or Import Object command. Most OLE compatible tools also support
direct import by "drag-and-drop". Refer to the user documentation for your documentation tool
for information about importing OLE objects into your application.

If the diagram contains panels or multiple views (such as concurrent or hierarchical state
machines) you are prompted which panel or view to insert.
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The normal File menu and toolbar buttons for file operations are disabled when adiagram is
edited as an OL E object from within the documentation tool. These are replaced by options to
save acopy or return to the host document.

In order to import a design object using OLE, the hds.hdp project file which is used for library
mapping information must be saved in a standard |ocation which can be accessed from the
documentation tool.

The default location is a user directory created beneath your Profiles directory. For example:

C:\Winnt\Profiles\<username>\Application Data\HDL Designer Series\
C:\Windows\Profiles\<username>\Application Data\HDL Designer Series\
C:\Documents and Settings<username>\Application Data\AHDL Designer Series\

Caution
D Initialization and preferences files saved in aworking directory or at locations specified

by the HDS LIBSand HDS USER_HOME environment variables cannot be used when
you use the OLE facility.

If the embedded diagram is on aremote disk drive, you must ensure that full UNC pathnames
are used in the project file. Pathnames using a mapped external drive are not supported when
using OLE.

If adocument containing an embedded or linked diagram is moved or copied to another
workstation, the diagram can only be opened if a suitably licensed HDL Designer Series
installation is available. If the document contains alinked diagram, the library containing the
diagram must be defined in the hds.hdp project file on both workstations.
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Using Drag and Drop

If your documentation tool supports OLE using drag and drop (for example, Microsoft Word or
Adobe FrameMaker) you can import a diagram editor view from a graphical editor window by
simply dragging and dropping it into the documentation tool window.

Hla GraphTutor/Timer /struct * (Block Diagram)
File Edit M“iew HDL Diagram Tasks Simulate Add  Options  Window  Help
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Dirag from here and drop whole diagram into OLE application. See "window > OLE" menu for options

Click on the vertical blue drag bar at the left of the graphic editor window using the L eft mouse
button and drag with the button held down. The cursor changesto & .
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When you move over avalid destination in the documentation tool it changes to and the
graphic isinserted as an embedded object when you rel ease the mouse button.

[ ] |
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plwmi = held Gl Ewae

The entire diagram isinserted at the cursor location and may be clipped if it islarger than the
document page size. However, you can resize the diagram by dragging its resize handles within
the document window.

If the diagram contains panels (for example, Panel0 in the example below) you can choose
which panel to drag by clicking the Right mouse button over the gray border and selecting the
required panel name from the Set Drag Panel cascade of the popup menu before performing the
drag. Y ou can also choose Set Drag Panel or reset Set Drag All from the OL E menu. The OLE
drag bar can be shown or hidden by toggling View Drag Bar in the OL E menu.

Opening an OLE View

Y ou can open adiagram or table view from within the document tool by double-clicking on the
embedded OLE object. The normal editing capabilities are available if you have write
permissions to the source files.

If adiagram contains multiple views (such as concurrent and hierarchical flow charts or state
machines) or multiple panels you are prompted which view to edit.

If you open atabular 10 view from the OLE object, the port declaration table is normally
displayed. Y ou can access the generics table (in a VHDL view) by using the button or
choosing Toggle Ports/Generics from the Table menu. Similarly, you can access the
parameters table (in aVerilog view) by using the button or choosing Toggle

Ports/Par ameter s from the Table menu. These commands are only available when the tableis
opened as an OLE object.

Generating HDL

Y ou can generate HDL from graphical views by using the |1
the Gener ate options from the Tasks menu in any window.

button or by choosing one of

Graphical Editors User Manual, V2008.1 41
September 18, 2008



Introduction
Generating HDL

Y ou can usethe E| button to display a pulldown palette with options to run the task on asingle
design level, the hierarchy through blocks, the hierarchy through component or the hierarchy
through components from the design root:

Run Single
<| ’
i Run Through Blocks
=
& Run Through Components

Run Through Components from the Design Root

Corresponding commands are provided in the Tasks menu.

HDL isgenerated for any graphical viewsin the specified design hierarchy which have changed
since HDL was last generated. However, you can force generation by setting Set Gener ate
Always or Generate All (One Shot) in the Tasks menu.

Note

D The generate aways option remains set for the duration of the current work session
(unless unset). The one shot option takes effect on the next generate command and isthen
automatically unset.

The design can include VHDL and Verilog views. Corresponding VHDL architecture and
Verilog module files are generated in a single operation.

When a design explorer window is active, you can generate HDL for the selected object (or
objects) or for the specified hierarchy of current views beneath the selected object(s).

When ablock diagram or IBD view is active, you can choose to generate HDL for the hierarchy
of current views beneath the active view. If ablock or component is selected, the generation
command operates on the selected object (or objects).

When a state diagram, flow chart or truth table is active, HDL is generated for the active view
only unless you choose to generate from the design root.

If you choose to generate hierarchy from the design root, HDL is generated for all objectsin the
hierarchy below the design root. However, if no design root is set, HDL is generated for the
hierarchy beneath the selected or active view.

Refer to “ Setting the Design Root” in the HDL Designer Series User Manual for more
information about the design root.

If no views have been defined for any block in the design hierarchy, adummy HDL fileis
generated.
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If agenerated file would have the same name as an existing source HDL file, a Generation File
Clash dialog box is displayed. Y ou can choose to continue or cancel the HDL generation until
you have checked whether both files are required. If you choose to continue, the existing HDL
fileisrenamed with a.replaced suffix to ensure that no datais lost.

Note
A file name clash may occur when you migrate a pre-2003.1 design or if you have

converted aHDL text view to graphics and made it the default view.

The HDL iscreated in the generated library directory specified by the library mapping which
must exist for each library referenced by your design. Generated HDL files are given the
extension specified as a preference in the File tab of the VHDL or Verilog Options dialog box.

The VHDL entity declaration and the VHDL architecture body can be generated as a combined
file or you can choose to generate them as separate files by setting a preference in the File tab of
the VHDL Options dialog box.

When the active view is a symbol and you have chosen to combine architectures and entitiesin
asinglefile, the current view architecture isincluded when you generate HDL.. If you have
chosen separate files, only the entity is generated. The whole module is generated if you are
using Verilog.

Refer to “ Setting HDL File Options’ of the HDL Designer Series User Manual for more
information about VHDL and Verilog options.

Any generation errors are reported in the Task Log window. All views in the hierarchy to be
generated must have been saved and you are prompted if any views need to be saved. Views
which have not been changed since they were last generated are not generated unless you have
set the HDL generation run options to force regeneration.

If no views need to be generated, asingle dot is displayed for each processed hierarchy with a
row of dashesto represent each selected hierarchy followed by a generation completed

message.

Y ou can set preferences to enable (or disable) HDL generation checks which carry out a full
semantic error check on the generated code and optionally also report any warnings that are
encountered.

Note

D If an error is encountered during bulk parsing, the timestamp for the generated file is set
to the oldest date alowed by the system. (January 1st 1970 on UNIX or January 1st 1980
on aPC). This ensures that the generated HDL fileisretained with an older timestamp
than the graphical view.
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Y ou can automatically display the generated HDL or graphics corresponding to an error
me in the Task Log window by double-clicking on the message (or by explicitly clicking
the

or [F%4] button).

Refer to “Task Log” in the HDL Designer Series User Manual for more information about the
Task Log window.

If your design references a user-defined VHDL package, the application checks whether it has
been compiled and compiles the package if required. Any package compilation errors are
reported in the Task Log window and must be corrected before generation can be compl eted
successfully.

VHDL Component Declarations

Y ou can choose whether component declarations are created in the generated VHDL by setting
Create component declarationsin the HDL menu for block diagramand IBD views.

Refer to “ Setting HDL Style Options” inthe HDL Designer Series User Manual for information
about using this option and setting its default.

Setting a Black Box for Synthesis

Y ou can make the active block diagram IBD view, state diagram, flow chart or truth table a
black box for synthesis by setting the Black box for Synthesis option in the HDL menu. When
thisoption is set, synthesis control pragmas are included in the generated HDL so that the view
isavailable for simulation but isignored for synthesis.

For Verilog, the synthesis off pragmaisinserted after the input/output statements and after any
Verilog parameters declared in the symbol but before the type declarations. The synthesis on
pragmaisinserted immediately before the end module statement.

For VHDL, the synthesis off pragmaisinserted after the architecture header and the synthesis
on pragma after the end of the architecture.

Downstream operations (including synthesis) can also be disabled for aVHDL architecture
view by using the "don't touch" property. However, "don't touch" cannot be used for Verilog or
acombined VHDL entity and architecture view since the interface isincluded in the same
generated HDL file. Refer to “ Disabling Downstream Operations’ in the HDL Designer Series
User Manual for information about setting "don't touch" properties.

Viewing the Generated HDL

Y ou can view the generated HDL for the active window by using the button, Ctrl + G
shortcut or choosing View Generated HDL from the HDL menu in any window. The text
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editor is opened to display read-only views of the generated VHDL entity and architecture (or
Verilog module) for the selected object.

In ablock diagram or IBD view, the generated HDL for the active window is displayed if no
blocks or components are selected. However, if one or more blocks or components are selected,
the HDL for the current views of these design unitsis displayed.

If an object is selected and your text editor recognizes line number arguments, the generated
HDL is opened at the line corresponding to the object. For example, if an embedded block is
selected on a block diagram, the Source window is opened to display the corresponding code in
the generated HDL for the block diagram.

Y ou can aso view the generated HDL filesin the design explorer as described in the“HDL File
Modes’ section of the HDL Designer Series User Manual.

Note
Y ou should not normally edit the generated HDL since any changes will be overwritten

the next time you generate HDL for the source design unit.
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Chapter 2
Graphical Editor Windows

This chapter describesfeaturesthat are available in the diagram and table editors. Later chapters
describe features that are implemented in a particular editor.

Diagram Editor Windows. . . . ... 48
Setting Preferencesfor Diagram Views . .. ...t e e 48
Setting Diagram Master Preferences ... i 49
Moving and Copying Diagram Objects . .. ... 51
RESIZING O ECES . . . .ot 53
Arranging ObjectS. . ... oo 53
Adding Comment TeXt . . .. ..ot 56
Editing TextonabDiagram . . ...t e e 59
Editing Textinthe Text Editor. .. ... .. e 61
MOVING TOXE . . oot e e e 62
Changing Text Visibility . ... e e 63
Adding Comment GraphiCs . .. ...oo ittt 67
AddingaTitleBlock. . ... 71
Displaying Object Information. . .. ... it e e 72
PaNElS . . 73
Editing ROULE POINES. . . . .. o 77
Setting Visual ARINDULES. . .. .. ..o 78
Toggling the Grid Visibility and Snapping. . . .. .. ... 80
Changingthe Diagram VIewW . . ...t e 81

Table Editor Windows. . ... ..o e 81
Setting Preferencesfor Table Views. . . ... i e 82
Selecting Table Cells ... ... e 83
EditingaTable Ceall ... ... .. 83
Changingthe Table View . . ... e e e 84
ResizingaColumn or ROW. . .. ..ottt e e e e 84
ExportingaTable. . ... 85

TheDiagram Browser ... ... e 86
Browsing Diagram SIrUCIUre . . ... ..ot e 87
Browsing Diagram Content . ...ttt 89

SignalsTable . ... . e 94
SignalsTable NOtation . . . ... ..o 95
Adding Port or Local Signal Declarations . . .. ...t 96
Adding Commentsto aPort or Local Signal Declaration ......................... 97
ReSiZiNg COlUMNS. . . ..o e e e e 98
Hiding Columns . .. ... o e 99
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Filtering Columns. . . . ..o 99
Grouping SIgnal ROWS . . . ..ottt 99
101

Sorting Signal ROWS . . . . ..o

Diagram Editor Windows

This section describes features that are available in the block diagram, flow chart, state
diagram, ASMI chart and symbol diagram editors.

Setting Preferences for Diagram Views

Y ou can set the preferences used for new diagram editor viewsin the Diagramstab of the Main
Settings dialog box which is displayed when you choose M ain from the Options menu in any

window.

H[} Main Settings

General | Test  Diagrams | T ables | Checks | Save | |zer Wariables |

Font Settingz
Fant: |.-’-'-.ria| Marmal 8 point

Set...

[v Usze scalable fonts [ Usze clozest matched fonts

Text lezs than |3 ;{ pixelz high iz not vizible.
Text lezs than |3 ;{ pixelz high iz not zelectable.

Title Blocks

Template file:
$HOS_TEAM_WERMitle_block. tmpl Browse. ..

[v &dd Title Blocks in new diagrams

[v Show Anchors for associated objects

[+ Enable Stokes

k. | Cancel Apply | Help |

Y ou can change the default font by using the Set... button to choose from the fonts available on
your system.

Scalable fonts are normally used. However, you can unset this option to use fixed size bitmap
fonts on UNIX systems or true type fonts on PC systems.
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Y ou can aso choose to match the default font specified in your preferences or in saved
diagrams to the closest font available on your workstation.

Y ou can specify the minimum number of pixel height for text visibility; if the text isless than
the specified number, then it is not visible. Similarly, you can specify the minimum number of
pixel height for text selectability; if the text isless than the specified number, then it cannot be
selected. Note that the text selectability settings apply to the selection of single lines; in case of
multiple lines, the pixel height you specified is automatically decreased by one pixel.

Y ou can specify the location of the template used when you add atitle block to a diagram and
choose whether atitle block is automatically included on new views. For more information
about title blocks, refer to “Adding a Title Block” on page 71.

Y ou can choose whether visible anchors are displayed connecting movable text selected on the
diagram to its associated object.

Y ou can aso enable the stroke shortcuts which are described in “ Strokes’ on page 22.

Setting Diagram Master Preferences

Y ou can change the master preferences for a block diagram, symbol, flow chart, state diagram
or truth table editor view by choosing Master Preferences from the Options menu in the
design manager window.

Note
The table editors for tabular 10 do not have their own master preferences but use the
same default values that are set for the symbol and block diagram.

Y ou can change preferences for the active diagram by choosing Diagram Pr efer ences from the
Options menu in any diagram editor or truth table window.

Separate dialog boxes are used to set preferences for each editor but usually provide separate
pages for setting the visual appearance of each graphical object, the default values used by new
objects, the visual attributes of the background grid and other miscellaneous preferences for
each editor.

State machine, flow chart and truth table preferences are described in the help topics that can be
displayed by using the Help buttons which are available on each dialog box.

When you edit preferences for the active view, the dialog box allows you to choose whether the
preferences are applied to new objects or to both new and existing objects in the diagram.
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Note

[

Y ou can change appearance preferences in the active view but you cannot change
preferences for default values, grid attributes or for many of the miscellaneous options.

These preferences can only be accessed when you are editing master preferences from the

design manager.

The Master Preferences cascade menu in the graphic editor windows provides options to
Apply to New Objects or to Apply to New and Existing Objectsin the active diagram view.
Y ou can also choose Update from Diagram to update the master preferences using the current
preferences from the active view. Y ou are prompted for confirmation before the master

preferences file is updated.

Refer to the “Default Preferences’ appendix in the HDL Designer Series User Manual for lists

of default preferences.

Setting Background Preferences

Y ou can set preferences which control the background used for each diagram editor by using the
Background page which is available in the master preferences dialog box for each editor.

Hla Structural Diagram Master Preferences

General

=1 Default Settings

- WHDL

Werilog

Default Properties

b oduleta’ are

= Block Diagram

= Digplay Settings

- DObject Visibility

YWHOL Signal Digplay
WHOL PortlO Digplay
Yerilog '35 Signal Display
Yerilog '35 Portl0 Dizplay
Yerilog 2005 Signal Dizplay
Yerilog 2005 PortlO Dizgplay
b oduletfare Dizplay
Appearance

b Eackaround

— Grid

x|

v Show Grid
Cilor
Digplay horizontal grid even

Dizplay vertical and ewvery

|-| poirk
|-| poirk

— Diagram

B ackaround colar

I"-.-'v"hite = I

o]

Cancel Help

Y ou can choose whether the background grid is displayed or hidden.
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Tip: You can also toggle the Grid display option for the active diagram from the View
menu.

Y ou can change the grid color by clicking on theZ| button to display a palette which allows you
to choose from a set of 25 standard colors. Y ou can aso use the Other option on the palette to
set color attributes using any of the colors available on your system.

The background grid is permanently set to 1000x1000 points. Grid snapping is always enabled
for asymbol, block diagram or flow chart and cannot be unset. In a state diagram you can
choose to unset the Snap to Grid option in the View menu.

Y ou can choose a different granularity for the display of horizontal and vertical grid points. For
example, setting the display factorsto 10 would display every tenth grid point. The default
display granularity is 1 in both the horizontal and vertical directions.

The background preferences can be set as defaultsin the diagram master preferences dialog box
or can be applied to the active diagram when accessed from the diagram preferences dial og box.

Moving and Copying Diagram Objects

Y ou can move an object (or group of selected objects) in adiagram editor by simply pressing
down the L eft mouse button and dragging the selected objects to a new position.

Y ou can move a object to the next grid space by using the , , or keys with the
Ctrl key.

Y ou can move asingle segment of anet or flow in ablock diagram or flow chart while retaining
connectivity with adjacent orthogonal segments. Y ou can also move a group of selected
segments in different nets or flows while retaining the same relative separation and connections
to unselected objects. Any attached portsin ablock diagram are automatically moved with the
selected segment.

Orthogonal routing is preserved when you move an object and route points added to nets or
flows where necessary to preserve connectivity. Ports attached to an object are not moved but a
dangling net connector will move with the attached net.
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For example, the following picture shows the effect of moving ablock in ablock diagram.
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In a state diagram, you can change the shape of atransition arc by dragging an individual route
point to a new position with the L eft mouse button.

Y ou can also move an object (or objects) by dragging with the Right mouse button and
choosing the M ove Her e option from the popup menu to move the object to the position of the
cursor. The popup menu also provides an option to Copy Her e which creates a copy of the
selected objects at the new position and a Cancel option to abort the copy or move operation.

Y ou can use the Shift key with the L eft or Right mouse button to constrain the movement to
horizontal or vertical directions. For example, to prevent accidentally changing the length of a
net during a horizontal or vertical move.

In ablock diagram or flow chart, you can use the Alt key with the L eft or Right mouse buttons
to select an individual segment of anet or flow (or Alt+Shift or Ctrl and L eft or Right to select
multiple segments) and then drag the selected segments. Any connected but unsel ected
segments are not moved but may be stretched to maintain connectivity.
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Resizing Objects

Any diagram editor object can be resized by selecting the object and dragging one of itsresize
handles. However, an object which includes text cannot be resized to be smaller than the text it
encloses.

resize

handles\-

When you resize a circular object (such as the state shown above) the shape is preserved.

When you resize any other shape (such as arectangle or polygon) you can use the middle
handles to resize horizontally or vertically and the corner handles to resize in both directions
simultaneously. Y ou can also use the Shift + L eft mouse button to preserve the aspect ratio
while resizing.

Comment text or comment graphics (or grouped comment text and graphics) can be resized, but
the resize may be constrained by the grouped objects. For example, the aspect ratio of acircular
comment graphics object must be preserved and the aspect ratio of group containing acircleis
therefore constrained to preserve the aspect ratio of all objectsin the group.

Arranging Objects

Any diagram object (or group of objects) can be aligned, distributed, rotated, flipped, layered or
grouped with other diagram objects.

Arrange Object Toolbar

The following commands are available from the Arrange Object toolbar in the block diagram,
state diagram, flow chart and symbol editor:

Table 2-1. Arrange Object Toolbar
Description
v Aligns the selected objects
Distributes the selected objects
Flips the selected objects horizontally about a vertical axis

| 8
>

Flips the selected objects vertically about a horizontal axis

Rotates the selected objects 90 degrees clockwise

Rotates the selected objects 90 degrees anti-clockwise

CEDEH
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Table 2-1. Arrange Object Toolbar (cont.)
I con Description
Th Brings the selected objects to the front
|E| Brings the selected objects to the front
|LEI| Groups the selected objects
= Ungroups the selected objects

The [|&/+] and [smef+] buttons perform a default command or you can use the ] button to
display a pulldown palette and choose the required operation. This choice then becomes the
default operation (indicated by the icon shown on the button) until another operation is chosen.

The toolbar can be displayed or hidden by setting the Arrange Object option in the Toolbars
cascade of the View menu.

Refer to “ Toolbars’ on page 20 for more information about toolbars.

Aligning or Distributing Objects

Y ou can align the currently selected objects using the button or by choosing Align from
the Edit menu in ablock diagram, state diagram or flow chart. The toolbar palette or cascade
menu provides optionsto Align L eft, Align Center, Align Right, Align Top, Align Middle or
Align Bottom.

For example, if you choose |I€ from the palette or Align L eft from the menu all objectsin the
current selection set are aligned with the |eft edge of the left-most object. If you choose |T or
Align Center the selected objects are moved horizontally and aligned vertically about their
vertical axisor if you choose ﬁ or Align Middle, the selected objects are moved vertically
and aligned horizontally about their horizontal axis.

In general, text is moved with its associated object although sel ectable text groups (such as the
signal name and type on a block diagram or actions text on a state diagram) can be aligned
separately from their associated objects.

The Align cascade menu aso includes options to Distribute Horizontally or Distribute

Vertically which can be used to arrange the selected objects so they are equal distances from

each other in the vertical or horizontal direction. These options are also available by using the
button and choosing |; or |¥ from its pulldown palette.

Rotating and Flipping Objects

When any non-symmetrically shaped object (or objects) is selected, the Edit and popup menus
include a Rotate cascade which alows you to rotate the shape clockwise by 90, 180 or 270
degrees. However the menu options are not available for symmetrical shapes such as circles.
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Y ou can aso use the button to rotate the selected objects by 90 degrees clockwise or the
button to rotate them by 90 degrees anti-clockwise.

Note
Y ou cannot rotate any objects (other than comment text) on a flow chart and you cannot

rotate the package list, compiler directiveslist or declarations text on any diagram.

Y ou can flip an object horizontally about its vertical axis by using the button or choosing
Horizontal from the Flip cascade in the Edit or popup menus.

Y ou can flip an object vertically about its horizontal axis by using the button or choosing
Vertical from the Flip cascade menu.

Layering Comment Text and Graphics

In general, if you add an object overlapping another object the new object is added over the
existing object. However, you can change the layer of the selected comment graphics or
comment text (or grouped comment text and graphics).

Y ou can bring an object to the front using the E‘ button or by choosing Bring to front from
the Layer cascade of the popup menu. Y ou can aso push an object to the back using the @
button or by choosing Send to back from the Layer cascade menu.

Only two layers are supported. If more than one object is overlapped, sending an object to the
back may cause an overlapped object to be brought in front of other objects it previously
overlapped.

If you send comment text to the back, the background color is moved behind any overlapping
object but the text always remainsin the foreground. Similarly, although you can place
comment graphicsin front of another diagram object (such as ablock or component), the text
associated with the object (for example, the name of the block) is always on the top layer.

Grouping Comment Text and Graphics

Y ou can group one or more selected comment text or comment graphics objects using the
button or by choosing Group from the Group cascade of the popup menu.

Once grouped, all text and graphics in the group can be cut, copied, pasted, aligned, moved,
hidden or deleted as one object.

Grouped comment graphics can also be resized, rotated or flipped athough the aspect ratio must
be preserved if the group contains circular objects. Grouped comment text can still be edited
individually but a group containing comment text cannot be rotated.
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Grouped objects do not need to be adjacent. For example, you could define atitle block by
grouping a heading comment text at the top of your diagram with afooter comment text
containing version information near the bottom of the diagram.

Y ou can ungroup objects by selecting the group and using the El button or by choosing
UnGroup from the Group cascade of the popup menu. All comment text and graphics text
objects are ungrouped although the group may have been created by grouping several existing
groups.

Note
D Y ou cannot attach grouped comment text to another diagram object, although you can

choose to include the group at the file start, in the file header or at the end of filein the
generated HDL..

Adding Comment Text

Y ou can use the text tool button, the Ctrl + F1 shortcut or choose Comment Text from
the Add menu to add comment text as annotation on a block diagram, flow chart, state diagram
or symbol.

The cursor changes to a cross-hair which allows you to open atext entry box by clicking at an
empty location anywhere on the diagram and enter free-format text. Any line feeds or blank
lines you enter are preserved on the diagram.

The text edit box hasits own scroll bars which allow the text to be scrolled horizontally or
vertically while editing.
'.-._ —T— |
Thi=z i= a
|cnmment

F

1 | v

To complete the text edit and return to the normal select mode, click the L eft mouse button
outside the text object. The text is drawn using the default font and can be moved, copied or
resized in the same way as any other diagram object.

If the text is larger than can be displayed in the default box, thisisindicated by the label <<--
more -->>, However, you may want to resize the text object in order to fully display the
enclosed text.

Y ou can abort text mode without saving the text by clicking the Right mouse button or using
the button to return to the normal select mode.
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Y ou can change the appearance of comment text by setting visual attributes for the sel ected text
or change the default appearance by setting default visual attributes for comment text in the
diagram master preferences.

Y ou can edit comment text directly, send it to the text editor or use the Comment Text page of
the Object Properties dialog box which can be displayed using the button, Alt+ Enter
shortcut or by choosing Object Properties from the Edit menu when the text annotation is
selected on the diagram.

When a comment text object is selected, you can attach it to any diagram object by choosing
Includein HDL from the popup menu and selecting the Befor e Object, After Object or End
of Line cascade option. An anchor is attached to the cursor which you can terminate on any
other diagram object by clicking the L eft mouse button over the required object. Comment text
attached in thisway isincluded as commentsin the generated HDL next to the appropriate HDL
for the associated object.

Note

D Y ou can attach separate comment texts containing synthesis pragmas before and after an
object to include the pragmas in the generated HDL and turn synthesis processing off for
the object.

Y ou can associate comment text with the interface to ablock by selecting the In Block
I nter face cascade option and attaching the anchor to ablock. When this option is used, the note
isincluded as commentsin the generated VHDL entity or Verilog module for the block.

If the block is subsequently converted to a component, any block interface comments are moved
into the symbol for the component. Any comments added before or after a block object are
included before or after the instantiation statement for the parent diagram.

Y ou can also associate comment text with the diagram itself by selecting the At File Start,
After FileHeader or At File End cascade option. Comment text attached in thisway is
included as comments at the specified position in the generated HDL for the diagram.

Y ou can detach comment text from an object by selecting the text and choosing Do Not Include
in HDL from the popup menu. Detached comment text isignored by HDL generation.

Note
D In aflow chart, comment text attached to the start point isincluded at the beginning of the

generated HDL and comment text attached to the end point at the bottom. Comment text
associated with achild diagram in a hierarchical flow chart can be used to label the HDL
generated from the diagram. However, comment text in a state machine associated with a
child state diagram is always added at the top of the generated HDL because the state
machine is flattened before generation.
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Y ou can hide the selected comment text (or comment graphics) object by choosing Hide from
the popup menu or from the Comment Graphics cascade in the Diagram menu and show all
hidden comment text or graphics objects by choosing Show All.

Editing Text Properties

Y ou can edit existing comment text by using the button, Alt + Enter shortcut or choosing
Object Propertiesfrom the Edit menu. If asingle comment text object is selected on the
diagram, the Comment Text node of the Object Properties dialog box is enabled and the
Comment text page is displayed showing the existing text.

The Comment Text page alows you to resize the bounding box to fit the text and choose the
text position from a pulldown list.

H[} BD Dbject Properties - Text
+ Bounding Box
¥
. [ Resize tofit kext
+ Text Pozition: Top ﬂ
¥
¥
Comment Text:
¥
¥ Thiz iz a comment J
¥
- Comment Test
Text Appearance
Box Appearance
Idzer Declarations J
k. | Cancel Apply | Help |

Any free-format text can be entered in the dialog box. Comment text can optionally be
associated with the document header or attached to any diagram object and included as
comments when HDL is generated for the diagram.

If the popup option to include the text comment After File Header is set, you can choose
whether to Add comment char acter s before the text strings. If this option is unset, thetext is
treated as a HDL statement in the generated HDL.

Y ou can include internal or user-defined variables (which are interpreted when the text is
applied and automatically updated when you save the diagram). When you enter text using the
dialog box or text editor, the text may also include any specia characters (including for
example, Kanji characters) if they are available on your system.
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Note
The %(d), %(f), %(p), %(library), %(unit) and %(view) variables are only interpreted
after the diagram has been saved and are shown as <TBD> in unsaved views.

Refer to “Using Internal Variables’ in the HDL Designer Series User Manual for more
information about internal variables.

Y ou can protect a comment text (or grouped comment text) from changes to the diagram or
master visual attribute preferences by unsetting the Allow Visual Change menu option in the
popup menu (or Text cascade in the Diagram menu). This can be useful when you have saved
comment text as atitle block with different visual attributes from other comment texts on the
diagram.

Y ou can use the M odify check box to apply the new text to all selected comment text or
embedded HDL text views on the diagram.

The Text page can also be used to edit an embedded HDL text view on a block diagram. When
used to edit HDL text, and the syntax checking preference is enabled for block diagrams, the
text is automatically syntax checked for the current hardware description language.

Caution
D Internal variables are not interpreted when the Text pageis used to enter HDL text. For

example, %d istreated as an internal variable (translated as the current design unit) in
comment text but as a Verilog variable (translated as a decimal value) in aVerilog HDL
text view.

Editing Text on a Diagram
The text associated with any graphic object can be edited directly on the diagram in the
following way:
1. Click onthetext to select it.

2. Click on the selected text again. The selected text is highlighted and can be replaced by
overwriting with new text. If you click again, the cursor changes to an I-beam and you
can edit the existing text.

3. After editing, click outside the text to return to select mode.

There may be more than one text element associated with a graphic object and each text element
can be edited separately. For example, asignal has a name and type; ablock has alibrary name,
ablock name and an instance name; a transition may have condition and actions text.
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Some text elements (such as the text in acomment text object, the HDL text for an embedded
block on ablock diagram or actions text in a state diagram) are multi-line objects. When one of
these objects is edited, a popup text edit box allows you to enter free-format text.

condition="1"

Note
Tab characters are interpreted as spaces using the current setting of the tab width

preference used for VHDL or Verilog views.

After editing, click with the L eft mouse button outside the text object (or click anywhere with
the Right mouse button) to return to select mode.

Text Editing Shortcuts
The following standard keyboard shortcuts are defined for in-place text editing:

Table 2-2. Text Editing Shortcuts

Shortcut Description

Double-click L eft Selects the word under the cursor
button

(] + [2] Selects all text in the selected object

+[c] or [copy Copy selected text to the clipboard

+w] or [Paste] | Paste text from the clipboard
+ [=] + Move selected text to the clipboard

Delete selection or delete next character if none selected.
Delete selection or delete previous character if none selected.

Move one character to left

Move one character to right

Move up oneline

EEREHE

Move down oneline
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Table 2-2. Text Editing Shortcuts (cont.)

Shortcut Description
+ Move one word to |eft
+ Move one word to right
+ Go to end of text box
awl] + Go to beginning of text box
Shitt] + Extend selection by one character to left
shitt| + Extend selection by one character to right
ctll + [Gnin] + Select to beginning of word
ctr| + [shit] + Select to end of word
shitt| + Extend selection to next line above
shitt]| + Extend selection to next line below
+ Extend selection to beginning of line
shitt| + |End Extend selection to end of line
Esc Terminate edit
The [copy|, [Paste] and [cut] keys are only available on Sun workstations.

Editing Text in the Text Editor

Y ou can send multi-line text such as comment text or embedded HDL text on a block diagram
to the current text editor (or the current HDL viewer in aread-only diagram) by choosing Send
to Editor from the popup menu or from the Text cascade of the Diagram menu.

If the Model Sim simulator isinvoked, this command is replaced by Send to Sour ce which
opensthe temporary HDL text file in the Model Sim Source window instead of using the current
text editor.

Thetext is exported to atemporary location in the temporary directory specified by the TMP
(Windows) or TMPDIR (UNIX) variable. (If these variables are not set, the root directory of the
current drive is used on Windows or /usr/tmp on UNIX.). All exported text files for the current
session are saved in atemporary subdirectory which is deleted when the session is exited.

Text which has been exported to the text editor shown as dark gray text with alight gray
background and cannot be edited directly (or from the Object Properties dialog box) until you
save any changes in the text editor and choose Finish Edits from the menu to re-import the
modified text.

If more than one text element is exported to the text editor, you can choose Finish All Editsto
re-import al changed text.
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If you save the diagram editor view while any text is exported, the tool will attempt to import
the edited text automatically.

The syntax of Imported text is checked for the current diagram language unless the syntax
checking preference has been unset in the diagram master preferences.

Moving Text

Many text elements (or grouped text elements such as the name, bounds and type of a net) can
be moved independently from their associated object.

For example, block or component name text can be moved outside the object and transition or
signal text can be moved from its default position.

Thetext is connected to its associated object by an anchor. The anchor is visible when the text
is selected unlessthis preferenceis unset in the Diagramstab of the Main Settings dialog box as
described in “ Setting Preferences for Diagram Views’ on page 48.

If the associated object is moved, the text is also moved maintaining the same offset position
from the object.

;lgﬁ ELib]Z:aryE
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. & Anchor

The following anchored text elements can be moved in this way:

Block Diagram
block block, library and instance name

component component, library and instance names
port name, bounds and type
VHDL generic or Verilog parameter values

signal signal name, type and initial value or delay
bus bus name, dlice, type, bounds, initial value (or delay)
bundle bundle name

embedded block name, number and HDL text
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Symbol

body symbol name
port name, slice, type, bounds, initial value (or delay)
VHDL generic declarations, Verilog parameter declarations

State Diagram

state state actions
transition transition text (including conditions and actions)
link link name
Flow Chart
action box name
actions
decision box name
condition
case box name
expression
port name
wait box name
statement
loop name (anchored to start loop object)

Changing Text Visibility

Y ou can change the visibility of multi-line text objectsin a diagram editor using the Object
Visibility Settings dialog box.

The dialog box is displayed when you choose Object Visibility from the background popup
menu by using the mouse button when nothing is selected.

For example, the Object Visibility Settings dialog box inaVHDL state machine:

H[} Object Visibility Settings
Comrnent T ext ;I OF. I
Architecture Declarations
O Process Declarations
[ Global Actions Help |
O Concurent Statements
[ 5tate Register Statements j
o

Graphical Editors User Manual, V2008.1 63
September 18, 2008



Graphical Editor Windows
Diagram Editor Windows

Note
The comment text option is available in the dialog box only when visible or hidden

comment text exists in the diagram.

The Object Visibility Settings dialog box controls whether the following multi-line text objects
are displayed on agraphical diagram:

VHDL Verilog

Block Diagram Package List Compiler Directives
Port and Signal Declarations Port and Signal Declarations
Comment Text Comment Text

State Diagram Package List Compiler Directives
Architecture Declarations Module Declarations
Global Actions Global Actions
Concurrent Statements Concurrent Statements
State Register Statements State Register Statements
Process Declarations Comment Text
Comment Text

Flow Chart Package List Compiler Directives
Architecture Declarations Module Declarations
Concurrent Statements Concurrent Statements
Sengitivity List Sengitivity List
Process Declarations Local Declarations
Comment Text Comment Text

Many diagram objects have associated text which can be optionally hidden or displayed. Y ou
can hide individual text elements by choosing Hide Text from the popup menu (or from the
Text cascade of the Diagram menu).

Y ou can make all text elements associated with an object (including text that is hidden by
default) visible by choosing Show Text from the menu when the object is selected. For
example, you can choose a component and make all associated text visible.

Y ou can hide or show associated text for the following objects on ablock diagram:

Object Associated Text Element
external port name

type (and bounds)

initial value (VHDL) or delay (Verilog)
signa or bus name (and dlice)

type (and bounds)

initial value (VHDL) or delay (Verilog)
bundle name

signal names (and slices)
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component library name
component name
instance name
port name (and slice)
port type (and bounds)
port initial value (VHDL) or delay (Verilog)
VHDL generic or Verilog parameter mapping
port mapping assignments

block library name
block name
instance name
VHDL generic or Verilog parameter declarations
VHDL generic or Verilog parameter mapping

embedded block name
number
HDL text statements

generate frame frame declarations

declarations port declarations

pre-s

signal declarations

post-s
See also “ Changing the Display of Port Properties’ on page 198 and “ Changing the Display of
Signal Properties’ on page 200.

Y ou can hide or show associated text for the following objects on a symbol:

Object Associated Text Element
declarations port declarations

S
symbol library name

cell name

VHDL generic or Verilog parameter declarations

Y ou can aso change the visibility of the text associated with ports by using the Port Display
Control dialog box as described in “ Changing the Display of Port Properties’ on page 198.

Y ou can hide or show associated text for the following objects on a state diagram:

Object Associated Text Element
state actions
transition condition, actions and transition priority
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Note

D Y ou cannot hide the name of a state.

Y ou can aso change the visibility of the following text objects on a state diagram:

Global Actions

Concurrent Statements
Architecture Declarations (VHDL)
Module Declarations (Verilog)
Signals Status

Process Declarations (VHDL)
State Register Statements
Package List (VHDL)
Compiler Directives (Verilog)

Y ou cannot hide the titles for these text elements from the popup menu but you can hide the
entire text block by clearing the corresponding Visible check box in the State Machine

Properties or the Object Visibility dialog boxes.

Y ou can hide or show associated text for the following objects on aflow chart:

Object Associated Text Element
action box name
actions
decision box name
condition statement
wait box name
wait statement
loop name
control statement
case name

expression

Y ou can also change the visibility of the following text objects on a flow chart:

Architecture (VHDL)

Module Declarations (Verilog)
Concurrent Statements
Sengitivity List

Process Declarations (VHDL)
Loca Declarations (Verilog)
Package List (VHDL)
Compiler Directives (Verilog

Y ou cannot hide the titles for these text elements from the popup menu but you can hide the
entire text block by clearing the corresponding Visible check box in the Flow Chart Properties

or the Object Visibility dialog boxes.
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Adding Comment Graphics
Y ou can add comment graphics on ablock diagram, flow chart, state diagram or symbol by
using the Comment Graphics toolbar or choosing Comment Graphics from the Add menu.

Comment Graphics Toolbar

The following commands are available from the Comment Graphics toolbar in the block
diagram, state diagram, flow chart and symbol editor:

Table 2-3. Comment Graphics Toolbar

I con Description

[ Add arectangle, ellipse, circle or polygon

S Add aline, polyline or arc
Add abitmap

The [[J}] and [3\,[7] buttons perform a default command or you can use the 7] button to
display a pulldown palette and choose the required operation. This choice becomes the default
operation (indicated by the icon on the button) until another operation is chosen. The palettes
are shown below:

Table 2-4. Comment Graphics Palettes

Shapes | Operation Lines Operation

n Add arectangle N Add aline

o Add an dlipse 1 Add apolyline
% Add acircle i Addanarc
- Add apolygon

The toolbar can be displayed or hidden by setting the Comment Graphics option in the
Toolbar s cascade of the View menu.

Refer to “Toolbars” on page 20 for more information about toolbars.

Corresponding commands are also available from the Comment Graphics cascade of the Add
menu:

Table 2-5. Comment Graphics Menu Commands

Command Description
Line Addaline
Polyline Add a multi-segment line
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Table 2-5. Comment Graphics Menu Commands (cont.)

Command Description
Polygon Add apolygon
Arc Add an arc
Rectangle Add arectangle
Ellipse Add an ellipse
Circle Add acircle
Bitmap Add a bitmap

When you use any of these commands, the cursor changes to a cross-hair which allows you to
add the graphics object by clicking and dragging at the required location on the diagram.

For example, you can add a polyline by clicking the L eft mouse button at a number of route
points and clicking twice to terminate the polyline or you can add arectangle by dragging across
the diagonal of the required shape.

Comment graphics can be cut, copied, pasted, aligned, moved, resized, rotated, flipped, hidden
or deleted in asimilar way to other diagram objects.

Y ou can reshape a comment graphics object by choosing Edit Vertices from the popup menu to
display its vertices which can then be dragged to change the shape or you can add an additional
vertex by clicking anywhere between the existing vertices. Y ou can remove a vertex by moving
it onto an existing vertex.

Note
D Adding verticesto aline convertsit into apolyline. You can also change arectangle into

apolygon (or a polygon into arectangle). However, you cannot edit the vertices of aarc,
circleor an elipse.

Comment graphics can be grouped with other comment graphics or comment text by choosing
Group (or UnGroup) from the Group cascade of the Edit or popup menu.

Y ou can hide an individual comment graphics (or comment text) object by choosing Hide from
the popup menu or from the Comment Graphics cascade in the Diagram menu and show all
hidden comment text or graphics objects by choosing Show All.

Y ou can hide agroup of comment text and graphics object by choosing Hide Group from the
popup menu.

Y ou can change the appearance of comment graphics by using the Appearance toolbar or
choosing Appear ance from the popup or Edit menu to set visual attributes for the selected
graphics or you can change the default appearance by setting default visua attributes for the
object in the diagram master preferences.
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Adding a Line or Polyline

Y ou can add a comment graphics line on a block diagram, flow chart, state diagram or symbol
by using the button or by choosing L ine from the Comment Graphics cascade in the
Add menu.

The cursor changes to a cross-hair and you can start the line by pressing down the L eft mouse
button and dragging to the required destination. The line is completed when you release the
mouse button.

Y ou can choose an alternative button operation by using the El button to display apalette. After
choosing an operation from the pal ette, the new default isindicated by the icon on the button.
For example, the button changesto when you choose |T from the palette.

Y ou can add a polyline by using the button or by choosing Polyline from the Comment
Graphics cascade in the Add menu. The cursor changes to a cross-hair and you can start the
line by pressing down or clicking the L eft mouse button and dragging to arequired vertex. A
vertex is added each time you click the mouse button and the line is completed when you
double-click the mouse button at the last vertex.

Note

D Y ou can change aline to a polyline (and add or remove vertices to a polyline) by
choosing Edit Vertices from the popup menu. If you end a polyline at its starting point
the enclosed area automatically becomes afilled polygon.

Y ou can add (or remove) arrowheads on aline or polyline by using the button in the
Appearance toolbar and choosing an arrowhead style from the pulldown palette to set
arrowheads at the beginning, end, neither or both ends of the selected line. After choosing an
operation from the palette, this becomes the default operation for the button.

Y ou can aso change the color, style and width for the selected line by using the ,
and @I buttons in the Appearance toolbar to display a palette of alternative choices. After
choosing an operation from the palette, this becomes the default operation for the button.

Adding an Arc

Y ou can add a comment graphics arc on a block diagram, flow chart, state diagram or symbol
by using the button and choosing E from the pulldown palette or by choosing Arc from
the Comment Graphics cascade in the Add menu.

After choosing an operation from the palette, the new default isindicated by the icon on the
button. For example, the button changes to when you choose E from the palette.

The cursor changes to a cross-hair and you can start the arc by pressing down the L eft mouse
button and dragging to the end of the required arc. A ghosted line is drawn between these two
points and becomes an arc when you rel ease the mouse button and move the cursor to either side
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of the arc. The arc is completed when you click the mouse button to specify a vertex on the
required arc.

Note
All arcs are circular although you can change the radius by editing the start end or
intermediate vertices.

Adding a Rectangle or Polygon

Y ou can add a comment graphics rectangle on ablock diagram, flow chart, state diagram or
symbol by using the iill button or by choosing Rectangle from the Comment Graphics
cascade in the Add menu.

The cursor changes to a cross-hair and you can draw the rectangle by pressing down the L eft
mouse button and dragging across the diagonal of the required rectangle. A ghosted rectangleis
drawn between these two points and becomes afilled rectangle when you release the mouse
button.

Y ou can choose an alternative button operation by using the E| button to display a palette. After
choosing an operation from the pal ette, the new default isindicated by the icon on the button.
For example, the button changes to when you choose E from the palette.

Y ou can add a polygon by using the button or by choosing Polygon from the Comment
Graphics cascade in the Add menu.

The cursor changes to a cross-hair and you can start the polygon outline by pressing down or
clicking the L eft mouse button and dragging to arequired vertex. A ghosted connection to the
starting point indicates the outline of the polygon which can be completed by double-clicking at
the last of any number of vertices.

Y ou can change the fill color and pattern for the selected rectangle or polygon by using the
f<.] v| and j buttons from the A ppearance toolbar.

An existing rectangle can be converted into a polygon by choosing Edit Vertices from the
popup menu to add or move vertices.

Adding an Ellipse or Circle

Y ou can add a comment graphics ellipse on ablock diagram, flow chart, state diagram or
symbol by using the [[J]+] button and choosing <& from the pulldown palette or by choosing
Ellipse from the Comment Graphics cascade in the Add menu.

The cursor changes to a cross-hair and you can draw the ellipse by pressing down the L eft
mouse button and dragging across the diagonal of the required ellipse. A ghosted elipseis
drawn between these two points and becomes afilled ellipse when you rel ease the mouse
button.
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After choosing an operation from the palette, the new default isindicated by the icon on the
button. Ilﬂ example, the button changes to when you choose E or to when you
choose |-} .

Y ou can add acircle by using the button or by choosing Cir cle from the Comment
Graphics cascade in the Add menu.

The cursor changesto a cross-hair and you can draw the circle by pressing down the L eft mouse
button and dragging across the radius of the required circle. A ghosted circle is drawn between
these two points and becomes afilled circle when you rel ease the mouse button.

Adding a Bitmap

Y ou can add a comment graphics bitmap on a block diagram, flow chart, state diagram or
symbol by using the button or by choosing Bitmap from the Comment Gr aphics cascade
in the Add menu.

A file browser is displayed for you to locate a bitmap file. This can be any standard windows
bitmap (.bmp), portable network graphics (.png) or portable bitmap (.pbm) image.

Note
Y ou are advised to use bitmaps which have been saved using 256 or less colors. Although

any valid bitmap can be added, images containing more than 256 colors may cause color
flashing problems unless you are using a high performance graphics card.

The cursor changes to a cross-hair and you can add the image on your diagram by pressing
down the L eft mouse button and dragging across the diagonal of the required image size. The
image can be resized at any time by dragging itsresize handles. If you use Shift + L eft mouse
button, the aspect ratio is preserved as you drag the image.

Y ou can cut, copy, paste, align, move, group, layer, hide or delete abitmap in asimilar way to
other comment graphics objects but you cannot flip or rotate a bitmap.

Bitmaps are included by reference and you can specify the pathname of the bitmap by browsing
or by entering a hard or soft pathname. If you open a diagram which references a bitmap that
cannot be found, acrossis displayed. Y ou can change the pathname for an existing bitmap by
selecting the bitmap and choosing L oad Bitmap from the popup menu.

Adding a Title Block

Y ou can add atitle block by choosing Title Block from the Add menu in ablock diagram, flow
chart, state diagram or symbol. The cursor changesto a cross-hair which allows you to place the
template title block defined in your preferences by clicking at alocation anywhere on the
diagram.
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The templatetitle block isread from the file specified in the Diagr ams tab of the Main Settings
dialog box. Refer to “ Setting Preferences for Diagram Views’ on page 48.

The current template title block is automatically included at the lower right side on a new
diagram (including concurrent and hierarchical diagrams) when you create a new graphic editor
view unless this option is unset in the General tab of the Main Settings dialog box.

Thetitle block text can be included in the generated HDL by choosing Includein HDL from
the popup menu.

Y ou can create your own title block template by grouping one or more comment texts (which
may optionally include internal or user-defined variables) and choosing Save Title Block from
the File menu to save the title block at the location specified in your preferences.

For example, the default title block comprises ten grouped comment texts and substitutes the
internal variables %(project_name), %(library), %(unit), %o(view), %(user), %(dd), %o(month)
and %(year) by the project name, library, design unit, design unit view, username and modified
date.

Refer to “Using Internal Variables’ in the HDL Designer Series User Manual for more
information about internal variables.

The %(project_name), %(user), %(dd), %(month) and %(year) variables are interpreted when
the text is applied to the diagram. (examples, joans, 31, Mar and 2003 in this example) but the
%(library), %(unit) and %(view) variables are shown as <TBD> until you save the diagram.

Froject: |examples
<e0mpany names ! | P

Zenter comments here=

Title: <enter diagram title herex
F ath: “THD=<TED=/<THBD=
Edited: |byjoans on 31 har2003

Although you cannot apply different formatting to individual words or charactersin a comment
text, you can apply different formatting to each separate comment text in the group (such asthe
<company name> text in the above example).

Displaying Object Information
When you move the cursor over any object in a diagram editor, summary information about the
object is displayed in a popup object tip window. The tip remains displayed for approximately
five seconds or until the cursor is moved to another object.

This feature can be disabled or enabled by setting the Object Tips option in the View menu.

Y ou can set preferences for the maximum number of characters and the maximum number of
lines displayed for multi-line text in the popup information box.
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These preferences can be set in the Diagrams tab of the Main Settings dialog box as described
in “ Setting Preferences for Diagram Views’ on page 48.

If these limits are exceeded (for example, a state with multiple actions), an ellipsisis added to
the end of each long line or to indicate that a multi-line field has more than three lines.

The object tips can be useful to identify objects on a diagram after you have used
HDL 2Graphicsto convert alarge design or when you have deliberately hidden text elementson
the diagram.

The following example shows atip for a component output port count connected to aVHDL
bus named high with type unsigned and bounds 3 DOWNTO 0.

*[Part OUT SRR
C|Bughigh
lunzighed[3DOWMNTOO) | - - - - oo

Note
D The slice, bounds and initial value (or delay) for asignal or bus are shown if they exist.

Panels

A panel is adefined and named area on a block diagram, flow chart, state diagram or symbol
which facilitates viewing or printing the enclosed area.

Panels can be moved, copied or re-sized (by dragging their resize handles) and may partially or
completely overlap other panels. Y ou can also change the appearance of a panel by setting
visual attributes for the panel box or name text.

Adding a Panel

Y ou can add a panel to a block diagram, flow chart, state diagram or symbol by using the
button, or by choosing Panel from the Add menu.

The cursor changes to a cross-hair and is attached to a ghosted panel which you can place
anywhere on the diagram by clicking with the L eft mouse button or you can hold down the L eft
mouse button and drag the cursor to resize the panel.
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Editing Panel Object Properties

Y ou can change the name of a panel by clicking on the panel name to select the text and clicking
again to edit the text. Alternatively, you can double-click on the panel, use the button, Alt +
Enter shortcut or choose Object Propertiesfrom the Edit menu or popup menu, to display the
Panel Object Properties dialog box.

Hlj Panel Object Properties E3

E sizting Panels:

- - Fanel
i+ Specified Panal?
Ll |

Parel Mame:  [Paneld

— Type — Yigibility
' Begular % Show
" Sheet " Hide
= Mon-autaraute ™ Show outline only
[ Anchored
(] | Cancel | Help L;:E

If you do not change the name of a panel, each new panel is given a unique name by adding an
integer to the default name (for example: PanelO, Panel1, Panel2...).

The dialog box can aso be displayed when a panel is not selected by choosing Obj ect
Properties from the Panels cascade of the Diagram menu. (This can be useful when panels
exist but are not visible in the current diagram view.)

The dialog box displays alist of al the panels that exist on the diagram. Y ou can select one or
more Specified panels or choose to edit the properties for All panels on the diagram. When a
single panel is selected, you can use the dialog box to rename the panel by typing in anew panel
name.

New panels are created as Regular panels but you can change any panel into a Sheet or Non-
autor oute panel.

Note

D A Sheet panel definesadiagram areaand is used to support multi-sheet designs imported
using guided HDL 2Graphics placement. A Non-autoroute panel definesadiagram areato
be excluded from autorouting operations.
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Any panel can also be Anchored. An anchored panel cannot be moved or re-sized and definesa
fixed area of the diagram. An anchored panel may typically be used to define a page boundary
or border. An unanchored panel can be freely moved around a diagram or re-sized to enclose
other diagram objects.

Y ou can also choose to Show or Hide the selected panels or to Show outline only (hiding the
panel name).

Displaying a Panel

Y ou can hide a panel by choosing Hide from the popup menu when a panel is selected or hide
the panel name by choosing Hide Text from the popup menu or Text tab of the Diagram menu
when the name is selected.

Y ou can make a hidden panel visible by choosing Show Panel in the Panels cascade of the
Diagram menu. If more than one panel exists on the diagram, the Choose Panel to Show dialog
box is displayed for you to select the panel to make visible.

H[j Choose Panel To Yiew E3
Fanell
FPanel?
FPanell
(] I Cancel
%

Viewing a Panel

Y ou can change a diagram editor view to a named panel by choosing View Panel from the
View menu or from the popup menu when a panel is selected.

If apanel isnot selected and more than one panel exists on the diagram, the Choose Panel to
View dialog box is displayed for you to select a panel. When you execute the dialog box, the
diagram view is zoomed in or out to the extent of the specified panel.

The diagram view is also moved to the middle of the selected panel if you use the Zoom In or
Zoom Out commands when apanel is selected.

Protecting Panels

Y ou can protect all the existing panels on adiagram editor view by choosing Protect All Panels
from the Panels cascade of the Diagram menu or from the popup menu when a panel is
selected.
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A protected panel cannot be selected, moved, copied re-sized or deleted (unless you use the
explicit Delete Panel command).

Note

D If you create another panel it is not automatically protected until you toggle protection to
unprotect and then protect all panels on the diagram. Y ou cannot explicitly protect or
unprotect asingle panel.

Deleting a Panel

Y ou can delete an unprotected panel using the Del or key but you cannot delete a
protected panel in thisway. However you can delete a protected or unprotected panel by
choosing Delete Panel from the Panels cascade of the Diagram menu.

If no panels are selected when you choose this command and more than one panel exists on the
diagram, the Choose Panel to Delete dialog box is displayed for you to choose which panel to
delete.

H[} Choose Panel To Delete E3
Fanell
FPanel?
FPanell
(] I Cancel
%

Printing a Panel

Y ou can print any named panel by using the button, choosing Print from the File or popup
menu or by using the Ctrl + P shortcut and selecting the required panel name in the Print dialog
box.

Y ou can aso print the area within an unprotected panel by selecting the panel and choosing
Print from the popup menu or from the Panels cascade of the Diagram menu. This can be
useful when you have added atemporary panel to define aprint area. However, protected panels
(which are not selectable) cannot be printed using this command.

The panel is printed using the current scaling specified in the Page Setup dialog box. However,
page breaks are not automatically calculated when you print a panel and unsatisfactory breaks
may be imposed if your panel is larger than the current page size.

Y ou can set the panel visibility in the Page Setup dialog box. For example, you can choose
Show Specified Panel to print the specified panel as a border around the print area.
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Editing Route Points

Signals, buses and bundles (in ablock diagram), transition arcs (in a state diagram) or flows (in
aflow chart) may have any number of route points.

When anet is selected, afilled square handle is displayed showing the position of each route
point. These handles can be moved by dragging with the L eft mouse button or deleted by
moving the handle over another route point.

Libracy
Elockl
I1

Y ou can also remove route points by clicking on aroute with the Right mouse button. A popup
menu allows you to Remove Route or Remove All Routes.

If the cursor is further from a route point than the current grid spacing interval, the Add Route
option allows you to add a new route point.

Route points are added when you single-click the L eft mouse button while adding asignal, bus,
bundle, transition arc or flow.

Y ou can delete the last route point added while routing by using the Del key. The routeis
completed when you click over a destination object.

Tip: You can terminate asignal, bus or bundle without a destination object on a block
diagram by double-clicking the Left mouse button.

When aroute is connected using a curved spline (for example, the default type for atransition
arc in astate diagram), you can also add a route point by dragging one of the unfilled diamond
shaped handles which as shown midway between each route point when the spline is selected.

Transition arcsin a state diagram are drawn (by default) as splines but signals, buses and
bundlesin ablock diagram or flowsin aflow chart are drawn as orthogonal polylines.

The default drawing style and other attributes can be changed by setting diagram master
preferences.
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Existing orthogonal lines on a diagram can be made into diagonals by creating, dragging or
deleting route points.

Setting Visual Attributes

Visual attributes can be set for individual elements of each diagram object. For example,
separate visual attributes can be set for the name, shape, outline and actions text that comprise
the symbol for a state.

Mame Actions

17
Shape

Y ou can set visual attributes for one or more objects in a diagram editor by selecting the
required objects and using the Appearance toolbar or by choosing Appear ance from the Edit or
popup menu to display the Edit Appearance dialog box.

The dialog box indicates the current setting when a single object (or multiple objects with the
same attribute) is selected.

H[} Edit Appearance E3

— Color — Style

Foreground: I—j Fill Style: Iij
B ackground: I—j Line Style: I:j
Line Color: - j Lirie “fidth: |: j

—Font

Sel.

(] Cancel Apply Help

i

When a single object is selected in a graphic editor, the dialog box shows the current
Foreground and Background colors for the selected object. When acell is selected in the
interface editor, the dialog box shows the Font and Background cell colors.

Y ou can click on the E| button adjacent to each button to display a palette which allows you to
choose from a set of 25 standard colors or use the Other option on the palette to set color
attributes using any of the colors available on your system.
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Y ou can choosethe Line Color used for object outlines, nets on ablock diagram, transition arcs
on a state machine or flows on aflow chart.

Y ou can choose from a palette of nine alternative Fill Style patterns which combine the current
foreground and background colors or choose the J fill pattern to make an object transparent.

Y ou can aso choosethe Line Style and Line Width used for object outlines, nets, transition
arcs and flows on a graphical diagram. The line widthsinclude ano line ﬂ option which
makes the line transparent.

In the interface editor, you can also set the alignment of text in the table cells.

Y ou can set alternative text display fonts by using the Set button to choose from the fonts
available on your window system. The available font sizes usually include the range 6 to 14
point in normal, bold, italic and bold italic typeface for a variety of font families.

The modified attributes are applied to all objectsin the current selection set when you confirm
the dialog box.

Appearance Toolbar

Y ou can also set visual attributes using the following commands which are available from the
Appearance toolbar in the block diagram, state diagram, flow chart and symbol editor:

Table 2-6. Appearance Toolbar

Button | Description
05~ Appliesalogical symbol shape to the selected object
Eé.

=~ Changes the foreground color of the selected object

Changes the color of the selected text string

Changes the color of the selected line or object outline

Changes the line style used for the selected object

Changes the line width used for the selected object

v Changes the fill pattern style used for the selected object

e Changes the arrowhead style used for the selected line or polyline

Note
D The Et?*| button is not available in the state diagram and flow chart editors.

Each of these buttons performs a default command or you can use the El button to display a
pulldown palette and choose the required operation. This choice becomes the default operation
until another operation is chosen.
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For example, the foreground, text font and line color buttons display a color choice palette and
the last selected color becomes the default for the button. The pal ettes are shown below:

Table 2-7. Appearance Palettes

Logical Shapes | Foreground, Text |Line Line Fill Pattern | Arrow
or Line Color Style Width Style
DD D EEECE | .. — ™ =
N1 T | B FEEEp | - — m: t—
T O R EEEEE — - N -
W OO0 — —
© [ Other... | — L

The toolbar can be displayed or hidden by setting the Appear ance option in the Toolbar s
cascade of the View menu.

Refer to “Toolbars” on page 20 for more information about toolbars.

Setting Color Attributes

Y ou can use the Other option on the color palette to display a Color selection dialog box which
allows you to set any other color which is supported on your workstation.

On PC systems, the Other option displays a Color dialog box which provides a palette of 48
basic colors and an option to Define Custom Color s by setting red green blue (RGB), or hue,
saturation and luminosity values. Up to sixteen custom colors can be defined and are saved as
preferences.

On UNIX systems, the Color chooser dialog box provides slider controlsto set colors using red,
green, blue (RGB) or hue, saturation and value (HSV) color models. Alternatively, you can use
the Color Names button to choose from a selection list of the named colors defined for your
window system or display a Color Disk and gray scale which can be used to pick any available
color.

Toggling the Grid Visibility and Snapping

Y ou can toggle the grid visibility for the active block diagram, flow chart, state diagram or
symbol by setting (or unsetting) the Grid option in the View menu.

Y ou can aso set the default grid visibility and snapping for each type of diagram by setting a
preference.
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Note
D Grid snapping is always enabled for a block diagram or symbol and cannot be unset.

Y ou can toggle grid snapping for the active state diagram by setting (or unsetting) the Snap to
Grid option in the View menu.

Changing the Diagram View

Y ou can change the view of the active diagram editor window by using the button, the
Shift + shortcut or by choosing Zoom In from the View menu or popup menu to increase
the magnification of the diagram and the button, Shift + shortcut or Zoom Out from
the menu to decrease the magnification of the diagram.

Y ou can restore the view before the last zoom command by choosing Zoom L ast from the View
menu. You can view the entire diagram by using the button, the shortcut key or
choosing View All from the View menu.

Note
Y ou can display popup information about the object under the cursor even if you have
zoomed out and text elements are not visible.

Y ou can choose an areato view using the button, the Shift + Home shortcut or View Area
menu option. When you choose one of these options, the cursor changesto a cross-hair and you
can drag select the required areato view.

Y ou can scroll the active diagram by using the vertical scroll bars E.Egﬂ and [E_?&I keysorin
smaller increments by using the and keys. Y ou can pan the diagram using the

horizontal scroll bars or the and keys.

Y ou can also scroll and pan the active diagram by using the button and holding down the
L eft mouse button. In this mode, the cursor changes to ™ and the diagram moves with the
cursor which changes to s until the mouse button is released.

The button is shown pressed while in panning mode until you return to normal select mode by
using the button or cancel the command using the Esc key.

If you have a three-button mouse, you can also scroll and pan by holding down Ctrl + Middle
mouse button.

Table Editor Windows

This section describes features that are available in the truth table, tabular 10 and IBD view
table editors. Later chapters describe features that are implemented in a particular editor.
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Setting Preferences for Table Views

Y ou can set the preferences used for new tabular 10 and I1BD views in the Tables tab of the
Main Settings dialog box which is displayed when you choose M ain from the Options menu in
any window.

H[} Main Settings

General | Text | Diagrams ~ Tables | Checks | Save | |zer Wariables |

IBD Fant
Fant: |Tahu:uma Marmal 10 paint [

[w Enable AutoComplete for cell values (in IBDAT abular [0

todulefare Params Display... | [for tooltipz in IBDY]

k. | Cancel Apply | Help |

Y ou can change the default font for IBD by using the Set... button to choose from the fonts
available on your system.

Y ou can enable automatic completion of cell values for both IBD and Tabular 10 views. When
thisoption is set and you enter the initial characters for a existing or previously entered string,
the entry is completed automatically.

Y ou can use the M oduleWar e Params Display button to display the ModuleWare Parameters
Object Tips Visibility dialog box and set the default object tips displayed in an IBD view:

Hla ModuleWare Object Tip Visibility

— Object tips
W Instance name W Active port levels
W In-Line / name W Part Synchronization
V¥ Part widths ¥ Puort-zpecific settings
[v HOL preview

k. Cancel Help

Note

These preferences are used for tabular 10 and IBD views only.
The default font for the text in truth tables can be set in the Truth Table Master
Preferences dialog box.
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Selecting Table Cells

Y ou can select asingle table editor cell by clicking with the L eft mouse button or select
multiple cells by clicking on a cell and dragging to extend the selection.

Y ou can aso extend the selection set in the tabular 10 or IBD view editor by holding down the
Shift key to add arange of cellsto the existing selection or the Ctrl key to add individual cells
to the selection.

Alternatively, you can use the Shift +[1], Shift +[Z], Shift +[+] or Shift +[=] shortcutsto
extend the selected range using the arrow keys.

Note
D These shortcuts are not available in the truth table editor.

Y ou can select an entire row or column by clicking on the first cell in the row or column. You
can select multiple rows or columns by selecting multiple cellsin the first row or column.

Editing a Table Cell

Y ou can add text to atable editor cell by smply selecting the cell and typing the required
expression. Any existing text is overwritten or you can double-click in acell to explicitly add
new or edit existing text characters.

Thetext is entered when you click in another cell or you can usethe key (which also
selects the cell below), the Shift +[«=Retum | keys (which select the cell above), the key
(which selects the cell to the right) or the Shift +| % | keys (which select the cell to the left).

Y ou can move to the first column in the current row by using the Home key, thefirst columnin
thefirst row by using the Ctrl + Home keys or the last column in the last row by using Ctrl +
End.

Y ou can also use the End key with the Home, [1], [1] =] or [=#] keys to move between
cells. Unlike other key modifiers, End is followed by the key and the keys do not need to be
pressed together.

Y ou can Cut, Copy, Delete or Paste text to or from one or more cells using the Cut, Copy, D€l
or Paste keys or the corresponding commands available from the Edit or popup menus. Y ou
can also clear the text from one or more selected cells by choosing Clear from the Table or
popup menu.

Y ou can use Ctrl with the L eft mouse button to add cells to a selection set, or Shift to add all
cells between the selected cell and the current cursor cell. Y ou can select all cellsin acolumn or
row by clicking the L eft mouse button in the ruler or select all cellsin the table by clicking the
origin cell in the top left corner of the table.
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Y ou can usethe Alt + shortcut in atabular 10 or IBD view cell to display alist of choices
for the cell which match the entered characters. For example, if the Bounds column already
contains: (0to 9), (1 DOWNTO 0), (11 TO 16), (32 TO 64) and (100 DOWNTO 33) and you
enter a1 character followed by Alt +[ 1], thelist of choicesincludes: (1 DOWNTO 0), (11 TO
16) and (100 DOWNTO 33).

Changing the Table View

Y ou can scroll atable editor window using the vertical scroll bars or the and keys
and pan the window using the horizontal scroll bars.

In a truth table editor window, you can also scroll the window using the Shift +[ 1] or Shift +
keys and pan the window using the Shift + [&] or Shift +[=] keys.

Note
D These shortcuts are not supported in the tabular 10 or IBD view editors.

Resizing a Column or Row

Y ou can change the width of a column or row in atruth table, tabular 1O or IBD view by
dragging the sash in the horizontal or vertical ruler.

Harizontal sashes

/

A - B 1 ¢ 9 10 |

‘1_.

ertical |

—_

zashes \

2
3
[
4
; I

Y ou can automatically fit a column (or columns) to the width of the text contained in the
selected cell (or cells) by using the button or by choosing Autofit from the Table menu. If
no cells are selected, then all columnsin the table are re-sized.

Note
D This command is not available in the truth table editor.
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Exporting a Table

Y ou can export the current table editor view as a tab-separated value (TSV) or comma-
separated value (CSV) format file by choosing TSV or CSV from the Export cascade of the
Table menu.

The currently displayed tab is exported in an IBD view. The All tab should be selected if you
want to export all interface information for the current design unit view.

If you do not specify afile extension, .csvis used when you export a comma-separated valuefile
or .txt when you export a tab-separated value file.

TSV and CSV files can be useful to preserve the column layout when you transfer tabular
information into external documentation tools such as Adobe FrameM aker and Microsoft Word
or Excdl.
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The Diagram Browser

The diagram browser is a sub-window that appears on the right of a graphical editor view. The
sub-window is divided into two vertical panes.The upper pane displays the Sructure Navigator
and the lower pane displays either the Content List tab or the Flow Help tab.

Hla UART /serial_interface,/struct * {Block Diagram)

File Edit M“iew HDL Diagram Tasks Simulate Add  Options  Window  Help

[B-r«smRBEQ 2R - A= PP DL

e £ sSignal Table
. = E—tl.': senal_interface

El Declarations/Statements

- zample: ———————
- startoxmit ———————————

LUART
xrpit_row_control
u_n

= . .
o _oread bit || row_bit_ent : (2:0)
e Content -
e
..... e | Mame I
datine  [Jp———————— convert
.................. L [termsz: 2
[ > 1 recudt : (70 j:l (items: 2)
.................. il < (70 S prems 1
"""" FE (tems: 2)
E [ltems: 5)
E (ltems: 10)
O (tems: 1]
hiertor Graphics Corporation Emj=ctl @ (lterms: 2]
Performs
R L[ R Senal Interface stores st
. . . _ . _ |Path: uartfzenal_interface/strct | 3
Edtad: e 15mah an o0 kAar 700d -
4 I _bl_l Content Lizt | EEEREE]
|F|eau:|_l,l i

Y ou can hide the diagram browser by clicking on the right arrow icon in the window border or
show the diagram browser by clicking on the left arrow icon. Y ou can also hide or show the
diagram browser by setting Diagram Browser in the View menu.
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The diagram browser and main graphical editor panes can be resized by dragging the resize
sashes between the panes. Horizontal or vertical scroll bars are automatically displayed when
the contents of abrowser are larger than its current size. The diagram browser panes are
normally tiled to share the available window area but you can use the following buttons to
change the layout:

@ Expand pane verticaly to full height of window

=] Return paneto normal horizontal tiling

Browsing Diagram Structure

The Sructure Navigator pane shows the structure of the active diagram view including any
embedded blocks on a block diagram or concurrent and hierarchical views on aflow chart,
ASM chart or state diagram view and the Signals table.

The following icons are used to identify viewsin the Sructure Navigator pane for a block
diagram:

Table 2-8. Structure Navigator Notation — Block Diagram

I con Description

fa Block diagram design unit

i IBD view design unit

19 Embedded diagrams or tables on ablock diagram or IBD view
4 Individual embedded block on ablock diagram

i | Signalstable

When the design unit is selected, the contents of the diagram are shown in the Content List pane
as described in “Browsing Diagram Content” on page 89. Y ou can also access the diagram
properties and package list or set object visibility on the diagram by using the Right mouse
button to display a popup menu. When an individual embedded view, declaration or package list
is selected, the diagram is panned and centered on the selected object.

When the signals table is selected, it becomes the active view in the diagram window.
The following icons are used to identify viewsin the Structure Navigator pane for a state

machine, ASM chart, flow chart or for these views when they are embedded on a block
diagram:
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Table 2-9. Structure Navigator Notation — State Machine, ASM, Flow Chart
I con Description

State diagram view

e

23 Concurrent state diagram view
= ASM chart view
T3

&

3%

Concurrent ASM chart view

Flow chart view

Concurrent flow chart view

= Truth table view (when embedded on a block diagram or IBD view)
i | Signalstable

When one of the diagram views s selected, it becomes the active diagram and the contents of
the diagram are shown in the Content pane as described in “Browsing Diagram Content” on
page 89. Y ou can also access the diagram properties and package list, rename a concurrent view
or set object visibility on the diagram by using the Right mouse button to display a popup
menu.Y ou can also create new Concurrent views by selecting New Concurrent M achine from
the popup menu of a concurrent machine.

When the signalstable is selected, it becomes the active view in the diagram window.

The following icons are used for to identify views in the Sructure pane for a symbol:

Table 2-10. Structure Navigator Notation — Symbol

I con Description

i Tabular interface view

B Graphical symbol view

6} Generic declaration table (VHDL only)
13 Parameter declaration table (Verilog only)

Y ou can toggle between the tabular interface, graphical symbol and VHDL generics or Verilog
parameters view.

88 Graphical Editors User Manual, V2008.1
September 18, 2008



Graphical Editor Windows
The Diagram Browser

The Structure Navigator pane also shows text objects such as the package list or compiler
directives. The following icons are used for text objects in the Structure Navigator pane:

Table 2-11. Structure Navigator Notation — Text Objects

I con Description

P Package list

Compiler directives

Signal, port and s, architecture or module declarations

Process declarations

Local declarations

Concurrent statements

Sensitivity list or state register statements

Recovery state settings

20 0E e

Global actions

An = iconisoverlaid on any text object shown in the Structure Navigator pane of the diagram
browser which is currently hidden on the graphical diagram. Y ou can control which text objects
are shown or hidden in the diagram browser by choosing Show Object from the popup menu
for the design unit icon in the diagram browser.

When you select one of the text objects, the diagram is panned and centered on the selected
object. You can use the Right mouse button to choose from a context-sensitive popup menu of
available commands. For example, you can hide or show declarations text on the diagram or
open an object properties dialog box to edit the declarations. If there is only one command
available, it isautomatically performed when you select the object. For example, the s dialog
box is opened when you select a s object.

Declarations and statement blocks which apply to the whole diagram are shown in the hierarchy
below the design unit icon. Declarations and statement blocks which apply to a concurrent
diagram are shown in the hierarchy below the concurrent view icon.

Browsing Diagram Content

The Content list paneis displayed when the design unit or a concurrent state diagram, ASM
chart or flow chart is selected in the Structure Navigator pane. The Content List panelistsall the
design objects contained in the view.

When you select an icon in the Content List pane, the corresponding object is selected on the
diagram. The diagram may be panned and centered if the selected object is not within the
current diagram view.Y ou can choose to autozoom on selected object by choosing Auto Zoom
on Select from the popup menu to display.
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Y ou can edit the properties of a selected object in the Content List pane by choosing Obj ect

Properties from the popup menu to display the Object Properties dialog box.

The following icons are used in the Content List pane for ablock diagram or IBD view

Table 2-12. Content List Notation — Block Diagram, IBD

Icon Description

1 Block

‘B Component

IR Externa |P component
i ModuleWare component
o | Embedded block

= Input port

= Output port
Bidirectiona port
Buffer port

fig! Generate frame

0 Panel

The following icons are used in the Content pane for aflow chart:

Table 2-13. Content List Notation — Flow Chart

| con

Description

=

Action box

Hierarchical action box

Decision box

Wait box

Start point

End point

Start loop

End loop

Case box

wEErEETAEE N B RN |

Panel

90
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The following icons are used in the Content pane for a state diagram:

Table 2-14. Content List Notation — State Diagram

I con Description

- Interrupt point

) State

@ Hierarchica state
@ Wait state

0 Panel

The following icons are used in the Content pane for an ASM chart:

Table 2-15. Content List Notation — ASM

| con

Description

Interrupt point

Reset point

Enable point

H-  |ea|=

Action box

Hierarchical action box

State box

BT W&

Hierarchical state box

]

Link

Case box

If decode box

OoE B

Panel

Changing the Columns in the Content Pane

Y ou can change the columns displayed in the Content pane by checking optionsin the Columns
cascade of the popup menu which is displayed if you click the Right mouse button over any
column heading.

New columns are displayed in the order they are added. However, you can change the column
display order by dragging the column header with the L eft mouse button.

Y ou can change the width of the columns by dragging the sashes between each column or
automatically resize a column to fit its contents by double-clicking on the sash.
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Sorting the Content Pane

The order of the objects Content pane can be changed by choosing Sort Ascending or Sort
Descending from the popup menu over any column header to re-order the objects in ascending
or descending order for the selected column.

The new sort order isindicated by a [5] or [&] indicator in the column header.

Tip: You can quickly toggle the existing order by clicking the L eft mouse button in any
column header.

Using Groups in the Content Pane

Y ou can group design objectsin the Content List pane by choosing Group by thiscolumn from
the popup menu for a column header.

If you choose more than one column to group by, the groups are nested in the order that you
selected them.

Y ou can use the = iconsto expand any group and reveal the objectsit contains. The following
example shows the fibgen block diagram in the Sequencer_vhd example design grouped by
object type with the block and input port groups expanded:

[Mame [Instance |

S j:l [ltems: 1]

ESequencer_vhd.curéFSM
+ j:l [ltems: 2]
+ ;I:l [Items: 3)
+ &> [ltems: 1)

- E> [ltems: 2)

reset

clock,

+ O (tems: 1]

Y ou can choose Ungroup from the popup menu to remove al column groups.

Using Flow Help

The Flow Help pane provides you with a set of demos and instructions that guide you in using
the active graphical editor and in navigating through the design.
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The following icons are used in the Flow Help pane:

Table 2-16. Flow Help Notation

I con Description

@ Move back to previoudly visited pages
& Move forward to recently visited pages
) Return to the home page

£ Refresh the active page

To use flow help:

1. Make sure you have aweb browser configured to display Macromedia Flash
applications installed on your system.

2. Click on any of the topic links in the Flow Help pane.

@ BDES

What do you want to learn
about?

# Tipz on Diagram M avigation
& Defining the Interface

& Adding a Signal

& Setting the Bus Style

& Different Block Tupes

[ l Flaw Help ]

3. A new pageisdisplayed showing alist of demonstrations. Each topic is demonstrated by
either self-running demos or a set of manual instructions.

@ BES

Adding a Signal

u Wiew a Flazh Demao now
Z] View manual instructions now

Tip: To add signals to a newly added
component. Right click on the
component and zelect ‘Add Signal
Stubg...'

l l Flow Help ]
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4. Click on any of the demonstrationsto view in your default web browser

Signals Table

The signal declarations associated with each graphical view can be displayed in atabular view
by selecting the Signals page in the diagram browser. Refer to “ The Diagram Browser” for
information about browsing diagram structure and content.

Thetable is synchronized to show only the signals for the active graphical view including any
ports which have been added to the symbol (if it exists). Any redundant ports are removed and
the type, bounds and other properties updated from the symbol.

If you have edited the signals table, the graphical view is synchronized with the signal status.
The table has a separate row for each signal defined in the interface plus additional rows for any
locally defined signals.

The following example shows the signals table for a block diagram view of the cpu_interface
design unit in the UART example design.

HUART /cpu_interface/struct {Signals for struct)
File Edit Yiew HDL Table Tasks Add Options ‘Window Help

[B-ea2EBE Q| E@o - H
[+ ¢ oL Lwm-E e

B ] E F a

Marne Type Bounds Initial Cormrernt 3 Signal Table

= Eﬁ":, cpu_interface
[~ Declarations/Sta

@

clk_div_en std_logic

clr_int_en skd_logic

s skd_logic

datout std_logic_wector [ (7 DOWNTO 0) data to cpu

div_data std_logic_wector | (7 DOWHTO 0) 4 I

nikw skd_logic
-9 Content

ser_iF_data std_logic_wectar [ (7 DOWNTO )

wrnitdt_en skd_logic

L o = e I = B V.0 I S W R % B

clear_Aags skd_logic

oy
L=

clk skd_logic

enable_write std_logic

rst I skd_logic
start_xrmit QuUT std_logic i Content List

|2-A-2-|A & B £ U|=
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Signals Table Notation

Vertical and horizontal scroll bars are available if the signals table does not fit in the current
window. However, the header row and the Group, Name and Mode columns are non-scrolling
and are always shown.

Refer to “ Grouping Signal Rows’ on page 99 for information about using the Group column.

Note
D Note that you can select an entire row by clicking the row number or an entire column by

clicking the column letter. Y ou can aso select the entire table by clicking on cell Al.
Y ou can resize any cell by dragging the sashes between the columns.

Signal Declaration Columns

The signal declarations for interface ports are displayed in the Name, Mode, Type, Bounds,
Delay or Initial and Comment columns.

New signal declarations can be added using an empty row at the bottom of the table.

Name Port or locally declared signal name.

Mode Signal mode: input, output, bi-directional, buffer (VHDL only) or local.
Type VHDL type definition or Verilog net type.

Bounds Range of the specified type (may use short or long format for VHDL).
Delay Delay value for aVerilog signal.

Initial Initial value of aVHDL signal.

Comment Comment appended to asignal declaration.

Refer to the “ Component Interface Views’ chapter for more information about port signal
declarations.

Signals Table Toolbars

The following commands are available from the Graphical Editors Tools toolbar in the signals
table:

Table 2-17. Signals Table Toolbar
Description

Q
S
5

Add an input port

Add an output port
Add abidirectiona (inout) port

EEE
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Table 2-17. Signals Table Toolbar (cont.)

Description

Add abuffer port (VHDL only)

Add alocal signa

Group the selected rows or add a group (in hierarchical mode)

Ungroup

Expand al groups

Collapse all groups

Toggle Filter

Fit the cell width to the contents of the selected cell

Sort in ascending order

2] oz 5 < el [ [ 2 ) &

Sort in descending order

1]
-

Toggle between grouped and ungrouped mode

The Standard, HDL Tools and Tasks toolbars are also available in the signals table window.
Refer to* Toolbars’ on page 20 in the Graphical Editors User Manual for information about the
Standard graphical editors toolbar. Refer to “Toolbars’ inthe HDL Designer Series User
Manual for information about the HDL Tools and Tasks toolbars.

Adding Port or Local Signal Declarations

Y ou can add ports to a component interface using the Add menu or the following buttonsin the

tabular 10 view:

Table 2-18. Tabular 10 View Commands for Adding Port or Local Signal

Declarations

Button Function Key Description

> F8 Add an input port

F9 Add an output port

[¢] F11 Add abidirectional (inout) port
[¢] F12 Add abuffer port (VHDL only)

The port is added in the next available row with default name, type and bounds.

Alternatively, you can add ports by entering a declaration directly into the next row of Name,
Mode, Type and Bounds cells. The mode defaults to the last mode used or you can choose from
alist of available modes: input, output, bidirectional (inout) or buffer (VHDL only).
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If you do not change the name of a port, each new port name is made unique by adding an
integer to the default name. (For example: In0, Inl, In2...).

If you add a port whose name suggests it might be a clock, reset, or enable, the port type, mode
and category columns are populated with the signal default values. Y ou can add a declaration
for alocal signal by using the button or choosing L ocal Signal from the Add menu. A new
declaration is added at the bottom of the table with the default name Local or LocalN (where N
isautomatically incremented if it exists).

You can aso add alocal signal declaration by entering the new signal name directly in the
Name column of the empty row at the bottom of the signals table.

The port or local signal type defaults to the last type used or you can choose from a dropdown
list of available typesin the Type column. The bounds defaults to the last range used or you can
choose from a dropdown list of recently entered ranges in the Bounds column.

A VHDL bounds can be entered in long or short format. The display format can be set by setting
or unsetting the Short Form option in the Table menu.

If you enter aport or signal name followed by avalid bounds constraint, for example, myport(7
DOWNTO 0), the constraint is automatically moved to the Bounds column.

o Tip: You can automatically complete arow with default properties by using the
key after entering a port name to move to the name cell in the next row.

Y ou can optionally enter avaluein the Initial (VHDL) or Delay (Verilog) and Comment
columns. The delay or initial value can be chosen from a dropdown list of recently entered
values.

If you enter characters that match charactersin an existing entry of the same column, the
remaining characters are entered automatically.

If you have changed port declarations to the signal table, the interface is automatically
synchronized when you save the state machine view and any new ports added to the parent
view.

Adding Comments to a Port or Local Signal Declaration

Y ou can add comments to a port or local signal declaration by choosing Comments from the
popup menu when the declaration row is selected.
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A free-format entry Comments dialog box is displayed which alows you to add asingleline
comment at the end of the declaration or you can enter a multi-line comment to be included
before or after the declaration.

& gingle line comment can be added at the end of the declaration line.
tultiple-line comments can be added beforeafter the declaration.
Comment characters will be added when appropriate.

E nd-of-line [zingle ling comment]:

Before [multi-line comment]: v Add comment characters
-
-
< E
After [rmulti-ine comment]: v &dd comment characters
-
-
< E

(] I Cancel | Help |

%

Comment characters for the current hardware description language (VHDL or Verilog) are
automatically inserted if the Add comment character s check box is set.

When this option is unset, the comments must be valid HDL statements and are automatically
syntax checked if checking is enabled.

If adeclaration is deleted, the corresponding comments are also del eted.

Although multi-line comments can be added using the dialog box, these comments are not
displayed in the table. However, end-of-line comments can be edited directly in the Comment
column for the local signal declaration row.

Resizing Columns

Y ou can automatically fit a column (or columns) to the width of the text contained in the
selected cell (or cells) by using the button or by choosing Autofit from the Table or popup
menu. If no cells are selected, then all columnsin the table are re-sized.
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Hiding Columns

Y ou can hide and show columnsin the signals table by choosing Hide Column from the popup
menu or the Columns cascade of the Table or menu.

If one or more columns are hidden, you can display a dialog box listing the hidden columns by
choosing Show Columns from the popup or Table menu.

Refer to “Hiding Columns” in the Graphical Editors User Manual for more information.

Filtering Columns

Y ou can filter the content of columnsin the signals table by using the button or setting the
Filter option in the Table menu. When this option is set, an additional row is added in the non-
scrolling area and a dropdown filter menu is available in each column.

Y ou can apply filters to more than one column or set options to match case, match whole words
or useregular expressions by choosing Filter Settingsfrom the Table or popup menu to display
the Filter Controls dialog box.

Refer to “Filtering Columns’ in the Graphical Editors User Manual for more information.

Grouping Signal Rows

Y ou can group rows in the signals table by selecting arow or rows and using the EI button or
choosing Group from the Add menu.

The selected rows are added to a new group with the default name SmGroupN or AsmGroupN
(where N isautomatically incremented if it aready exists).

Y ou can also add a group or create anew group by entering a name in the Group column for the
ports you want to group.

Note
Y ou can choose from adropdown list of existing groups. If you type a partial string that

matches the name of an existing group the name is automatically completed.

Y ou can remove a group name by selecting arow (or rows) and using the EI button or by
deleting the name from the Group cell.

If you rename or remove an existing group cell and the group is no longer referenced, you are
prompted to delete the old group name.

When the signals table includes one or more groups, you can use the button or set Show
Grouped in the Table menu to toggle between grouped and ungrouped mode.
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All rows are displayed normally in flat mode but rows in the same group are shown asasingle
(but expandable) group in hierarchy mode.

Y ou can expand all the group rows by using the button or choosing Expand All Groups
from the Ports cascade in the Table menu. Alternatively, you can expand an individual group
by clicking on the = icon.

Y ou can collapse all the group rows by using the button or choosing Collapse All Groups
from the Ports cascade in the Table menu.

When grouped modeis set, you can enter acomment in the group row as shown for the Inputs
and Outputs groups in the example below. The Inputs and Outputs groups are both shown
expanded but the Locals group is shown collapsed:

HlaUART,.-"cpu_inl:erfal:e,.-"sl:rucl: * {Block Diagram)
File Edit Wiew HDL Table Tasks Add Options ‘Window Help
EErEr=EERE T
2 4 ++ A 7
|+ 0o oL =T 2l @S- W-9-8- - -|| &
A E e o E E 5 Structure Naviga... 1|
@ | Marne Made Type EBounds Initial Cormrment Et? Signal Table E
= F2 cpu_interface =
= Inputs B Declarations/Statems 3
2 | Cutputs 11 Embedded Diagrz 5
3 datout ouT std_logic_wectar [ (7 DOWMTO 0) data to cpu < I I ﬁ
4 clear_Aags ouT std_logic 'i
c enable_write ouT skd_logic il :I
[ skart_xrmit ouT std_logic
v Content List
|&2-A-B- Ay B I U|E=E=
|Design "UART fopu_interface/struct” saved successiully, i

Note
Groups added in the signal s table may be discarded and replaced by the groups defined in
the tabular 10 view when the table is synchronized with an updated symbol view.

If you delete a group which contains local signals only, they are deleted. If you delete a group
which includes ports, only the local signals in the group are del eted.

Y ou can also alow or disallow signals sorting within agroup by choosing Allow Sort/Disallow
Sort from the group popup menu or the Group cascade of the Table menu. Unsortable groups
do not get sorted when you sort signals and have the [SORT PROTECTED] label displayed
beside their name.
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Sorting Signal Rows

Y ou can sort the rowsin a selected column of the signals table in ascending alphanumeric order
of the cell data by using the [&}] button or choosing Sort Ascending from the popup menu or
the Columns cascade of the Table menu.

Alternatively, you can sort the data in descending order by using the button or by choosing
Sort Descending from the popup menu or the Columns cascade of the Table menu.

Note
Signalsin Sort Protected Groups will not be sorted, but rather the group itself is placed

among other signals or groups according to its name.
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Chapter 3
Block Diagram and IBD Views

This chapter describes how the structure of a design can be represented using a graphical block
diagram or tabular I1BD view.

Editing Block Diagramand IBD Views. . ...t 104
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Addingan Embedded Block. . . ... o 118
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Editing Block Diagram and IBD Views

Y ou can edit agraphical view describing the structural interfaces between design unitsusing the
block diagram or IBD view editors. These views are saved as the same design unit view
(struct.bd if it is created as a block diagram or struct.ibd if it is created as an IBD view).

This chapter describes procedures that are common to block diagram and IBD views. Refer to
Chapter 4, Block Diagram Editor or Chapter 5, IBD View Editor for proceduresthat are specific

to each editor.

Y ou can display an IBD view by using the button or by choosing Show 1BD from the
Diagram menu in the block diagram editor.

When you display an IBD view from ablock diagram, some objects (for example, bundles) will
not be displayable and an ! is displayed in the Instance Ref row of the interface column in the

IBD view.

Note
D When you select a net or net declaration on a block diagram, the net name is selected on

the IBD view.
When you select anet row on an IBD view, the net and the net declaration are selected on

the block diagram. However, if you select a net name cell, only the net declaration is
selected on the block diagram.

Adding Blocks and Components

Y ou can add a block or component instance on a block diagram or IBD view by using the Add
menu or by using one of the buttons in the block diagram or IBD view toolbars. Some objects
can also be added using a shortcut or mnemonic key as shown in the following tab:

Table 3-1. Block Diagram/ IBD Commands for Adding Blocks and

Components

Button Shortcut Mnemonic | Description

El Ctrl + F3 B Add ablock
F3 C Add a component
none none Add a ModuleWare component

IR none none Add an external HDL (I1P) model
F4 E Add an embedded block
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Note
D The mnemonic shortcut keys are not supported in an IBD view.

Assigning Automatic Instance Names

The instance names for blocks and components are normally derived from a base name
specified in your block diagram preferences.

The base name can be asimple string (such as the default characters U_) which can be manually
edited on a block diagram or IBD view.

Alternatively, you can use an automatic name derived from the design unit name which cannot
be edited once you have created the design unit.

Y ou can set automatic instance names for the active view by choosing Automatic I nstance
Names from the Diagram menu on a block diagram or the Table menuin an IBD view.

Instantiating a Block

When you add a block on ablock diagram, a ghosted rectangle is attached to the cursor and can
be placed on the diagram by clicking the L eft mouse button at the required location. The block
isadded with adefault size or you can hold down the mouse button and drag across the diagonal
for arequired size.

When you add a block on an IBD view, a hew instance column is added to the table matrix.

The block has a library name, block name and instance name. Y ou can change any of these
names individually on ablock diagram (or the instance name on an IBD view) by double-
clicking on the name.

Y ou can edit the name or library name (if the library row is displayed) of ablock inan IBD
view by choosing Rename from the popup menu.

Y ou can aso edit the library name, block name or instance name by using the Blocks pagein
the Object Properties dialog box which is displayed when you by use the button or choose
Object Propertiesfrom the Edit menu.

If you do not change the library name for a block on an untitled view, it is automatically given
the same library name as the parent view when the view is saved. Once aview has been saved,
itslibrary is used as the default library for new blocks added to the view.
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Note

D Each block must have a unique block name and instance name. The block and instance
name cannot be the same when you are using VHDL but can be given the same name if
you are using Verilog.

If you do not change the instance name, each new block is given a unique instance name by
adding an integer to the default name (for example: U 0, U _1,U 2, U _3..)).

The name text can be moved independently away from (or into) the block on ablock diagram. I
you want to contain the text inside the block outline, it may be necessary to resize the object.

Instantiating a Component

When you add a component, the component browser is displayed which allows you to choose a
component (including ModuleWare components and components you have created) from an
existing library and drag an instance of the component on to a block diagram or IBD view.

Note

D The component browser can also be displayed by choosing Component Browser from
the Window menu in agraphical editor window or from the Tools menu in the design
manager. Refer to “Using the Component Browser” in the HDL Designer Series User
Manual for more information.

Y ou can instantiate a component by selecting the required design unit or view and holding
down the L eft mouse button to drag the & cursor over ablock diagram or IBD view.
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For example, the following picture shows the dialog box used to instantiate the truth table view
of the accumulator component in the Sequencer_vhd library:
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To inztance a component, drag onto a
diagram, or uze Copy and Faste.
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The & cursor changesto when you move over avalid destination and is added when you
rel ease the mouse button.

If you drag a component design unit, the default view isinstantiated. If you use the + icon to
expand the design unit and drag adesign unit view of aVHDL design unit, it isinstantiated asa
named view.

Note
Y ou can instantiate a Verilog component in aVVHDL design or aVHDL component in a
Verilog design.

Y ou can also add a component by copying or dragging a design unit or design unit view from a
library displayed in adesign explorer window.

When you add a component on a block diagram, a ghosted rectangle is attached to the cursor
and can be placed on the diagram by clicking at the required location. The component shape and
port positions on the block diagram are defined by its symbol.

When you add a component on an IBD view, anew instance column is added to the table
matrix.

The component is added with its existing object name and a unigue instance name. If you have
selected anamed VHDL view, the view name (for example: struct.bd) is shown after the
instance name. Y ou can change the instance name on ablock diagram by double-clicking on the
name.
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Y ou can also edit the instance name and other component properties by using the Components
page in the Object Properties dialog box as described in “ Editing Component Properties’ on
page 127.

If the component references any VHDL packages which are not already referenced in the
package list, you are prompted whether to add them.

If you do not change the instance name, each new component is given a unique instance name
by adding an integer to the default name (for example: U O, U_1,U 2, U 3...).

The instance name can be automatically derived from the design unit name or it can be an
editable string derived from a base name specified in your preferences as described in
“Assigning Automatic Instance Names™ on page 105.

The name text can be moved independently away from (or into) the component on a block
diagram. If you want to contain the text inside the component outline, it may be necessary to
resize the object.

Y ou can move ports around the component symbol on a block diagram by dragging them with
the mouse. (If you select more than one port, their relative separation is preserved.)

Y ou can aso space all the ports on each edge of a component evenly by choosing Equidistant
Ports from the popup menu or Ports cascade of the Diagram menu when the component is
selected.

Instantiating Verilog 2005 or System Verilog3.0 Text Components

A Verilog 2005 or System Verilog 3.0 text component can beinstantiated in a Block diagram or
IBD design if the component interface islogically compatible with the language of the diagram.

Tip: A logically compatible interface is one whose port types can be mapped to Verilog
95 port types.

For compatibility reasons alevel of type substitution will be provided. Following the type
substitution, if the component interfaceis still logically incompatible i.e one or more port types
failed to map to Verilog 95 port types, amessage is issued and the operation is aborted.

Examples of port types that would fail to map are types void or enum.

The table below shows alist of Verilog2001/System Verilog 3.0 types that are supported as
Verilog 95 compatible ones.

Table 3-2. Supported Verilog2001/System Verilog 3.0 Types
Type Size

logic 1

108 Graphical Editors User Manual, V2008.1
September 18, 2008



Block Diagram and IBD Views
Adding Blocks and Components

Table 3-2. Supported Verilog2001/System Verilog 3.0 Types (cont.)

Type Size
bit

byte 8
char

shortint 16
shortreal 32
integer 32
int 32
longint 64
time 64
real 64
realtime 64

For Verilog 95 diagrams, any type from the above table will be mapped to reg or wire of the
corresponding size depending on the following

Mode of the Declar ation to be Substituted

» Output ports are substituted with "reg"

* Input/Inout ports are substituted with "wire"
Type of Diagram

Verilog 95 structural diagrams override type of nets according to diagrams master
preferences while symbol types are not changed.

For VHDL diagrams, ports map to std_logic or std_logic_vector depending only on the size

For BD/IBD, type substitution is applied to the newly created nets connected to a Verilog 2001
or System Verilog 3.0 instance. As for symbols created for Verilog 2001/System Verilog 3.0
text, type substitution is applied to the module ports themselvesi.e. they would be replaced by
Verilog 95 compatible types in the symbol.

Note
Verilog 2000/System Verilog 3.0 synchronization occurs only from text to graphics, any

changes in the graphics are not reflected in the text.

Synchronization occurs between the instantiated component and the underlying text view
according to the following rules:
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» Graphical components with no symbols are updated only when you manually update
them by choosing Component>Update>Interface from the component popup menu.

» Symbolsof graphical components are updated on saving there underlying text
components.

» A mixed design symbol is updated when changing the default view to Verilog 2005/
System Verilog3.0

Tip: Symbol/ Interface updating can be allowed/disallowed through Options>Main>Save
tab in the Design Explorer window or from the symbol properties dialog incase of mixed
designs.

In all of the above casesthe tool checksif the Verilog 2000 /System Verilog typesin the text are
logically compatible with the language of the diagram and updates the graphical interface doing

any needed type substitution.

Instantiating a ModuleWare Component

HDL Author and HDL Designer include a parameterizable ModuléWare library which can be
used to instantiate language-independent component parts representing a wide range of logic
and arithmetic functions.

The moduleware library is automatically pre-selected in the component browser when you use
the button or choose M oduleWar e from the Add menu.

When the moduleware library is displayed in the component browser, you can choose from a
number of categories which each contain parts supporting afamily of functions. Each category
is displayed as an expandable folder.
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For example, the Arithmetic folder contains parts which can be used to implement arithmetic

functions.
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Y ou can edit the instance name or other object properties for aModuleWare part in the same
way as any other component by using the Components tab in the Object Properties dialog box

as described in “Editing Component Properties’ on page 127.

Editing ModuleWare Parameters

Y ou can edit ModuleWare parameters by using the ModuleWare page in the Object Properties

dialog box.
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For example, the following picture shows the ModuleéWare Parameters dialog box for the
Accumulator arithmetic function:
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Y ou can also display the ModuleWare Parameters dialog box by double-clicking on a
M oduleWare component instance or by selecting Par ameter s from the M oduleW ar e cascade
in the popup menu.

Y ou can edit the ModuleWare parameters by entering the required values in the table or (for
enumerated parameters) by choosing from a dropdown list.

Y ou can preview the parameter settings and the generated HDL (or the error and warning
messages that would be issued when HDL is generated) by using the Preview button to display
the ModuleWare Preview dialog box.

Y ou can aso display the ModuleéWare Preview dialog box by choosing Preview from the
M oduleéW ar e cascade of the popup menu when a ModuleWare instance is selected.

Y ou can optionally display ModuleWare parameters in a comment text box when apart is
instantiated on a block diagram and set the parameters which are displayed by using the
Params Display button as described in “ Setting the Visibility of ModuleWare Parameters’ on
page 114.
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Y ou can restore all parametersto their default values by using the Restor e Defaults button.

Y ou can aso choose whether HDL for the ModuleWare instance is generated in-line or to a
separate file. When set to in-line, the generated HDL is embedded in the HDL for the parent
diagram. When the in-line option is unset, the generated HDL is written to a separate file with
the name shown in the dialog box. (This name is a unique signature derived by adding a unique
32-bit hexadecimal number to the part name.)

Refer to the ModuleWare Parameters dialog box description for more information about setting
ModuleWare parameters.

Note
D Signals and buses can be connected to a ModuléWare instance in the same way as any

other component. Note that the port size parameters default to Automatic and will be
automatically set to the width of the connected net.

Note also, that you can connect bus slices directly to the bit manipulation models but not
to any other type of ModuleWare or component instance.

Refer to the ModuleWar e Reference Guide for more information about using the ModuleWare
library including full descriptions of each supported function.

Note that the relevant pagein aHTML version of the reference guide can be accessed by using
the Details button in the ModuleWare Parameters dialog box or by choosing Details from the
popup menu in the component browser.

Using Dynamic ModuleWare Components

A number of dynamic ModuleWare components (and, nand, nor, or, sand, sor, sxor, xnor, Xor,
mux, omux, merge, and split) are available. These components have two input or output ports
when they are instantiated but can be extended to support any number of ports by resizing the
instance to disclose the required number of ports or by setting the required number of portsin
the ModuleWare Parameters dialog box.

To resize an instance, select the component by clicking with the left mouse button then drag on
the top or bottom resize button as shown below until the required number of ports are available.

HE EH =
L
| % |
Drag
Here
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Additional port polarity parameters are available in the ModuléWare Parameters dialog box for
each port.

Y ou can also change the polarity by selecting a port and choosing Active High or Active Low
from the Port Type cascade of the popup menu.

When aModuleéWare instance is sel ected, you can often change the function by choosing one of
the Change to options from the M oduleW ar e cascade in the popup menu. For example, if an
and gate is selected, you can change it to an or or xor gate with the same number of ports. The
logical shape is automatically updated to represent the new function.

Setting the Visibility of ModuleWare Parameters

Y ou can set the visibility of the ModuleWar e parameters on a block diagram by using the
Params Display button in the ModuleWare Parameters dialog box to display the Moduleware
Parameters Visibility dialog box:

Hla ModuleWare Parameter Visibility

— Text box

W Instance name [T Active port levels
W In-Line / name W Part Synchronization
V¥ Part widths V¥ Part-zpecific settings
[v HOL preview

k. Cancel Help

%

The dialog box can aso be displayed by double-clicking on an existing ModuleWare
Parameters text box.

The selected parameters are shown in atext box on the diagram which is usually displayed by
default but can be hidden by choosing Hide Text from the popup menu for the text box. If not
shown the text box can displayed by choosing Show Text from the popup menu for the

M oduléWare component.

Y ou can set the default visibility of ModuleéWare parameters on ablock diagram and the
properties which are shown in the object tips for aModuleware instance using the ModuleéWare
Params page of the Block Diagram Master Preferences dialog box.

These preferences can also be accessed in an existing diagram to change the visibility for new
and existing instances in the same diagram. Refer to “ Setting Block Diagram Preferences’ on
page 223 for more information.

114 Graphical Editors User Manual, V2008.1
September 18, 2008



Block Diagram and IBD Views
Adding Blocks and Components

Instantiating an External HDL Model

Any existing external HDL model can be instantiated by reference as a component in a block
diagram or IBD view. The HDL Designer Seriesinstallation includes HDL for Inventra,
Seamless CVE and speedCHART models (in the hdl_libs/src subdirectory).

VHDL and Verilog source for synthesizable Inventra system level building blocksis provided
in the hdl_libg/src/inventra installation subdirectory astwo files:

inventra_soft_cores.vhd (VHDL entities)

inventra_soft_cores.v (Verilog modules)

These models are based on soft cores distributed by the Inventra Intellectual Properties (1P)
business unit of Mentor Graphics Corporation.

More information including descriptions of all the currently available models can be obtained
from the Inventra worldwide web site at:

http://ww. nentor.conlfinventra/index. htn

VHDL 87 source for using the following Seamless CVE modelsis provided in the
hdl_libs/src/cve_ghdl_vhdl installation subdirectory:

arm7tdmi.vhd dram.vhd mc68040.vhd register_mem.vhd
dpram.vhd fifo.vhd ppc603e.vhd sram.vhd

Refer to the Seamless CVE documentation for a full description of these models.

Note
D Seaml ess expects these models to be compiled into the library:

cve_ghdl_vhdl.lib at $CVE_HOME/cve_ghdl_vhdl_87_lib

where the CVE_HOME environment variable specifies the location of the Seamless

software. Y ou should add thislibrary to your library mapping and enter cve_ghdl_vhdl as

the compiled library in the Add Instance dialog box when instantiating a CVE model.

Please contact Mentor Graphics customer support for information about the latest available

CVE models for other compilers (including Verilog language models) or visit the Seamless
worldwide web site at:

http://ww. nmentor. com codesi gn/ mai n-f/i ndex. ht m

VHDL source for the following speedCHART component libraries. can be found in the
hdl_libs/src/spdch/vhdl installation subdirectory:

spdch_components.vhd

spdch_entities.vhd

spdch_configurations.vhd
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Thefollowing Verilog file can be found in the hdl_libs/src/spdch/verilog installation
subdirectory:
spdch_comp_lib.v

Note
D The models defined in these files are provided for users transitioning from speedCHART

Project Designer to the HDL Designer Series and can be instantiated as external HDL
models or converted using HDL import.

Any other models defined in aVHDL entity declaration, component definition in aVHDL
package or Verilog module description on your file system can also be instantiated. For
example, FPGA or 3Soft models.

Note that an external HDL model can be defined using a different language to the view it is
instantiated in. VHDL models can bere-used in aVerilog block diagram or Verilog modelsin a
VHDL diagram.

The Add External 1P dialog box is displayed when you use the button or choose | P from the
Add menu:

Hla Add External IP

Language: & WHOL 1 Verlag

Entity source file: ID:HBuiIdsthsEDDM ahhdl_libsharchinventrahinventra_soft || Browse...

E ntity narme: IMBEEH& Browse. ..

Architecture file: |D:xaui|dsxhdsznn4.1axhd|_|ibsasn:xinventraxinventra_saft Browse...

Ui

Architecture name: I Browsze

Diownstream library: I ExtemallP_lib j

k. | Cancel | Help

k\_

Y ou can enter (or browse for) the pathname of an existing HDL file which containsaVHDL
entity declaration or Verilog module and browse alist of the entities (or modules) contained in
thefile.

Note
If the file extension is not recognized as one of those specified in the File tab of the

VHDL or Verilog Options dialog box, it is assumed to be VHDL.

Y ou can optionally enter a soft pathname which is defined as an environment variable or (on
UNIX systems) in alocation map. However, the full expanded pathname is shown when you
use the Browse button.
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For an external VHDL file, you can browse for the name of a separate architecture file and
architecture name. (Y ou can optionally omit the architecture name or enter a name which is not
yet defined.) However, you must specify the downstream library which contains (or will
contain) the compiled object. Thislibrary can be set by choosing from a drop down list of
currently mapped Downstream Only libraries.

The library name, entity name and an automatically generated unique instance name are shown
on the component.

For an external Verilog file, you can optionally use alibrary to contain the compiled object. The
Verilog module name, filename and an automatically generated unigue instance name are
shown on the component.

Caution
D External VHDL or Verilog models must be compiled outside the HDL Designer Series

tool.

The external HDL fileis parsed to extract information about the interface including contained
VHDL entities, VHDL architectures or Verilog modules, VHDL package referencesand VHDL
generic or Verilog parameter declarations.

If the specified file contains asingle HDL model (described by a VHDL entity, VHDL
architecture or Verilog module) thismodel is automatically selected. An error message isissued
iIf aparse error is encountered.

If aVHDL model requires any VHDL packages which are not already referenced, you are
prompted whether to add them.

A symbol isautomatically created and the external HDL model is added on a block diagram as
acomponent instance with input ports automatically placed on the left, output ports on theright,
bidirectional ports on the top and buffer ports on the bottom.

The default values of any VHDL generic or Verilog parameter declarations are shown on a
block diagram and can be edited using the Object Properties dialog box.

Using a Soft Pathname for External HDL

If you want your design to be portable, it is advisable to specify the location of external HDL
models using a soft pathname.

The soft pathname can be an environment variable or on UNIX systems a soft prefix defined in
alocation map.

The Browse buttons on the Add Instance and Update dialog boxes do not allow you to browse
soft pathnames. However, you can enter a soft pathname directly or use the browser to locate
the external HDL file and then substitute the appropriate prefix.
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A leading $ must be included when you are using an environment variable or |ocation map
prefix. For example, you could enter $External in the file name entry box, then use the Browse
button to navigate below this location and select an external HDL file. Then substitute
$External in the hard pathname before confirming the dialog box.

Updating an External HDL Model

Y ou can update or replace an external HDL model by choosing From HDL from the Update
cascade in the popup menu when an external 1P component is selected on ablock diagramor in
an IBD view.

The Update/Replace Foreign Component dialog box is displayed which alows you to update
the pathnames for the external HDL source files or replace the name of the VHDL entity,
VHDL architecture or Verilog module).

For example, the following dialog box is displayed when the external HDL is VHDL.:

Language: & wHDL € Yerlog

Entity source file: ID:'xBuiIds'xhdsEElEld.2'xhdI_IiI:us'xsru:'xinventra'xinventra_sn:nft_ Browse... |
Entity narne: ImpCi Browse. .. |
Architecture file: ID:'xBuiIds'xhdsEEIEId.2'xhdI_IiI:us'xsru:Hinventrahinventra_snft_ Browse... |
Architecture name: I Browse. .. |

Diownstream library: IE:-:ternaIHDL j
k. | Cancel | Help L

Y ou can also change the downstream library for an external HDL model. However, the
language can not be updated. If you want to replace an external HDL model by one of a
different language, it must be deleted and re-instantiated in order to update the interface
correctly.

Note

D Y ou do not need to update the pathnames if you used a soft pathname which is defined as
an environment variable or (on UNIX systems) in alocation map. The references are
retained if the definition of the soft pathname changes.

Adding an Embedded Block

When you add an embedded block on a block diagram, a ghosted rectangle is attached to the
cursor and can be placed on the diagram by clicking the L eft mouse button at the required
location.
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The embedded block is added with a default size or you can hold down the mouse button and
drag across the diagonal for arequired size. When you add an embedded block on an IBD view,
anew instance column is added to the table matrix.

The embedded block is added with a default name and instance number. The default name can
be set as a preference but is made unique by adding a numeric suffix if the name already exists
on the diagram.

The instance number controls the ordering of the HDL code describing the embedded view in
the generated HDL when there are multiple embedded views in the same diagram.

Y ou can edit the name or instance number of the embedded block on a block diagram (or the
instance name on an IBD view) by direct text editing. Y ou can edit the name of an embedded
block inan IBD view by choosing Rename from the popup menu.

Y ou can aso edit the name and number by using the Embedded Blocks page in the Object
Properties dialog box which is displayed when you by use the button or choose Obj ect
Properties from the Edit menu.

Opening an Embedded View

Y ou can open the existing embedded view of an embedded block by choosing Open from the
popup menu or by double-clicking over the embedded block on the block diagram or IBD view.
If no view exists, the Create Embedded View dialog box is displayed.

Hla Create Embedded Yiew

Create a new view for:  Embedded Block: OR1

Select twpe of view to create:;
Cancel
o+ Text
(" State Diagramn
" Flow Chart
" ASM

" Truth Table

The dialog box allows you to create an embedded flow chart, state machine, truth table or HDL
text view. However, each embedded block can have only one view.

Note

D A flow chart, state machine or truth table created in thisway is saved as part of the same
design unit and not as a child hierarchical design unit. The embedded view shares the
same undo log as the parent view and any Undo (or Redo) command will perform the last
command executed in either view.
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If an embedded block has an existing view, you can choose Change Embedded View from the
popup menu. Y ou are prompted whether to delete the existing view and the Create Embedded
View dialog box is displayed for you to open anew view.

When you create an embedded flow chart, state machine or truth table, the embedded view is
named by adding the embedded block name to the parent view name separated by a colon and
displayed in anew tab added to the active window.

For example, if the block diagram TEST\Counter\Struct contains an embedded block named
Decode which is defined by atruth table, the truth table istitled TEST\Counter\Struct: Decode.

An embedded state machine or flow chart can also include hierarchical or concurrent diagrams
which are named in the usual way (by appending the object name in square brackets). However,
if more than one embedded state machine block isincluded on any view, the state vector is not
written and only one ENUM attribute is declared.

VHDL architecture declarations or Verilog module declarations are disabled in an embedded
flow chart, state diagram or truth table. However, these can be entered on the parent view
containing the embedded block.

Adding Embedded HDL Text

When you create an embedded HDL text view on a block diagram, a default text object
containing the embedded view name and number as comment text is added on the diagram.

This object is associated to the embedded block by an anchor but can be moved independently
by dragging with the mouse. Y ou can resize the text object by dragging its resize handles or
change the visibility of the text to hide or show it on the diagram.

Y ou can edit the HDL text by direct text editing on a block diagram or by using the Text page
of the Object Properties dialog box which is displayed when you use the button or choose
Object Propertiesfrom the Edit menu.

Refer to “Editing Text Properties’ on page 58 for more information about the Text tab of the
Object Properties dialog box.

Y ou can also open an embedded HDL text view in the text editor by selecting the text object (or
the embedded block instance in an IBD view) and choosing Send To Editor from the popup
menu, by choosing Open from the popup menu or by double-clicking on the embedded block
instance.

Note
If you double-click on an embedded block when the HDL text view is already open in the

editor, you are prompted whether to finish the edits.
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Any valid HDL statements for the current hardware description language can be entered in free
format (including line breaks and indentation which are preserved when the text is displayed on
adiagram) but each statement must be terminated by a semi-colon.

The syntax is automatically checked for the hardware description language of the active view.
However, syntax checking can be disabled by unsetting a preference. If you change the
language for the current view, syntax errors are reported when you close the HDL text view.

The HDL code isinserted after the first BEGIN statement in the generated HDL for the block
diagram or IBD view. When there are more than one embedded HDL text views in the same
view, they are treated as concurrent statements.

Updating an Instance

Y ou can know the instances that need to be updated in IBD editor, by choosing I nstance

I nterface Consistency from the Table menubar option. Instances that need to be updated will
be highlighted in red. Y ou will be prompted if all instances are up-to-date. If any instances are
out-of-date, the following dialog box appears.

Check Instance Intrface Consistency Eq |

The Fallawing companent instances are auk of date with respect ko their symbal inkerface: -
5 I1, Iz, I3
IJse Update Interface command ko resolve differences,

L

Do wou want bo update them nows

Yes Mo |

You can update instances later by clicking No. If you choose to update instances now,
instances ar e updated but the red highlight will continueto appear until you clear it by
clicking Clear Net Highlight from the menu bar.

Note
D If you try generating an IBD that has out-of-date instances, an error message appears in
the Log window listing the instances that need to be updated.

Y ou can update a component instance with the latest interface defined by its symbol by
choosing one of the options from the Update cascade of the Diagram or popup menu when the
component is selected.

If you choose I nter face, the Reconcile Interface dialog box is displayed as described in
“Reconciling Interfaces’ on page 122. This command examines the interface defined in the
child view and allows you to reconcile any differences by updating either the child or parent
views.New ports added in the graphics or text will be synchronized (i.e. added to the other
description). Deleted ports will be synchronized (i.e. removed form the other description)
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Note
D Type differences (e.g. wire/reg etc.) are not updated in either direction for Verilog
designs with text leaf-level descriptions.

Y ou can choose I nterface and Graphics when the symbol defining the interface to a
component has changed and you want to update its instantiation on the block diagram or IBD
view. This command attempts to preserve the instance size and port positions.

Alternatively, you can choose to update From Symbol when you want to replace the selected
component including any graphical layout changes specified in the symbol. The connectivity is
preserved although nets may have to be moved if the port positions have changed on the
symbol.

Y ou can aso choose Graphics To Symbol when you want to update the symbol with changes
to the layout, appearance, port placement or visibility from the component instance. Y ou must
have write permissions to the component to use this command. If there are any interface
differences on the symbol, you are prompted to resolve them.

Similarly, you can update a block instance with the interface information from a child HDL text
view by choosing From HDL from the Update cascade in the popup menu.

If any of the interface ports have been renamed, the port is disconnected when you update the
instance but the overlapping ports and signals can be reconnected using the Connect option
which is available from the Diagram menu or popup menu in ablock diagram.

Note that Verilog is case sensitive but VHDL is case insensitive, therefore port names will be
disconnected if you change the case of a Verilog port name but not if you change the case of a
VHDL port name.

If VHDL generic or Verilog parameter declarations are defined on the symbol, their values are
not updated on the component and may need to be edited using the Object Properties dialog
box.

Reconciling Interfaces

When you create a new block diagram or IBD view its externa ports are defined by the parent
view. These ports are defined by the symbol for acomponent or by the connections to the parent
view for ablock. However, the interfaces may become inconsistent and need to be reconciled
after a diagram has been edited.

Note
D Y ou are automatically prompted to update the interface when you save or close a block
diagram or IBD view after changing the port declarations.
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Y ou can reconcile interfaces by choosing I nter face from the Update cascade of the Diagram
menu in ablock diagram or from the Table menu in an IBD view to display the Reconcile
Interface dialog box.

H[j Reconcile Interface E3
Instance 11 :: The interfaces are DIFFEREMT. Instances
The inconziztencies are cauzed by:- B LART fopuinterface (1]
ch_int_en: M std_logic LART Azenial_interface [14]

ch_int_enable: IM  std_logic

The instance interface iz:-
clear_flagz : OUT  ztd_logic
cl: 1N ztd_logic
clk_div_en: M ztd_logic —
ch_int_enable: IM  std_logic
cz: M ztd_logic
data_out: OUT  std_logic_wectar [7 DOWwWMTO O]
div_data: I[N std_logic_wvector [7 DOWMNTO 0
enable_write : OUT  ztd_logic
ng s M std logic
et 1M ztd_logic
zer_if_data:IM  std_logic_wector [F DOWwWMTO O] _ILI
k

Kl « | ]
i+ Wake the instance conzsistent with child view .
Optiohz...
= Make child view consistent with the instance
(] Cancel | Apply | Help

If no block or component instance is selected, this command reconciles interfaces with the
parent view.

If ablock or component instance is selected, the command is also available from the popup
menu and you can reconcile the interface to the selected child view.

Y ou can also compare the interface of a component representing external 1P with the interface
defined in the external HDL file. However, in this case only the instance can be updated.

If more than one block or component instance is selected, all the views are listed and can be
reconciled by selecting an instance name from the list.
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By default, reconcile interface ignores any differences due to inconsistent case or port ordering
but you can set Enfor ce consistent case or Enfor ce consistent port ordering by using the
Options button to display the Reconcile Interface Options dialog box.

Hla Reconcile Interface Options [E3

[™ Enforce consistent caze

™ Enfarce consistent part ordering

ak | Cancel | i

If you change either of these options, the new default is saved as a preference.

Inconsistent case or port ordering is not reported until all other inconsistent interfaces have been
successfully reconciled.

Note

D If there are any changes to the ports defined in the symbol, any comments added in the
symbol are reconciled. However, changes to the comments in the symbol are ignored if
there are no changes to the interface declarations.

Y ou can use reconcile interfaces to add or remove ports or propagate changes to signal
properties between views. However, you cannot use reconcile interfaces to propagate changes
to signal names. Refer to “Propagating Net Changes’ on page 158 for information about
propagating asignal change through hierarchical views.

If you change a signal name and reconcile the interfaces, a port and stub signal are added to the
related view for the new name and the old signal is disconnected.

Any inconsistencies are reported and you can choose to automatically apply changes to make
either the current view or the related (parent or child) interface consistent.
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Checking the Design

Y ou can set options for checking the connectionsin ablock diagram or IBD view by choosing
Design Checking Options from the Diagram menu in ablock diagram or the Table menu in

an IBD view to

display the Design Checking Options dialog box:

Hla Dezign checking options B3

Select design check options:

W Check interface - Check Block Diagram interface againzt the parent.
¥ Dangling nets - Report nets that are missing drivers and/or loads.
W Unconnected ports - Report component ports that are not connected.
W width mizmatches - Report portdnet width mizmatches.

¥ Type mismatches - Report port/net type mismatches.,

¥ Stict wpe companizon - Types must match exactly.

W Multiple drivers - Report nets that are driven by multiple ports.

] I Eancell

%

Y ou can check the connectionsin the design by using the button or choosing Check Design

from the Diagram menu in ablock diagram or from the Table menu in an IBD view.

This command issues areport to the log window listing any mismatch with the interface and

any netswhich

have no drivers (source is unconnected) or no loads (destination is

unconnected). For example:

H[} Log Window M=]E3

L= el REREREN = s

Report for design checks in Block Diagram 'SCRATCH_LIB/Counter/struct'; ;I
Checking for interface mismatch:
Interfaces are DIFFEREMT.
The inconziztencies are caused by
clk_en:IN  ztd_logic
cout: OUT  std_logic
The fallowing netz have no loads:
# cout : std_logic
The following nets have no drivers:
# clk_en: std_logic
Found 2 net/s that were mizzing drivers, loads or bath,
Found 0 ingtanceds that had dangling ports.
Found 0 netds that had multiple drivers.
Found 0 port/s that had mismatched widths.,
Found 0 port/s that had mismatched bpes. |

Reported 3 design warnings. ;I

Log
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An error message isissued in the log window if the option to check the interface is set and the
view has not been saved. If the view has been saved, any inconsistencies with the interface are
reported.

Y ou can check the block diagram or IBD view for unconnected (dangling) nets or ports and for
any nets connected to ports with a different width or type. These checks include unconnected
nets contained in a bundle or connected only to a global connector or ripper.

Y ou can set strict type comparison to report any unmatched types or unset this option to allow
nets connections with arelated type (for example: std_ulogic and std_logic).

Y ou can aso check for nets that are driven by multiple ports.

Note that you can click on the net names reported in the log window to cross-reference to the
nets on the block diagram or IBD view.

Checking Through Hierarchy

Y ou can check al block diagram and IBD views hierarchically by selecting any design unit in
the design explorer and choosing Check BD/IBD Through Hierarchy from the Tools or
popup menu.

If any of the block diagrams or IBD views in the hierarchy violate the current design checking
options, areport window is displayed in the design explorer showing these viewsin an
expandable list.

Note
D If no violations are detected, amessageis raised informing you that the check is complete
without any failures found as shown in the figure below.

Check BD/IBD Through Hierarchy E3

\!}) hecks completed with no Failures,

Y ou can open any of these views by double-clicking or choosing Open File from the popup
menu. The design check violations for each view are shown in the Log window when they are
opened.
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Editing Object Properties

Y ou can display and edit properties for objectsin a Block Diagram or IBD view through the
Object Properties dialog box.

To display the Object Properties dialog box:

1. Select an object in the Block Diagram or IBD view.

2. Do one of the following:

(0]

(0]

(0]

(o]

Click the button on the shortcut bar.
Usethe Alt + shortcut.
Choose Object Propertiesfrom the Edit menu.

Choose Object Properties from the cascade popup menu.

The left pane of the dialog box displaysalist of the block diagram objects. These include
Components, Blocks, Embedded blocks, Moduleware. External 1Ps, Signals, Bundles, Portl Os,
Frames, Comment Text, Comment Graphics and User Declarations. Y ou can use + to expand or
collapse an object list.

Note

D The Generics Sub-page is available for Components, Blocks and External IPsif you are
using VHDL or the Parameter s page if you are using Verilog. The Bundles, Portl O,
Comment Text and Graphics pages are not available in an IBD view.

Selected objects are displayed in black and their corresponding pages are enabled. Objects not
in the selection set are displayed in grey and their corresponding pages are disabled.

The right pane of the dialog box displays the selected object properties page.

Editing Component Properties

The Componentsobject is selected if you display the Object Properties dialog box when one or
more component is selected on a block diagram or IBD view.
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The components page of the BD Object Properties dialog box allows you to specify the library,
component name and I nstance name.

H[} BD Object Properties - Components
- J Components Library: U&RT - WV isi
’ : : v Yizible
Generics | J
Text Visibility Compotent M arme: |,3|,:,,3k divider
Partt ap Frame -
Allributes |nztance Mame; Uz -
Appearance - | _ [+ izible
+ Yiewddrchitecture
T
! o Default View [ Exclude view name from embedded configurations
+ v o
- " Specified Yiew: | J
¥
T
+.
+
----- I1zer Declarations
‘o Uszer Properties
k. Cancel Apply Help

For aVHDL component, you can also change the instantiated view. This can be the default
view or any other named view which existsfor the component. If you choose the default view, it
can optionally be included with no architecture reference. When you are using Verilog, the
default view is always used and the Architecture options are not available.

Editing Component Generics and Parameters

The Generics page for the Component Object of the BD Object Properties dialog box allows
you to override the default Generics that have been already defined on the component symbol
using the Symbol editor. In addition it allows you to specify HDL Generation Settings.

The same applies to the Par ameter s page which is available if you are using Verilog as your
design language.
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HBBD Object Properties - Component Generics ﬂ
E|;|:| Companerts —HDL Generation
""" Generics ¥ Generate Generic Mappings for this instance
i Tent Wisibility
----- Porttd ap Frame ¥ Generate Generic Declarations in the Component Declaration
----- Attributes
i Appearance ™ &dd OFF/0M pragmas around Generic Declarations and Mappings

Inst Kame MHarme Type Yalue Fragma Carmment

H ¢ wi oG ioqis

----- |Jzer Declarations
‘o zer Properties

|pdate ligt |
k. I Cancel | Apply | Help |

%

Refer to “ Defining Generics and Parameters’ on page 176 and “ Editing Generics and
Parameters for Instances’ on page 178 for more information.

Editing Component Text Visibility

The Text Visibility page for the Component Object of the BD Object Properties dialog box
allows you to set the visibility of VHDL generic or Verilog parameters and also allows you to
modify port display properties for the selected component instance. Refer to “Changing the
Display of Port Properties’ on page 198 for more information.
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HBBD Object Properties - Component Text Yisibility

E|;E| Components

: ) [T Show genernic values
- Lenerics

e.g. name, type and constraints.

Controls the farmat and vizibility of usage and declaration infarmation attached to all ports

— Fields to dizplay
[~ Port Mame

[¥ Tupe Conztraint
[ Type Hame
[ Initial W alue

[v Dizplay Port and Declaration information on the same line

— Format for type constraints
" Full form - e.g. [7 DOWNTO 0]

¥ Short form - e.g. [7:0)

— Mizc
¥ Selectable Text

[allowz the properties text ztrings o be
individually zelected)

Format Preview:

ok ]

Cancel Apply Help

Editing Component Port map Frame

The Port Map Frame page for the Component Object of the BD Object Properties dialog box
allows you to enable (or disable) a port map frame and edit the mapping between formal ports

on the component and the actual signals.

When Enable Port Map Frame s set, mapping generated automatically by direct connections
isshown in read-only list with a separate editable list where you can explicitly map the ports
and signals. When Connection by Nameis set, any signal connected to the frame with the same

name as a component port isimplicitly connected.

When you enable aport map frame, atemplate port map for al unconnected component portsis
shown as an editable comma separated list in the dialog box. For example:

VHDL Verilog
portA => | . portA(),
portB =>, . portB(),
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VHDL Verilog
portC => .portC()
Y ou can enter actual VHDL signal names after the => operator or actual Verilog signal names

inside the parentheses (). Ensure that you remove any duplicate entries from the editable list if
they already exist in the automatically generated list before attempting to generate HDL .

Refer to “Port Map Frames’ on page 273 for more information about using port map frames.

HBBD Object Properties - Port Map Frame

El;. Components
L L Generics
ext Visibility ¥ | Eornestion Bl ame

Embedded Blocks
b odulehf are
EuternallPz

ﬁ Comment Graphics
|Jzer Declarations

|zer Properties
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Setting Component Attributes and Embedded Constraints

The Attributes page for the Component Object of the BD Object Properties dialog box allows
you to set attributes and embedded constraints for the selected components. Refer to “ Setting
Attributes and Embedded Constraints’ on page 157 for more information.

HEBD Object Properties - Attributes x|

El;l:l Components
E i Generics

----- T ext Wigibility Thiz text will be ingerted into the generated WYHOL.
..... Porthdap Frame The template text iz defined in the WHDL Options dialog

Enter WYHDL Attributes andd/or embedded syunthesis constraintz
relating to this signal/port/block /companent using YHOL suntas,

[Headerz Page - Embedded Constraintz].

R Altributes
o Appearance
----- -- Template for Spnopays DC constraints ;I
_____ -- pragma dc_zcript_beqin
""" - pragma dc_zcript_end
..... -
..... - WHDL Attribute Template

--attribute <name> of <objects : <clazsr iz <values;

----- |Jzer Declarations
‘o zer Properties

k. I Cancel Apply | Help |

Modifying Component Appearance

The Appear ance page for the Component Object of the BD Object Properties dialog box
allows you to set visual attributes for the selected components.

The attributes include the foreground, background and line color, the line style, fill style, line
width. Y ou can set the font used. Y ou can also change the appearance of a component by
choosing Appear ance from the popup menu.

Y ou can change the shape of the selected blocks by choosing a standard logic shape from a
drop-down list or by choosing Autoshape from the popup cascade menu to choose from alist of
standard shapes. Y ou can aso define your own shape by selecting Editing Shape from the
popup cascade menu.
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Refer to “ Changing the Shape of a Block or Component” on page 220 for more information.

H[1BD Object Properties - Edit Appearance |
El@ Components
. L Generics - Color 3l
Test Visibility Foreground. [ || Firswle K
Parttdap Frame ; . :
Aitibutos Background: I j Line Style: l:j
e Line Colar: I || | Line it —
'J — Change Shape:
_____ P| rectangle J
..... 1
....-

----- |Jzer Declarations
‘o zer Properties

(] I Cancel Apply Help

Editing Block Properties

The Blocks object is selected if you display the Object properties dialog box when ablock is
selected on ablock diagram or IBD view.

The Blocks page of the BD Object Properties dialog box allows you to specify the Library,
Block name and I nstance name.

Note
The block and instance name cannot be the same when you are using VHDL but can be
given the same name if you are using Verilog.

Y ou can change the library for all the selected blocks but the instance name and block name
must be unique HDL identifiers and can only be edited if asingle block is selected.
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When the dialog box is displayed from a block diagram, you can choose whether the library and
instance name are visible on the diagram.

Y ou can also set the visibility of the declarations and values for VHDL generics or verilog
parameters on the diagram and choose whether ports are shown for nets connected to the block.

Refer to “ Opening Block and Component Views’ on page 185 for more information.

Editing Block Generics and Parameters

The Generics page for the Block Object of the BD Object Properties dialog box alows you to
specify HDL Generation Settings.

The dialog box also lists any existing VHDL generic declarations and allows you to change the
values mapped for each instance. The same appliesto the Parameter s pagewhich isavailableif
you are using Verilog as your design language.

Refer to “ Defining Generics and Parameters’ on page 176 and “ Editing Generics and
Parameters for Instances’ on page 178 for more information.

Modifying Block Port Ordering

The Port Ordering page for the Block Object of the BD Object Properties dialog box allows
you to modify the port ordering by choosing the Manual option to disclose an ordered list. The
list shows how the port declarations will be ordered in the generated HDL for the block

One or more port declarations can be selected and moved up and down thelist by using the :l
and Ll buttons. If you choose Automatic the list is ordered a phanumerically.

Y ou can modify the port ordering for a block by choosing the Manual option in the dialog box
to disclose an ordered list showing how the port declarations will be ordered in the generated
HDL for the block.

Note

D If ablock has been set to use manual port ordering, then manual ordering is used when
you create a child block diagram or IBD view. Consistent port ordering can optionally be
enforced when you reconcile interfaces.
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Setting Block Attributes and Embedded Constraints

The Attributes page for the Block Object of the BD Object Properties dialog box allows you to
set attributes and embedded constraints for the selected blocks. Refer to “ Setting Attributes and

Embedded Constraints’ on page 157 for more information.

e

'!BD Object Properties - Attributes

Enter WYHDL Attributes andd/or embedded synthesis constraintz
relating to this signal/port/block /companent using YHOL suntas.
Thiz text will be ingerted into the generated WYHOL.

The template text iz defined in the WHDL Options dialog
[Headerz Page - Embedded Constraintz].

-- Template for Spnopays DC constraints ;I
-- pragma dc_zcript_beqin

-- pragma dc_zcript_end

- WHOL aAttribute Template
--attribute <name> of <objects : <clazsr iz <values;

(] I Cancel Apply | Help |

Setting Block Appearance
The Appear ance page for the Block Object of the BD Object Properties dialog box allows you
to set visua attributes for the selected blocks.

The attributes include the foreground, background and line color, the line style, fill style, line
width. You can set the font used.
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Y ou can also change the shape of the selected blocks by choosing a standard logic shape from a
drop-down list.

HBBD Object Properties - Edit Appearance

[ I
—
—

ﬂ Euternall Pz ’7
M, Signals rectange 7]
ML, Bundles
m- ot 0z
Frames
Comment Text
ﬁ Comment Graphics
Idzer Declarations
|zer Properties

Refer to “ Changing the Shape of a Block or Component” on page 220 for more information.
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Editing Embedded Block Properties

The Embedded Blocks pageis selected if you display the Object Properties dialog box when an

embedded block is selected on a block diagram or IBD view.

HBBD Object Properties - Embedded Blocks ﬂ
- ~Embedded Block
T M arne; |E|:.'| IV Wizible
B it i ¥ isible
- Block Appearance
¥ Show Parts when connected
..... J
..... 1
.....
295
----- |Jzer Declarations
‘o zer Properties
1] | ]
(] | Cancel | Apply Help |

%

The Embedded Blocks page allows you to specify the name and number of the embedded bl ock.
The name must be a unique HDL identifier in the view. The number must also be unique and

determines the order in which the HDL for unconnected embedded blocksisincluded in the

HDL for the view.

If you enter anumber which is aready used by another embedded block in the same design unit
view, the numbers are swapped. The name and number can only be edited if asingle block is

selected.

When the dialog box is displayed from a block diagram, you can choose whether the name and
number are visible on the diagram and choose whether ports are shown when nets are connected

to the embedded block on the diagram.
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Editing Embedded Blocks HDL Text

The HDL Text page for the Embedded Block Object of the BD Object Properties dialog box
allows you to edit the existing HDL text.

Any valid HDL statements for the current hardware description language can be entered in free
format (including line breaks and indentation) but each statement must be terminated by a semi-
colon.

The syntax is automatically checked for hardware description language of the active view.
However, syntax checking can be disabled by unsetting a preference.

Y ou can use the modify check box to apply the new text to all the selected embedded HDL text
views on the diagram.

Y ou can also modify the text position in the bounding box.

Modifying Embedded Blocks Text Appearance
The Text Appear ance page for the Embedded Block Object of the BD Object Properties dialog

box allows you to modify the font of the comment text.

Modifying Embedded Blocks Text Box Appearance

The Text Box Appear ance page for the Embedded Block Object of the BD Object Properties
dialog box allows you to set visua attributes for the selected blocks text box.

The attributes include the foreground, background and line color, the line style, fill style, line
width.

Modifying Embedded Blocks Appearance

The Appear ance page for the Component Object of the BD Object Properties dialog box
allows you to set visual attributes for the selected embedded blocks.

The attributes include the foreground, background and line color, the line style, fill style, line
width. You can set the font used.

Y ou can al so change the shape of the selected blocks by choosing a standard logic shape from a
drop-down list.

Refer to “Changing the Shape of a Block or Component” on page 220 for more information.
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HBBD Object Properties - Edit Appearance ﬂ
i — Caolor — Style
E|d:| Ermbedded Blocks Foreground: I j Fill Style: I. j

_____ B ackaround: I—j Line Style: l:j

Line Colar: A Line twidti: -
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:g — Change Shape:
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‘o zer Properties
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Editing ModuleWare Properties

The ModuleWar e object is selected if you display the Object properties dialog box when a
moduleware is selected on a block diagram.

The Moduleware page of the BD Object Properties dialog box allows you to specify the
Moduleware Instance name.The library and the component name fields can not be modified.

Y ou can choose to display the library and instance name on the moduleware symbol.

Y ou can use the Moduleware parameters button to display the ModuleWare Parameters dialog
box. Refer to “ Editing ModuleéWare Parameters’ on page 111 for more information.
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Editing Moduleware Port map Frames

The Port Map Frame page for the Moduleware Object of the BD Object Properties dialog box
allows you to enable (or disable) a port map frame and edit the mapping between formal ports
on the Moduleware and the actual signals.

When Enable Port Map Frameis set, mapping generated automatically by direct connections
is shown in read-only list with a separate editable list where you can explicitly map the ports
and signals. When Connection by Name is set, any signal connected to the frame with the same
name as a component port isimplicitly connected.

When you enable a port map frame, atemplate port map for all unconnected ModuléWare ports
Is shown as an editable comma separated list in the dialog box. For example:

VHDL Verilog
portA => | .portA(),
portB =>, . portB(),
portC => . portC()

Y ou can enter actual VHDL signal names after the => operator or actual Verilog signal names
inside the parentheses (). Ensure that you remove any duplicate entries from the editable list if
they already exist in the automatically generated list before attempting to generate HDL .

Refer to “Port Map Frames’ on page 273 for more information about using port map frames.

Setting ModuleWare Attributes and Embedded Constraints

The Attributes page for the Moduleware Object of the BD Object Properties dialog box alows
you to set attributes and embedded constraints for the selected M oduleWare components. Refer
to “Editing ModuleWare Parameters’ on page 111 for more information.

Editing External IPs Properties

The External 1Psobject is selected if you display the Object properties dialog box when an
External IPis selected on a block diagram or IBD view.

The External 1Ps page of the BD Object Properties dialog box allows you to specify the Instance
name.

For aVHDL component, you can also change the instantiated view. This can be the default
view or any other named view which exists for the External IP. If you choose the default view,
it can optionally be included with no architecture reference. When you are using Verilog, the
default view is always used and the view options are not available.

Y ou can use the + to expand the objectsist.
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Editing External IP Generics

The Generics page for the External |P Object of the BD Object Properties dialog box allows
you to specify HDL Generation Settings.

Editing External IP Text Visibility

The Text Visibility page for the External 1P Object of the BD Object Properties dialog box
allows you to set the visibility of VHDL generic or Verilog parameters.

The dialog box also allows you to modify port display properties for the selected External 1P
instance. Refer to “ Changing the Display of Port Properties’ on page 198 for more information.

Editing External IP Port map Frame

The Port Map Frame page for the External |P Object of the BD Object Properties dialog box
allows you to enable (or disable) a port map frame and edit the mapping between formal ports
on the External IP and the actual signals.

When Enable Port Map Frameis set, mapping generated automatically by direct connections
is shown in read-only list with a separate editable list where you can explicitly map the ports
and signals. When Connection by Name is set, any signal connected to the frame with the same
name as a component port isimplicitly connected.

When you enable aport map frame, atemplate port map for al unconnected component portsis
shown as an editable comma separated list in the dialog box. For example:

VHDL Verilog
portA => | . portA(),
portB =>, . portB(),
portC => . port ()

Y ou can enter actual VHDL signal names after the => operator or actual Verilog signal names
inside the parentheses (). Ensure that you remove any duplicate entries from the editable list if
they already exist in the automatically generated list before attempting to generate HDL..

Refer to “Port Map Frames’ on page 273 for more information about using port map frames.

Setting External IP Attributes and Embedded Constraints

The Attributes page for the External 1P Object of the BD Object Properties dialog box allows
you to set attributes and embedded constraints for the selected External 1Ps. Refer to “ Setting
Attributes and Embedded Constraints’ on page 157 for more information.
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Modifying External IP Appearance

The Appear ance page for the External | P Object of the BD Object Properties dialog box allows
you to set visual attributes for the selected External IP.

The attributes include the foreground, background and line color, the line style, fill style, line
width. Y ou can set the font used.

Y ou can also change the shape of the selected External |P by choosing a standard logic shape
from adrop-down list.

Editing Bundle Properties

The Bundle object is selected if you display the Object properties dialog box when aBundleis
selected on ablock diagram.

The Bundle page allows you to specify the Bundle name. If you change the bundle name all
occurrences of the name on the diagram are updated. The visible check allows you to choose
whether the bundle name is displayed or hidden on the diagram.

Hi BD Object Properties - Bundles x|

rat

zin
enable_=mit_clk
enable_rowv_clk
zample
div_data

datin
clear_flags
enable_wirite
ztart_«rmit
zer_if_data
datout

int

oLt
zer_if_zelect

Add Signal

il

o]

—J Marne: IHEQS I+ “wirap contents v Visible name

:g Al NE-'-tS List — Bundle Contents

-5 clk_div_en Add v ‘izible contents

_____ + #mitdt_en

: cli_int_en clear_flags : std_logic
nna Remove enable_write ; std_logic
Czd start_=mit ; std_logic
2|k ' Fermowe Al

Cancel I

Apply |

Help

-

A list of the bundle contentsis normally shown on the diagram as asingle line below the bundle
name but you can check the wrap contents option to list each signal on a separate line.
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A list of declared netsis displayed on the |eft hand side of the page, and alist of the bundle
contents is displayed on the right hand side. Y ou can add a declared net to the bundle by
selecting nets from the left hand side list and clicking “Add”. Y ou can remove a net from the
bundle declaration by selecting it from the right hand side list and clicking “Remove”. Y ou can
clear all the bundle signals by clicking on “Remove All” button.

Y ou can add a new signal to the bundle contents by clicking the Add Signal button to display
the Add Signal dialog box.

Modifying Bundle Appearance

The Appear ance page for the Bundle Object of the BD Object Properties dialog box allowsyou
to set visual attributes for the selected bundle.

The attributes include the line color, line style and line width.

x
i — Colar — Syl
* Foregraumnd: -j Fill Syl -j
j% B ackaraumnd: -j Line Style: —_— j
- I:
B Line Colar «[| | Line width: —-
=l Bundles -J J

(] I Cancel Apply Help

Editing Signal Properties

The Signals page is selected if you display the Object properties dialog box when a Signal is
selected on ablock diagram or IBD view.

The Signal page allows you to edit the declarations of al the signals on ablock diagram or IBD
view.
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Editing VHDL Signal Declarations

The following page is available when you edit signal declarationsfor a VHDL view:

H[}1 BD Object Properties - Signals ” x|
—Uze
Style: " Signal % Bus
Mame: Idiv_data
Signalz Slicendex: DM j
fo Test Visibility I I I
b Attributes 20 Slice: DOWNTD =
----- Comments I I JI
ﬁ‘_LD Appearance — Declaration
Ezl .....
Type: i =
[]_ peE Istd_lu:ugu:_veu:tu:ur J
-y Bounds:
L P 7 | |0
o5 | [powNTo =] ]
----- Izer Declarations 20 Bk I ITD j I
‘o zer Properties
Kind: " Fegister  Buz % Mone
—a&pply changes ko
SCope: Joined 'fires in thiz diagram j
(] | Cancel | Apply | Help L
e

If you edit the net name, it is changed wherever it is used in the view and must beavalid VHDL
identifier.

Y ou can change the type by choosing from a pulldown list of VHDL types or by entering any
other valid type. The type must be defined in a VHDL package referenced in the package list or
be one of the standard predefined types.

Note

D The pulldown list includes all the most commonly used types and any other types which
have already been used in the active view. However, you may need to add a new package
reference if you choose atype which is not in the currently referenced packages. For
example, if you want to use the signed or unsigned types, the ieee.numeric_std package
should be referenced.

144 Graphical Editors User Manual, V2008.1
September 18, 2008



Block Diagram and IBD Views
Editing Object Properties

The bounds can be used to specify the indexes for the elementsin an array or the range for a
scalar type (for example: 15 DOWNTO O0or 0 TO 7).

Y ou can also use the first bounds entry box to enter a user specified range constraint such as an
enumerated or integer type name or you can enter an array name or type name of the form:

<array> RANGE or <array> REVERSE RANGE

Y ou can aso add the VHDL keywords BUS or REGISTER to the net declaration by choosing
Busor Register kind. (If not specified, the default is None.)

Note
Setting initial valuesfor signals can be useful for simulation but may hide the behavior of
acircuit that would be in an arbitrary state at power up.

Using 2D Signal Types

Y ou can use the 2D bounds and 2D dlice fields of the Object Properties dialog box when you
have specified an unconstrained two dimensional array type. This type must be specified in a
VHDL package referenced on the block diagram or IBD view or be defined in the user
declarations for the view.

For example:

type ny2dtype is array(natural range <>, natural range <>) of std_l ogic;
Y ou can also define atwo-dimensional "vector of vectors' by defining an array of avector type.
For example:

type ny _vtype is array(natural range <>) of std _|ogic_vector(3 downto 0);

A two dimensional bounds for signals using this type can then be entered in the dialog box.

Note
D If you useastd logic vector signal and try to define atwo dimensional bounds for this

signal using the Object Properties dialog, HDL generation issues an error message of the

form:

Error, std_|ogic _vector requires 1 index val ues.

Thisisbecause std_logic_vector isaone dimensional unconstrained array and cannot be
given two ranges.
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Editing Verilog Signal Declarations

The following page box is available when you edit net declarations for a Verilog view.

HBBD Object Properties - ¥Yerilog Signals ﬂ
;J —Uze
"J Style: & Signal T Bus
g M arne: I:-:mitdt_en
[=Ea W Signals Sliced ndesx: I
o Tent Wisibility
""" Attributes — Declaration
i Comments :
Type: ; -
e AppEArance IW"E J
G- T Yector Bounds: I : I
[:IELDJ Srray Bownds: I : I
M- E2
e Expansion: [<NOT-SET> =l
----- Idzer Declarations
----- Uszer Properties Charge Strength: |<NEIT-SET> j
Delay # I
—&pply changes to
Scope: IJ:::ineu:I “Wires in thiz diagram j
(] I Cancel | Apply | Help |
g

If you edit the signal name, it will be changed wherever it is used in the view and must be a

valid Verilog identifier.

Y ou can change the type by choosing from a pulldown list of supported Verilog types.

The vector bounds can be used to enter an expression specifying the index of an element in an
array or to specify arange of values (for example: 15:0 or 0:7).

Y ou can specify the vector bounds for awire, tri, wor, trior, wand, triand, tri0, tril, supplyO,
supplyl, reg or trireg type. For signals which connect between embedded blocks, you can
specify the array bounds for integer or time types and for areg type you can specify both a

vector and array bounds.

Y ou can specify expansion and charge strength options:

Y ou can choose whether the expansion options are scaler ed, vector ed or not set. The delay and
expansion options are not available when reg, integer, time, real or realtime type is selected.
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When the trireg type is selected, you can choose the charge strength from small, medium,
lar ge or not set.

Verilog Arrays

Although Verilog does not support multi-dimensional arrays, it does distinguish between
vectors (single elements which are n bits wide) and arrays (multiple elementswhich are 1 or n
bits wide). For example:

integer count[0:7] an array of 8 count variables

reg bool[31:0] an array of 32 1-bit register variables
timet_chk[1:100] an array of 100 time variables

reg [4:0] port_id[0:7] an array of 8, 5-bit port_id vectors

Arrays can be defined for reg, integer, time and vector register data types and do not typically
appear in the signal declarations although they may sometimes be required to connect between
embedded blocks.

Arrays of registers are typically used to represent memories. The following example shows an
array of eight five-bit vectors connected to an embedded block:

.. .. .. .. ... Declarations
ol seh o gk D)
1 F. reg[4:07[0:7] . D L

HDL 2Graphics automatically adds the vector and array bounds to net declarations on a block
diagram or IBD view when a vector with an array declaration and reg type is detected in the
source Verilog. A vector boundsisrecovered for an array of integer or time. If an array element
Isaccessed in a Verilog instantiation, then a corresponding slice is added to the signal on the
block diagram or IBD view.

Y ou can also add the VHDL keywords Bus or Register to the net declaration by choosing bus or
register kind (if not specified the default is none)
Editing Signal Text Visibility

The Text Visibility page for the Signal Object of the BD Object Properties dialog box allows
you to modify the signal display properties.
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Refer to* Changing the Display of Signal Properties’ on page 200

HBBD Object Properties - Text ¥isibility
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‘o Usger Properties

— iz
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Setting Signal Attributes and Embedded Constraints

The Attributes page for the Signal Object of the BD Object Properties dialog box allowsyou to
set attributes and embedded constraints for the selected signals. Refer to” Setting Attributes and

Embedded Constraints’ on page 157.
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Editing Signal Comments

The Comments page for the Signal Object of the BD Object Properties dialog box allowsyou to
add commentsto asignal. Refer to “ Adding Commentsto a Signal or Port Declaration” on
page 155.

'!BD Object Properties - Edit Signal Commments " ﬂ
zJ & zingle ling comment can be added at the end of the declaration line.
E-2 Fultiple-line comments can be added beforeafter the declaration.
.J Comment characters will be added when appropriate.
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[]'ﬂn
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H-EE il F
L -
_____ User Declarations After [rmulti-ling comment] ¥ Add comment characters

_
w“r
o
e
(=]
-
)
g
w“r
ol

(] I Cancel Apply | Help |

Modifying Signal Appearance

The Appear ance page for the Signal Object of the BD Object Properties dialog box allows you
to set visua attributes for the selected bundle.
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The attributes include the line color, line style and line width.

HBBD Object Properties - Edit Appearance ﬂ

— Colar — Syl

J
'i Forearaid -j Fill Syl -j
:% B ackaroumnd; -j Line Style: l:j
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i Comments

(] I Cancel Apply Help

Editing Port IOs Properties

The Port 10 object is selected if you display the Object properties dialog box when a Port is
selected on a block diagram.

The Port 10 page allows you to specify the port mode settings as In, Out. InOut or Buffer in
VHDL designsand In, Out or InOut in verilog designs.

Editing Port IO Text Visibility

The Text Visibility page for the Port 10 Object of the BD Object Properties dialog box allows
you to modify the Port 10 display properties.

Refer to* Changing the Display of Port Properties’ on page 198.
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Modifying Port IO Appearance

The Appear ance page for the Port 10 Object of the BD Object Properties dialog box allows
you to set visual attributes for the selected Port.

The attributes include the foreground, background and line color, the line style, fill style, line
width.

Editing Frame Properties

The Frames page is enabled if you display the Object properties dialog box when aframeis
selected on ablock diagram or an IBD view.

The Frames page of the BD Object Properties dialog box allows you to display and edit
generate frames.

Y ou can choose the frame style from a pulldown list that includes FOR, IF and EL SE when
using Verilog or FOR, IF and BLOCK when using VHDL

Y ou can change the label, number and frame expression. When you are using VHDL, aPreview
field in the dialog box shows the current frame expression. Y ou can set the visibility of the
frametitle (Iabel and expression) and the frame number.

When you are using VHDL, you can enter a Parameter and range for a FOR frame, a Condition
for an IF frame or an optional Guard expression for aBLOCK frame.

When you are using Verilog, you can enter the Range for arepeating instance in a For frame or
the Macroname for an IF frame

The syntax of the expression is checked on entry and the Generate Keyword is automatically
included in VHDL FOR and |IF expressions.

When the Declarations button is selected a free-format entry dialog box is displayed which
allowsyou to specify local declarationswhich apply only within the frame. Y ou can also choose
whether these declarations are Visible on the diagram. The syntax of the declarationsis checked
on entry. For more information refer to “Editing Generate Frame Properties” on page 292.

Modifying Frame Appearance

The Appear ance page for the Frame Object of the BD Object Properties dialog box allows you
to set visual attributes for the selected frames.

The attributes include the line color, style and line width.
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Editing Comment Text Properties

The Comments object is selected if you display the Object properties dialog box when a
Comment is selected on a block diagram.

The Comment Text page allows you to modify the existing comment text and position.

Y ou can also choose to resize the bounding box to fit the comment text.

Modifying Comment Text Appearance

The Comment Text Appearance page for the Comment Text Object of the BD Object
Properties dialog box allows you to set visual attributes for the selected comment text

The attributes include the text color and font.

Modifying Comment Text Box Appearance

The Comment Text Box Appear ance page for the Comment Text Box of the BD Object
Properties dialog box allows you to set visua attributes for the selected comment text boxes.

The attributes include the foreground, background and line color, line style, fill styleand line
width.

Editing Comment Graphics Properties

The Comments Graphics object is selected if you display the Object properties dialog box
when a Comment Graphic is selected on ablock diagram.

The Comment Graphics page alows you to set visual attributes for the selected comment
graphics.

The attributes include the foreground, background and line color, line style, fill style and line
width.

Note
The embedded VHDL style option to Include View Name in Embedded

Configurations must be set if you want to instantiate a specified view.
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Editing User Declarations

The User Declaration page of the BD Object Properties dialog box allows you to add or edit
user-defined declarations for ablock diagram or IBD view. Y ou can enter free-format
declarations before or after the signal declarations.

HBBD Object Properties - User Declarations
+ [v  &lign in Colurnns
¥ Ilzer Declaration
¥ Pre User Entered Declarations:
+ These declarations will be ingerted in the generated HOL before
H the automatically generated declarations for signalz on the diagram.
s -
¥
¥
¥
+ of

. Pozt Uszer Entered Declarations:
o Uszer Declarations These declarations will be inzerted in the generated HOL after
‘o zer Properties the automatically generated declarations for signalz on the diagram.

o o

k. Cancel Apply | Help |

Y ou can access the User Declarations dialog box directly in an IBD view by choosing User
Declar ations from the Table menu in an IBD view.

Y ou can edit the declaration statements directly on ablock diagram by clicking to select the text
on the diagram and clicking again to edit the text.

Pre user declarations can be referenced by signal declarations or by post user declarations. For
example, you could use a pre user declaration for a bus width constant which is referenced by a
graphically defined signal declaration.

Similarly a post user declaration can reference asignal declared in the graphically defined or
pre user declarations.

The syntax is automatically checked when you confirm the dialog box. However, syntax
checking can be disabled by unsetting a block diagram preference.
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Editing User Properties

The User Properties page of the BD Object Properties dialog box alows you to define internal
variables as a property of a selected design object. The defined Internal variables are described
by Class and Name attributes to which values are then assigned for the selected design object.

HBBD Object Properties - User Properties ﬂ

E Components

Add or modify properties azzociated with the zelected object.
It iz niot neceszany to specify a Clazs for uzer-entered properties.

: Class Marne Yalue

- < <

i Uszer Declarations

IJzer Properties

(] | Cancel | Apply Helm

Setting the Scope for Net Changes

When you edit asignal declaration on ablock diagram or IBD view, you can choose whether
the changes are applied only on the active view or are propagated to other design unit viewsin
the hierarchy.

Y ou can set the scope in a block diagram by choosing Scope For Changes from the popup
menu or from the Signals cascade of the Diagram menu.

Note
Y ou can aso set the scope for changes in the Signals tab of the block diagram Object
Properties dialog box.

Y ou can choose Joined Wiresin this diagram to apply changes to the explicitly joined net
segments only (excluding any net segments connected by name), Entire Net in diagram to
change al segments in the same net on the active diagram, or Entire Net in hierarchy to apply
the net changesto all viewsin the hierarchy.
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Y ou can set the scopein an IBD view by choosing Scope For Changes from the popup menu or
from the Nets cascade of the Table menu. For an IBD view, you can choose Non Hierar chical
or Hierarchical scope.

The scope is saved as a preference and is used as the default until the next time a signal
declaration is edited.

When you edit a net declaration and the scope for changes includes hierarchical views, adiaog
box is displayed to control how changes are propagated to netsin the hierarchy.

Refer to “ Propagating Net Changes’ on page 158 for more information about propagating new
signals and changes to the properties of anet.

Adding Comments to a Signal or Port Declaration

Y ou can add commentsto asignal or port declaration on a block diagram by choosing Edit
from the Comments cascade for Ports or Signalsin the Diagram menu or by choosing
Comments from the popup menu when the net or its declaration is selected.

Y ou can add commentsto asignal declarationinan IBD view by choosing Commentsfrom the
Nets cascade in the Table menu or by choosing Commentsfrom the Add or popup menu when
one or more signal rows are selected in the table matrix.

A free-format entry Comments dialog box is displayed which alows you to add asingleline
comment at the end of the declaration or you can enter a multi-line comment to be included
before or after the declaration.

Comment characters for the current hardware description language (VHDL or Verilog) are
automatically inserted if the Add comment character s check box is set. When thisoption is
unset, the comments must be valid HDL statements and are automatically syntax checked if
checking is enabled.

The comments are displayed in the port or signal declarations list on a block diagram. If a
declaration is deleted, the corresponding comments are also del eted.
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Y ou can control the display of comments on a block diagram by choosing Show or Hide from
the Comments cascade of the popup menu (or Ports cascade of the Diagram menu) when the
port or signal declaration is selected.

& gingle line comment can be added at the end of the declaration line.
tultiple-line comments can be added beforeafter the declaration.
Comment characters will be added when appropriate.

E nd-of-line [zingle ling comment]:

Before [multi-line comment]: v Add comment characters
-
-
< E
After [rmulti-ine comment]: v &dd comment characters
-
-
< E

(] I Cancel | Help |

%

Although multi-line comments can be added to an IBD view using the dialog box, these
comments are not displayed in the table. However, end-of-line comments can be edited directly
in the Comment column for the port or signal declaration row.

Comments added to internal signals on ablock diagram or IBD view are included in the
generated HDL..

Comments added to port declarations are ignored when HDL is generated since the interface
information is generated from the symbol. If you want to include comments in the generated
HDL for interface ports, these should be added using the symbol or tabular 10 editor.

Note

D A special font isrequired to display Kanji charactersin the dialog box. If Kanji characters
are required in comment text, this font can be enabled by setting the
“HDS_KANJ_DIALOG” environment variable.
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Setting Attributes and Embedded Constraints

Y ou can add embedded constraints or other attributesto a net or port declaration in a block
diagram by choosing Edit from the Attributes cascade for Ports or Signalsin the Diagram
menu or by choosing Attributes from the popup menu when the net or its declaration is
selected.

Y ou can add attributes to asignal declaration in an IBD view by choosing Attributes from the
Nets cascade in the Table menu or by choosing Attributes from the Add menu or popup when
one or more signal rows are selected in the table matrix.

A free-format entry dialog box is displayed containing any existing attributes for the selected
object. If no attributes have been set, the dialog box contains the template attributes and
embedded constraints defined in your preferences.

H[} Attributes E3

Enter WYHDL Attributes and/or embedded synthesis constraintz
relating to this signal/port/block /component uzing WHDOL syntax.
Thiz text will be inzerted inta the generated WHDL.

The template text is defined in the YHDL Options dialog
[Headerz Page - Embedded Constraintz].

-- Template for Synopays DC constraints ;I
-- pragma dc_zcript_begin

-- pragma dc_zcript_end

- WHOL aAttribute Template
--attribute <names of <objects ; <clazsr iz <values;

o o

| ak I Cancel |

%

Y ou can add attributes to a port declaration in the symbol editor by choosing Attributes from
the popup menu when the port or its declaration is sel ected.

Y ou can add attributes to a port or locally declared signal declaration in atabular 10 view by
choosing Attributes from the popup when one or more signal rows are selected in the table
matrix.

Y ou can also set attributes by using the Block, Component, Signals, Bundles or Declar ations
attributes pages of the block diagram or IBD view Object Properties dialog box.

The default template includes template begin and end pragmas which can be used to enclose
embedded commands for the downstream tool. For example:
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-- pragma dc_script_begin
-- set_max_area 2500.0

-- set _drive -rise 1 port_b
-- pragma dc_script_end

Note
D Default embedded constraints can be set as VHDL or Verilog preferences from the

Header s tab of the VHDL and Verilog Options dialog boxes.

The dialog box aso contains a default template for in-line signal attributes. For example, having
declared asignal int_signal you could add VHDL attributes such as:

attribute preserve_signal of int_signal:signal is TRUE ;
attribute nodgen_sel of int_signal:signal is FAST ;

Attributes and embedded constraints are not normally shown on ablock diagram. However, you
can choose Show or Hide from the Attributes cascade of the popup menu (or Ports cascade of
the Diagram menu) when a port or signal declaration is selected.

When shown, the attributes are displayed below the declaration of the corresponding port or
signal in the Declarations list.

Note
Y ou can change the default visibility by setting Show Signal Attributesin the

Miscellaneous tab of the Block Diagram Preferences dialog box.

The contents of the edit box are associated with the selected signal declaration when you
confirm the dialog box and will be included in the generated HDL for the view.

Attributes added to internal signals are included in the generated HDL . Although attributes can
be added to a port declaration, these are ignored when HDL is generated since the interface
information is generated from the symbol.

If you want to associate attributes to a port (for example, a pin number attribute) these should be
added to the port declaration in the symbol or tabular 10 editor.

Propagating Net Changes

By default, changes to nets are made non-hierarchically to the active view only.

However, you can set the scope for changes to include connected or hierarchical nets as
described in “ Setting the Scope for Net Changes’ on page 154.

If anet property is changed when ahierarchical scopeis set, the Net Propagation Optionsdialog
box is displayed for you to choose how the changes are propagated to nets in other views.
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Note
The dialog box is aso displayed when you change the properties of a port in the symbol
or tabular 10 editor and the scope is set to apply the changes hierarchically.

All changesto the net or port properties (including any comments and attributes) can be
propagated.

Y ou can choose whether net changes are applied Up or Down the hierarchy and whether to
propagate the changes Through Components or Include Embedded Blocks.

If you choose to propagate through components, an extra option controls whether the changeis
propagated Through portswhere port name differs from the net.

If thisoption is set and you have write permission to any connected component, the port names
in the component symbol are changed.

Hla Met Propagation Options E3

—a&pply changes Hierarchically
[ Up v Diown

[~ Through Components

[T Tihrawgh potewhene port nane differs e net

¥ Include Embedded Blocks

— Change
[v Declarations

[v Comments and Attributes

[+ Shyle [Signal / Bus]

¥ Mode / Direction

[ Include Design Objects in Pratected Libraries
¥ 2pply changes to leaf-level views
[+ Stop at read-only diagrams

[+ Highlight Met

ak I EanceIJ/

A

Y ou can choose whether changes are made to Declar ations, Comments and Attributes, net
Style (represented as asignal or bus) or the Mode (in, out, bidirectional or buffer).

Y ou can aso chooseto Include design objectsin Protected libraries, Apply changesto leaf-
level views, Stop at read-only diagrams or Highlight the net.
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Y ou cannot propagate up through components since the design traversal will stop when a
symbol is reached.

Y ou cannot propagate through atext view.

When you confirm your choicesin the Net Propagation Options dial og box, the Net Propagation
progress window is displayed which lists all the occurrences of the net in the specified
hierarchy.

The progressisindicated in the dialog box and a complete indicator displayed when all viewsin
the hierarchy have been traversed.

Hla Met Propagation : UART fuart_top E3
Mets[s]: Iaddress
Wiew M ame Current “igw Statug Met(z]
TART~uart_top~struct struct . bd ()54 addr
TAET~addres= decode~thl thl. tt ()54 addr
|lpdate |
Status: Select an item for a detailed dezcription. ;I
Frogress: complete
Apply | Diane |
g

If an Error or Warning is encountered, these are indicated in the Status column and the full
message appears in the Status box when the view name is selected. For example, atext or read-
only view cannot be updated.

Note
D Note that propagation will stop if an error is encountered to avoid creating an incorrect

design.

Y ou can display any view listed in the progress window by double-clicking on its name in the
progress window.

Y ou can use the Update button to change any of the net propagation options and update the
preview window for changes made to any of the views in the hierarchy. For example, if you
have made a read-only view available for edit.
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The changes are made when you confirm the preview window using the Apply button. The
status column shows Modified for all views which have been changed.

Inserting and Removing Nets

Y ou can propagate signals or buses on a block diagram or IBD view and ports on a symbol or
tabular 10 view to other viewsin the hierarchy by selecting the net and choosing Single L evel
Up, Single Level Down or Hierarchical from the Insert Net cascade in the popup menu.

Thelnsert Net cascade is aso available in the Signals cascade of the Diagram menu in ablock
diagram, the Ports cascade of the Diagram menu in the symbol editor, the Nets cascade of the
Tablemenu in an IBD view or the Ports cascade of the Table menu in atabular 10 view.

If you choose Hierar chical, the Net Insert Options dialog box is displayed.

—a&pply changes Hierarchically
[ Up
) U b b

) U ba contect
v Diown

[~ Through components

— Met Inzertion

[T Autoroute nets

[~ Add rets to global connectors

[~ Propagate through test siews
™ Include design objects in Protected libraries

[+ Stop at read-only diagrams

¥ Highlight net

(] I Eancell

Hel
epL

If you choose the Up option in the dialog box and anet is connected to an external port, you can
propagate the net up through the hierarchy to the top level symbol or until a connection can be
made to an existing net with the same name and bounds.

If you choose the Down option and a net is connected to an instance of ablock or component,
you can choose to propagate the net Through Componentsin the hierarchy.
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Y ou can also choose to Autoroute nets or to Add netsto global connectors. Global
connectors can be added when you propagate down an input net and will be added to all blocks
in the hierarchy.

If the global connectors and through components options are set, net stubs are added to each
component in the hierarchy.

Y ou can also choose whether to Propagate through text views, Include design objectsin
Protected libraries, Stop at read-only diagrams or Highlight the net.

If you select anet that is not connected to any instances on the active view, aNet I nsert/Remove
Parameters dialog box is displayed which allows you to choose the port mode and select one or
more instances to traverse:

Hla Met Inzert/Hemove Parameters E3

FParameters required to start net inzert/remove:;

— Part Parameters

bl ode; IIN vI

— Instances
Al " Selected

addresz_decode : |13
cpu_interface : 11
zenal_interface : |4
clock_divider : 12

(] | Eancell Help L

If there are more than one instances in the hierarchical view, you can choose whether the new
net is connected to All instances or to Selected instances only.

Y ou can remove signal or bus nets from related views in the hierarchy using the Remove Net
cascade in the popup menu.

The Remove Net cascade is also available in the Signals cascade of the Diagram menuin a
block diagram, the Ports cascade of the Diagram menu in the symbol editor, the Nets cascade
of the Tablemenuin an IBD view or the Ports cascade of the Table menu in atabular 10 view.
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If you choose Hierar chical, the Net Remove Options dialog box provides options to remove
nets Up or Down and Through Componentsin the hierarchy.

—a&pply changes Hierarchically
[ Up
v Diown

[~ Through components

™| Tihrowat parts where par name differs from met

[~ Propagate through test siews
[ Include design objects in Protected libraries

¥ Stop at read-only diagrams
¥ Highlight rst

ak I Eancell Help |
g

When you remove nets through components, you can choose whether the change is propagated
Through portswhere port name differsfrom net. If this option is set and you have write
permission to the component symbol, the ports are removed from the component.

The Net Remove options dialog boxes also allows you to Propagate through text views,

Include design objectsin Protected libraries, Stop at read-only diagrams or Highlight the
net.

When you choose one of the single level options (or confirm the hierarchical options), the Net
Propagation progress window is displayed which lists all the occurrences of the net in the
specified hierarchy.

Y ou can use the progress window to display views, update the net propagation options and
apply changes in the same way as described in “ Propagating Net Changes’ on page 158.

Ordering Port and Signal Declarations

The declarations of signals and external ports are normally ordered automatically by mode (in,
out, inout or buffer) and alphanumeric name as they are added in the block diagram or IBD
view. However, you can enable manual ordering by choosing M anual from the popup or
Diagram menu.

Note

D This command is available from the Or dering cascade of the popup menu or Ports and
Signals cascades of the Diagram menu in ablock diagram or directly from the popup
menu for the Order columnin an IBD view.
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When manual ordering is enabled in the block diagram, you can re-arrange the port or signa
declarations by dragging one or more declarations with the L eft mouse button. Any number of
adjacent declarations can be moved in thisway but you cannot mix port or signal declarations
with user declarations (or port and signal declaration on ablock diagram). The new order is
preserved on the diagram and in the generated HDL..

When manual ordering is enabled in the IBD view, the Order column displays numbers which
indicate the order used for the port and signal declarationsin the HDL code. Y ou can choose
Show Order to re-order the table rows in declaration order.

Y ou can re-order port rowsin the IBD view by selecting an entire row and dragging it with the
Right mouse button. However, you cannot update the declaration order from the IBD view.

Manual ordering is automatically set if you synchronize component interface ports with atext
view to preserve the port ordering specified in the text view.

Manual port and signal ordering is normally used when diagrams are created by HDL2Graphics
in order to preserve the order (and any in-line comments) from the source HDL code. If you
choose Automatic, the original ordering is discarded and the declarations sorted by mode and
alphanumeric name.

Y ou can modify the port ordering for a block instance by editing the object properties for the
block as described in “Editing Block Properties’ on page 133.

Adding or Removing Design Hierarchy

Y ou can re-level ablock diagram or IBD view by choosing the Add Hierarchy or Remove
Hierarchy command from the Re-level cascade in the block diagram Diagram menu, IBD
view Table menu or the popup menu in either view.

Adding hierarchy replaces the selected objects by a new block or component and moves the
selected objects into the new design unit view.

When this command is used in a block diagram, a child block diagram view is created and the
new block or component is attached to the cursor so that you can place it on the parent diagram.
Any signals connected to the new object are automatically re-routed.

Whenusedinan IBD view, achild IBD view is created and the objects replaced by asingle new
instance on the parent table.
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The Add Hierarchy dialog box is displayed for you to specify the name of the new design unit
containing the selected objects and whether to create it as a block or component.

H[j Add Hierarchy E3

Thiz command iz not undoable. Please choose the twpe
of Degign Unit and provide a unique name.

[rezign Unit; |

" Create Component % Create Block

—Autolaypout

[~ Existing Yiew [~ Mew Yiew

ak I Cancel | 7

Y ou can also choose to automatically update the block diagram layout for the existing view and
for the new hierarchy view. When these options are not set, the layout is preserved.

Any package references or compiler directives are copied to the new design unit. Global
connectors are automatically included on the new view if any blocks or embedded blocks are
selected.

If any of the selected objects are connected using a bundle and you choose to create a
component, a port map frame is automatically added.

Removing hierarchy deletes the selected block or component instance and replaces it by the
objectsin the child hierarchical view.

If the parent and child views are block diagrams, the relative placement of the new objectsis
preserved and a ghosted view is attached to the cursor so that you can place it on the parent
diagram.

If the parent view is ablock diagram and the child view an IBD view, the new objects are
automatically connected and the routing is completed when you place the ghosted objects on the
diagram.

If the child view included other hierarchical views, their hierarchy is retained but can be
removed by another re-level operation.
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Y ou are prompted to confirm alist of design objects which will be deleted by the re-level
operation. For example:

H} HDL Designer - Pro E3

Thiz command iz not undoable. The following dezsign objects
are to be permanently deleted. Deleting Components will
require manual updating of views that reference them.

Do wou wizh to continue?

FHDS_HOME fexamplesduart/srchinterlfaces\default_view ;I
FHDS_HOME fexamplesfuart/srchinterlfaceshinterlface
FHDS_HOME fexamplesduart/srchinterlfacesstruct. bd

f o

| ak I Cancel |

%

If acomponent is deleted, you may need to manually update any other views that referenced the
deleted component.

If there are global connectors in the child view, these become global connectors in the merged
parent view and are connected to all blocks and embedded blocks in the parent view.

The package references or compiler directives for the child view are merged with those defined
for the parent view.

If removing hierarchy replaces a component with port map frame expressions, these mapping
expressions are preserved as an embedded HDL text view.

An error message isissued if you attempt to remove hierarchy for an instance which is not
described by a block diagram or IBD view or which has a different language.

Generics and Parameters

Generics and Parameters are constants that you declare graphically and give a default value;
they are later included in the generated HDL code. VHDL generics are a VHDL feature used to
pass information to an instance of an entity. Verilog parameters can be used in asimilar way
when you are using the Verilog language.

Using generics and parameters involve the following two main procedures.

1. Genericsand Parameters are primarily declared for the components symbols and blocks.
Refer to “ Defining Generics and Parameters’ on page 176 for details.
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2. Subsequently, the declared generics and parameters are edited on the level of the
individual instances of the component or block. Refer to “Editing Generics and
Parameters for Instances’” on page 178.

Note
D Note that you can also declare generics/parameters through the default view of the

component and it will synchronize with the symbol. See “Generics and Parameters
Synchronization” on page 184 for information.

Typical usesfor VHDL generics and Verilog parameters include:

» Substitution in place of an integer value for the least or most significant field of asignal
bounds specification.

» Declaration of adelay that can be varied on each instance of are-usable component.

The following exampleillustrates the use of VHDL generics:

library ieee
use ieee.std_logic_1164.all

entity xorx is
generic(width : integer; delay : tine);
port(x1l, x2 : in std logic vector( width DOANTO 0 );
xout : out std |ogic vector( width DOANTO 0 ));
end xorXx;
architecture generic_xorx of xorx is
begin
xout <= xinl xor xin2 after del ay;
end generi c_xorXx;

-- Test bench for instance generic xor
library ieee
use ieee.std logic_1164.all;

entity testbench is
generic(tb width : integer := 4; tb _delay : tine := 5 ns);
port(ina, inb : in std logic vector(tb_w dth DOANTO 0);
outa : out std_logic_vector(tb_w dth DOANTO 0));
end testbench;

architecture tb_arch of testbench is
conponent Xxor X
generic(width : | NTEGER,
delay : TIME );
port(x1, x2 : in std_logic_vector(w dth DOANTO 0);
xout : out std_logic_vector(w dth DOANTO 0));
end conponent;
begin
Ul : xorx generic map ( tb_width, tb_del ay)
port map (ina, inb, out);
end tb_arch;

The following example illustrates the use of Verilog parameters:

Graphical Editors User Manual, V2008.1 167
September 18, 2008



Block Diagram and IBD Views
Generics and Parameters

nmodul e xor x(xout, xinl, Xxin2);
paraneter width = 4,
del ay = 10;
output [1:w dth] xout;
input [1:width] xinl, xin2;
assign #del ay xout = xinl ~ xin2;
endnodul e
/'l Testbench for instance xor
nodul e testbench;
paraneter tb_width = 4,
tb_delay = 5;
wire [1:tb_w dth] outl;
reg [1:tb_width] inl, in2;
xorx #(tb_width, tb delay) Ul(outl, inl, in2);
endnodul e

Generics and Parameters Tables

The Generics Table and Parameters Table allow you to declare VHDL generics and Verilog
parameters respectively. The Generics Table is available if you are designing using VHDL and
the Parameters Table is available if you are using Verilog.

Accessing the Generics or Parameters Table

The Generics and Parameters Tables are found within any view window; for components, they
can be mainly accessed through the symbol or the view. To open the Generics or Parameters
Table, do one of the following:

* Inthe Structure Navigator pane of the Diagram Browser, click Generics Table to
declare VHDL generics or click Parameters Table to declare Verilog parameters.

* From the Diagram menu, select Genericsto declare VHDL generics or Parametersto
declare Verilog parameters.

Generics Table:

Hla UART /serial_interface/struct {Generics for struck) - |EI|5|
File Edit M“iew HDL Table Tasks Add Options Window Help

(B-e«=2aEdE8Q9- 2R A -&-M-4-8-
| Sk W= 5= 7|4 2V E @ B &
A ] C o] E F Structure Mavi._.

| aroup | Marne Type | Walue |F‘ragma Cormment ESig"al Table

1| | =l | | | 2] Generics Table

= B8 serial_interface
(- Declarations/Stateme
= B-JJ4] Embedded Diagran

4 | ¥
Cartent A
Ready 5
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Parameters Table:

Hla UART_¥/serial_interface;struct (Parameters for struck) - |EI|5|
File Edit M“iew HDL Table Tasks Add Options Window Help

(B -¢«amaEHdE Q- =28 - @ F-<-M-4-8-
| w5 =74 2 E @R|E

A B c o Structure Mavigator *
| Group | Marme Walue | Cornrrent | E Signal Table E
= 4] Parameters Table =
! | | | | = B8 serial_interface 3
(- Declarations/Statements S
I Embedded Diagrams =
%
-
Content :
|F|eau:|_l,l i

Generics Table Controls

Y ou can manage the Generics Table using the generics toolbar which consists of the following
buttons.

Table 3-3. Generics Toolbar

Description
Add Generic
Group selected rows

Ungroup selected rows
Expand All Groups
Collapse All Groups

Fl'l!@%
o

Toggle Filter

Autofit column size to contents

Sort column in ascending order

22 o 82| e

Sort column in descending order

=) Toggle show grouped rows
o Toggle between Ports/Generics table

To declare VHDL generics through the Generics Table, you have to enter the following
information:
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Table 3-4. Generics Table Content

Column Description

Group Specify agroup name to categorize the VHDL generic if necessary.
Name Specify the name of the VHDL generic.

Type Choose athe type of the VHDL generic.

Vaue Specify the default value of the generic.

Pragma Choose whether to enclose the VHDL generic in pragmas or not.
Comment Enter agenera comment if necessary.

Parameters Table Controls

Y ou can manage the Parameters Table using the parameters toolbar which consists of the
following buttons.

Table 3-5. Parameters Toolbar

Description
Add Parameter
Group selected rows

Ungroup selected rows

Fl'l!@%
o

Expand All Groups

Collapse All Groups

Toggle Filter

Autofit column size to contents

Sort column in ascending order

22 o 82| e

Sort column in descending order

Toggle show grouped rows

ng
-

Toggle between Ports/Parameters table

',_
m

To declare Verilog parameters through the Parameters Table, you have to enter the following
information:

Table 3-6. Parameters Table Content

Column Description

Group Specify a group name to categorize the Verilog parameter if necessary.

170 Graphical Editors User Manual, V2008.1
September 18, 2008



Block Diagram and IBD Views
Generics and Parameters

Table 3-6. Parameters Table Content (cont.)

Column Description

Name Specify the name of the Verilog parameter.
Vaue Specify the default value of the parameter.
Comment Enter acomment if necessary.

Using the Generics and Parameters Table
This section describes the different operations that can be performed in the Generics/Parameters
Table.

Add Generics/Parameters

To declare new generics or parameters, do the following:

1. Add the generic or parameter through one of these methods:

o Click Add Genericinthetoolbar if you are using VHDL or Add Parameter if you
areusing Verilog.

o Choose Add > Genericin case of VHDL or Add > Parameter in case of Verilog.
o Choose Generic or Parameter from the Add cascade of the popup menu.

A row is added with adefault Name and Typein case of VHDL generics, or with a
default Name only in case of Verilog parameters.

2. Inthe added row, insert the Name and Value of the generic/parameter, in addition to a
Typein case of the generic.

3. Click Save.
Another method to add a generic/parameter is by typing the information directly in an empty
row.
Grouping Generics/Parameters

Grouping enables you to organize the content of the generics/parameterstable. Y ou can specify
agroup for each generic/parameter declaration, and then different groups can be assembled and
individually collapsed or expanded.

To group genericy/parameters, select one row or more and then do one of the following:

» Click Group in the toolbar.
* Choose Add > Group.
e Choose Table > Group > Group.
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* Choose Group from the popup menu.

The selected rows are added to a new group with the default name GroupN (whereNisa
number automatically incremented if it already exists).

* You can aso enter aname directly in the Group column for the generic/parameter.

Note
Y ou can choose from a dropdown list of existing groups. If you type a partial string that

matches the name of an existing group, the name is automatically compl eted.

To remove agroup for ageneric or parameter, select the relevant row (or rows) and then do one
of the following:

» Click UnGroup in the toolbar.

e Choose Table > Group > UnGroup.

* Choose UnGroup from the popup menu.

* You can also delete the name from the Group cell.

If you rename or remove an existing group cell and the group is no longer referenced, you are
prompted to delete the old group name as shown in the figure below.

H[jDelete non-referenced Groups x|

The fallowing Groups no longer have any references. Do you want to delete them'?

v Groupl

4 I Eancell

%

To assemble similar groups as collapsible and expandable groups, do one of the following:

* Click Toggle Show Grouped in the toolbar.
* Choose Table > Show Grouped.

By that, you have moved from the flat mode to the group mode. Rows in the same group are
shown as asingle (but expandable) group in hierarchy mode.

A E Z C E F
Harme Type Yalue Pragra Zarnrmenkt

1) - Integer

z width integer = || 15 M

3 delay integer ;I c M

4 | + Strimg

: ]
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To expand all groups and display their rows, do one of the following:

» Click Expand All Groupsin the toolbar.
» Choose Table> Group > Expand All Groups.

» Click on the plusicon in the group row. This method enables you to expand an
individual group.

On the other hand, to collapse all groups and hide their rows, do one of the following:
» Click Collapse All Groupsin the toolbar.
* Choose Table > Group > Collapse All Groups.

» Click on the minusicon in the group row. This method enables you to collapse an
individual group.

Note
D When grouped mode is set, you can enter acomment in the group row.

Filtering Generics/Parameters

Y ou can filter the content of any column, that is display specific data, by doing the following:

1. Turnon thefiltering feature by doing one of the below steps:
o Click Toggle Filter in thetoolbar.
o SettheFilter option inthe Table menu.
o Choose Filter from the popup menu.

Consequently, adrop-down menu is displayed in each column through an additional
filter row.

2. Through the drop-down menu of the column you want to filter, select the filter value.
For example, if you choose integer in the Type column for a Verilog view, only the
parameters of type integer are displayed.

Y ou can also enter a simple match string in the filter cell to display only matching
generics/parameters. For example, you can enter param* in the Name column to display
only parameters starting with the characters param as shown in the below figure.
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Hla UART_¥/serial_interface /struct {Parameters for skruck) | - |EI|5|
File Edit %ew HOL Table Tasks Add Options ‘Window Help
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Y ou can apply filters to more than one column or set options to match case, match whole words
or use regular expressions by choosing Filter Settings from the Table or popup menu to
display the Filter Settings dialog box:

x

The filter contralz apply to the zelected columns. IF no columng
are gelected, they are applied to all the columns.

[T Match Case
[ Match Whole “ord Only
[ Regular Expression

] I EanceIL

i

The filter settings are applied to the currently selected columns or to all columnsif noneis
selected.

Sorting Generics/Parameters
Y ou can arrange the rows in a selected column in ascending or descending al phanumeric order
by either:
» Using the Sort in ascending order or Sort in descending order button in the toolbar.

* Choosing Table > Columns> Sort Ascending or Table> Columns > Sort
Descending.

» Choosing Sort Ascending or Sort Descending from the selected column’ s popup menu.
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Y ou can also sort by clicking the triangular icon on the right side of the column header cell as
shown in the following figure.

A C ]

Group Yalue Carmrment

1 Pararn_g 10

2 Pararn_1 5

Hiding Columns

To hide columns, select one column or more and then do one of the following:

* Choose Table > Columns > Hide Column.
* Choose Hide Column from the popup menu.

To show the hidden columns, do one of the following:

* Choose Table> Columns > Show Columns.
*  Choose Show Columns from the popup menu.

Consequently, adialog box is displayed listing the hidden column (or columns). Select which
columns you need to show again in the table and click OK.

x

Select one or more items:

(] I Cancel Help

Resizing Columns

To resize columns to the width of the text contained in the selected cell (or cells), do one of the
following:

* Click Autofit in the toolbar.
* Choose Table > Autofit.
» Choose Autofit from the popup menu.

Note that if you have not selected any cells, then al the columnsin the table are resized.

Note
Y ou can also resize a column by dragging its vertical borders with your left mouse button

and adjusting its width as required.
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Related Topics
» Defining Generics and Parameters

» Editing Generics and Parameters for Instances

Defining Generics and Parameters

As mentioned earlier, VHDL generics can be declared for both components and blocks if you
are using the VHDL language; the same appliesto Verilog parameters if you are using the
Verilog language.

Defining Generics for Components and Blocks

Defining generics for components and blocks is done through the Generics Table whichisa
tabular view similar to the Signals Table; refer to “ Generics and Parameters Tables’ on

page 168 for information. In case of components, the declaration of VHDL generics takes place
on the level of the symbol which defines the interface to the component.

Follow this procedure to declare generic values whether for component symbols or for blocks.

Procedure

1. Open the symbol of the VHDL component for which you need to declare generic values.
In case you are declaring generic values for blocks, open the block view.

2. Inthe Structure Navigator, click on Generics; the Generics table is displayed.

3. Click Add Genericinthetoolbar; note that arow is added in the Generics table with a
default Name and Type. Refer to “ Generics Table Controls’ on page 169 for
information on the generics toolbar.

4. Inthe added row, insert the generic’'s Name, Type and Value. Use the Group column to
categorize your generics if necessary.
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5. Repeat the above steps to add more generics for the component or block as required.
6. Click Save.

By that, you have declared generic values for the component or block. Y ou can now use
these generic values with individual instances; refer to “Editing VHDL Generic Values
for Instances’ on page 179.
Related Topics
* Generics and Parameters Tables

e Editing VHDL Generic Vauesfor Instances

Defining Parameters for Components and Blocks

Asthe caseiswith VHDL generics, defining Verilog parameters for components and blocksis
done through the Parameters Table which isatabular view similar to the Signals Table; refer to
“Generics and Parameters Tables” on page 168 for information. Note that in case of
components, the declaration of Verilog parameters takes place on the level of the symbol which
defines the interface to the component.

Follow this procedure to declare parameters whether for component symbols or for blocks.

Procedure

1. Open the symbol of the Verilog component for which you need to declare parameters. In
case you are declaring parameters for blocks, open the block view.

2. Inthe Structure Navigator, click on Parameter s, the parameters table is displayed.
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3. Click Add Parameter in the toolbar; note that arow is added in the Parameters table
with adefault Name. Refer to “ Parameters Table Controls’ on page 170 for information
on the parameters tool bar.

4. Inthe added row, insert the parameter’s Name and Vaue. Use the Group column to
categorize your parametersif necessary.

Hla UART_¥ /tester/flow (Parameters for tester_top) - |EI|5|
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5. Repeat the above steps to add more parameters for the component or block as required.
6. Click Save.

By that, you have declared parameters for the component or block. Y ou can now use
these parameters with individual instances; refer to “ Editing Verilog Parameter Values
for Instances’ on page 181.

Note
_Iﬁ It is worth mentioning that another method for defining verilog Parametersis through

User Declarations. For information, refer to “Editing User Declarations’” on page 153.

Related Topics
* Generics and Parameters Tables

» Editing Verilog Parameter Values for Instances

Editing Generics and Parameters for Instances

Having defined generics/parameters on the component or block level, you can now override
these declarations for the instance through editing its Object Properties.
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Editing VHDL Generic Values for Instances

Follow this procedure to edit VHDL generic declarations on the level of instances.

Prerequisites

* Youmust havethe VHDL generic declarations preset for the component or block; if not,
refer to “ Defining Generics for Components and Blocks’ on page 176.

Procedure

1. Open thetop-level design of the component instance or block; that is, the component or
block for which you previously declared VHDL generics. Refer to “ Defining Generics
for Components and Blocks” on page 176 for information on declaring VHDL generics.

For example, if you have defined generic values for the symbol of the uart_top
component, open the top-level uart_tb where an instance of uart_top is available with
thename U_1.

2. Right-click on the instance and choose Object Properties from the popup menu.
Following the examplein step 1, right-click on the U_1 instance in the top-level uart_tb.
3. Open the Generics page and then click Update List.

The generics currently declared for the symbol of the component or for the block are
consequently listed in the table as object properties of the instance as shown in the
below figure.

HBBD Object Properties - Component GEnerics ﬂ

El;D Companerts —HDL Generation
Y - rerics

Tt Vizibility
Porttd ap Frame ¥ Generate Generic Declarations in the Component Declaration

Attributes
Appearance [ Add OFF/0M pragmas around Generic Declarations and Mappings

¥ Generate Generic Mappings for this instance

Inst Kame MHarme Type Yalue Fragma | Comment
1 wiidth integer 15 ]
1 delay time a ]

‘o Uzer Declarations

|Ipdate ligt |
(] I Cancel Apply | Help |

%
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Note that any changes made to the generic declarations of the component symbol or
block are reflected on the Object Properties of the instance through clicking the Update
List button. Any declarations that are no longer defined in the symbol or block are
removed from the list and any new declarations are added. However, values that are
already set on the instance for existing declarations are preserved.

Note

The Generics page of the Object Properties dialog box is available if the language of the
selected instance is VHDL or the Parameter s pageif it isaVerilog instance.

4. Usethe Vaue column to override the default declarations of the generics with mapped

values. Type anew value or edit the existing value by double-clicking or using the F2
key.

It isworth noting that this table is entirely read-only except for the Vaue column, that
is, you cannot add generics through the Object Properties dialog box.

5. Set the following HDL Generation options as required:

o Generate Generic Mappingsfor thisinstance — Setting this option leads to
including the generic mappings in the generated HDL (that is, the mapped values
inserted in the dialog box to override the default generic declarations).

For example, you can unset this option, when instantiating components (such as
VITAL models) which have many generics but normally use the default values and
the generics need to be omitted for efficient synthesis.

o Generate Generic Declarationsin the Component Declar ation — Setting this
option leads to including the generic declarations in the generated component
declarations.

o Add Off/On pragmas around Generic Declarations and M appings — Setting
this option leads to enclosing the generic declarations and generic mappings with
trandate off and translate_on pragmas in the generated HDL..

6. Click OK to execute your settings.

In the diagram, if you right-click on the instance and select Show Text from the popup
menu, the generic mappings are consequently shown as text objects on the diagram. The
current dialog box settings are also shown in the object tips of the mappings text.

Note

[

Y ou can set the visibility of VHDL generic values from the block or component Text
Visibility pages of the Object Properties dialog box.

In the following example, the value of width is used to specify the upper bounds for the output
bus and has been changed to 7 for thisinstance of the multiplier component. The declaration for
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delay specifiesavariable value for an internal signal used inside the component which has been
set to the value 10 nsfor thisinstance.

std_logic width =7 [ integer )
Sigl
: dhusd
atd o
~ B unsighed( T DOWHTOO)

The mapping can be set to discrete value or an expression. For example, you could set width in
the exampl e above to the value breadth where breadth is declared as a VHDL generic for the
parent design unit.

Related Topics

¢ Generics and Parameters Tables

Editing Verilog Parameter Values for Instances

Follow this procedure to edit Verilog parameter declarations on the level of instances.

Prerequisites
* You must have the Verilog parameter declarations preset for the component or block; if
not, refer to “ Defining Parameters for Components and Blocks’ on page 177.
Procedure

1. Open thetop-level design of the component instance or block; that is, the component or
block for which you previously declared Verilog parameters. Refer to “ Defining
Parameters for Components and Blocks” on page 177 for information on declaring
Verilog parameters.

For example, if you have defined parameter values for the tester block, open the top-
level uart_tb where an instance of tester is available with the name U_O.

2. Right-click on the instance and choose Object Properties from the popup menu.
Following the examplein step 1, right-click on the U_0 instance in the top-level uart_tb.

3. Open the Parameter s page and then select one of the following options to update the
list of parameters: Symbol parametersonly or All Parameters.

This means you can choose either to update the list from the Verilog parameters
previously declared in the Parameters Table of the symbol only, or to include al
parameters previously declared in the Parameters Table in addition to those defined in
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the User Declarations. However, the latter option may take several secondsto retrieve
all the parameters for alarge module.

According to the selected option, the corresponding parameters are displayed in the list
along with their default declarations.

HBBD Object Properties - Block Parameters ﬂ
Ingtance 0" of module *tester"
™ Sumbal parameters only MHarme Walue
{* &l parameters ity 15
«Cear |
delay &
CLK_PRD 100
: RCW_CLK_PRD [CLE_FRD << Remove |
Add x> |
- Add All >
‘o User Declarations
1] [»

(] I Cancel | Apply | Help |

Note
The Parameter s page of the Object Properties dialog box is available if the language of
the selected instanceis Verilog or the Generics pageif itisaVHDL instance.

4. Select the parameter you need to override and then click Add. If you want to override all
the parameter values, click Add All directly (you can also add all parameters by
pressing the Shift key with the Add button). Consequently, the parameters along with
their values are moved to the right-hand-side table.

Y ou can control which parameters to override through the following buttons:

Table 3-7. Object Properties — Parameters Page Controls

Button Description
Add > Add selected parameter to the table
Add All >» Add all parametersto the table
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Table 3-7. Object Properties — Parameters Page Controls (cont.)

Button Description
<< Remove Remove selected parameter from the table
<4 Clear | Clear al parameters from the table
Note

D Any Verilog parameters with already overridden values are listed in the table.

5. Inthetable, use the Value column to insert the mapped value which shall override the
parameter’ s default declaration.

Apply step 4 and 5 to al parameters you need to override for the instance.
6. Click OK to execute your settings.

In the diagram, if you right-click on the instance and select Show Text from the popup
menu, the parameter mappings are consequently shown as text objects on the diagram.
The current dialog box settings are a'so shown in the object tips for the mappings text.

Note
D Y ou can set the visibility of Verilog parameter values from the block or component Text

Visibility pages of the Object Properties dialog box.

In the following example, the value of width is used to specify the upper bounds for the output
bus and has been changed to 7 for thisinstance of the multiplier component. The declaration for
delay specifiesavariable value for an internal signal used inside the component which has been
set to the value 10 nsfor this instance.

—_— I
: I

Sl e delay = 10

wire TEST width =7
51g1—t’1n1 Ilultiplier

wrire ite 10 bzl

Ot e[ 7.0]
wrire [wricth (] [

The mapping can be set to discrete value or an expression. For example, you could set width in
the example above to the value breadth where breadth is declared as a Verilog parameter for the
parent design unit.

Related Topics

e Generics and Parameters Tables
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Generics and Parameters Synchronization

VHDL Generics and Verilog Parameters are declared through the Generics Table and the
Parameters Table respectively; refer to “ Generics and Parameters Tables’ on page 168.

The standard usage method is to declare generics/parameters first in the component symbol or
block view, and then update the generics/parameters on the level of instances and override the
preset generics/parameters declarations with mapped values. Refer to “ Defining Generics and
Parameters’ on page 176 and “Editing Generics and Parameters for Instances’ on page 178.
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Nevertheless, the Generics and Parameters Tables are availablein all views of all types (block
diagram, IBD view, state diagram, flow chart, truth table), thus enabling you to declare generics
and parameters not only through the component symbol or block view, but also through other
views of the design unit, whether default or non-default views.

For example, the following figure illustrates the accumulator component (in the Sequencer_vig
library) and its different graphical views; as shown in the figure, the accumulator component

has a symbol view, in addition to the default view flow and the non-default view tbl. According
to the standard usage method, parameters would be declared through the Parameters table in the
symbol view; however, a Parameterstable is also available in the default and non-default view.

esgnut e |

=1 L) Sequencer_via
=] accumulator Component
: '@ accumulator b odule
..... g flow Flow Chart
.......... D symbal Symbol
R Eﬁ thl Truth T able
-] contral Block
o ;]:l fibgen Compaonent
-] fibgen_tb Companent
-] fibgen_tester Block

On declaring generics/parametersin one of the design unit views, the declarations are reflected
on the rest of the views in most cases. This synchronization between views depends on the type
of the view in which the declarations occurred as follows:

» If declarations are made in acomponent symbol, it automatically synchronizeswith both
the default and non-default views of the design unit on saving.

* If declarations are made in a default view, it automatically synchronizes with both the
symbol and non-default views on saving.

* If declarations are made in the non-default view, no automatic synchronization occurs
whether in the symbol or the default view on saving.

Related Topics
* Generics and Parameters Tables
» Defining Generics and Parameters

» Editing Generics and Parameters for Instances

Opening Block and Component Views

Y ou can open down into a child view of asymbol or tabular 10 view (or of a block, embedded
block or component on a block diagram or IBD view) by using the Right mouse button to
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display an Open As popup menu for the selected object. The menu allows you to choose any
existing views that exist for the object or open down to create a new child view.

If the selected object isacomponent, you can also choose Symbol to open the graphical symbol
editor or Interface to open the component interface in the tabular 10 editor.

If one or more views already exist, double-clicking on the parent object opens the current view
without displaying the menu. However, you can open any of the other existing views (or create
anew view) from the menu.

When, you create a new view, the File Creation Wizard is displayed. The wizard allows you to
choose agraphical view, HDL view (with the same language as the parent view), registered
view or text file. You can optionally select atemplate for aHDL text, registered or text file and
specify the new view name.

Refer to “Using the Design Content Creation Wizard” inthe HDL Designer Series User Manual
for more information.

If you open down from a new unnamed block, the Name Block dialog box is displayed for you
to enter the name for the block.

Hj Hame Block E3

The block name [<block:] was created automatically.

The block must be given a user created name for commands
zuch az "Open Down Create Mew Yiew'" to function.

Pleaze provide a name faor the block:

ak I Eancell

Once you have named the new block, the File Creation Wizard is displayed to create the new
view.

View Initialization

When you create a new block diagram or IBD view by opening down from an existing block
diagram the new view isinitialized with the interface ports defined on the parent view.

In general, these ports have the same properties as the ports on the parent view. However, if you
open down into ablock diagram or IBD view from aVerilog symbol or tabular 10 view, thereg
type output ports on the symbol are automatically initialized as wire type ports on the child
view.
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Note
D Reconcile interface ignores reg and wire differences between Verilog portsin the parent

and child diagram.

Nets connected to ports in the child diagram can be explicitly changed to reg. Such a
change is preserved even if the symbol port isawire and other port changes are
propagated from the symbol to the child diagram.

Setting the Default View

Y ou can set the default view of ablock or component instance by selecting Change Default
View from the popup menu and selecting the required view from the list of available viewsin
the cascade menu.

Mixed Language Designs

In HDS adesign unit can be created as a block or acomponent. Any design unit whether a block
or a component can be described as a state diagram, truth table, flow chart or HDL text view
using the VHDL or Verilog language.

0 Tip: You can not create VHDL and Verilog views for the same design unit.

Y ou can create an unlimited number of component instances in block diagram and IBD views
while you can only create a single instance of a block. The language of instanced components
can be different from that of their parent views. i.e. You can instance a Verilog component in a
VHDL block diagram view or the opposite. Blocks can only be added to parent views of the
same language.

If you are using asingle kernel simulator (such as Model Sm), the entire design can be compiled
and simulated in a single operation. For other tools, you can compile the design for one
language, then change the downstream tool to compile the remaining components which are
described using the other language.

In general, VHDL and Verilog data types are automatically mapped.

A VHDL instantiation of a Verilog component associates VHDL signals and values with the
Verilog ports or Verilog parameters.

Similarly, aVerilog instantiation of a VHDL component associates Verilog signals and values
with the VHDL ports and VHDL generics.

If aVerilog view isused in aVHDL design, the component declaration in the VHDL structural
code is created using the following rules:

Graphical Editors User Manual, V2008.1 187
September 18, 2008



Block Diagram and IBD Views
Mixed Language Designs

» The name of the port comes from the component symbol but the VHDL type comes

from the connected signal. If no signal is connected, then the default signal or bustypeis
used.

* VHDL generics are given the type string if the first non-whitespace character is a quote
character ", integer if it can be converted to an integer (for example: 3, 10) or real if it
can be converted to areal (for example: 3.2, 2.1).

Refer to the "Mixed VHDL and Verilog Designs' section in the Model Sm Users Manual for
more information about compiling mixed language HDL models.

VHDL Instantiation of Verilog Components
The following VHDL types can be connected to Verilog ports:

bit std _logic vl_logic
bit vector  std logic_vector vl_logic_vector

Thebit and std_logic types are sufficient for most applications, but the vl_logic typeis provided
asapre-compiled protected library (verilog) in case you need accessto thefull Verilog state set.

Thevl_logic type is an enumeration that defines the full state set for Verilog nets, including
ambiguous strengths.

A VHDL generic is generated for each Verilog parameter in the Verilog module which has an
initial value that does not depend on any other parameters.

The VHDL generic type is determined by the Verilog parameter's initial value as follows:

Verilog Parameter VHDL Generic

integer integer
real redl
string literal string

The default value of the VHDL generic isthe same as the Verilog parameter'sinitial value. For
example:

Verilog Parameter VHDL Generic
parameter p1 =1 -3; pl: integer :=-2;
parameter p2 = 3.0; p2 : real := 3.000000;
parameter p3 ="Abc"; p3: string :="Abc";

A VHDL port clause is generated for each Verilog port. The VHDL port type can be bit,
std_logic, and vI_logic. If the Verilog port has arange, then the VHDL port type can be
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bit_vector, std logic_vector, or vl_logic_vector. If the range does not depend on Verilog
parameters, then the vector type is constrained accordingly, otherwise it is unconstrained.

Verilog Instantiation of VHDL Components

Y ou can reference aVHDL entity or VHDL configuration from Verilog as though the design
unit isa Verilog module of the same name (in lower case).

A VHDL view can beinstantiated in Verilog if it meets the following criteria:

» Thedesign unit has an entity and architecture or is a configuration declaration.

* Theentity ports have any mix of the types: bit, bit_vector, std_ulogic,
std_ulogic_vector, vi_ulogic, vi_ulogic_vector or their subtypes.

» VHDL genericsare of typeinteger, real, time, physical, enumeration or string. (Stringis
the only composite type allowed.)

Port associations may be named or positional. Use the same port names and port positions that
appear in the entity.
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Chapter 4
Block Diagram Editor

This chapter describes how the structure of a design can be represented using a graphical block
diagram.

BIOCK Diagrams . . ... o 192
Block Diagram NOtation. . . . ... 193
Blocksand Components. . . ...ttt e 194
Embedded Blocksand Embedded Views. . ... . 195
Signals, Busesand Bundles . ........... . 196
Portsand SIgnals. . .. ..o 197
Changing the Display of Port Properties . ... 198
Changing the Display of Signal Properties. . ... 200
Block Diagram Editor Toolbar . .. ... 203

Adding NetsonaBlock Diagram . ........... i e 204
ROULING NEES . . . . 204
AddingaSignal or BusonaBlockDiagram . ... 205
Ripping from aBuUS. . . ... .. 207
Adding Signal StubsonaBlock Diagram . ............... i 209
AddingaBundleonaBlock Diagram . ... 209
Adding SignalstoaBundle . ... ... ... 210
RippingfromaBundle. . ... ... 210
Using HDL Textto Combineor SplitSignals . .. ........... .. .. 212
Adding PortsonaBlock Diagram . ... 212
Adding a Global Connector onaBlock Diagram. . ............ ... .. o, 214
Connecting Overlapping NEtS. . ... ...t e e 214
Connecting NetstoaBlock or Component . ............o i 215
Connecting NetstoaPort MapFrame . . ... e 217
HighlightingaNetonaBlock Diagram. . ............ .. ... .. 217

Logic Shape NOtation. .. ... e e et 219
Changing the Shape of aBlock or Component. . .............. ... 220
Hiding Portson aBlock or Component . ... i 222
Indicating Not or Clocked POrts. . .. ... e 223

Setting Block Diagram Preferences. . ... e 223

Refer to the Block Diagram and IBD Views chapter for information about procedures which are
common to the block diagram and IBD view editors.
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Block Diagrams

A block diagram represents adesign as a number of functional blocks connected by signals. For
example, the top level block diagram for the TIMER _Vhdl design:

. Counter
Bl LU |

- [Control
oo

 arvasmeamen e IR qunnss SCSERRRETERS
m- T
et o [TIMER_vhal * TIMER_Vhdl

ol e o

- OR1 2
+ + |alarm <= hold OF beep;

Each functiona block may be defined by a state machine, flow chart, truth table or HDL text
view, or be decomposed into a hierarchy of lower level blocks.

A block or embedded block with an interface defined by the connected signals can be created on
the diagram or an existing component which has a fixed interface can be instantiated. A block

can be converted to a component and re-used any number of timesin the same (or different)
designs.

A signal can be added as a thin polyline with a name and type representing a scalar connection
(for example, the signal start in the picture has type std_logic) or asathick polyline
representing a vector bus with a name, type and bounds (for example, the bus dat_in has type
unsigned and bounds 3 DOWNTO 0).

If hierarchical operations are performed on signals connected to a block, the block interfaceis
automatically modified.

A component has afixed interface which can only be changed by editing its symbol or if the
component isitself defined by a block diagram by editing this block diagram.

Note
Mapping between actual signals on the block diagram and formal ports on a component
with different properties can be achieved by using a port map frame.
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Block Diagram Notation

A block diagram is constructed from the following graphical objects:

Libracy
Elockl

Library [
Component
Ul

Y7

dbusl : (15:0

| dbu=00s:07

A newly added block has no input or output ports. Its
interface is defined by the connections on the block
diagram.

A component has fixed input and output ports which are
shown on the symbol and can be used to connect signals
and buses which have compatible properties.

An embedded block can be used to add concurrent HDL
to ablock diagram without creating hierarchy. Its
interface is defined by the connections on the block
diagram.

Groups of signals or buses can be combined into abundle
which can be connected to a block or be unconnected.

External connections are represented by input and output
ports. Bidirectiona signals are connected using an inout
or buffered signals using a buffer port.

Signals connected to a global connector are implicitly
connected to every block on the diagram.

A net connector joins together signals or buses with the
same properties. An explicit connection is shown as a
filled dot @ or a“dangling” net connector shown as an
unfilled dot o .is an implicit on-page connection to other
signals or buses with the same name and type on the
diagram.

A ripper splits or combines slices or elements of a net
which have the same name and type. It can aso be used to
add or remove nets from a bundle.
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Blocks and Components

When you add a new block it has no ports (unlike a component which has fixed port interfaces
defined by its symbol). Ports are automatically added when you connect signals and a connected
block on ablock diagram looks similar to a component (although they are normally drawnin a
different default color).

Anicon indicating the type of view is displayed by default. A [2] iconisdisplayed if the view
typeis unrecognized.Y ou can choose to remove thisicon by unsetting a display setting
preference. Refer to “ Setting Block Diagram Preferences’ on page 223 for information about
changing the display setting preferences.

For example, the following picture shows two blocks. BlockA is defined by a block diagram
(indicated by the B icon); BlockB is defined by a state diagram (indicated by the % icon):

—» _bist (150) -
-~ | scRaTCH_LIB - | scratcH_Le -
= Elockh B ElockE -
R B o cbust: (150 L P

The following icons are used to identify graphical editor and HDL text views:
Table 4-1. Graphical Editor and HDL Text Views Notation

Icon Description

1y Block diagram view
] IBD view

T State diagram view
= ASM chart view

=N Flow chart view

i) Truth table view

E VHDL file

] Verilog file

If the default view is any other registered view, the appropriate icon is displayed.

Refer to “File Registration” in the HDL Designer Series User Manual for information about
registered view types.
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A block can be converted into a re-usable component but a component cannot be converted
back to a block. The interface for ablock can be edited dynamically by adding or deleting the
connected signals.

Note

D Y ou must rename a block before converting it to a component if it was under version
management control. A prompt message will appear if you attempted converting blocks
to components without renaming them while using RCS or Super CVSversion
management interfaces.

The interface for a component that is defined by a child block diagram can be edited by editing
that diagram. Otherwise the symbol must be explicitly edited using the symbol editor.

Library [ Library [ — o Library [
Elockl Component Component

U1 Hu 2 - —Hu 2 [—
Block Connected Component Connected
Block Component

The interface to ablock is defined by its connections and all signals have the same namesin its
child views. The interface to acomponent is defined by its symbol and signals can be connected
to ports with a different name provided that they have compatible properties. Y ou can aso
connect to ports indirectly by using a port map frame.

A block or component can have one or more child block diagram, IBD view, flow chart, state
diagram, truth table, HDL text or other registered views. When there is more than one child
view, you can change the current view by setting the default view or by using a VHDL
configuration.

Embedded Blocks and Embedded Views

An embedded view is saved as part of the block diagram or IBD view on which it isinstantiated
and does not create a separate design unit. When HDL is generated, concurrent codeis
generated for the embedded view in the same files (VHDL entity and VHDL architecture or
Verilog module) as the structural description of the design unit.

An embedded view has an interface described by the signals connected to the embedded block
which represents it on the block diagram or IBD view.

An embedded block looks very similar to a block (although they are normally drawn in a
different default color) but has no library name since it is always in the same name space as the
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view. However, it does have a unique name and a number which determines the relative
ordering when there are multiple unconnected embedded blocks in the generated HDL..

ehl > ehl
1 — 1
Unconnected Connected
Embedded Block Embedded Block

An embedded view can be used to represent a VHDL process, procedure or function, Verilog
alwaysor initial code, Verilog task or any other concurrent statements and istypically described
by HDL text. The concurrent HDL can also be represented by a graphical state diagram, flow
chart or truth table view which is normally hidden but can be displayed in an editor window by
double-clicking on the embedded view.

Signals, Buses and Bundles

Connections can be added between objects on a block diagram using signals, buses or bundles.
The only semantic difference between a signal and bus is the polyline style and you can change
the style used at any time by editing the signal properties. Signal styleistypically used to
represent scalar information and bus style to represent a composite array.

A new signal (or bus) is automatically declared when it is added to a diagram and the
declaration is stored as a property of the net. However, you can specify adlice or index for each
segment of a net (for example, when slices are ripped from a bus). The declarations for each
named net are shown as text Declarations on the diagram and the visibility of properties
displayed for each net segment can be individually set.

Y ou can optionally set a preference which displaysawidth label on bus nets. When enabled, the
width is shown independently from the bounds which can be optionally displayed in the signal
properties. The following example shows two bus nets with bounds (7 DOWNTO 0) and a
width label indicating that the buses are 8 bit wide:

recvit : t?:tlj g _.'

wmitdt: (708

Refer to “ Setting Block Diagram Preferences’ on page 223 for information about setting this
preference.

A bundle isacomposite grouping of connections which may include any number of signals and
buses and is normally shown on the diagram as a dotted line.
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The following pictures illustrate how a default signal (sig0), bus (dbus0) and bundle (bundle0)

are shown in VHDL and Verilog syntax. Notice how the name, type and bounds are shown for

the first use of abus. Only the nameisinitially shown for subsequent segments but the slice (or
element) is shown if defined. The bundle shows the names (and slices if defined) of the signals
it contains.

VHDL Verilog

Declarations Declarations

Dimgram Signals: Dimgram Signals:
SIGHAL dbus0 : std_logic_wector[15 DOWHNTO O] wire [15:0] dbus0;
SIGHAL sigd : std_logic wire =igl;

sigld » sigd »

sigD =igd
dbusd : (15:07 dbusd : [15:0]
Ldbusﬂ(?:tlj Ldbusﬂﬁ':ﬂ]
bundled bundled
Cpembumdlen D S o e bindlsn S N N o

(dbus0Cs DOWNTO 0],5ig0) [dbus0[F:0]=sigl

Refer to “ Changing the Display of Port Properties’ on page 198 and “ Changing the Display of
Signal Properties’ on page 200 for more information about the properties displayed on ports
and signals.

Ports and Signals

A port on ablock or an external port on a block diagram has the same name and properties as
the connected signal (or bus).

0 - - [N -
-— o hae i -
.............. T TEET Commsigned(15doemta 00 . . 0 . . 0 L. L
............... T Elockd o

[ = w4 e e
............ std_] o L sigd .
.................. P TR——

A port on acomponent has a name defined by its symbol and may be connected to asignal with
adifferent name on the block diagram provided the port and signal have compatible properties.
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For example, the signals sens, select, reject, disp and dispense_drink are connected to the ports
sensor, selection, refuse, display and dispense in the following example:

........ selict

Y ou can also connect actual signals on ablock diagram to formal ports on a component which
have different properties by using a port map frame.

* CnitBuardle e

. (dispense,display, refusel . . . .

. display == display, . . L L
- dispense == dispense,- - - - - -
- pefise == refise - - - - o - - -

For more information about using port map frames, refer to “Port Map Frames’ on page 273.

Changing the Display of Port Properties

Y ou can change the properties that are displayed for any selected input/output (10) port or
component port on a block diagram.

Note
D Refer to “ Setting Block Diagram Preferences’ on page 223 for information about setting

default port display properties.

Y ou can change the visibility of the properties for an input or output port on ablock diagram by
selecting the port and choosing Portl O Text Visibility from the popup menu to display the
PortlO Display Control dialog box.

A similar dialog box is displayed when one or more component instances are selected and you
choose Port Visibility from the popup menu.
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This Port Display Control dialog box sets the properties displayed for al ports on the selected
instance.

H[} Port Display Control B3

Contralz the format and wisibility of ugage and declaration
information attached to all portz e.q. name, type and
constraints.

— Fieldz to digplay
V¥ Part Mame

¥ Tupe Constraint
W Type Mame
v Initial *alue

¥ Display Part and D eclaration information on the zame line

— Format for bupe conztraints
& Full farm - e.g. [F DOWNTO 0]

= Shart form - e.g. [7:0]

— Misc
V¥ Selectable Tes

my_pork : bit_vector[¥ DOwWMTO O]
irit_val

Format Presview:

k. Cancel

The same dialog box is a so displayed when you choose Port Display from the Diagram or
popup menu in the symbol editor or use one of the Port Display buttonsin the Symbol tab of
the Object Properties dialog box.

Note
Note that you can set separate port propertiesfor ports displayed in the symbol editor and
the default port properties displayed when the symbol is instantiated on ablock diagram.

Y ou can choose to display the port name, type constraint (including the type name and boundsiif
defined) and VHDL initial value (if set) or Verilog delay (if set). Only the port name is shown
by default but you can choose to display the type constraint and initial value (or delay).

The name and type constraints are usually shown on asingle line (separated by a colon) with the
initial value or delay on a separate line. For example, a VHDL port 1n0O with type unsigned,
bounds (7 DOWNTO 0) and initial value "01010101" would be shown as:

———{ = In0 : unsigned(F DOVINTO O
"oqoq0109"
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Y ou can choose to display the port name and declaration information on separate lines and use
short format (which omits the VHDL keywords DOWNTO or TO). For example, the example
above becomes:

— = InD
unsigned(7:00
"oqoq0109"

Verilog signals are similar except that the bounds is always shown with short format. For
example, a Verilog bus In0 with type wire, bounds [ 15:0] and delay #3 would be shown as:

—— = In0 : wire[15:0]
3

or with the signal and declaration on separate lines as.

— = Ind
wire[15:0]
3

Y ou can choose whether to display the port name, type constraint, type name and initial value or
delay for the selected ports by setting a tri-state check box.

When multiple ports which have different display properties are selected, the check box is
dimmed and no changes are made for that property when you execute the dialog box.

Note
D The full port declarations are available in the IBD view or (when object tips are enabled)

in the object information displayed when the cursor is moved over a port in the block
diagram editor.

If the Selectable Text option is set, the properties text strings can be individually selected when
the symbol is instantiated as a component on a block diagram but if this option is unset, the
properties cannot be selected. If selectable text is enabled, the port text can be moved
independently but you cannot change the visibility of an individual port property. Thisoptionis
not present when an external port is selected.

Y ou can also hide any of the port properties by selecting the text and choosing Hide Text from
the popup menu.

Y ou can make all properties currently set in the port display properties visible by choosing
Show Text from the popup menu when the port is selected.

Changing the Display of Signal Properties

Y ou can change the properties that are displayed for any selected signal or bus on a block
diagram.
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Note
D Refer to “ Setting Block Diagram Preferences’ on page 223 for information about setting
default signal display properties.

Y ou can change the visibility of the properties for the selected segment of asignal or bus net on
ablock diagram by choosing Signal Visibility from the popup menu.The Signal Display
Control dialog box is displayed:

H[} Signal Display Control B3

Contralz the format and vizibility of usage and declaration
information attached to zignalz e.q. name, slicedelement,
tppe and constraints.

— Fieldz to digplay

V¥ Signal name and slice/element
¥ Tupe Constraint

[ Tupe Mame
[ Initial Walue

¥ Display Signal and Declaration information on the zame line

— Format for glice and type constraints
= Full farm - e.g. [7 DOWMNTO 0]

i Shart form - e.g. [7:0]

— Misc

Format Preview: my_sig[3:0] : [7:0)

k. Cancel

Y ou can also set the signal visibility by displaying the Text Visibility page of the Object
Properties dialog box when asignal is selected.

Y ou can choose to display the signal (or bus) name (including the slice or element if defined),
type constraint (including the type name and bounds if defined) and VHDL initial value (if set)
or Verilog delay (if set).

The name and type constraints are usually shown on asingle line (separated by a colon) with the
initial value or delay on a separate line.

For example, aVHDL bus dbus0 with slice (7 DOWNTO 0), type unsigned, bounds (15
DOWNTO 0) and initial value "01010101" would be shown as:

e dbusD(7 DOWNTO 0) : unsignedii5 DOWNTO 0)
"04040404"
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Y ou can choose to display the signal name and declaration information on separate lines and use
short format (which omits the VHDL keywords DOWNTO or TO). For example, the example
above becomes:

dbus0( 70

unsigned{15:07
"oqoq0109"

Verilog signals are similar except that the bounds is always shown with short format. For
example, aVerilog bus dbusO with slice [ 7:0], type wire, bounds [ 15:0] and delay #3 would be
shown as:

dbuz[7:0] : wire[15:0]
3

o

or with the signal and declaration on separate lines as:

dbus0[7:0]
wire[15:0]
3

Y ou can choose whether to display the signal name and dlice, type constraint, type name and
initial value or delay for the selected signals by setting atri-state check box. When multiple
signals which have different display properties are selected, the check box is dimmed and no
changes are made for that property when you execute the dialog box.

Note
The full signal declarations are available in the IBD view or (when object tips are
enabled) in the object information displayed when the cursor is moved over asignal or
bus.

Y ou can display different properties against each net segment on the diagram. Typically, the full
properties are shown for thefirst use of asignal or bus but only the name and slice (or element)
on ripped signals. For example:

dbusdi7 0y

unsigned{15:07
"oqoq0109"

dbusdz:0)

Y ou can also hide any of the signal properties by selecting the text and choosing Hide Text
from the popup menu. Y ou can make al text elements associated with asignal visible by
choosing Show Text from the popup menu when the object is selected.
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Block Diagram Editor Toolbar
The following commands are available from the Block Diagram Tools toolbar:
Table 4-2. Block Diagram Editor Toolbar
I con Description
[z = Select text or object
aly~ Select text only

Select object only

Add or modify comment text
Pan the window
Highlight all segments of the selected net on the block diagram

HEES

1

Highlight all segments of the selected net in the hierarchy

Clear net highlighting
Add ablock
Add a component

Add a ModuleWare component

Add an external HDL (I1P) model

Add an embedded block

Add aFOR, IF, ELSE or BLOCK generate frame
Addasignd

Add abus

Add abundle

Add aport

Add aglobal connector

Add a panel

Show the block diagram asan IBD view

FIEEEEIE R YRS

Note
Some buttons (for example, | [ [*|) have a pulldown palette which alows you to change

the command as shown in the table. The |{Egi+| button has a pulldown menu which allows
you to choose aFOR, IF, BLOCK (VHDL only) or ELSE (Verilog only) generate frame.

The toolbar can be displayed or hidden by setting the Block Diagram Tools option in the
Toolbar s cascade of the View menu.
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Refer to “Toolbars” on page 20 for more information about tool bars including the standard
toolbar buttons which are available in more than one editor.

Adding Nets on a Block Diagram

Y ou can add signal or bus nets, bundles, ports and global connectors on a block diagram by
using the Add menu or by using one of the block diagram toolbar buttons.

Note

D The | L |'| | "L.|'|, |%|'| and | - |'| buttons have a pulldown palette which allows you to

change the command as shown in the table below.

Some objects can also be added using a shortcut or mnemonic keys shown in the table below:

Table 4-3. Block Diagram Commands for Adding Nets

Button Shortcut | Mnemonic | Description
LI F7 S Add asignal net
|l|:| none none Add asignal net with a port
Etl Shift + F7 | U Add abus net
|l|:| none none Add abus net with a port
|E|:| none none Add abus net with aripper
| | Ctrl+F7 |N Add abundle
Elj none none Add abundle with aripper
| = || F8 I Add an input port
|:|:| F9 O Add an output port
| =~ F11 T Add abidirectional (inout) port
|i|l| F12 F Add abuffer port (VHDL only)
@ F5 G Add aglobal connector

Routing Nets

A net can be routed asasimple signal, vector bus or as a bundle which groups signals and buses

together.

A net connection (shown as afilled dot @) can be made by terminating a signal, bus or bundle
on an existing net. When ajunction between busesis made using a net connector in thisway, all
net segments have the same properties and only the net name is shown on the new net segment.
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You can also rip anindex or slice from abus by using aripper. For example, bits 15 and 14 are
ripped from the 16-bit bus outbusl in the picture on the next page.

Aninput or output port isimplicitly added to the symbol for a block when you connect a signal
or busto or from the block.

Y ou can change the port direction (in, out, bidirectional or buffer) by selecting the port and
choosing Change M ode from the popup menu which can be displayed using the Right mouse
button.

Any signal, bus or buffer connected to aglobal connector isimplicitly connected to every block
in the block diagram. For example, clk isaclock signal connected to BlockO, Block1 and Block2
in the picture.

- -

hit std_lngic
TEST £ig -
.MD Elocki std_logic <L i3
: . o
wneigped? D OWHTO 07 o TEST AOEL
Elack2
» I otk 2
TEST - i msignedi15 DOWHTO 0)
Bloal | Sl
dbmel stid_loggic
i e outhas 1715 D OWHTO 14
hit
B p— L
bit, msignedi15 DOWHTO 0)

A net connector can aso be used to implicitly connect by name separate segments of asignal,
bus or bundle which have the same name. For example, reset isareset signa connected by
name to Blockl and Block2 (but not Block0) although it not explicitly connected to Block2.

Adding a Signal or Bus on a Block Diagram

When you add a signal or bus, the cursor changes to a cross-hair which allows you to specify a
source, destination and any number of route points by clicking the L eft mouse button.

The source and destination can be a block, embedded block, port or port map frame on a
component. Y ou can aso connect to an existing signal, bus, bundle or global connector on the
block diagram.

If the source isin open space on the diagram or the signal is terminated by double-clicking in
open space, a dangling net connector is created. However, you can use the [=] pulldown menus
to change the default buttons to | 'L v| or I’L.—|v and automatically create an input port if the
source is an open space or an output port if asignal is terminated in open space.
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Note
D If the source object is an input, output, buffer or bidirectional port on a component, the

default endpoint has the same mode.

If you add asignal or bus without a port, the name, type and bounds properties are displayed on
the signal. However, if you add a signal or bus with a port, the signal properties are hidden and
the properties are shown on the port.

If the source is over an existing signal or bus, the source name, type and bounds are used.
However only the nameis shown on the diagram for the new net segment. If the sourceisover a
component port, the signal will have the same properties as the port (except in aVerilog
diagram when wire type is used when connected to a port with reg type).

If the source is unconnected and the destination is over an existing signal, bus or component
port, the destination name, type and bounds are used.

If both ends are connected, the source and destination must have compatible properties.

If neither end is connected, asignal is added with a default name and scalar type or abusis
added with a default name, vector type and bounds.

If the source of asignal isover abus or if you connect abusto an existing bus using the
button, the connection is made using aripper and adialog box isdisplayed for you to choose the
required element index or sice. Refer to “Ripping from a Bus’ on page 207 for more
information.

If the source of asignal or busis over abundle, adialog box is displayed for you to choose the
required signal, bus and optionally an element index or dlice. If the destination is over abundle,
the signal or busis added to the bundle. Refer to “ Ripping from aBundle” on page 210 for more
information.

Y ou can change the name, type and bounds by clicking on the text to select it and clicking again
to edit the text. The text is normally placed midway along the route but can be moved to any
other position by dragging it with the mouse.

Y ou can aso edit the name, type, bounds and other properties by using the Signalstab in the
Object Properties dialog box which is displayed when you by use the button or choose
Object Propertiesfrom the Edit menu.

The signal style (scalar signal or vector bus) can be changed in the Object Properties dialog box
or you can change the appearance by setting its visual attributes.

If you do not change the name, each new signal or busis given a unique name by adding an
integer to the default name (for example: sigl, sig2... for asignal; or dbusl, dbus2... for abus).
The default signal and bus name, type and bounds can be set by preferences.
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The name and type constraints text (if visible) are aligned with the net orientation. Thus the
nameis horizontal for ahorizontal net segment and vertical for avertical net segment. However,
the text can be rotated independently by choosing Rotate Text from the popup menu.

Ripping from a Bus

Y ou canrip asingle element of abus by using the button to connect asignal starting from
any point on the bus using aripper.

The Rip Element From Bus dialog box is displayed which allows you to specify the required
dlice. For example, the following dialog box is displayed when you are using VHDL.:

H} Rip Element From Bus E3

Specify bug element to rip;
Buz:  dbusl: std_logic_wector[15 DOWMTO 0]

Specify Element: j I j I j

(] Cancel | Help

k\_

The dialog box allows you to enter or select the index for the required element.

Alternatively, you can use the button to rip aslice from the bus using the Rip Slice From
Bus dialog box:

H[} Rip Bus/Slice From Bundle: E3

Chooze bus or bug ghice to rip;
Bundle:  bundle0

Rt | dbus - std_logic_vector(15 DOWNTO 0] =]

Optional Slice: |-|5 j IDDWNTD j IE‘ j
(] I Cancel I Help L

o

Y ou can choose from a pulldown list of existing slices ripped from the net. Y ou can also use
separate pulldown lists to compose the required slice.

The following examples show atwo-bit slice 7 DOWNTO 5 (VHDL) or [ 7:5] (Verilog) ripped
from dbus0O which has 15-bit bounds 15 DOWNTO 0 (VHDL) or [15:0] (Verilog). A one-bit
slice dbusO(1) or dbus0[ 1] has also been ripped from the bus and drawn as a signal.
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VHDL
p—out - 150 o [rontrol = dbusn(n:
dbu=zl1) . 1 control
o—
Declarations dbusl(7 5 2 nenbus (20
Fort=: )-
dbua=0 : 5td_log':i.c_vecto:|:[15 DOTITO 0)
comtrol : std logic newbuz == dbusDF DOVHTOSY; |
newbu= : 5td_log':i.c_vecto:|:[2 DOTITO 0)
Verilog
[ dbusd - [15:0] ] Iassign control = dbus0[1];
dbusl[1] 1 control
o—
Declarations dbusIF 5] b 0]
Farts: 1l : 2 l newbus : [2
wire [15:0] dbu=0; P -
wire control ; -
wize [2:0] newbus ; Iasmgn nenbus = dbus0[f:5]; I

All other properties for the new net segment are the same as the source bus.

Do not attempt to change the name of aripped signal or connect a slice or element of abus
directly to an output port. However, you can use embedded HDL text to assign the slice or
element to an aternative output signal. In the example, bit 1 of dbus0 is assigned to the control
output and the slice to the newbus output.

Note

D The embedded view containing HDL text can optionally be connected to the signals or
buses or you can use connection by name as shown for the control signal in the example.
Y ou can al'so map ripped slices or elements of a bus to the ports on a component by using
aport map frame.

Note that you can choose Change to Junction from the popup menu to replace aripper by anet
connector representing an unripped junction. Y ou can also choose Change to Ripper from the
popup menu to replace a net connector by aripper. After using these commands, the signal
properties for each net segment may need to be edited using the Object Properties dialog box.

Y ou can flip the direction of aripper joining two nets on a block diagram by using the and
IE. buttons in the Arrange Object toolbar or by choosing Flip Ripper from the popup menu
when the ripper is selected.
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Adding Signal Stubs on a Block Diagram

Y ou can add signals and buses corresponding to the ports on a component by choosing Add
Signal Stubsfrom the Diagram or popup menu.

If the component is selected, the Add Signal Stubs dialog box allows you to choose whether to
add signal stubs on Input, Output, InOut or Buffer (VHDL only) ports. Signal stubs are added to
all unconnected ports of the specified type.

If one or more ports are selected on ablock diagram, signal stubs are added to the selected ports
and any unselected ports are left unconnected.

Signal stubs are added with properties corresponding to the ports defined on the symbol for the
component.

If the component has a different language from the parent view (for example, a Verilog
component instantiated in a VHDL view) the signal properties are automatically mapped to the
language of the parent view.

The signal stubs are implicitly connected by name to nets with the same name on the diagram
and you are warned if any of the net names already exist.

Adding a Bundle on a Block Diagram

Bundles can be useful to connect a group of signalsto different parts of a diagram without the
need for long connecting nets.

A bundle allows a number of netsto be grouped as a single line on a block diagram.
Unconnected bundle segments with the same name are implicitly connected.

When you add abundle, the cursor changes to a cross-hair which allows you to specify asource,
destination and any number of route points by clicking the L eft mouse button.

The source can be asignal, bus, bundle, block, port map frame, global connector, embedded
view or unconnected. The destination can be any object except asignal, bus or port but can also
be left unconnected by double-clicking the L eft mouse button to compl ete the route.

Although you cannot connect a bundle to a component port, you can connect a bundle to a port
map frame and set Connection By Name in the object properties for the component to connect
signalsin the bundle to corresponding component ports with the same name.

A new bundleinitially has no content (unless originated on an existing signal, bus or bundle)
but you can add signals or buses to a bundle (which is then displayed with the constituent parts
after the bundle name) by terminating them over any point on the bundle.

Y ou can then rip signals or buses from the bundle by starting a new net at any point over the
bundle.
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If any signal or buses are selected when you add a new bundle, the selected signals are
automatically included in the bundle. However, the signal names in the bundle are not updated
if the discrete signal name is changed unless the signal is explicitly connected to the bundle.

If you connect a bundle to a block, then all of the constituent signals or buses in the block are
connected to the block and are represented by separate portsin achild block diagram. Similarly,
if you connect abundleto aglobal connector, all of the signals and busesit contains are
considered to be connected to every block on the diagram.

Y ou can change the bundle name by clicking on the text to select it and clicking again to edit the
text. Thetext isnormally placed midway along the route but can be moved to any other position
by dragging it with the mouse.

Y ou can also edit the bundle name by using the Bundlestab in the Object Properties dialog box
which is displayed when you use the button or choose Object Properties from the Edit
menul.

If you do not change the bundle name, each new bundle is given a unique name by adding an
integer to the default name (for example: Bundlel, Bundle2...). The default bundle name can be
set by a preference.

Adding Signals to a Bundle

If existing signals or buses are selected when you add a new bundle, they are automatically
included in the bundle.

Y ou can add signals or buses to a bundle by dragging the dangling net connector at the
destination end of the existing net onto the bundle or by terminating a new signal or bus on the
bundle.

Note
D Signals or buses with the same properties are implicitly connected by name and need not
be graphically connected.

Ripping from a Bundle

You canrip asignal (or element of abus) from abundle by using the button to connect a
signal starting from any point on the bundle using aripper.

The Rip Signal/Element From Bundle dialog box is displayed which allows you to choose from
adrop down list of signals and busesin the bundle and (when a busiis selected) specify the
required element.

210 Graphical Editors User Manual, V2008.1
September 18, 2008



Block Diagram Editor
Adding Nets on a Block Diagram

For example, the following dialog box is displayed when you are using VHDL :

Chooze zighal or bus element ko rip:
Bundle:  bundle0

Rip: | dbusD : std_logic_vector15 DOWNTO )

=

Specify Element: j I j I j
(] I Cancel I Help L

5

You can rip abus (or dlice of abus) from a bundle by using the button to connect a bus
starting from any point on the bundle.

The Rip Bus/Slice From Bundle dialog box is displayed which allows you to choose from a
drop down list of busesin the bundle and (optionally) specify the required dlice.

For example, the following dialog box is displayed when you are using VHDL :

Chooze bus or bug ghice to rip;

Bundle: bundled

Rip: Iu:ll:uus'l »gtd logic_vectar[15 DOWNTO 0]
Optional Slice: |15 j IDDWNTD j IE‘

(] I Eancell Help I
g

-
-

You can use the button to rip a secondary bundle. The Rip New Bundle dialog box is

displayed which allows you to select one or more signals and buses to include in the new
bundle.

For example, the two buses dbusO and dbusl are being ripped to create a new bundle in the
picture below:

Hj Rip New Bundle: E3

=igd Select one ar mare ibems:
sig1
dbusd : [15:0
dbusi : [15:0
|<ML|LTIF'LE SELECTION:=

bundlet LA x_
i e A7, ok | Cancel | Hep |

%

A bundle can be directly connected to a block (but not to a component) and all the netsin the
bundle will be available as individual signals and busesin child views of the block.
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Using HDL Text to Combine or Split Signals

An Embedded HDL text view can be used to combine or split signals which have different
properties by using simple HDL assignment statements.

For example, the following picture shows embedded HDL text used on a block diagram as a
splice to combinethe signals sig0, sigl and sig3 into signal sigout. The signals do not need to be
explicitly connected to the embedded block and the same signal combination can be achieved
with implicit connection as shown by the second example:

sigh

I -- Spliced 1 |
sigl > Spliced sigot == (s1g0 OF sigl O sigd);
: 1 :
sigd sigmdt
o I o
sgl ~ipliceE 2 ;
sigl o SpliceE sigot == (s1g0 OF sigl O sigd);
. 2 .
sigd o o sigmdt

Note
D If the text does not fit in the default size text box on ablock diagram, the additional text is
indicated by the word <<.. more ..>>. Thistext can be displayed by resizing the box.

Y ou can hide the HDL text box on a block diagram by selecting the text and choosing Hide
Text from the popup menu or re-display the text by choosing Show Text when the embedded
block is selected.

Y ou can also change the shape of an embedded block. For example, an embedded HDL text
view which performs alogical OR or AND function can be represented by a corresponding
logic shape.

Refer to “Logic Shape Notation” on page 219 for information about changing the shape of an
embedded block.

Adding Ports on a Block Diagram

When you add an external interface port on a block diagram, the cursor changes to a cross-hair
which allows you to add the port by clicking to drop the port at the required location on the
diagram.

Note
D Buffer ports are not available when the hardware description language is set to Verilog.
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A port represents a connection for signal paths in or out of the block diagram and can be
connected to asignal or bus. An unconnected port has no name, but when connected it is
identified by the name of the connected signal or bus and this name is used as the port name on
the default symbol for the block diagram.

If aport isadded over the dangling net connector on an existing signal or bus, it isautomatically
connected to the net.

Adding Ports to Existing Nets

Y ou can also add external interface ports to dangling net connectors by choosing Add Port 1/0
from the popup menu (or the Signals cascade of the Diagram menu) when one or more nets are
selected. Appropriate ports are added for the signal properties. For example, an output port is
added to an output signal or a buffer port to buffered signal. If both ends of anet are
unconnected, an input port is connected to the source end.

Adding Ports from a Component

Y ou can add external interface ports connected to signal stubs from the ports on a component by
choosing Add Portl O from the Diagram or popup menu in ablock diagram.

If the component is selected, the Add Signal Stubs dialog box allows you to choose whether to
add signal stubs on Input, Output, InOut or Buffer (VHDL only) ports. Signal stubs are added to
all unconnected ports of the specified type.

If one or more component ports are selected on a block diagram, signal stubs with ports are
added to the selected ports and any unsel ected ports are left unconnected.

The signal stubs are added with properties corresponding to the ports defined on the symbol for
the component. If the component has a different language from the parent view (for example, a
Verilog component instantiated in aVHDL view) the properties are automatically mapped to
the language of the parent view.

The signal stubs are implicitly connected by name to signals with the same name on the view
and you are warned if any of the signal names already exist on the diagram.

Changing the Mode of a Port

When one or more ports are selected on a block diagram or in the symbol editor, the popup
menu and the Ports cascade of the Diagram menu include a Change M ode cascade which
allows you to change the mode (In, Out, InOut or Buffer) of the ports.

This option can be used for external ports defining the interface or ports on ablock which define
the interface to achild view.
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Note
D If you change the mode of a port to or from an input port, it is rotated automatically by
180 degrees.

Rotating a Port

When an external interface port on ablock diagram is selected, the Edit and popup menus
include a Rotate Port cascade which allows you to rotate the port clockwise by 90, 180 or 270
degrees.

Rotating Signal Names

Y ou can rotate a signal name (or a port name in the symbol editor) by choosing Rotate Text
from the popup menu to rotate the text clockwise by 90, 180 or 270 degrees.

Adding a Global Connector on a Block Diagram

Y ou can add a global connector on a block diagram using the @ button or G shortcut key or
by choosing Global Connector from the Add menu.

The cursor changes to a cross-hair which alows you to add the global connector by clicking at
the required location on the diagram. A global connector represents acommon connection to all
blocks in the diagram. Any number of signals, buses or bundles can be connected to the same
global connector. This does not imply any connection between them.

Note
D A global connector connects the attached net (or nets) to all blocks on the diagram but
does not connect to components or ModuleWare instances.

Connecting Overlapping Nets

A net can be individually connected to another net or other object by dragging with the L eft
mouse button over the net or object. Y ou can also make a connection to one or more nets by
overlapping the dangling net connectors and choosing Connect from the Diagram or popup
menus.

When you connect nets in this way, the new net adopts the properties of the selected net. For
example, the following nets become signal X, signalY and signalZ if the Connect command is
used when signal X, signal’Y and signalZ are selected.

signaldy - sigpalyl signald
signalEs - sigpal¥ signal¥
signall . signalZ signal?
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Y ou can connect dangling net connectors to a bundle by drawing a bundle to overlap the net
connectors and then choosing Connect. For example, after adding signal stubs to a component
you can group the output signalsinto a single bundle for easy routing to another area of the

diagram.

st fr——0

data ozt D—ci}

ot

data_cazt

Similarly, if the dangling connectors represent slices of a bus, they can be connected to asingle
bus although the net properties may need to be edited to ensure that all connected net segments

have the same name.

For example, in the following picture, dbus2 has been connected and then edited to have the
same name (and compatible range) as the slices dbus1(0) to dbusl(3).

dhnasd

dhnas 1

dhnas 1

dnas 111

dhnas 1

]
msignedi15 DOWHTO 0)

s 1 o
Dol Wsigred s D OWHTO 03
s 1

dns 11

s 1

Connecting Nets to a Block or Component

Signals or buses can be individually connected to a block or component by dragging with the
L eft mouse button over the body of ablock or over an existing port or port map frame on a

component.

Y ou can also make a connection by overlapping a block or component with the dangling net
connectors on the end of existing signals or buses and then choosing Connect from the

Diagram or popup menus.

This can be useful when you have created a new child block diagram and want to add ablock or
component connected to the nets created when the child diagram isinitialized.
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When you are using this method to connect a component port, the port must be fully

overlapping as shown below:

hold :
std logic SR
dat 1

e load in

unsignedi 15 downto 0

VHDL Port Mapping

If asignal has no dlice or element, then the port has the type and range (if any) of the signal. All
other declarations are the same except that initial values on signals are not propagated to the
port. The type and range are different if slices or elements are used.

If the signal has a dlice, then the port has the type and the range of the slice. However, the type

must be one of the following:

std _logic_vector
std_ulogic_vector
bit_vector

signed

unsigned

integer
natural
positive
real
string

If not one of these types, for example, a subtype defined in aVHDL package such as slv7dO IS
std_logic_vector(7 DOWNTO 0), an error isissued. To use such atype, you should either
change the block to a component or assign the slice to an intermediate signal.

If the signal is an element of abus, and the bus array type is one of those in the following list,

then the corresponding port scalar type is used:

BusArray Type

std_logic_vector
std_ulogic_vector
bit_vector

signed

unsigned

integer

natural

positive

real

string

Port Scalar Type

std_logic
std_ulogic
bit
std_logic
std_logic
integer
natural
positive
real
character

If not one of the above types, an error isissued and you should either change the block to a
component or assign the element to an intermediate signal.
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A signal isregarded as an element if the slice boundsis specified in asingle field and is either
an integer or avalid identifier. For two dimensional arrays, each array is treated accordingly,
whether a slice or an element.

Connecting Nets to a Port Map Frame

If aport map frame is enabled and the nets or the component body are selected, then
overlapping net connectors are connected to the frame unless they aso overlap a port with
compatible properties on the body of the component.

high o high >
e 2 clear clear {= clear
load
2 load load 1 load
hold {E’" e hold [ oot
—_—
4t i By G i I load_in
. . »
[4 camr i [4 camr i
ok o ok ok ol

Note
D If the port map frame is selected, all overlapping nets are connected to the frame.

Highlighting a Net on a Block Diagram

Any set of signalsor buses which are connected explicitly or implicitly connected by nameform
anet.

Y ou can highlight an entire net by selecting any net segment, port declaration or signal
declaration on the block diagram and choosing Highlight Net from the popup menu or from the
Signals cascade of the Diagram menu.

A cascade menu alows you to highlight all routes in the selected nets for a Single L evel block
diagram or to highlight the netsin any open Hierar chical diagram. These options are also
available using the [1<}] and [ #}+] buttons.

If multiple nets are selected, four different highlight colors are used. However, the colors may
be repeated when more than four nets are selected and bundles are always highlighted in red.

If you choose the single level option, al segments on the active diagram in the selected net are
highlighted even if they are connected only by name including any bundles which contain the
net.
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If abundleis selected, any nets contained in the bundle are highlighted even if they are not
graphically connected to the bundle.

If you choose the Hierarchical option, the Net Highlighting Options dialog box is displayed.

H[} et Highlighting Options

Apply Higrarchically
[ Up v Diown

[~ Through Components

[T Tihraugh potewhene port nane differs e net

ak I Cancel |

Z

Y ou can choose whether the highlighting is applied Up and Down the hierarchy and whether it
should be traced Through Components. If you choose to highlight through components, an
extra option controls whether the highlighted net is traced Through portswherethe port
name differsfrom the net.

When you confirm your choices in the Net Highlighting Options dialog box, the net is
highlighted on the active diagram and a progress window is displayed which lists all the
occurrences of the net in the specified hierarchy.

Hla Met Highlighting : UART fuart_top
Mets[s]: control
Wiew M ame Current “igw Statug Met(z]
TART~uart_top~struct struct . bd ()54 control

Status: Select an item for a detailed dezcription. ;I
Frogress: complete

Done I

5
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The progressisindicated in the dialog box and a complete indicator displayed when all viewsin
the hierarchy have been traversed.

If any errors or warnings are encountered, these are indicated in the Status column and the full
message appears in the Status box when the view name is selected.

Y ou can display any view listed in the preview window by double-clicking on its namein the
preview window. If the view is ablock diagram, all occurrences of the net are highlighted and
the window is zoomed to view the entire net.

You can clear al net highlighting by using the 2, button or by choosing Clear All from the
menul.

Logic Shape Notation

The standard block diagram notation uses simple rectangular shapes for blocks, embedded
blocks and components connected by directed lines representing signals, buses or bundles.

This notation allows the designer to focus on the high level behavior of the design without
prematurely committing to implementation details. However, there are many cases particularly
inlow level design or where existing components are being re-used when it is useful to use gate-
level logic notation.

Y ou can choose from a set of aternative standard shapes representing standard data path
functionsincluding multiplexer, buffer, AND, OR, XOR, arithmetic logic unit, ground, supply,
pulldown and pullup.

These shapes can be used to represent inverted logic (including NAND, NOR, NXOR) by
adding an active low (Not) indicator to the port or you can add a clock indicator to an edge-
triggered input port.
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For example, clock @ and active low indicators @ have been applied to the clock and out2
ports on the DFF component in the picture below.

The shapes can also be applied to any block or embedded block and you can choose to hide the
block ports when the flow isimplied by using these logical shapes. For example, the ports have
been hidden on the embedded blocks AND1 and BUF in the picture.

Changing the Shape of a Block or Component

Y ou can change the shape of the selected block, embedded block or component instance on a
block diagram by choosing the Shape cascade of the Diagram or popup menu.

Note
D Note that you can create a custom shape for acomponent symbol which will be applied to

all instances of the component by using the symbol editor as described in “Customizing a
Symbol” on page 307.

Y ou can check Edit Shape from the Shape cascade menu to edit the existing shape directly or
choose Autoshapes to choose from a palette of standard shapes.

If you choose Edit Shape, the block, embedded block or component is replaced by aresizable
rectangular boundary enclosing the default shape. A customized shape can be created by adding
comment graphics within this boundary.

The default shape can be deleted or you can superimpose any humber of comment graphics
objects. Alternatively, you can use the Edit Vertices command from the popup menu to modify
shapes.
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Any comment graphics or comment text added completely within the boundary is considered
part of the customized shape. The block boundary is drawn in red while in edit mode and
existing comment graphics or text can be moved inside the boundary.

When you uncheck Edit Shape in the menu, the boundary is redrawn in gray and al comment
graphics or text within the boundary become part of the customized shape.

The cascade menu also includes an option to add autowhiskers. If Autowhisker is checked in
the menu, whiskers are automatically added as orthogonal lines between the ports on the block
boundary and the contained comment graphics shape. However, no whiskers are added if the
line would not intersect with a graphics object.

Choosing a Standard Shape

Y ou can apply a standard shape to the selected block, embedded block or component by
choosing Autoshapes from the Shape cascade of the Diagram or popup menu or by using the
Change Shape button in the block diagram Object Properties dialog box.

Y ou can change the shape of a component symbol which will be applied to all instances of the
component by choosing Autoshapes from the Diagram or popup menu when the body of the
symbol is selected in the symbol editor or by using the Change Shape button in the Symbol tab
of the Object Properties dialog box.

The Choose Shape dialog box allows you to change the default rectangle shape.

rectangle
b L

Buf

And

Or

=0r

Al

Gnd

Wioo
Pulldown
Pullup
circle
doubleCircle

rectangle

ak I Cancel

The following alternative standard shapes are available:

Name Shape Function Name Shape Function
Mux 0 Multiplexer Gnd 0 Ground
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Buf > Buffer Vce T Supply

And D AND gate Pd 3 Pull down

Or D OR gate Pu T Pull up

XOr D Exclusive OR gate circle s Circle

Alu > Arithmetic logic unit doubleCircle & Double circle

Y ou can also apply these shapes using a pulldown pal ette accessed from the button in the
Appearance toolbar.

Y ou can use these shapes to represent other logic functions (such as NAND, NOR and NXOR
gates) by setting an active low indicator for any selected port.

For example, an invertor can be represented by a buffer shape with a Not port:

P

Hiding Ports on a Block or Component

Ports are normally added automatically when a signal is connected to a block or embedded
block. However, you can clear the Show ports when connected option in the Blocks or
Embedded Blocks tab of the Object Properties dialog box to hide the ports. This can be useful
when you have changed the shape of ablock to represent a standard logic function.

For example, the following picture shows an how an embedded block representing alogical
AND function would be displayed with the ports displayed or hidden:

A A
—
eh hid eh hid
1 1
B B
—
Paortz Displayed Parts Hidden

Y ou can aso choose whether connected ports are displayed on a component by setting the
Show portswhen connected option in the Symbol tab of the Object Properties dialog box in
the symbol editor.
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Note
D Unconnected component ports are always displayed.

Indicating Not or Clocked Ports

Y ou can choose whether a selected port (or ports) on ablock or embedded block in ablock
diagram is shown with active low (Not) polarity (indicated by # ) by choosing On from the
Not cascade in the popup menu (or Ports cascade of the Diagram menu) when the port is
selected. Choose Off from the cascade menu to set active high polarity and remove the
indicator.

If aport on a ModuleWare component which supports polarity control is selected, you can
choose Active High or Active L ow from the Port Type cascade of the popup menu or you can
set the port type parameter in the ModuleWare Parameters dialog box. Many of the
ModuleWare components al so provide synchronous (Sync) and asynchronous (Async) polarity
and Rising or Falling clock options.

Y ou cannot directly change aregular component port but you can set an active low indicator by
using the popup menu (or Ports cascade of the Diagram menu) in the symbol editor.

Y ou can also choose whether a selected input port (or ports) is shown as an edge triggered clock
signal (indicated by B ) by choosing On from the Clock cascade in the Diagram or popup
menul.

Y ou can aso choose to hide connected ports when you want to represent a standard data path
logic function. For example, the following picture shows a component representing aflip-flop
with an edge triggered clock and active low reset:

Paortz Displayed Port= Hidden

Setting Block Diagram Preferences

Y ou can set block diagram preferences by choosing Structural Diagram from the M aster
Pr efer ences cascade of the Options menu in the design manager to display the Structural
Diagram Master Preferences dialog box.
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The dialog box has separate pages for setting Gener al preferences, Default Settings,
ModuleWar e preferences, Block Diagram preferences (which include Display Settings,
Appear ance and Background preferences), in addition to | BD preferences.

Y ou can set the block diagram appearance, display setting and background preferences (but not
default values) for the active diagram by choosing Diagram Pr efer ences from the Options
menu in the block diagram editor to display the Block Diagram Preferences dialog box.

When you edit these preferences for the active diagram, the dialog box allows you to choose
whether the preferences are applied to new objects or to both new and existing objects in the
diagram.

Refer to “ Setting Diagram Master Preferences’” on page 49 for information about applying
master preferences to existing views and updating the master preferences from the active view.

The General page allows you to set genera preferences for the block diagram.Y ou can set an
option to check the HDL syntax of declarations and embedded HDL text objects on entry.
Checks are also performed for unsynthesizable constructs if the common synthesis checks
option is set in the Checks tab of the Main Settings dialog box.

Hla Structural Diagram Master Preferences x|
- Defouk Setings P ]
o WHDL Part/Signal Orderinig
o Wil )
P Deerflauuﬁlt Prapetiss W Check syntas on enty {* A tomatic
i Mu:uduleWare ¥ Generate indine Modulsiaare code i~ Manual
= Block Diagram

= Digplay Settings
_____ Object Yisibility Default zave name: Istruu:t
- WHDL Signal Display
o WHOL Portl0 Display
----- Yerilog '35 Signal Display
- Werilog '95 Portl0 Display
----- Yerilog 2005 Signal Dizplay
----- Yerilog 2005 PortlO Dizgplay

Lo Maodulein are Drigplay
o Appearance
‘o Background
= IED
e ADpEArance
4 | ol
(] I Cancel | Help |
]
Y ou can choose whether in-line or separate HDL code is generated by default for any
instantiated M oduleWare components.
Y ou can specify the default save name used for new block diagrams.
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Y ou can al so specify whether port declaration ordering is automatic (by mode and a phanumeric
name) or if manual ordering is allowed.

The Default Settings page allows you to set the default names used for the signal, bus and
bundle name, embedded block name and global connector name.

Hla Structural Diagram Master Preferences | x|

e pewsas
(= [ cfault Settings
- WHDL — Default Mames
..... Verilog Signal Isigl:l
‘o Default Properties
e b oduleta’ are B I':":"'JSI:I
- Block Diagram ;
= [_flispla_l,l Settings undle: II::unu:IIeEI
- Dbject Visibility Embedded block: [eb1
- WHOL Signal Dizplay
o WHOL Portl0 Display Global connector: ||3

----- Yerilog '35 Signal Display

|nztance Mame

- Werilog '95 Portl0 Display
- Verilog 2005 Signal Display, | | ©* Manual " Automatic
----- Yerilog 2005 PortlO Digplay,
‘o Maduleiare Display IU_U
i Appearance
o Backaround
= IBD
o Appearance
4 | ol

(] I Cancel | Help |

4

Y ou can aso choose whether the instance name for a block or component is derived from a
specified root name or from the design unit name.

When set to Manual, the specified string is used as the root of the instance name. The default
name can be changed or the instance name can be edited on a block diagram or IBD view and
replaced by any other valid HDL identifier.

Theinternal variable %(unit) can be included to insert the design unit name and the instance
name can be edited on a block diagram or IBD view.

When set to Automatic, theinternal variable %(unit) isused. The default name can be modified
but must always include the %(unit) variable. The variable is automatically replaced by the
design unit name and the instance name cannot be edited on a block diagram or IBD view.
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Separate VHDL and Verilog sub-pages can be used to set default types, constraints and bounds
for VHDL and Verilog signals. For example, the following picture shows the VHDL sub-page:

x|
—— [respssser T
= Default Settings
. HOL YHDL
..... erilog Signal type: std logic j
‘o Default Properties
- Modulehare Bus type: std logic j
El- Block Diagram _
=l Display Settings Bounds(Index]: 15 powNTD | [0
S Object Vigibility

- WHDL Signal Display

o WHOL Portl0 Display

----- Yerilog '35 Signal Display
- Werilog '95 Portl0 Display
- Werilg 2005 Signal Display
----- Yerilog 2005 PortlO Dizgplay
Lo Modulgh are Drigplay

i Appearance

- Backaround

e AppEArance

(] I Cancel | Help |

The bounds can be entered as arange (for example, 15 DOWNTO 0 or 0 TO 75in VHDL or 0:7
in Verilog) or you can use the first bounds entry box as an index for asingle element in an array
leaving the second entry empty.

Note that for VHDL, you can use the first bounds entry box to enter a user specified constraint
such as an enumerated or integer type name or you can enter an array hame or type of the form:

<array>' RANGE or <array>' REVERSE_RANGE

The following picture shows the options on the Verilog sub-page

structuralDisgram Master Preferences
. odmit [obabsedseibes ]
=l Default Settings
- WHDL Yerilog
Verlog T}'I:IEZ y -
- Default Properties IW"E J
- Modulgefare Bounds: |-|5 : ||:|
=l Block Diagram
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Y ou can use the Default Properties sub-page to define default user properties for block

diagram views.

x|
e DefsutPopeties
B [Eflefault Settings Specify default properties in the table below
o YHDL It iz not neceszsany to specify & Clazs for user-entered properties.
- Werilog
O =5t Properties Class Marne Yalue
i Moduledsfare - -
=1 Block Diagram _I _I
= Digplay Settings
- Ohbject Yisibility
- WHDL Signal Display
o WHOL Portl0 Display
----- Yerilog '35 Signal Display
- Werilog '95 Portl0 Display
----- Yerilog 2005 Signal Dizplay,
----- Yerilog 2005 PortlO Dizplay,
Lo Maodulein are Drigplay
i Appearance
o Backaround
= IBD
e Appearance
4 | ol
(] I Cancel | Help |
i

Refer to the HDL Designer Series User Manual for information about “Using View Property

Variables’.

Note

[

The default values take effect on the next block diagram you open and can only be edited
from the Master Preferences cascade in the design manager Options menu.
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The ModuleWar e page alows you to set the default visibility for the content of the object tip
displayed when the cursor is over a ModuléWare instance in a block diagram or IBD view.

Hla Structural Diagram Master Preferences x|
= e —
=l Default Settings

- WHDL — Object tips
i Werilog

. Default Properties

; h oduleifare

=1 Black Diagram

= Display Settings

- Dbject isibility

- WHDL Signal Display

o WHOL Portl0 Display

----- Yerilog '35 Signal Display
- Werilog '95 Portl0 Display
- Werilg 2005 Signal Display
----- Yerilog 2005 PortlO Dizgplay
Lo Modulgh are Drigplay

i Appearance

- Backaround

e AppEArance

¥ Instance name
¥ IreLine / name
¥ Part widths
v HOL preview

[ Active port levels
¥ Part synchronization

v Port-specific setiings

o]

Cancel | Help |

Tip: When these settings are accessed from the editor, you can choose whether to apply
the display settings to new objects only or to all new and existing objects on the diagram.
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The Block Diagram page enables you to set general block diagram options in addition to
routing preferences.

x|
e et ]
=l Default Settings
o VHDL — General Options
e Werilog
‘o Default Properties [ Modify instance width on update
o b oduleta’ are
=1 ”':"::k- Liagram — Interactive Routing Options
= [_flispla_l,l Settings
----- Object Yigibility —Paort 10 Stub Rowtng———— 1~ Diefault Mode
o YWHOL Signal Display " |f more than 10 i’ ] et o
: I anid units Diagonal
- WHOL Portl0 Dizplay =
- Yerilog '95 Signal Display % Mewver raute, just move the stub " Dogleg

- Werilog '95 Portl0 Display
- Werilog 2005 Signal Display ~ — Realtime Keys
----- Yerilog 2005 PortlO Dizgplay V¥ Use |7
o Moduleh are Dizplay
i Appearance
- Backaround

= Riiver

* tvoidance [can be slow]

ke to change mode

e AppEArance

(] I Cancel | Help |

4

As part of the Block Diagram General Options, you can choose to automatically modify the
width of an instance in a Block Diagram, on using the Update Interface option. Thisis
applicable when you have added a port with along name to a Symbol and then saved;
subsequently, on right-clicking on the symbol’ s corresponding instance in the Block Diagram
and choosing Update I nter face from the popup menu, the width of the component isincreased
to accommodate the width of the added port name.

On the other hand, if the option “Modify instance width on update” is not selected, then on
updating the interface, the component width shall not be increased to contain the long port
name.

Note
Y ou must set the Port Name option in the Port Visibility settings of the component, in
order to have the name text visible on the component ports.

In the Interactive Routing Options section, you have the ability to set the default routing method
aswell as the stub routing options as follows:

1. You can set the Default Mode for net routing as Diagonal, Dog Leg, River, or
Avoidance. The default routing mode is Avoidance.
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o Diagonal: alowsrouting in a straight-line mode.

o Dog Leg: alowsrouting in an angular mode with the ability to create overlapping
between nets.

o River: alowsrouting in an angular mode with the ability to create net loops.

o Avoidance: does not allow any cross-overs of objects; that is, this mode avoids the
overlapping of any existing objects.

Through the Real-time Keys section, you can specify a key through which you can
toggle between the above mentioned routing modes while routing (by pressing the key
you specified).

2. Inthe Port 10O Stub Routing section, you can choose one of two options. First, you can
allow stub routing only if the stub exceeds a specific length of your definition; that isto
say, if the stub length is more than the number of grid units that you define, only then it
will be routed.

On the other hand, you can choose not to route the stub, but rather to re-locate it directly
on moving its relevant object.
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The Display Settings sub-page contains options which control how objects are displayed on a

diagram.

Hla Structural Diagram Master Preferences

- General

= Default Settings

E ..... WHOL

----- erilog

L Disfault Properties
i Moduleh are

=1 Block Diagram

L:_| Digplay Settings
- Obiject Vigibility

- WHDL Signal Display

o WHOL Portl0 Display

----- Yerilog '35 Signal Display
- Werilog '95 Portl0 Display
- Werilg 2005 Signal Display
----- Yerilog 2005 PortlO Dizgplay
Lo Modulgh are Drigplay

i Appearance

. Background

----- Appearance

B

— Components

W Use Symbol visual attributes for Components

v Use Component Port digplay for connected Mets

—Metz
[ Show Signal attibutes

[ Show 'wire width label
[ Aute update Signal style

[ “wrap Bundle contents

W Show View lcon

—%iew [con Pozition:

" Battam Left
™ Bottom Right
" Top Left

i~ Top Right

o]

Cancel |

Help |

Y ou can choose whether to use the symbol visual attributes when a symbol isinstantiated in a
block diagram as a component and whether to take display settings from component ports. This
option makes the visibility of properties on anew net the same as the visibility of properties on
the connected component port. Otherwise, the default signal display properties are used.

Y ou can choose whether attributes added to port and signal net declarations are shown on the

block diagram. Y ou can choose whether to display an optional net width label and whether the
signal style (signal or bus) is automatically updated when you change the bounds of anet. You
can also choose to wrap the contents of bundles and show each signal on asingleline or display
all the signals on the same line below the bundle name.

Y ou can a so enable or disable an icon which indicates the default view of ablock or component
and specify where thisicon is displayed on the instance.
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Note

Many of the display settings can only be set in the master preferences and are
permanently dimmed when the dialog box is accessed from the editor.

An Object Visibility sub-pageis available in the Structural Diagram Master Preferences dialog
box which allows you to set the default object visibility for multi-line text objects on the

diagram.
x|
e N
= Default Settings
""" """Hl_:'l- Declaration
- Verlog _ Package List (vHDL]
""" Default Properties Compiler Directives [Werlog)
i Moduleh are

- Elock Diagram

= Digplay Settings
----- Object Wisibility

- YHOL Sigrial Display

- YHOL Portl0 Display

----- Werilog '35 Signal Dizplay
- Werilog '95 Portl0 Display
----- Werilog 2005 Signal Dizplay
----- Werilog 2005 PartlD Digplay
o Moduleiware Display

i Appearance

o Backaround

e AppEArance

o]

Cancel | Help |

Refer to “Changing Text Visibility” on page 63 for more information about the objects which
can be displayed or hidden on a block diagram.
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Separate VHDL Signal, Verilog Signal,Verilog 2005 Signal,VHDL Portl O, Verilog Portl O
or Verilog 2005 sub-pages can be opened to set the default display propertiesfor signal nets and
external ports. For example, the following picture shows the VHDL Signals page:

Hla Structural Diagram Master Preferences

General

=1 Default Settings

E ..... WHDL

----- erilog

. Default Properties
b oduleta’ are

=1 Block Diagram

= Digplay Settings

- Object Visibility

™ /HDL Signal Display

- WHDL Portl0 Display

----- Werilog '35 Signal Dizplay
- erilog '35 Portl0 Display
----- Werilog 2005 Signal Dizplay
----- Werilog 2005 PartlD Digplay
L Modulehare Display

Contralz the format and vizibility of uzage and declaration information attached to

zignalz e.g. name, zlicedelement, type and constraints.

x|

— Figldz to digplay

v Signal name and slice/element
W Tupe Constraint

[~ Tupe Mame
[ Initial Walue

v Display Signal and Declaration information on the zame line

— Format for glice and type constraints
= Full farm - e.g. [7 DOWMNTO 0]

& Shart form - e.g. [7:0]

o Appearance
oo Background — Misc
- IBD ; :
: F kP i 0] [7:
.. Appearance armat Preview |m_l,l_$|g[3.ﬂ].[?.ﬂ]
< | ]
ok I Cancel | Help |
]
Note

[

The display properties can be set separately for VHDL and Verilog when you edit the
master preferences or for the language used by the active diagram when accessed from
the editor. When accessed from the editor, you can choose whether to apply the signal
and port display changes to new signals and ports only or to all new and existing signals

and ports on the diagram.

Refer to “ Changing the Display of Signal Properties’ on page 200 and “Changing the Display
of Port Properties” on page 198 for more information about the signal and port properties.

A ModuleWare Display sub-page allows you to set the visibility of the ModuleWare
parameters that can be displayed as comment text adjacent to a ModuleWare instance on a block
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diagram. Note that the settings in the ModuleWare Display sub-page apply to block diagrams
only, whereas the settings in the ModuleWare page apply to structural diagramsin general.

Hla Structural Diagram Master Preferences x|
o e —

=1 Default Settings

""" WHDL ™ Show text box by default
i Werilog B
“o Diefault Properties el
- Modulehare ¥ Instance name [T Active port levels
& E:!Icu:k.Dlagram . v In-Line / name ¥ Part Synchronization
= DISD|E|_',' Settings
----- Object Yigibility v Port widths v Part-zpecific settings
i WHOL Signal Display _
- VHDL PortlD Display I HDL preview

----- Werilog '35 Signal Dizplay
- Werilog '95 Portl0 Display
----- Werilog 2005 Signal Dizplay
----- Werilog 2005 PartlD Digplay

lay

o Appearance
‘o Background

----- Appearance

(] I Cancel | Help |

When this page is accessed from the Structural Diagram Master Preferences dial og box, you can
choose whether the text box is displayed by default.

Tip: When accessed from the editor, you can choose whether to apply the display settings
to new objects only or to all new and existing objects on the diagram.

Refer to “ Setting the Visibility of ModuléWare Parameters’ on page 114 for more information
about displaying ModuleéWare parameters.
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The Appear ance page allows you to set visual attributes for individual block diagram objects.

“laBIul:k Diagram Preferences - Untitled E

- Display Settings

b WHDL Signal Display
- WHDOL Portl0 Display
- bdoduleve’are Display
‘... Background

The master preferences can be acceszed from the Dezign Browser

Arch, Declarations Test
Block

Block Frame

Block Test

Bundle

Bundle Text

Busz

Buz and Signal Test
Comment Box
Comment Text
Component

Component Paort
Component Port Buffer
Component Port Test
Component Test
Embedded Block
Embedded Block HOL Box
Ermbedded Block HOL Test
Embedded Block Text
External IP

Frame Test

Generate Frame
Genenc Azzoc, Tedt
alobal Connectar
Global Connector Label
Junction

— Colar — Style
Foreground -j Fill Style .j
B ackground I j Line Style .j
Line Color -j Lire “wfidth -j
— Font
Courier Mew Mormal 8 point Set..
Apply Changes to
" Mew Objects ™ Mew and Exizting Objects
Changes apply to objects in this diagram only
Ok, I Cancel | Help |
p

These attributes include the foreground and background colors, line color, fill style, line style,
line width and text font. Some attributes may not be available for all objects (for example, the
line style, width and color attributes are not available for atext object).

Refer to “ Setting Visual Attributes’ on page 78 for more information about visual appearance

attributes.
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The Background page alows you to control the diagram background color and grid attributes

used by the block diagram editor.

Hla Structural Diagram Master Preferences

General

=1 Default Settings

- WHDL

Werilog

Default Properties

b oduleta’ are

= Block Diagram

= Digplay Settings

- DObject Visibility

YWHOL Signal Digplay
WHOL PortlO Digplay
Yerilog '35 Signal Display
Yerilog '35 Portl0 Dizplay
Yerilog 2005 Signal Dizplay
Yerilog 2005 PortlO Dizgplay
b oduletfare Dizplay
Appearance

Background

Appearance

— Grid

x|

v Show Grid
Cilor
Digplay horizontal grid even

Dizplay vertical and ewvery

|-| poirk
|-| poirk

— Diagram

B ackaround colar

I"-.-'v"hite = I

(] I Cancel | Help |

These preferences are described in “ Setting Background Preferences’ on page 50.

Refer to the “Default Preferences’” appendix in the HDL Designer Series User Manual for lists
of the default preferences set when you invoke aHDL Designer Seriestool for the first time.
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Chapter 5
IBD View Editor

This chapter describes how the structure of a design can be represented using a tabular IBD.

Refer to the Block Diagram and IBD Views chapter for information about procedures which are
common to the block diagram and IBD view editors.

Interface-Based DeSIgN . .. ..ot 238
New Design Creation FIOW. . ... ..o e 238
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IBD View Toolbar .. ...... .. e 242

Getting Designsinto IBD Editor. ... ... 243
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Expanding and Collapsing IBD Views. .. ... e 255
Moving Rowsand ColumnsinanIBD View. .......... .. ..., 256
Sorting Rows and Columnsinan IBD View ..., 256
Grouping IBD Rowsand Columns. . . . ... 256
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Managing Design Hierarchy . . ... 263
Addingalevel of Hierarchy ........ ... .. . . 263
Flattening Design Hierarchy . . . ... ... 264

Generating HDL from IBD VIGWS. . . . ..ot 265
Controllingthe Generated HDL Code . . .. ...t e e 265
Enforcing Generation . . ... ... i 266
Cross Referencing Generation Errors. . ... ..ot 267

SettingaBlack Box for Synthesis. . ... . 267

Documenting IBD DeSign VIEWS. . . .. oottt e e e 268
Creating Visualization VIEWS. . . . . ..ottt 268
EXporting to HTML . ..o e 269
Exportingto TSV or CSV FIles . .. ..o e 269

Setting IBD Preferences .. ... 270

Interface-Based Design

The Interface Based Design methodol ogy represents the structure of adesign by atabular
description of the interfaces between the lower level blocks, embedded blocks and components
in adesign. It enables you to manage the finest details of FPGA and ASIC SOC designs while
still visualizing the big picturei.e you can see both the forest and the trees.

The methodology makes use of the editing and filtering mechanisms of tabular represented data
thus giving you ultimate control over your design elements. Design blocks and nets are easily
managed and organized: Specific areas and elements of the design can be fully explored and
focused on: Connectivity problems can be easily detected.

The IBD editor is empowered with a synchronization feature by which you can smoothly move
from an interface-based view to a block diagram view without losing any of your developed
design features.

Whether you are using an old piece of code to build upon or you intend to specify a new design
or even willing to assemble designs from diverse teams the simplicity and clarity of the IBD
editor can make your job easy by following a series of defined steps.

IBD istightly integrated with leading synthesis, analysis, verification and design creation
solutions for advanced FPGA and ASIC design.

New Design Creation Flow

Starting alarge design in the IBD editor can mean saving yourself a huge amount of time you
would have otherwise wasted working on connecting design instances instead of focusing on
design definition. The tabular representation of blocks and nets gives you visibility and control
over your design. The probability of wrong connections or undesired open ports leading to
malfunction of the circuit and days of function debugging is aggressively reduced.
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All you have to do is create anew graphical IBD view, add your blocks and stubs, interconnect
your blocks then prune your design to focus on areas of interest. Once you are done, you can
quickly check your design for any inconsistencies. A more complex design check can be
configured through the invocation of the integrated DesignChecker tool.

On completing your design you are ready to generate HDL code. IBD gives you full control
over the style, order and scope of the generated code.

The documentation options available act as an excellent mechanism by which designs can be
further analyzed and reviewed.

Create a Mew IBD Wiew

Document the Design

Code Re _Use Flow

Starting a new project with an old piece of code can be a very challenging job. Entangling the
design complexities, filtering elements of interest, detecting connectivity problems and
checking for certain constraints are all obstacles that may hinder and delay the actual design
devel opment process.
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IBD offers a series tools by which you can quickly and smoothly permeate the old design and
fully understand it. Once you have done that you can then start customizing it to fulfill your
requirements.

The illustration below defines are-use flow approach that can be followed when dealing with
previously developed designs.

Design Assembly Flow

Diversity of teams while being potentially beneficial or even in some cases a necessity due to
the large size, complexity and sophistication of a project can sometimes lead to problemsin the

assembly stage.

The probability of signal mismatches, connectivity problems, interface gaps in addition to the
need to fully understand each area of the assembled design are all problems that are can be
tackled and resolved by the IBD editor.

IBD editor gives designers the tools to detect assembly problems as well as the tools to solve
these problems.

Docurment the Design
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IBD Working Environment

IBD View Matrix

| Column Filter Cells | | Blocks and Components |
a B c |- ~f e [l a | 3 | m | F 5 T
1 - Paneld
58
)
2 Name Type Bounds - 0 = _gt E‘ Q Delay Comment
| |
5 T | ®
: T T
Library: 3| adulewsadulewvezMER._WIMER, Y
Instance Ref: =1 Iz I3 10 It

E
4
(A} Port Map:

L

7 | clear wire 3| [1] I
B |clk wire | I I | Row Filter Cells
3 |dat_in wire | [2:0] (| 1 1 '
10 | hold wire =t I
11 |load wire =t I I
12 | high wire | [3:0] =) = I e}
13 | low wire  |[3:0] = = o
14 | zero wire ;l o] L]
1E | carry_in wire [ [2:10] =] O I
16 | zerol wire ;I I o] I
17 | zerol Wire hd I 8]
18 l
T.
‘ Ports and Internal Signals | Design I0s | Interconnects |

Net declarations are represented horizontally and are described by the Name, Slice, Type,
Bounds, Delay, Initial and Comment columns.

Blocks, Embedded Blocks, Components and | Ps are represented vertically and are described by
the Name, Library, Instance Ref and Port Map (incase of components) rows.

The cellsinterconnecting net declarations with block, component and embedded block columns
show the interface connections.

Graphical Editors User Manual, V2008.1 241
September 18, 2008



IBD View Editor

IBD Working Environment

IBD View Toolbar

Table 5-1. IBD View Toolbar

I con Description
|E| Add a component
Add ablock
Add moduleware component
IR Add an external HDL (IP) model
Add an embedded block
gl ~ Add aFOR, IF, ELSE or BLOCK generate frame
L] Add asignal
Add abus
L Add abundle

Add a port map expression

u]
+T
a

Add a property column

o

Toggle filter

&

Create viewpoint

Add anet dice

Fit the cell width to the contents of the selected cell

Sort in ascending order

Sort in descending order

Clear net highlighting

R x| [z (2] 2] ]

[

Edit BD
] Visualize as BD
Note
The button has a pulldown menu which alows you to choose a FOR, IF, BLOCK

(VHDL only) or ELSE (Verilog only) generate frame.

Thetoolbar can be displayed or hidden by setting the | BD T ools option in the Toolbar s cascade
of the View menu.
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Getting Designs into IBD Editor

Working on a Previously Created HDS Design

Y ou can get previously created HDL or block diagram HDS viewsinto the IBD editor. Doing so
you will be able to focus on areas of interest in your design using the different filtering

mechanisms available. Refer to Creating Filtered Views.Y ou will also easily spot any
unconnected ports.

To get an HDL view into IBD editor:
1. Do one of the following to display the Convert to Graphics wizard:

o Select an HDL view in the Design Manager window and choose Convert to
Graphics from the popup menu or the HDL menu.

o Openan HDL view in DesignPad and choose Convert to Graphics from the
Graphics menu.

2. Choose IBD from the hierarchy description options and click finish.

How do | create an IBD using “Convert to Graphics’

To get a block diagram view into IBD editor:

1. IntheBD editor window click on the Edit asIBD &l icon in the toolbar or choose Edit
as|BD from the Diagram menu. A synchronized IBD view is created.Synchronized BD
and IBD views are actually two representations of the same design in which saved
changes in one view automatically appear in the other.

On choosing to create a synchronized view the title bar of the created view shows
“Synchronized-View”. The next time you open your BD view and click the Edit asIBD
icon your synchronized view will be automatically opened.

Hla UART /cpu_interface;struct * {IBD) {Synchronized-¥iew)

File Edit “iew HDL Table Data Tasks Add Options  Window Help

|- HE & -4 B RB|o o @

(a0 e - -%9 -@- L% -
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IBD View Editor
Adding Design Elements

In the Design Manager synchronized views appear with a chain beside their icons.

[ Design Unit Type Language | Time Stamp
[P UAAT =
# 1] address_decoda  Block WHDL MonJan 16 200B 13:23:03
&l clock_divider Component  WHDL MenJan 16 200B 13:23:03
% ] control_operation Component  WHDL Mon Jan 16 2006 13.23:03
¥ 3 cru_interfaca Block. VHDL Mondan 16 2006 12:.23:03
=) seid_nterface  Block WHDL Men Jan 16 2008 13:23:.03
=0 stabus ieguters  Block WHOL Mon.Jan 16 2006 13:23.05
% o tester Black. VHDL Mondan 16 2006 132303
&l uat_th Component  WHDL MonJan 16 2008 13:.23:.03
= Component  WHDL ‘wed Jan 18 2006 11:27.43
Ty | B0 WHDL Wwed Jan 18 2006 11:27-43
Block Diagram “YHDL \Wad Jan 19 2006 11:27:43
P Symbel WHDL MonJan 16 2006 1323:03
=3 wmil_rev_cartial  Black WHDL Mon.Jan 16 2006 13 23.03 ﬂ

Creating a New Design View

Y ou can start creating a new design using the IBD editor.

To create a new IBD view using the Design Content Creation wizard:
1. Invokethe Design Content Creation Wizard by doing one of the following:

o Choose Design Content from the New cascade of the File menu or click the E
icon in the Explore tab of the Design Manager left side bar.

o Clickthe E icon in the toolbar to display a menu and choose Design Content.

2. Choose Graphical View from the Categories pane and IBD from the File Type pane and
click Next.

3. Specify view name and location and click Next to specify view interface or click Finish.

Y ou can refer to Design Content Creation Wizard.

o Tip: You canclick the Elliconinthe Design Explorer toolbar and choose | BD from the
Graphical View cascade menu.

Adding Design Elements

Now that you have adesign in the IBD editor the next step isto start working on this design.
Y ou can add new design elements, edit their properties, organize elements into groups and
bundles or sort them.
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Adding Components

Y ou can instance components that arein an HDS library or you can choose to instance an
external IP. You can also instance a component from atext file.

How to add componentsto an IBD

To add a component from an HDS library:

1. Select the Add Component icon from the toolbar or Component from the Add menu to
display the component browser.

2. Add thelibrary containing the component to the component browser then drag the
required component to the IBD table.

Y ou can also add components from the Design explorer.
1. Select one or more component from the Design Explorer window and choose Copy
from the Edit or popup menu.
2. IntheIBD Editor choose Paste from the Edit or popup menu.

Y ou can simply drag a component from the Design explorer window to the IBD editor window.

To add a moduleware component:

1. You can do one of the following to display the component browser showing the
ModuleéWare library:

o Click the ModuleWareicon in the IBD editor toolbar.

Select the Add Component icon from the shortcut bar or Component from the Add

[0}
menu to display the component browser and click the ModuleWare icon.

2. Drag the selected component to the IBD editor window.

To add a component from an HDL text file:
Y ou will first have to import your component into an HDS library.

1. Inthe Design Explorer select the library you would like to import your design file to.

2. Choose Filefrom the Import cascade of the File menu to display the File Import dialog.
Browse for your file, select Import and click OK.

Importing your design to an HDS library, alows you to deal with it asany HDS
component. Refer to To add a component from an HDS library:
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To add an external IP:

Usethe button or choose | P from the Add menu to display the Add External IP dialog.

Note
D When adding a component to your design arow is added to the IBD matrix to show the
number of unconnected ports. On expanding this row the unconnected ports' details are

displayed.

Port Map: + + = = Port Actual

[ [ [ I | | I | | = =
|

- Unconnected Port Filters

I: din(1:0]
0: dout

To filter unconnected ports:

Choose afilter value from the component port column drop down list of the unconnected port
group.

Adding Blocks

Usethe button or choose Block from the Add menu. Y ou can then define the required view
type.
To define the view type:

1. Select New View from the Open As cascade of the component popup menu to display
the Open Down File Creation wizard.

2. Specify the new view type and click Next.

3. Typethe view name and click finish.

Adding Embedded Blocks
Usethe button or choose Embedded Block from the Add menu.
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Adding Nets

Adding a Signal or Bus

To add a signal or bus do one of the following:

1. Select Signal or Busfrom the Add menu.
o Whenyou add asignal, anet declaration row is added to the table with a default

name and scalar type while when you add a bus a net declaration row is added with a
default name, vector type and bounds.

Each new signal or busis given a unique name by adding an integer to the default
name. (For example: sigl, sig2... for asigna or dbusl, dbus2... for abus.)

Y ou can change the default signal and bus name, type and bounds through the
Default Settings page of the Structural Diagram Master Preferences Dialog. Refer to
Setting | BD Preferences.

2. Type anet declaration directly into the Name, Bounds and Type cells for the empty row
at the bottom of the table.

The following hints can help you enter signal and bus details:

(0]

Note

If you enter characters that match charactersin an existing entry of the same column,
the remaining characters are entered automatically.

If you enter a net name followed by avalid bounds constraint, for example: mynet(7
DOWNTO 0), the constraint is automatically moved to the Bounds column.

Using the key after entering a signal name automatically completes the row
with default properties and moves the cursor to the name cell in the next row.

D Net declarations are automatically added to your design when you choose to connect
unconnected ports. Refer to Connecting Ports.

How do | create Nets, Slices and Bundles

To edit a signal or bus do one of the following:

1. Click once and edit the cell contents. Note that you can choose from a pulldown list of
standard types by clicking in aType cell and using the [=] button. The current type or the
type that most closely matchesthe current string is preselected in the list. For example, if
the characters st are entered in aVHDL view, the std_logic typeis selected.)
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2. Usethe button or choose Object Propertiesfrom the Edit menu or popup menu to
display the Object properties dialog box.

Y ou can create a port on ablock or embedded block by enteringan |, B, O or U in the
interconnect cell for the signal row and block instance column.

0 Tip: Thedirection indicator (I, B, O or U) can also be selected from adrop down list.

Adding Ports

Enter an| (input), B (Bidirectional), O (Output) or U (Buffer for VHDL only)in the interconnect
cell for the externa interface column.

o Tip: Thedirectionindicator (I, B, O or U) can aso be selected from adrop down list.

Y ou can add net declarations with external interface ports for all unconnected ports on a
component. New net declaration rows are added with properties corresponding to the ports
defined on the symbol for the component.

Adding a Net Slice

Select a net row and add one or more net slices by using the button or by choosing Net
Slice from the Add menu.

Specify the required index or slice range in the Slice column of the expanded net row. Y ou can
slice a net with no bounds to be able to connect it to more than one port.

Adding Generate Frames

A generate frame can be used around one or more instances (including blocks, components and
embedded blocks) on an IBD view to represent repeated, conditional or aternative structuresin
the HDL code.

For example, a FOR frame can be used to replicate a component which uses VHDL generics or
Verilog parameters to define itsinterface or an |F frame may be used to implement the
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contained instances only when the generate expression istrue. IF and EL SE frames can be used
to define alternative structuresin aVerilog design.

To add agenerate frame:

1. Select oneor moreinstance |2 B c | o =] F
columns. : :
2. Usethe |z~ or choose Name | Type Bounds JIEWE| ¢
Frame from the Add menu to 4 ERE
display the Frame options Library: =il & - :
Cascade menu. Instance Ref: =1

Port Map:

3. Choose one of the following
frame options

FOR A FOR frane can be used around a bl ock or component to
define a repeating instance.

I F An | F frane can be used to define a conditional
di agram ar ea.

ELSE An ELSE frane can be used with an I F frane which has
the same label to define an alternative diagram

BLOCK A BLOCK franme can be used (in VHDL only) to define an

area containing objects to be generated as concurrent
HDL statenents using the BLOCK keyword.

The frame is added around the selected instances with a default title (comprising a label and
expression). The label must be avalid HDL identifier. Example:

g0: FORi IN O TO n GENERATE

The frame can be expanded and collapsed using the + and - buttons.

If you do not change the label, each new frame is given a unique label by adding an integer to
the default name (for example: g0, g1, g2...). However, if you add an EL SE frame to aVerilog
view and thereisonly one existing IF frame on the view, then the EL SE frame is given the same
label.

Using Generate Frames for Repeating Instances

A FOR generate frame can be used in VHDL or Verilog to replicate a component where the
relationship between the ports on the instances of the component and signals on the diagram can
be described by an expression. For example, a number of instances attached to each element of
amulti-bit bus where an instance is required connected in parallel for each element or group of
elements.
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Using Generate Frames for Repeating Structures

When you are using VHDL, it is possible to use a FOR generate frame around a diagram area
containing a number of existing block and component objects.

Using Generate Frames for Conditional Structures

An IF generate frame can be used in Verilog to describe conditional structures. An alternative
structure can be defined by using an EL SE frame which must have the same label asthe
corresponding IF frame.

Using a BLOCK Generate Frame

When you are using VHDL, aBLOCK generate frame can be used to cluster related concurrent
statementsin the generated HDL. All the HDL statements generated for the objects contained in
aBLOCK frame are executed concurrently.

In the following example, separate BLOCK frames and frame declarations have been used to
specify delay constants for the ipdelay and opdelay embedded blocks. The main functionality is
implemented by two instantiations of subcircuit which are contained within athird BLOCK
frame.

Connecting Design Elements

Having added your design elements to the IBD matrix, you can now start connecting nets, net
slices and HDL expressions to blocks and components.

Connections are created either through direct connection of netsto ports or through port
mapping. If you are using VHDL 93, you can map afunction call or other valid HDL
expression. If you are using Verilog, arbitrary expressions are allowed on inputs but outputs
must be directly connected to nets.

Connecting Nets to Component Ports

Y ou can connect nets and components using one of two approaches. The first approach isto
connect existing netsto selected component portsi.e net-centric approach. The second approach
IS to select component ports then connect, add signals or add portlOs. Thiswill create new
signals connected to the selected component ports.ie port-centric approach.

Connecting Existing Nets: Net_Centric_Connection Approach

To connect an existing net to a component port do one of the following:

» Click intheinterconnect cell for the component and enter a direction indicator, the first
available matching port with the specified direction is entered in the Port column.
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» Usethe + button to expand the Port column and click the interconnect cell to choose
from adrop down list of available ports.

A E < C =l) F G 1 K| L w M s
E | -
=l &
g £
1 MName Type Bounds - ﬁ I_g E fhitsel Initial | Comment
J R
THE
2 Library: =1l ® |UART moduleware
3 Instance Ref: =1 u_o 10
@ Port Map: + + - + Port
w = = 2| I S | 3 | S o . [ |
& | +| Unconnected Port filters =1 2 =
7 clk std_log =1 I I
2 clk_div_en |std_log =1 I I
9 clr_int_en std_log =1 I I
10 s std_log =l 1 1 -
11 div_data std_log (7100 =1 I I i din1:00 i
12 nrw std log = I I

Y ou can connect to the full range of the port or enter the port name with an index or range, for
example: addr(5:4).
To connect an existing net to one or more component ports in one step:
1. Select anet, pressthe Ctrl key and select one or more unconnected ports.

2. Choose Connect from the popup menu of the last unconnected port.

Signal Centric Connectivity

Connecting Ports: Port_Centric_Connection Approach

In this approach, new net declarations are added to the IBD matrix with properties
corresponding to the ports defined on the symbol of the component.

If the component has a different language from the parent view (for example, a VHDL
component instantiated in aVerilog view) the signal properties are automatically mapped to the
language of the parent view.

Y ou are warned if any of the net names already exist in the IBD view and you can choose to
create unique net names or connect the component to the existing net.

Quickly Connect Ports Across Multiple Instances

To connect unconnected component ports together:
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Select one or more unconnected ports and choose Connect from the popup menu. The first
chosen port is used to add a net of the same name, the subsequent ports are then connected to
this net.

To connect unconnected component ports to new signals do one of the
following:

1. Select the unconnected ports and choose Add Signal from the popup menu.

2. Select the component with unconnected ports. The Add Signals dialog box is displayed.
Choose whether to add signals on Input, Output, InOut or Buffer (VHDL only) ports.

Hlap.dd Signals

Fleaze specify the type of paorts that require signals:

[v mput
[v DOutput
[v [n0ut

(] 4 | Cancel |

Mapping Expressions or Function Calls to Component
Ports

Examples on Expressions:

Example 1: You can apply logical operations on signals or certain bits of a bus. For example,
you can AND two signals and invert the result:

I'(sig0 & sigl)
Y ou can also OR bitsin buses:
dbusO[ 3] | dbus5[ 3]
Example 2: You can aso apply arithmetic operations, for example:
a+b
Example 3: Y ou can use power. The expression below shows 2 raised to power in_a:
2**in_a

Example 4: Y ou can call functionsin expression rows. For example, the expression below calls
amultiplier function:

mult(in_a,in_b)
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To map an expression to a component port:

1. Choose Expression Row from the Add menu or use the button and enter the
expression in the Name column eg 1'b1.

2. Usethe + button to expand the Port column and click the interconnect cell to choose

from adrop down list of available ports.

& B c | D =l F | & | 1 1 k-] L
&
2
1 MName Type Bounds - ﬁ ntrol_operatii E fhitsel
IE' |E
% =
2 Library: =l = UART moduleware
3 Instance Ref: =1 u_o 10
@ Port Map: + - |Actual [ + Port
w = = 2| N | | e [ |
E Unconnected Port filters =1
7| |11 | =l | | O |dout

Y ou can also use the + button to expand the Actual column and enter the expression. A star sign
* appears in the component interconnect cell to indicate that an expression is mapped to the
port. Note that actuals take precedence over formal ports.

In some cases you may need to connect one expression to more than one port on the same
component. Adding a slice to the expression will enable you to do that.

To connect an expression row to more than one port on the same

component:

1. Select expression row and choose Slice from the Add menu.
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2. Usethe + button to expand the Port column of each expression row slice and click the
interconnect cell to choose from a drop down list of available ports.

2 B c o =1l F G | I 3 kK | L w| N
o
&
IE'
1 MName Type Bounds - ﬁ ntrol_operatii 2 fhitsel Initial
| =
S IE
=3 =
x
iy
2 Library: =l = UART moduleware
3 Instance Ref: =1 u_o 10
@ Port Map: + — |Actual - + Port
& | +| Unconnected Port filters =1 1 =
7 | -|1b1 = I |din |
3 =l .l
9 clk std_log =1 I I O dout l
10 clk_div_en |std_log =1 I I |

How do | create an expression to define complex port connectionsin IBD
To add ports from a component refer to “Adding Ports’ on page 248.

Another Port_Centric_Connection Convention

In some cases it may be more convenient to connect a port by choosing from adynamic list of
design nets and expressions. A dynamic net/expression list is one that gives you the option to
add new entries. The net /expression you select or add is automatically connected to your
selected port.

To connect a single port by choosing from a dynamic list of design
nets/expressions:

1. Expand the Unconnected Port Filtersrow. A list of unconnected ports appearsin the
component port column.

2. Click the actual column cell of the port you wish to connect. A dropdown list box is
displayed.The content of the list box is sensitive to the type/range of the selected
unconnected port.

3. According to what you select from the dropdown list the following occurs:

o If you chooseto create anew net, anet declaration row is added to the IBD matrix
with properties corresponding to the selected port defined on the symbol of the
component and is connected to that port.
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o If you choose to add a new expression, an expression row is added where you can
type in your expression. The expression is automatically connected to the selected

port.

Another important feature of this functionality isthat it will automatically create child
expression rows. That isto say, if you wanted to tie many unconnected ports on the same
component high with the same expression '1'b1'. then after the first port, you will notice that

child expression rows are added automatically.

VHDL Scal ar Ports

<New Net >
Cemmmmm e >
<New Expressi on>
OPEN

L} Ol

L} 1!

Li st of the existing expression
Li st of existing nets

Veril og Scal ar Ports

<New Net >
Commmmm oo — - >
<New Expressi on>
OPEN

L} OI

T

Li st of the existing expression
Li st of existing nets

VHDL Vector Ports

<New Net >
Cemmmmm e >
<New Expr essi on>
OPEN

(OTHERS => '0')

(OTHERS => '1")

Li st of the existing expression
Li st of existing nets

Veril og Vector Ports

<New Net >
Commmmm oo — - >
<New Expressi on>
OPEN

(OTHERS => '0')

(OTHERS => '1')

Li st of the existing expression
Li st of existing nets

Port-Centric Connectivity through Dynamic List of NetsExpressions

Organizing View Layout

Expanding and Collapsing IBD Views

Y ou can expand and collapse columns and rows in an IBD view by using the [+ and [=]
buttons. Alternatively, you can use the following commands from the Expand/Collapse
Columns and Expand/Collapse Rows cascades in the Table menu:

Expand/Collapse Columns

Expand All Expand al components and generate frames
Collapse All Collapse al components and generate frames
Expand All Frames Expand al generate frames
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Collapse All Frames Collapse all generate frames
Expand Visible Components Expand al visible components
Collapse Visible Components Collapse dl visible components

Expand/Collapse Rows
Expand All Expand all rows
Collapse All Collapse dl rows

A visible component is one which is already visible in the table.

Moving Rows and Columns in an IBD View

Y ou can move a net row or instance column in an IBD view by clicking the row number or
column letter and then dragging with the L eft mouse button over the row number or column
letter.

Sorting Rows and Columns in an IBD View

Y ou can sort the rows in a selected column or columnsin a selected row of an IBD view in
ascending or descending alphanumeric order by either:

» Using the / button.
» Choosing Data>Sort>Ascending or Data>Sor t>Descending.

» Choosing Sort Ascending or Sort Descending from the row/column popup menus.

Y ou can also sort by clicking the triangular icon on the right side of the column header cell.

=1l E I
&
&
; il B =
Click to sort E .
=
= g
=]
=l
=) = =l

Grouping IBD Rows and Columns

Y ou can group rows/columns by selecting arow or rows/column or columns and using the \il
button or choosing Data>Group>Group.
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The selected rows/columns are added to anew group with the default name GroupN (where N is
automatically incremented if it already exists).

Showing/Hiding Columns in an IBD View

To hide a column:

Select the required column and choose Hide Column from the popup menu.

To show a hidden column:
1. Choose Data>Show/Hide> Show Columnsto display the Show Columns dialog box.
2. Select the columnsto show and click OK.

H[} Show Columns

Select one or more items:

data_out_mus

k. | Cancel | Help

Adding Bundles to your IBD view

A bundleisacollection of logical signals. Connecting abundleto ablock or an embedded block
will connect all the signals contained in that bundle to the specified block or embedded block.
Changing the connectivity properties of the bundle changes the connectivity of the contained
signals.

There are severa way of creating a bundle and adding content to it.

1. Select aset of signalswhich youwant in aBundle. Then click the Bundle toolbar icon.A
new collapsible bundle frameis created around the selected signals with a bundle name.
Each new bundle is made unique by adding an integer to the default name. (For
example: bundle0, bundliel, bundle2...). You can choose to edit the bundle name.

2. If you already have an existing Bundle, you can:
o Select the bundle, and hit the Add Signal or Add Bus toolbar icons.

o Drag existing signalsinto the bundle. Note that the connectivity of the signals hasto
be consistent with that of the bundle.

3. If you wish to define bundle connections enter the connection mode in the bundle
interconnect cells.
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Notice that the signals' interconnect cells are populated accordingly. If one of the
signalsis aready connected you will receive an error.

To delete abundle signal select the signal bundle row and delete the signal. To delete a
bundle select the bundle frame row and press delete.

In the following example the created bundle includes the signals sig2 and sig3 that are inputsto
Block1 and outputs to Block2.

A E c o E =1l a H I 1 K L
=2 =2
1 Name Slice | Type Bounds j i ] eb1l | Initial Comment
z | 2| R
g
2 Library: j & ATCH_ATCH_
3 Instance Ref: =1 uo | U1
@ Port Map:
3 sigD std_lag [15:00 =1 s} I
7 sigl std_log (15:0) =1 I o
2 | - |Bundle =1 I L]
T sig2 skd_log [15:0)
F sig3 skd_log [15:0)
11 sig2 std_lag [15:00 =1 I s} s}
1z sig3 std_lag [15:00 =1 I s} I

Adding Net/Component Comments

To add a comment:

1. Choose Comments from the popup menu of the selected net or component to display
the Comments dialog box.

2. Enter End of line, Before or After comments.
Adding comments for the inclusion in the generated HDL

Adding Property Columns/Rows

Y ou can add property rows/columns as additional comments or as sort/filter keys.

Adding Property Rows/Columns
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Creating Filtered Views of the Design

Large designs can often be very difficult to manage and deal with. Y ou may need to focus and
work on a subset of the design data. IBD filters enable you to display and work on only design
data of interest.

Y ou may find it handy to be able to refer to your filtered views. IBD viewpoints provide
persistent views of filtered datathat are easily retrievable.

Defining Filter Settings and Logic

To specify filter settings and logic do the following:
1. Choose Data>Filters>Filter Settings. The Filter Settingsdialog is displayed.

Tip: You can display the Filter Settings dialog by choosing Filter Settings from the
popup menu of the design filter row/column. If the filter row and/or column are not
displayed toggle the filter icon in the design explorer toolbar.

2. Inthe General group box specify whether you want to match case and/or match whole
word.

3. Choosethetype of filter expression to be used (ssmple or regular). For moreinformation
on refer “Regular Expressions”

4. Inthe Filtering Logic group box specify the filtering logic you will be using as:
And: which displays all rows and columns that meet all filter expressions
Or: which displays rows/columns that display any filter expressions.

5. Click OK.

Y ou can invert any of your defined filter expressions by choosing I nvert Expression from the
popup menu of the filter expression cell.

Creating Persistent Subset Views of the Design

On selecting to filter rows all columns connected to these rows are displayed. Similarly
choosing to filter columns displays all rows connected to these columns

To create a viewpoint:

Select required rows and/or columns and do one of the following:

* Choose Data>Viewpoints>Create from the cascade of the menu.
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* Click the Filter icon in the design manager toolbar.

» Choose Create Viewpoint from the row/column popup menu or the viewpoint
dropdown box.

Y ou can also take a snapshot of what's currently visible without selecting any rows or columns.

A viewpoint filterx(ie Filterl, Filter2,...) is created. Viewpoints are saved in the drop down box
of thefilter cell.

c =l e |F
“MOME= g
=Create Viewpoint = E
Test_Miewpoint [=} I~
Bounds = ]
| ]
= | 2
= =
3, =
o |UART
u_o
+ o+

To rename a viewpoint:

Viewpoints names can be edited in the dropdown box to have more indicative names.

On saving your work you can always refer back to your created filtered views by:

To delete a viewpoint:

1. Choose Data>Viewpoints>Delete or Delete Viewpoint from filter row/column popup
menu to display the Delete Named Filter dialog.

2. Sdect thefilter to be deleted and click OK.

Note
Any edits(add/remove/copy/paste) a named filter content undergoes are preserved when
toggling between filters.
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Pruning IBD Designs

Filtering Nets in an IBD view

To filter IBD view nets do the following:

Select acolumn’sfilter cell. Choose afilter value from the drop down list or enter asimple
match string in the drop-down entry box.

.

r

B -

1

MName

Type

Bounds

Enter a simple

match string

Ll |l

2 IEFary:
3 | Instance RefR’
@ Pork-ap:
E |=AllL= wire ;'
=] clk. _ wire ;[;
g clk_div_en wird I
| clr _ink_erag Choose a filter value |
k| Wire

-1

In the example below we have chosen to filter all nets starting with the letter C by entering the

following expression C*. Notice the eyeicon indicating that the view isfiltered.

& a = e c =le | & 1]
=+ ~[e [ c 7N :
I.
i Mamae Type Housds - E condrol_sperstisn E
1 Manse Type Bounds - ‘s
L]
-
Enter a simple match stnng el | s =i % | UART [
2 LIsFEFyE _.zJ 3 Imstance Refi =1 | u_o
5 ‘/ 2 Port Map: - +| Pet
Instance ~ : =l =] =1 = =l
[ o [od loge | = R
c | = = ] | 7 clle_div_en | sid fogic | ] | 1
E [=ALL= WA =] | 8 cle_ind_sm  [aid legic | =l 1 | 1 [drinl_sn
17 |k e | =1 e [stel Jogie | Hl:1 [ 1 ]= |
I | chear_flags |sic Jopic | =] o @ | duar flags
"
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Select one of the following from the dropdown list of the cell at the intersection of the row and
column filters.

2 B c =1l E F | & I
=
=
o

1 MName Type Bounds - ﬁ control_operation | 2
I i
S 3
=3 =
3 =

2 Library: =1 o UART

2 |Instance Ref: =1 u_o

@ Port Map: - + Port

& | clle std_loagic =ALL= 4 I I |clk

Interconnected Mets
7 clk_di td_lagi I I
e Qiv_en e _ogre Cornrmon Mets

2 | cle_int_en std_logic Connected Mats I I |clr_int_en

9 |cs std_logic Floating Mats I I fcs

10 | div_data std_logic_a (7:0) Unconnected rows I I

All: Shows all the rows.

Interconnected Nets. Shows nets that are connected to more than one component/block
with bidirectional or different modes.

Connected Nets: Shows nets that are connected to at |east one call.

Unconnected Rows. Shows nets, bundles, expressions, user rows that are not connected
to any cell.

Floating Nets: Shows nets that are connected to only one cell.

Common Nets; Shows nets that are connected to more than one cell.

How do | show unconnected signals and rows.

Note

D If afilter matches anet in agroup or anet slice the parent net isincluded.

Filtering Components in an IBD View

To filter IBD view columns:

1

Identify the row you would like to filter your components based upon e.g. Name,
Library, net/expression.

Choose afilter value from the corresponding column filter cell dropdown list.

The IBD matrix displays the columns that satisfy the selected filter values.
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Managing Design Hierarchy

The IBD editor allows the hierarchy to be manipulated at any time. Hierarchy can easily be
added or removed to facilitate design understanding or to improve performance of “down
stream” tools such as synthesis.

Adding a Level of Hierarchy

Adding hierarchy replaces the selected objects by a new component and moves the selected
objectsinto the new design unit view.

To add a level of hierarchy:
1
2.

Select componentsto be re-leveled.

Signals which constitute the interface of the new cells have slices.

Selected objects are not in the same frame scope.

Choose Add Hierarchy from the Re-level cascade of the Table menu or popup menu.
An error message isissued if:

If prompted to save the design view click OK and specify Library, Design Unit and
View namein the Save Design Unit View dialog.

H[} Save Design Unit Yiew
Library: [rezign Unit; Wi

|L|.-’-'-.F| TV |uart_tu:up |$tru|:t

Ethernet addresz_decode

ewernplar cpu_interface

hds_package_library
renoir_package_libran
SCRATCH_LIB <default:
Sequencer_vhd
Sequencer_vlg
TIMER_hdl
TIMER_log

ART

JART TT

zenal_interface
statuz_reqisters
tester
wnik_roy_control
clock_divider

uart_th

control_operation

o]

Cancel

Help
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4. Specify the name of the new design unit in the Add Hierarchy dialog and click OK.

H[} Add Hierarchy

Thiz command iz not undoable. Please choose the wpe
of Degign Unit and provide a unique name.

[rezign Unit; |

Cancel

A child IBD view is created and the objects replaced by a single new instance on the parent
table.

Click hereto see ademonstration of adding an extralevel of hierarchy

Flattening Design Hierarchy
Removing hierarchy deletes the selected component instance and replaces it by the objectsin
the child hierarchal view.
To flatten a level of hierarchy:
1. Select asingle component instance to be re-leveled.

2. Choose Remove Hierarchy from the Re-level cascade of the Table menu or popup
menu. An error message isissued if you attempt to:

o Remove hierarchy from an instance which is opened.

o Remove hierarchy from an external P or moduleware instance.

o Select an instance which is not described by an IBD view.

o Remove hierarchy from an instance which has a different language.

3. Click Yesto confirm the design objects to be deleted by the re-level operation.Y ou may
need to manually update any other views that referenced the deleted component.

The child IBD view is deleted and its component instance is replaced by the objectsin the child
hierarchal view. If any of the instances included other hierarchal views, their hierarchy is
retained but can be removed by another re-level operation.

The package references or compiler directives for the child view are merged with those defined
for the parent view.

Click here to see a demonstration of flattening alevel of hierarchy
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To investigate a child view:
Select desired component column and double click to display child view.

Checking a Design in IBD Editor

1. Select Design Checking Options from the Table menu to display the Design Checking
dialog.

2. Set the desired checks and click OK.

HlaDesign checking options E1
Select dezign check options:
v Check intarface - Check IBD interface against the parent.
v Unconnected nets - Report nets that are mizsing drivers and/ar loads.
v Unconnected paorts - Report component ports that are not connected,
[ lgnore unconnected open ports - lgnare companent output parts that are not connected.
v width mizmatches - Report port/net width mismatches.
¥ Tuype mismatches - Report port/net type mismatches.
I Sict type comparison - Tupesz muzt match exactly.
v tultiple drivers - Report nets that are driven by multiple ports.
[ lgnore bidirectional drivers - lgnore nets driven by only bidirectional ports.
(] 8 I Cancel |
5

3. Sdlect Run Design Rule Checks from the Table menu or click the button.
Generating HDL from IBD views

Controlling the Generated HDL Code

Thisisreally split into three areas, setting the order of generation within an individual IBD,
specifying the hierarchical generation preference, and specifying the style of the generated
code.

Setting Generation Order

The declarations of signals and external ports are either ordered automatically or manually. In
automatic ordering generation order is set by mode(in,out,inout or buffer) and a phanumeric
name irrespective of the rows display order. In manual ordering generation order is set by the
rows display order.

In both automatic and manual ordering cell generation is set according to column order. Unlike
BD objectsthereisno frame sequence number or embedded block number to specify generation
order. The order can be modified simply by the use of a drag and drop approach to re-locate
components to the desired order. The right mouse button must be used to select the column.
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When more than one column is used to describe a component the leftmost column should be
selected.

Additionally it is possible to sort rows or columns by order using the sort keys on the main task
bar.

To enable manual ordering do one of the following:
* Select Manual from the popup menu of the @) icon.

* Sdect Manual from the Generation Order cascade of the T able menu.

Setting the Style of the VHDL or Verilog code

The style of the VHDL or Verilog code is controlled through a number of preferences.

Eg Setting Generated VHDL Preferences
¢ Setting Generated Verilog Preferences

Setting the Generation Hierarchy Level

To generate HDL from IBD views:
1. Select Main from the Options menu to display the Main Settings dialog box.
2. Select the Checkstab and mark the Perform Checks option and click OK.

:Z | button or choose one of the Gener ate options from the Tasks menu. If a
block or component is selected, the generation command operates on the selected object
(or objects).

4. Youcanusethe El button to display a pulldown palette with optionsto run the task on a
single design level, the hierarchy through blocks, the hierarchy through component or
the hierarchy through components from the design root:

Run Single
< k
= Run Through Blocks
=
& Run Through Components

Run Through Components from the Design Root

Enforcing Generation

Viewswhich have not been changed since they were last generated are not generated unless you
have set the HDL generation run options to force regeneration.
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IBD View Editor
Setting a Black Box for Synthesis

If no views need to be generated, asingle dot is displayed for each processed hierarchy with a
row of dashes to represent each selected hierarchy followed by a generation completed

message.
To Enforce Generation:

1. You can optionally enforce generation by choosing Settings from the Gener ate cascade
of the Tasks menu to display the Generator Settings dialog.

2. Check the Set Generate Always when using this task option.

Cross Referencing Generation Errors

Any generation errors are reported in the Task Log window.

Note

D If an error is encountered during bulk parsing, the timestamp for the generated file is set
to the oldest date alowed by the system. (January 1st 1970 on UNIX or January 1st 1980
on aPC). This ensures that the generated HDL file is retained with an older timestamp
than the graphical view.

Y ou can automatically display the generated HDL or graphics corresponding to an error
me in the Task Log window by double-clicking on the message (or by explicitly clicking

the [B4] or [1%4] button).

Refer to “Task Log” in the HDL Designer Series User Manual for more information about the
Task Log window.

Setting a Black Box for Synthesis

Y ou can make the active IBD view a black box for synthesis by setting the Black box for
Synthesis option in the HDL menu. When this option is set, synthesis control pragmas are
included in the generated HDL so that the view is available for smulation but isignored for
synthesis.

For Verilog, the synthesis off pragmaisinserted after the input/output statements and after any
Verilog parameters declared in the symbol but before the type declarations. The synthesis on
pragmaisinserted immediately before the end modul e statement.
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Documenting IBD Design Views

Creating Visualization Views
Y ou can visualize you IBD views or subsets of your design as Block diagrams. Visualized
views alow only non-logical edits.

To visualize your IBD views:

Choose Visualize as Block Diagram from the Table menu or click the Visualize asBD icon in
the IBD toolbar and save your visualized view.

Hla UART fcpu_interface/fintconx] [Block Diagram][¥izualization]
File Edit “iew Optione HDL Diagram  ‘“window Help

IHE 8-S #HP2LAPL LK -AM - WiE M

- ckduer [pesfoutmul o - - o - o o o
_______ na L I

it <= cl_clata WH EN ck_dh_ex
- 1" ELSE

er_It dats;

|Design "UART fopu_interfaceintcons] " saved succeszsfully. g

To open a visualized view:

1. IntheFiles pane, expand the Documentation and Visualization node to display the
Visualization folder.
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2. Click onthe plus sign + to expand the Visualization; each <library> node, which is
indicated by the book icon # , holds the visualized design units.

Eﬁ* DesignChecker -
| 23| Documentation & Visualiz...

-] HTML

El'a Yizualization

=L UART
B @ cpu_interface Block.
Bl intconx Block Diagram

9 Deszign Files |-

l;l
4| | 3

Exporting to HTML

Y ou can export IBD views or hierarchy of views as HTML pages which can be displayed in a
compatible Web browser.

1. Usethe button or choose Export Documentation from the File menu to display the
Document & Visualize dialog box. Notice that the Visualize your Code option is
disabled, while the Create a Website option is selected.

2. Browse for the target directory in which you wish to save your exported files.

3. Click the Options button to display the Documentation and Visualization Options dialog
box. Y ou can configure the HTML export preferences in the Website Options page as
well asthe HTML settings and Graphics Settings sub-pages or leave the preset default
options and click OK.

4. Onthe Document and Visualize dialog click OK to display your web browser showing
the exported HTML pages.

Refer to “Exporting HTML Documentation” in the HDL Designer Series User Manual.

Exporting to TSV or CSV Files
Y ou can export IBD viewsto text files (TSV) or Excdl files (CSV).

1. Select TSV or CSV from the Export cascade of the Table menu.

2. Inthe Select aFile dialog enter the name of the file to which you wish to export your
design and click Save.

Graphical Editors User Manual, V2008.1 269
September 18, 2008



IBD View Editor
Setting IBD Preferences

Compiler Directives

When you are creating Verilog based designs you can insert compiler directivesto pass
information to the Verilog Compiler or any downstream tool.

To set compiler directives:

1. Choose Compiler Directivesfrom the Table menu of the IBD editor to display the
Compiler Directives dialog.

2. Enter Pre, Post or End Module Directives.

Setting IBD Preferences

Y ou can set IBD preferences by choosing Options>M aster Preferences>Structural Diagram
in the design manager to display the Structural Diagram Master Preferences dialog box.

The dialog box has separate pages for setting Gener al preferences, Default Settings,
ModuleW ar e preferences, Block Diagram preferences (which include Display Settings,
Appearance and Background preferences), in addition to I BD preferences.

Y ou can set the IBD appearance (but not default values) for the active diagram by choosing
Diagram Prefer ences from the Options menu in the IBD editor to display the IBD
Prefer ences dialog box.

When you edit these preferences for the active diagram, the dialog box allows you to choose
whether the preferences are applied to new objects or to both new and existing objects in the
diagram.
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The Appear ance page allows you to set visual attributes for individual block diagram objects.

- General

Default Settings
----- Moduleisare
Block Diagram
e Appearance

H[} Structural Diagram Master Preferences |

x|

— Interface

¥ Enable Drag Fil
¥ Enable Single Click E dit

¥ Highlight Active Bow/Calumn

— Wizibility Settings
[v Display Library Fiow

¥ Digplay Complete Frame Title

— Port Dizplay
Connected Portz Unconnected Ports
[~ Show Type [ Show Type

v Show Bounds

[T Show Bounds

—%HDL Short Form
[ Edit Short Form

[v Dizplay Short Form

Cancel | Help

o]

P

These attributes include the foreground and background colors, line color, fill style, line style,

line width and text font. Some attributes may not be available for all objects (for example, the
line style, width and color attributes are not available for atext object).
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Chapter 6
Port Map and Generate Frames

This chapter describes how port map frames and gener ate frames can be used on a graphical
block diagram.

Port Map Frames. . .. ... 273
AddingaPort Map Frame. . . ... 273
EditingaPort Map . ... 274
GeNE At Frames . . . .o 277

GanErate Frames . .. 277
AddingaGenerate Frame. . . ... ...t 278
Using Generate Framesfor RepeatingInstances . .. ... 279
Using Generate Frames for Repeating Structures. .. ......... ..., 281
Using Generate Frames for Conditional Structures . . .......... .. ..., 282
UsingaBLOCK Generate Frame. . . ...t e e e 286
Using Nested Generate Frames. . . . ... ..ot 288
Editing Generate Frame Properties. . .. ... e 292

Port Map Frames

M apping between the actual signals on the block diagram and formal ports on a component with
different properties may be shown by using a port map frame. For example, to connect
individual slices of asignal to separate ports on the component.

Adding a Port Map Frame

Y ou can add a port map frame to acomponent on ablock diagram by choosing Enable from the
Port Map Frame cascade in the Diagram or popup menu when a component is selected.

Note
Y ou can also add a port map frame by setting the Enable Port Map Frame option in the
Componentstab of the Object Properties dialog box.

The following example shows the top level component from the UART example design with a
port map enabled on the block diagram. The type information has been hidden in this
illustration and the default mapping text is shown for both VHDL (on the left) and Verilog (on
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the right). Note that for VHDL, unconnected output ports are shown with the default value
OPEN.

addr==, . . ... g, L
int.== QOFEM, . . . . aout(y,. .. . . L.
ele==, - - - ey, -
sout == OFEN: -~ © st oo
W=, ARWG,
mt==, . ... smil,
data_out == OFEH,. . oal. oo
data in==,- - - - - addy . o -
sii== st
e data_out()

The port map frame can be used to map connections between formal ports on the component
and actual signals and buses on the block diagram.

When a port map frame is enabled, any signal or bus can still be connected directly to a
component port provided that their properties are compatible.

Y ou can aso connect any signal, bus or bundle to the port map frame and edit the port map text
to define the connections to the ports. For example, you can connect a busto the port map frame
and assign each slice or element of the bus to a separate formal port. A port can also be mapped
to any valid HDL expression.

When port mapping is enabled on ablock diagram, aframe is shown around the component and
the port mapping list can be optionally shown or hidden on the diagram.

Y ou can remove a port map frame on a block diagram by using the Del or key when only
the frameis selected or by choosing Disable from the Port Map Frame cascade. All
connections to the frame are unconnected and shown as dangling net connectors.

Editing a Port Map

Y ou can edit the port mapping by directly editing the text on the diagram, by using the
Components tab of the Object Properties dialog box or by choosing Edit from the Port Map
Frame cascade of the Diagram menu (in ablock diagram).

The Port Map Settings dialog box shows any explicit connections which have been made on the
block diagram in aread-only window. The editable window at the bottom of the dialog box can
be used to enter user port mappings which must be specified using the correct language (VHDL
or Verilog) syntax for your editor.
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When Connect by Name is set, any signal with the same name as a component port is
implicitly connected.

VHDL Port Map Example
The following picture shows the VHDL UART example design connected using a port map:

H[} Port Map Settings E3

Auta generated Port b ap [for explicit connectionz]

clk=> clock, ;l
data_in=rdata_in,

rst=>rzt,

K _>I_I
|zer Port Map

addif2) =» ad 1, ;l

addi[1 DOWHTO 0] => loc[15 DOWHTO 14),
oz =3 control{0],

data_out [7 DOWHTO 4] = topd,
data_out3 DOWMNTO 0] => lowerd,

int =3 interrupt,

niny =3 cantrol(1],

gin=3 control[2],

zout = zenial_out

o o

[T Connect by name | oK I Cancel |

The direct connections for clk, rst and data_in are shown in the read-only area at the top of the
dialog box and the user port map connections have been entered in the lower entry box. The
ad 1 signal is connected to index 2 of port addr and slice 15 DOWNTO 14 of theloc busis
connected to bits 1 and O of bus addr.

The control busis connected to the sin, N(RW and cs ports and the data_out port mapped to
separate top4 and lower4 buses. The int and sout output ports are mapped to the signals
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interrupt and serial_out. This mapping corresponds to the following connections on a block
diagram:

= > SRULBMNAIE e,
linterruptzerial_out)
- topd
data_in (3 DOWINT O 0
7 DOWNTO 03
- lae
(2 DOWNTO 0}
loc(15 DOWHTO 1<)
(15 DOWIHTO 0) » clk==clock,
data_in==data_in,
control rst==rst,
G2 DOINTO ) » addr(2)==ad_1,
addr{l DOWMNTO Di==loc{1a DOWNTO 143,
ce==cantrol{0),
data_out(7 DOWRTO 4)==top4,
ol ck data_out(3 DOWRTO M==lowerd,

int==interrupt,

rst nrw==cantral{1},
sin==contral{),

sout==serial_out

Verilog Port Map Example
When you are using Verilog, the port mapping has the following syntax:

.clk(cl k),
.data_in(data_in),
.rst(rst),
.addr(loc[2:0]),
.cs(control [0]),

. dat a_out (dout),
.int(interrupt),
.ntw(control[1]),
.sin(control [2]),
.sout (serial _out)
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The following picture shows the Verilog UART example design connected using a port map

frame.

et

Cowire[70] . . .
g

Cowire[70] . . .

Cocontrol” 0 T

Cowre[20] . . . .

| 4

0

Cowire[70] . . . ..

Coclkfelky,
Costirst), o0 L.
- odata. infdata. g, - - -
oinfinterruptd, - 0
. soutiserial outy,
o nB W eontrol[1]0,. . .
- simfcontrol(Z]), . . .
-+ esfcontrol[0f), - - - -
©ocaddefloe[200),

.. date outfdout),

Bits 2 to O of the loc bus are connected to the addr bus. The control busis connected to the sin,
NRW and cs ports and the data_out port mapped to the dout bus. The int and sout output ports
are mapped to the signalsinterrupt and serial_out which are connected using the bundle

cpu_bundle.

Generate Frames

A generate frame can be used around one or more instances (including blocks, components and
embedded blocks) on a block diagram to represent repeated, conditional or alternative

structures in the HDL code.

For example, a FOR frame can be used to replicate a component which uses VHDL generics or
Verilog parametersto define its interface or an IF frame may be used to implement the
contained instances only when the generate expression istrue. |F and EL SE frames can be used

to define alternative structuresin aVerilog design.

Note

D A generate FOR frame provides a static, compact representation of adesign on a
graphical block diagram or IBD view. When aVHDL code isloaded into asimulator, the
generate statement is elaborated (expanded) into individual occurrences of the objects
within the frame. However, most Verilog synthesis tools do not support automatic

elaboration.
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VHDL statements using the BLOCK keyword to define a cluster of concurrent statements can
be represented by aBLOCK frame around an area containing any of the standard block diagram
or IBD view objects. When HDL is generated, the frame contents are interpreted as a cluster of
concurrent statements using the BLOCK keyword. A BLOCK frame (and FOR or IF frames
defined using VHDL-93) may include local declarations which apply only within the frame.

Adding a Generate Frame

Y ou can add a generate frame on ablock diagram by using the button or choosing Frame
from the Add menu to display a cascade menu which provides the following frame options:

Option Shortcut  Description

FOR F6 A FOR frame can be used (in VHDL or Verilog) around a block or
component to define arepeating instance or (in VHDL only) to
define a repeating diagram area which may contain any number of
other diagram objects.

IF Shift + F6  An IF frame can be used (in VHDL or Verilog) to definea
conditional diagram area.

ELSE Ctrl+ F6  An ELSE frame can be used (in Verilog only) with an IF frame
which has the same label to define an alternative diagram area.

BLOCK Alt+F6 A BLOCK frame can be used (in VHDL only) to define an area
containing objects to be generated as concurrent HDL statements
using the BLOCK keyword.

If one or more or objects are selected on ablock diagram, the frame is added around the selected
objects. If nothing is selected, a ghosted frame is attached to the cursor and can be placed by
clicking at the required location. Y ou can resize the frame as it is added by holding down the

L eft mouse button and dragging with the cursor before you click for location or it can beresized
later by dragging the resize handles.

A frame can be "nested" within another frame. However, awarning is issued when you save a
block diagram if aninstanceis enclosed by overlapping frames. (This constructionis considered
to be an error by HDL generation.) If an instance is not completely enclosed by aframe, it is
considered to be outside the frame.

All frames are added with a default title (comprising alabel and expression) and default
number. The label must be avalid HDL identifier.

If you do not change the label, each new frame is given a unique label by adding an integer to
the default name (for example: g0, g1, g2...). However, if you add an EL SE frame to aVerilog
view and thereisonly one existing IF frame on the view, then the EL SE frame is given the same
label.
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The frame number is used to determine the order of insertion in the generated HDL and can be
any positive integer but must be unique. If you specify a number which is already used by
another frame on the same view, the numbers are swapped.

Note
The frame label for aVHDL instance can be an extended identifier but you cannot use an

escaped identifier for aVerilog instance.

Y ou can edit the title text and number by direct text editing or you can use the Framestab in the
Object Properties dialog box which is displayed when you use the button or choose Object
Properties from the Edit menu.

The syntax used in the frame title text is automatically checked for the hardware description
language of the active view.

Using Generate Frames for Repeating Instances

A FOR generate frame can be used in VHDL or Verilog to replicate a component where the
relationship between the ports on the instances of the component and signals on the diagram can
be described by an expression. For example, a number of instances attached to each element of
amulti-bit bus where an instance is required connected in parallel for each element or group of
elements.

The following VHDL example shows an arithmetic logic unit (ALU) which is repeated three
times with each instance connecting to the next group of elementsin the bus. The repetition is
defined by the VHDL expression FOR i IN 0 TO 2 GENERATE and each group of signals
assigned to the ports by a port map frame.

QO:FOR I INOTO 2GENERATE

=
:

[
[ [
[ [
[ o
ofl b Ly 1
& DOWNTO O : : (23 DOWNINTD O
o . - I
(23 DOWKTO O | |
n 1 |
(23 DOWKTO O I > 1
[ [
[ [
[ [
[ [
i Ope @or == cil_abi2+F3 DONNTO 13, i
1 Ope @i == A7+FS DOWNTD P, 1
1 Ope @2 == BT+ DOWNTD P, 1
1 Regtlt== ¥1{7+I'S DOWNTO 15 1
| e e o o e e e 1
This exampl e represents the following VHDL code:
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ARCHI TECTURE struct OF repetitive-instance IS
COVPONENT ALU
PORT (
Qperator: in unsigned(2 DOANTO 0);
Operandl: in unsigned(7 DOANTO 0);
Operand2: in unsigned(7 DOANTO 0);
Resul t: out unsigned(7 DOANTO 0)
)
END COVPONENT ALU,
BEA N
-- Generates 3 instances of ALU.
genl: FORi IN O TO 2 GENERATE
I1: ALU
PORT MAP (
Qperator => Ct| _ab(2+i *3 DOMNTO i *3),
Qperandl => A(7+i *8 DOWTO i *8),
Operand2 => B(7+i *8 DOMNTO i *8),
Result => Y1(7+i *8 DOANTO i *8)

)
END GENERATE;
END struct;

Repeating instances in Verilog are ssimpler (but less flexible than in VHDL) since only direct
port mapping is supported for Verilog and a port map cannot be used.

Thefollowing Verilog example shows a tri-state buffer Buffer 1 which isrepeated for each bit of
the 8-bit input and output buses. In this case, each instance gets a part select of the range
expression [ 7:0] starting from the right-hand index and the enable signal is connected to every
instance.

gl: [F:0]
___________ —
] l
In I o
—n L 5l ino T P S
wire[7:0] 1 e reg H wire[7:0]
: LocalLib I
buffif
2 enable |g 1
wire i :
1
|

This exampl e represents the following Verilog code:

nmodul e Tri st at e(
I n,
en,
Qut

)

input [7:0] In;
i nput en;
output [7:0] Qut;
wire [7:0] Inm;
wre en;
wire [7:0] OQut;
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buffif 10[7:0](

.1n0 (In),
.enabl e (en),
.Qut0  (CQut)

endnodul e // Tristate

Using Generate Frames for Repeating Structures

When you are using VHDL, it is possible to use a FOR generate frame around a diagram area
containing a number of existing block and component objects.

The following example shows a variable width bank of registers. Each register consists of aflip-
flip whose output is connected to atri-state buffer. The width of the input and output busesis
specified by the VHDL generic width and the frame is controlled by the expression: FOR
bit_index IN O TO width-1 GENERATE.

cell_array: FOR bit_index INO TO width-1 GEMERATE

____________________________________________ -1
.
1 |
1 |
1 |
] dat in » dat_unbuffered b data out |
| (Dawidth-12 (Dowidth-17 1
1 |
1 |
1 |
1 |
1 |
1 |
1 |
1 |
1 |
1 |
1 |
1 clock clb==clodk, a==dat_unbufferad, 1
1 std_logic gq==dat_unbufferad, en=rout_enable, 1
I d == data_in(bit_inde:) w=% data_outlbit_inde:) |
I out_enable |
LA e e —————— 1

Signals which are connected to all occurrences of the objectsin the generated code can be
connected directly (clk and en in the example above). Separate port map frames for each
component specify the connectivity expressions for each instance.

This example represents the following VHDL code:

LI BRARY ieee; use ieee.std |logic 1164.all;

ENTITY RegistersFrane |S
GENERI C (width : positive);
PORT (clock : IN std_I ogic;
out _enable : IN std_l ogic;
data_in : INstd logic_vector(0O TOwidth - 1);
data_out : QOUT std logic_vector(0 TOwidth - 1));
END Regi st er sFrane;
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ARCHI TECTURE struct of RegistersFranme IS
SI GNAL dat _unbuffered : std_| ogic;
COVPONENT D flipflop is
PORT (clk : IN std_logic;
d: INstd_|ogic;
g : QUT std_logic);
END COVPONENT;
COVPONENT tristate buffer IS
PORT (a : IN std_logic;
en : IN std_logic;
: QUT std_l ogic);
END COVPONENT;
BEG N
cell _array : FOR bit_index INO TOw dth - 1 GENERATE
10 : Dflipflop
PORT MAP (
clk => cl ock,
d => data_in(bit_index),
g => dat a_unbuffered
)
11 : tristate_buffer
PORT MAP (
a => dat a_unbuffered,
en => out _enabl e,
y => data_out (bit_index)
)
END CGENERATE cel | _array;
END struct;

Note
D Repeating structures are not supported when you are using Verilog.

Using Generate Frames for Conditional Structures

An |F generate frame can be used in VHDL or Verilog to describe conditional or alternative
structures. When you are using VHDL, there can be any number of conditional |F frames.

When you are using Verilog, an alternative structure can be defined by using an EL SE frame
which must have the same label as the corresponding IF frame.
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The following example instantiates different versions of the I[pm_add sub model determined
by whether the variable Ipm_REPRESENTATION is set to SGNED or UNSIGNED.

LZ: IF lpm_REPRESENTATION=5IGNED GENERATE

————————————
|
ADD_SUB 1 |
T |
I I
I I
DATA% : lpm WIDTH:1] 1 I
1 |
I I
I I
I I
CLOCKE ' 1 RESLLT : flpm WIOTH:13
T ]
I I
I I
I I
DATAB : (pm IDTH: 1 ! :
L]
1 I
1 I
1 I
e ———
lpm_WIDTH = lpm WNIDTH [ positive ]
lpm PIFELINE = 0 [ integer ]
1pm_DIEECTION = VHUSED [ string

Li: IF lpm_REPRESENTATION=UNSIGMED GEMERATE

ADD_SUB
o

DATAS : (pm WIOTH: 13

Cr

CLOCEK RESULT : Jpm WWIDTH:1)

i i
o OATAR : dpm WI0TH: 17
Ipn OIITH = lpe WIDTH  ( positive )
lpm PIFELINE = 0 [ integer ]
1pm DIEECTION = 1KUSED [ string
This example represents the following VHDL code:
LI BRARY i eee;
USE i eee.std | ogic_1164.all;
LI BRARY | pm
USE | pm | pm conponents. al | ;
ENTITY | pmadd_sub IS
GENERI C(
| pm W DTH . positive;
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| pm REPRESENTATION : string := SlIGNED
)
PORT
ADD SUB : IN std_l ogic = '1';
CLOCK  : IN std_l ogic = '0';
DATAA : IN std_l ogi c_vector (I pmWDTH DOANTO 1);
DATAB I'N std_l ogi c_vector (I pmWDTH DOANTO 1);

RESULT out std_logic_vector (I pmWDTH DOANTO 1)
)

END | pm add_sub ;

LI BRARY i eee;

USE i eee.std | ogic_1164.all;

LI BRARY | pm

USE | pm | pm conponents. al | ;

LI BRARY framelib;

ARCHI TECTURE struct OF | pmadd sub IS

COVPONENT | pm add_sub_si gned

GENERI C (
| pm W DTH © positive;
| pm REPRESENTATION : string := SlIGNED
)
PORT
ADD SUB : IN std_l ogic = '1';
CLOCK  : IN std_l ogic = '0';
DATAA : IN std_l ogi c_vector (I pmWDTH DOANTO 1);
DATAB I'N std_l ogi c_vector (I pmWDTH DOANTO 1);

RESULT out std_logic_vector (I pmWDTH DOANTO 1)

)
END COVPONENT:

COVPONENT | pm add_sub_unsi gned

GENERI C (
| pm W DTH : positive;
)
PORT
ADD SUB : IN std_logic := '"1';
CLOCK  : IN std_logic := '0';
DATAA : IN std_l ogi c_vector (I pmWDTH DOANTO 1);
DATAB I'N std_l ogi c_vector (I pmWDTH DOANTO 1);

RESULT out std_logic_vector (I pmWDTH DOANTO 1)
)
END COVPONENT;

BEG N
L1: | F | pm REPRESENTATI ON=UNSI GNED GENERATE
U: | pmadd _sub_unsigned
GENERI C MAP (
| pm W DTH => | pm W DTH,
)

PORT MAP (
ADD_SUB => ADD_SUB,
CLOCK  => CLOCK,
DATAA  => DATAA,
DATAB  => DATAB,
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RESULT => RESULT
)
END GENERATE L1;

L2: | F | pm REPRESENTATI ON=SI GNED GENERATE
V : | pm.add_sub_signed
GENERI C MAP (
| pm W DTH => | pm W DTH,

)

PORT MAP (
ADD_SUB => ADD_SUB,
CLOCK  => CLOCK,
DATAA  => DATAA,
DATAB  => DATAB,
RESULT => RESULT

)E

END GENERATE L2;

END struct;

When you are using Verilog, an alternative structure can be defined by using an EL SE frame

which must have the same label as the corresponding |F frame.

The following example instantiates Bufl if the macro definition BUF1 istrue, otherwise Buf2 is

instantiated. Both frames have the same label Genl.

©oena

This example represents the following Verilog code:

dout - -
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nmodul e tri state8(
ena,
in,
out

)

i nput ena;
input [7:0] in;
output [7:0] out;
wire ena,
wire [7:0] in;
wire [7:0] out;

“ifdef BUF1
buf 1 UL(
.enabl e (ena),
ip (in),
.op (out)
“el se
buf 2 U2(
.enabl e (ena),
ip (in),
.op (out)
);
" endi

endnodul e // tristate8

Using a BLOCK Generate Frame

When you areusing VHDL, aBLOCK generate frame can be used to cluster related concurrent
statementsin the generated HDL. All the HDL statements generated for the objects contained in
aBLOCK frame are executed concurrently.

In the following example, separate BLOCK frames and frame declarations have been used to
specify delay constants for the ipdelay and opdelay embedded blocks. The main functionality is
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implemented by two instantiations of subcircuit which are contained within athird BLOCK
frame.

functionality: BLOCK

al

input_delays: BLOCK undelayed_out1

undelaved _out?a

. . delaved inl output_delays: BLOCE
I-n2 E y ;F‘d'ﬂalf E delayed_in2 intemmediate . E
'-"3 Sy delayed_in3 :
1 .

pelayed_inl <= inl after dtime;
pelayed_in2 <= in2 after dtime;
pelayed_ind <= in3 after dtime;

ot 1 <= undelayed_out1 after dtime;
puts <= undelayed_out? after dtime;

This example represents the following VHDL code:

LI BRARY i eee;
USE i eee.std | ogic_1164.all;
USE i eee. nuneric_std. all;

ENTITY block_circuit 1S

GENERI C(
dtine : tinme := 10 ns
E
PORT(
In1 : IN bit;
In2 : IN bit;
I n3 I'N bit;

outl : OUT  hit:
out2 : OJT bi t
),
END bl ock_circuit ;

LI BRARY i eee;

USE ieee.std_logic_1164.all;
USE i eee. nuneric_std. all;

LI BRARY franelib;

ARCHI TECTURE struct OF block circuit IS

SI GNAL del ayed_inl : bit;
SI GNAL del ayed_i n2 . bit;
S| GNAL del ayed_i n3 ©obit;
SI GNAL i nternedi ate © bit;

SI GNAL undel ayed_out1 : bit;
SI GNAL undel ayed_out?2 : bit;

COVPONENT subcircuit
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PORT (
a : IN bit ;
b I'N bit ;

yl: OUT  bit :
y2 @ QJT bi t

),
END COVPONENT:

BEG N
i nput _del ays: BLOCK
BEG N
del ayed_inl <= inl after dtine;
del ayed_in2 <= in2 after dtine;
del ayed in3 <= in3 after dtineg;

END BLOCK i nput _del ays;

functionality: BLOCK

BEG N
celll : subcircuit
PORT MAP (
a => delayed_inil,
b => delayed_in2
y1l => undel ayed_out 1,
y2 => internediate
)
cell2 : subcircuit
PORT MAP (

a => internedi ate,

b => del ayed_in3,

y1l => undel ayed_out 2,
y2 => OPEN

)
END BLOCK functionality;
out put _del ays: BLOCK
BEG N
outl <= undel ayed outl after dtine;
out 2 <= undel ayed out?2 after dtine;
END BLOCK out put _del ays;

END struct;

Using Nested Generate Frames

A frame may be included within another frame. Typically arepeating structure may require
different instantiations for parts of the structure.
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Thefollowing VHDL example shows a FOR generate frame used to represent five instances
where there are alternative instances determined by whether the value i is 0 or 1 (two instances)
and 2, 3, or 4 (three instances).

gl: FOEiIN 0O TO 4 GENERATE

: gl: IFi== 1 GENEF.LTE

ey

Operstor == Ctl_CDC1+%2 DOWHTO 1%,
Operndl == CT+i%8 DOWHT O i8],
Opermnd? == D7+i%8 DOWHT O i),

1 1
11 1
11 :
1 1
11 b 1 VI
CtL D I T Msigned(E9 DOWHTO 0)
wisigned(12 DOWHTO 0] | |
e . :
meigned39 DOWHTO Dj: : I
i) T |
wisigned 39 DOWHTO 0] | |
] I
' 1
' 1
' 1
' 1
' 1

e gl e R R S

gl: IFi==2 GENEFLTE

e e R

1
1
1
1
1
1
1
1
1
1 -
! !
- [
- [
caep || g m——
o — [
- 1]
o p 1! 1]
o T I |
D 1 ! ]
o —— I
] I ] 1
] I ] 1
i P!
;|1 Dperator == Ctl_CDei%s DOWHTO i%3-2), I 1
. Operamdl == CiT+i% DOWHTO i), I |
;1 Opermd2 == D7+i%e DOWHT O i), I 1
;1 Resul == WarT+i*e DOWHTO i) I 1
| e e :
S |
This example represents the following VHDL code:
LI BRARY i eeeg;
USE i eee.std_l ogic_1164. al l;
USE i eee. nuneric_std. all;
ENTI TY NestedFranes |IS
PORT(
C : IN unsi gned (39 DOANTO 0);
ctl_Cb: IN unsi gned (12 DOANTO 0);
D : IN unsi gned (39 DOANTO 0);
Y2 . aJr unsi gned (39 DOANTO 0)
)
END Nest edFr anes ;
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LI BRARY i eee;

USE i eee.std | ogic_1164.all;

USE i eee. nuneric_std. all;

ARCHI TECTURE struct OF NestedFranes |S

COVPONENT ALU1

PORT (
Qperandl : IN unsi gned (7 DOANTO 0);
Operand2 : IN unsi gned (7 DOANTO 0);
Qperator : IN unsi gned (1 DOANTO 0);
Resul t oot unsi gned (7 DOANTO 0)

)

END COVPONENT;

COVPONENT ALUW2

PORT (
Operandl : IN unsi gned (7 DOANTO 0);
Operand2 : IN unsi gned (7 DOANTO 0);
Qperator : IN unsi gned (2 DOANTO 0);
Resul t . aJr unsi gned (7 DOANTO 0)

)

END COVPONENT:

BEG N
g2: FORi IN O TO 4 GENERATE
g0: IF i <= 1 GENERATE
10 : ALUL
PORT MAP (
Qperator =>Ct| _CD(1+i *2 DOMNTO i *2),
Operandl => C(7+i *8 DOANTO i *8),
Qperand2 => D(7+i *8 DOANTO i *8),
Result => Y2(7+i *8 DOANTO i *8)
)
END GENERATE gO0;
gl: IF i >= 2 GENERATE
1 : ALU2
PORT MAP (
Qperator =>Ct1 _CD(i*3 DOMNTO i *3-2),
Operandl => C(7+i *8 DOMTO i *8),
Operand2 => D(7+i *8 DOMNTO i *8),
Result => Y2(7+i *8 DOANTO i *8)
);
END GENERATE g1;
END GENERATE g2;
END struct;
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Y ou cannot include another frame within a FOR frame when using Verilog. However, you can

have any level of nested IF and EL SE frames.

genl: “ifdef COMP - - -

5t L R v v g g )

-‘gen1e|ge......-:........

j

1
o
=y

&

a=sign dout = (ena==13 *in : 7'BO;

e et St
[

This example represents the following Verilog code:

modul e tristate_vl og(
ena,
in,
out

)

i nput ena,
input [7:0] in;
output [7:0] out;
wire ena;
wire [7:0] in;
wire [7:0] out;

“ifdef COWP
bufif UL[7:0](
. enabl e (ena),
ip (in),
.op (out)

—m dost
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)

“el se
// HDL Enbedded Bl ock 1 ebl

assign out = (ena==1) ? in :

“endi f

endnodul e // tristate vl og

Editing Generate Frame Properties

7|

BO;

Y ou can display and edit properties for generate frames in ablock diagram or IBD view by
using the button, Alt + |_4Z_] shortcut or choosing Object Propertiesfrom the Edit menu.
In IBD views the Frame number and Appearance fields do not exist.

If aframe is selected, the Frames page of the Object Properties dialog box is displayed listing

its existing properties.

HlaBD Object Properties - Frames
¥ Frame Style: FOR
¥
H Label: |g|:| [v Wisible
¥
I b0l I W Wisible
¥
¥ FOR Frame Expression
¥ Presiew: gl: FOR i INOTO n GEMERATE
Appearance FParameter: |i
+ Range: ||:| ﬂ |n
Idzer Declarations
Declaration | M Wisible
k. Cancel | Apply | Help |

Y ou can use the dialog box to edit the frame style, label, number and expression and specify
whether the title (including the label and expression) and number are visible on the diagram.

The style can be selected from a pulldown list which includes FOR, |F and EL SE when using

Verilog or FOR, IF and BLOCK when using VHDL.

Refer to the dialog box description for details of the options and syntax supported for each of

these styles.

When you are using VHDL, you can use the Declar ations button (or choose Frame
Declar ations from the popup menu in an IBD view) to display afree-format entry Frame
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Declarations dialog box which allows you to specify local declarations which apply only within
the frame.

H[} Frame Declarations E3

Enter any frame declarations here:

=

<] _>I_I
IE Cancel !
o

Y ou can also choose whether these declarations are visible on a block diagram. Frame
declarations should only be used in a FOR or IF frame when VHDL-93 (or Any Dialect) is set

as apreference in the Style tab of the VHDL Options dialog boxes but can be specified in a
BLOCK frame when you are using VHDL-87 or VHDL-93.

The syntax of the declarations is checked on entry.

Tip: You can declare procedures, functions, shared variables, constants or other
declarations which are allowed in generate statements for the current VHDL dialect.
However, signal declarations local to generate frames are not supported.
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Chapter 7
Component Interface Views

This chapter describes procedures for using the tabular 10 and symbol views to edit a
component interface.

OpeningaComponent Interface ............ i 295
Tabular IO and Symbol VIiews. . ... e e 296
Tabular TONOtAtION . . ... e e 297
Hiding ColUMNS . ... o e e e e 298
Filtering Columns. . . . ..o 299
Tabular IO TOOIDAr . . . .o 300
Sortingthe RowsinaTabular IOView ... i i 301
Adding Portsinthe Tabular IOView. . ... e 301
Grouping POt ROWS . . . ..ot e e et 302
Setting Visual Attributesinthe Tabular IOView .......... ... ... .. ... 304
Symbol Notation. . ... e 305
Symbol Toolbar . . ... 305
Adding Portsinthe Symbol View . .......... . e 306
CustomizingaSymbol .. ... . 307
Editing Port Declarations . . ... ...t e 308
Changing the Port Declaration Order . . . ...t 309
Propagating Port Changes. . . ... ..o 310
Updating INStanCeS . . . . ..ot e 310
Adding Attributesto aPort Declaration. . .. ...t 311
Adding CommentstoaPort Declaration . .............. ... 311
Editing Symbol Generic or Parameter Declarations. .. ..., 312
Editing Symbol/Interface Object Properties. . .......... ... .. 314
Editing Symbol User Declarations . . .. . ... .o 314
Editing Symbol Body Properties ... 315
Setting Interface Preferences . ........... ..o 317

Opening a Component Interface
To create anew interface using the Design Content wizard:
1. Invoke the Design Content Creation Wizard by doing one of the following:

o Choose Design Content from the New cascade of the File menu.

o Clickthe E icon in the Design Manager |eft side bar.
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o Clickthe E icon in the shortcut bar to display amenu and choose Design Content
or choose Graphical View and select | nter face from the cascade menu.

2. Choose Graphical View from the Categories pane and Interface from the File Type
pane.

Y ou can aso choose | nter face from the Open As cascade of the component popup menu.
To create a new interface:

Click the E icon in the shortcut bar and choose I nterface from the Graphical View cascade
menu to open atabular 10 view.

Refer to “ Creating Design Views’ in the HDL Designer Series User Manual for detailed
information about creating new views.

To edit acomponent interface:
Do one of the following

o Select the symbol in the design explorer Design Units view and choose Open File
from the File or popup menu.

o Select acomponent instance from ablock diagramor IBD view and then open down
by choosing I nterface from the Open As cascade of the popup menu to edit a child
component interface.

o Usethe button or choose Open Up or I nter face from the Open cascade of the
File menu to edit a parent interface for ablock diagram, IBD view, state diagram,
flow chart or truth table.

If the view is ablock view, the parent block diagram or IBD view is opened. However, if itisa
component, the component interface is opened.

When you open up, the interface is opened as atabular 10 view or as a symbol diagram view
depending on an option set in the interface master preferences.

Note
If acomponent is described by ablock diagram or IBD view, the component interface can

also be updated by reconciling the interface from the block diagram as described in
“Reconciling Interfaces’ on page 122.

Tabular 10 and Symbol Views

Thetabular 10 and symbol views are aternative views of the component interface. The tabular
1O view istypically used to define the interface and the symbol view is used to define the
graphical view when the component is instantiated in a block diagram.
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Y ou can display the tabular 10 interface or symbol diagram view by choosing I nterface or
Symbol or in the diagram browser as described in “Browsing Diagram Structure” on page 87.

Y ou can enter the interface port declarations for a component by using either view. Any
changes made in one view are automatically made in the aternative view. Default port
placement is used for the symbol when you add portsin the tabular 10 view.

When you are using VHDL, you can set VHDL package references by double-clicking over the
package list in the symbol view, or by choosing Package Refer ences from the Diagram menu
in the symbol view or from the Table menu in the tabular 10 view. Refer to “ Setting Package
References’ on page 23 for more information.

Tabular 10 Notation

Thetabular 10 view (when the Ports page is active) displays the port declarations for the
interface as amatrix of seven columns with a separate row for each port.

For example, the following picture shows the interface to a Verilog symbol with four input and
two output ports:

Hj Untitled * {(Interface) M=l E3

File Edit W%iew HDL Table Tasks Add Ophions  Window Help|

[@- ¢« HE Q- BB - - A | S-L- - -

F = + &l Z = ™y
|+ 0 o L m=5 =74 2 il @&||&
A B C D E F 3 Shucture Mavigator al »|
@ Sroup Marne Made Type Bounds | Initial Cormrnernt i Interface = E
: & Symbol =
=1 1 Inputs In0 I std_logic_wectar | [15:0] G.‘ Generics §
2 | Outputs laT11] ouT std_logic_wectar | [15:0] Y, Declarations |z
=
3 Inouts ISt IMCUT || std_logic_wectaor 15:0
- (15:0) Cantent :I.§
4 - g
ERSR AN —
What do you want to

4
>
4
2
Ll
-3
:hd
-
g
=
(I
1
1l

The following columns are normally displayed:

Group Named groups of rows can be selectively displayed.
Name Port name.
Mode Port mode: input, output, bi-directional, buffer (VHDL only) or local.
Type VHDL type definition or Verilog net type.
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Bounds Range of the specified type (may use short or long format for VHDL).
Delay Delay value for a Verilog port.

Initial Initial value of aVHDL port.

Comment Comment appended to a port declaration.

For Verilog 2005 designs to extra columns are displayed:

Signed Specify whether anet is signed or not.
Value Initial value for aVerilog 2005 port.

If any synthesis properties have been added to a port declaration (for example, the input_drive
column in the picture above), these are shown as additional columns.

Horizontal and vertical sashes divide the tabular 1O view into scrolling and non-scrolling
regions. Vertical and horizontal scroll bars are automatically displayed if the scrolling area does
not fit in the current window.

Y ou can change the non-scrolling area by moving the cursor over the sash between the scrolling
areasin theletter row or number column. The cursor changesto «« and allows you to movethe
sash by pressing down the L eft mouse button and dragging it between the required column or
row.

Y ou can move a column or row (or several selected columns or rows) by pressing down the
Right mouse button and dragging them to the required position. However, you cannot move the
header row or the Group column and there must always be at |east two columns in the non-
scrolling area.

Y ou can resize any column by using the button to fit the column width to the text in the
selected cell (or cells) or by dragging the sashes between the columns.

Note
D Note that you can select an entire row by clicking the row number or an entire column by

clicking the column letter. Y ou can aso select the entire table by clicking on cell Al.

Hiding Columns

Y ou can hide the selected column (or columns) by choosing Hide Column from the popup
menu or the Columns cascade of the Table menu.

If one or more columns are hidden, you can display a dialog box listing the hidden columns by
choosing Show Column from popup menu or the Columns cascade of the Table menu. For
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example, the following Show Columns dialog box is displayed if the Type, Bounds and Initial

columns are hidden:

H[} Show Columns B3

Select one or more items:

Type
Bounds
| riitial

ok | cancel | Hel

p

%

Y ou can select one or more columns and confirm the dialog box to make them visible in the

table.

Filtering Columns

Y ou can filter the content of any column by setting the Filter option in the Table menu or by
using the button to toggle the current filter mode. When this option is set a dropdown menu

is available from an additional filter row in each column.

Y ou can choose from any of the valuesin the dropdown menu to filter the column content. For
example, if you choose wire in the Type column for a Verilog view, only ports with wire type

are displayed.

Y ou can aso enter asimple match string in the drop entry box to display only matching ports.
For example, you could enter data* in the Name column to display only ports starting with the

characters data as show by the following example.

Hla SCRATCH_LIB/Manual /symbol * {Symbol})

File Edit M“iew HDL Table Tasks Add Options Window Help

|B-e=>2HBE 9| BB o M
|[&-M-%-@- -3 -

[C =+ 4+ + & &
[+ >0 ofmm == =7 \% 22 @&
A E Z C E F 3
- @ Group Marme Mode Type Bounds | Initial |Commn
T L= data* =] =1 =1 =1 =1
2 data_in I std_logic_wector|  [(15:0)

3 data_out OUT  [std_logic_wectar|  (15:0)

4]

4 4

Shucture...
21
% Symbol
5} Generics
", Declarat ™

o

o

I 125 MO g Wb

Content

L
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Y ou can apply filters to more than one column or set options to match case, match whole words
or use regular expressions by choosing Filter Settings from the Table or popup menu to

display the Filter Controls dialog box:

The filter contralz apply to the selected columns. IF no columng
are gelected, they are applied to all the columns.

[ Match Case

[T Match Whole “aord Only
™ Regular Expression

] I Eancell

%

The filter controls are applied to the currently selected columns or to al columnsif none are

selected.

Note that alist of supported regular expressionsis available from the Quick Reference Index
which can be accessed through the Help and Manual s tab of the HDS InfoHub. To open the

InfoHub, select Help and Manuals from the Help menu.

Tabular 10 Toolbar

The following commands are available from the Tabular 10 Tools toolbar:

Table 7-1. Tabular 10 Toolbar

Description

v

Add an input port

Add an output port

Add abidirectional (inout) port

Group the selected rows or add a group

ungroup

eEEEE 3

Expand all groups

Collapse all groups

Toggle Filter

Fit the call width to the contents of the selected call

Sort in ascending order

[ e

Sort in descending order

=) Toggle between grouped and ungrouped mode
5 Toggle between the port and Verilog parameters table (OLE view only)
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The toolbar can be displayed or hidden by setting the Tabular 10 Toolsoption in the Toolbars
cascade of the View menu.

Refer to “ Toolbars’ on page 20 for more information about toolbars including the standard
toolbar buttons which are available in more than one editor.

Sorting the Rows in a Tabular 10 View

Y ou can sort the rows in a selected column of the tabular 10 view in ascending alphanumeric
order of the cell databy using the button or choosing Sort Ascending from the popup menu
or the Columns cascade of the Table menu.

Alternatively, you can sort the data in descending order by using the button or by choosing
Sort Descending from the popup menu or the Columns cascade of the Table menu.

Adding Ports in the Tabular 10 View

Y ou can add ports to a component interface using the Add menu or the following buttonsin the
tabular 1O view:

Table 7-2. Tabular 10 View Commands for Adding Ports

Button Function Key Description

> F8 Add an input port

F9 Add an output port

[¢] F11 Add abidirectional (inout) port
[¢] F12 Add abuffer port (VHDL only)

The port is added in the next available row with default name, type and bounds.

Alternatively, you can add ports by entering a declaration directly into the next row of Name,
Mode, Type and Bounds cells. The mode defaults to the last mode used or you can choose from
alist of available modes: input, output, bidirectional (inout) or buffer (VHDL only).

Thetype defaultsto the last type used or you can choose from a dropdown list of available types
in the Type column. The bounds defaults to the last range used or you can choose from a
dropdown list of recently entered ranges in the Bounds column.

A VHDL bounds can be entered in long or short format. The display format can be set by setting
or unsetting the Short Form option in the Table menu.

If you enter a port name followed by a valid bounds constraint, for example, myport(7
DOWNTO 0), the constraint is automatically moved to the Bounds column.
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0 Tip: You can automatically complete arow with default properties by using the
key after entering a port name to move to the name cell in the next row.

Y ou can optionally enter avaluein the Initial (VHDL) or Delay (Verilog) and Comment
columns. The delay or initial value can be chosen from a dropdown list of recently entered
values.

If you enter characters that match charactersin an existing entry of the same column, the
remaining characters are entered automatically.

If you do not change the name of a port, each new port name is made unique by adding an
integer to the default name. (For example: In, In1, In2...).

Grouping Port Rows

Y ou can group rows in the tabular 10 view by selecting arow or rows and using the EI button
or by choosing Group from the popup menu, the Add menu or from the Group cascade of the
Table menu.

The selected rows are added to a new group with the default name GroupN (where N is
automatically incremented if it already exists).

Y ou can also add agroup or create anew group by entering a name in the Group column for the
ports you want to group.

Note
Y ou can choose from a dropdown list of existing groups. If you type a partial string that
matches the name of an existing group the name is automatically completed.
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The following example shows groups defined for Inputs, Outputs and InOuts. The Inputs and
InOuts groups are shown collapsed but the Outputs group is shown expanded. When grouped
mode is set, you can enter a multi-line comment in the group row as shown below.

H[j Untitled * {Interface) =] 3
File Edit “iew HDL Table Tasks Add Options  Window Help|

[B-«=2EHEE- 2B - A& |Z-L-T -
|+ ¢ ¢ EmE-E=7|% 2li @B|®

a E [ L E = G Structure Mawvigataor
@ araup Marme Mode Type Bounds | Initial Camment 2¥i Interface
:D Symbol
=i ! Inputs Ini I std_logic_wectar | [15:0) 'IEJ Generics
2 | Outputs kil ouT std_logic_wector | [15:0) ", Declarations
3 Inouts igteTlii} IMCOUT || std_logic_wector | [15:0) Content
4 =
<::' E'|> @ =

What do you want to

|2 & BlA.5 13

|Head_l,l i

Tip: Note that you can select a port declaration row (or rows) and drag and drop the
row(s) into an existing group.

Y ou can remove a group name by selecting arow (or rows) and using the EI button, choosing
UnGroup from the popup menu, the Group cascade of the Table menu or by deleting the name
from the Group cell.

If you rename or remove an existing group cell and the group is no longer referenced, you are
prompted to delete the old group name.

When the view includes one or more groups, you can use the button or set Show Grouped
in the Table menu to toggle between grouped and ungrouped mode. All rows are displayed
normally in flat mode but rows in the same group are shown as a single (but expandable) group
in hierarchy mode.

Y ou can expand all the group rows by using the button or choosing Expand All Groups
from the Group cascade of the Table menu. Alternatively, you can expand an individual group
by clicking on the = icon.

Y ou can collapse all the group rows by using the button or choosing Collapse All Groups
from the Group cascade of the Table menu.
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Note

D If you delete agroup, al its contents are deleted. If you copy agroup, all portsin the
copied group are automatically made unique.

Setting Visual Attributes in the Tabular IO View

Y ou can set the visual attributes for the selected cell (or selected cells) by choosing
Appear ance from the Edit or popup menu. The Cell Edit Appearance dialog box is displayed:

H[} Cell Edit Appearance B3
— Colar Style
Font: -j Fill Style: I. j
Eackground: I j alignment: I Center - I
— Font
T ahoma Marmal 10 paint Set..
ak Cancel | Apply | Help

The dialog box allows you to set the font and cell colors. Y ou can also set thefill style, default

text font and cell text alignment.

Y ou can also edit the visual attributes used in the table using the Appearance toolbar. Refer to

“Setting Visual Attributes’ on page 78 for more information.
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Symbol Notation

When a component is defined by a child block diagram or IBD view, the ports shown on the
symbol correspond to ports on the child view.

&
B Ind E Outd fop-
SERP.T_I:H_LIB
Cprt
=
[ Clack g Outl =
By default the port name and

Input ports are shown by E entering the symbol and output ports
by B exiting from the symbol.

A bidirectional (InOut) port isindicated by « and a buffer port
by <.

Any input port can be shown as an edge triggered clock signal
(indicated by ).

Any input, output, bidirectional or buffer port can be shown asan
active low (Not) signal (indicated by @ ).

other properties text is shown inside the symbol body but can

optionally be moved outside the symbol.

Y ou can choose to hide propertiestext in the symbol view or when the symbol isinstantiated in
ablock diagram. Y ou can also choose to automatically hide connected ports when the symbol is
instantiated. (This option is typically used when the clocked and inverted attributes are set.)

When a symbol is automatically created, input ports are placed on the left, output ports on the
right, bidirectional ports on the bottom edge and buffer ports on the top edge but these positions

can be changed when you edi

t the symbol. Note that vertical text isautomatically used for ports

on the upper and lower edges.

Symbol Toolbar

The following commands are available from the Symbol Tools toolbar:

Table 7-3. Symbol Toolbar

Icon Description

|15 [+ Select text and shapes, text only or shapes only

|A] Add or modify comment text

Pan the window

Add an input port

Add an output port

Add abidirectional (inout) port

Add a buffer port (VHDL only)

BekE =

Add apanel
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The [Ty - button sets normal tion mode (text or_shapes) but has a pulldown menu which
allowsyou to select text only als™ or shapes only |k 7|. The button changes to indicate the
active selection mode.

Refer to “ Adding Comment Text” on page 56 for information about adding comment text and
“Panels’ on page 73 for information about adding panels.

Refer to “ Toolbars’ on page 20 for more information about toolbars including the standard
toolbar buttons which are available in more than one editor.

Adding Ports in the Symbol View

Y ou can add ports to a component interface using the Add menu or the following buttonsin the
symbol view:

Table 7-4. Symbol View Commands for Adding Ports

Button Function Key Mnemonic Description

F8 I Add an input port

F9 O Add an output port

@ F11 T Add abidirectional (inout) port
[¢] F12 F Add abuffer port (VHDL only)

The cursor changes to a cross-hair which alows you to add a port by clicking near the required
location on the symbol outline.

The port is added to the symbol outline at the point nearest to the cursor. By default, the port
name, type and bounds constraint are added inside the symbol alongside the new port but the
text can be moved outside the outline.

Note that the command normally repeats until you use the Esc key (or Right mouse button) to
terminate the repeating command.

The ports are added with default type and bounds but these properties can be changed by
directly editing the text on the diagram or by double-clicking on the port declarations to display
the tabular 10 view.

Y ou can change the mode of a port in the symbol view by choosing Change M ode from the
popup menu (or Ports cascade of the Diagram menu) which is displayed when you use the
Right mouse button with a single port selected.

If you do not change the name of a port, each new port is given a unique name by adding an
integer to the default name. (For example: In, In1, In2...).
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Y ou can move ports around the symbol body by dragging with the L eft mouse button. (If you
select more than one port, their separation is preserved.)

Y ou can space all the ports on each edge of a symbol evenly by choosing Equidistant Ports
from the popup menu when the symbol body is selected or space the selected ports when one or
more parts are selected.

The port name (and type constraints if visible) is aligned with the port orientation. Thus, the
name text is horizontal for a port on the left or right of the symbol and vertical for aport on the
top or bottom of the symbol. However, the text can be rotated independently by choosing
Rotate Text from the popup menu.

You can add an active low @ (Not) or edge-triggered clock E indicator on a symbol port as
described in “Indicating Not or Clocked Ports’ on page 223.

Customizing a Symbol

Y ou can customize a symbol by checking Custom Symbol in the Diagram or popup menu in
the symbol view or by checking the Custom Symbol option in the Symbol tab of the Symbol
Object Properties dialog box.

When this option is active, the symbol body is replaced by a resizable rectangular boundary
containing an editable comment graphic.

Any comment graphics object can be superimposed on the default shape or you can use the Edit
Vertices command from the popup menu to modify the default shape.

Any comment graphics or comment text completely within the boundary is part of the custom
symbol and will be displayed when the symbol is instantiated in a block diagram.

The following example shows a custom symbol for the uart_top design unit (with autowhiskers
enabled and aHDS logo added as a custom graphics bitmap):

addr int
@ —
data_in sout _
70 —
data_out _
sin S Tm }_
i . . .
B g '
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Comment graphics or text outside the boundary is visible only inside the symbol editor.

Refer to “ Adding Comment Graphics’ on page 67 for more information about using comment
graphics.

Y ou can check L ock from the Diagram or popup menu to lock all objects inside the symbol
boundary so that they behave as a single object. (Note however, that all objectsinside the
boundary of an autoshape are automatically included.)

Ports can be added to the symbol boundary in the normal way. If Autowhisker ischecked inthe
Diagram or popup menu or in the Symbol tab of the Symbol Object Properties dialog box.

Whiskers are automatically added as orthogonal lines between the ports on the symbol
boundary and the contained comment graphics shape. However, no whisker is added if the line
would not intersect with the contained comment graphics.

Y ou can also change the shape of a symbol by applying a standard logic shape as described in
“Choosing a Standard Shape” on page 221.

Editing Port Declarations

Y ou can edit port declarations by direct text editing in the symbol view or by editing the cellsin
the tabular 10 view.

Y ou can edit the port name, mode, type, bounds, VHDL initia value or Verilog delay and
comments for an existing port in the tabular 10 view by editing the cell contents.

Note that you can choose from a pulldown list of standard VHDL or Verilog types by clicking
inaType cell and using the =! button. The type which most closely matches the current string
isautomatically selected in the list. (For example, if the characters st are entered for aVHDL
view, the type std_logic is selected.)

If you are using VHDL, the type must be defined in aVHDL package, referenced in the
package references or be one of the standard predefined types.

The pulldown list includes the most commonly used types and any other types which have
already been used in the view. However, you may need to add a new package reference if you
choose atype which is not in the currently referenced packages. For example, ieee.numeric_std
should be referenced if you want to use the signed or unsigned types.

The standard Verilog types can be selected if you are using Verilog. However, input or
bidirectional ports cannot have type reg and automatically default to wire.

The bounds can be used to specify the indexes for the elementsin an array or the range for a
vector type. For example: 15 DOWNTO O or 0 TO 7 (if you areusing VHDL); 15:0 or 0:7 (if
you are using Verilog).
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If you areusing VHDL, you can aso enter a user specified constraint such as an enumerated or
integer type name or you can enter an array name or type of the form: <array>'RANGE or
<array>'REVERSE_RANGE.

If you are using VHDL, you can use the Initial column to enter an expression defining an initial
value for the net connected to the port.

Note
D VHDL can be generated for a block diagram containing component interfaces with

unconnected portsiif the ports have been assigned an initial value. However, HDL
generation issues an error for unconnected ports without an initial value.

If you are using Verilog, you can use the Delay column to enter adelay as one, two or three
values. If two or three delay values are required, they must be separated by commas and
enclosed in parentheses. For example: (delayl, delay2, delay3).

Changing the Port Declaration Order

The port declarations are normally ordered automatically by mode (in, out, bidirectional or
buffer) and al phanumeric name as they are added. This mode isindicated by an (&) iconinthe
first cell of thetitle row in the tabular 10 view.

Y ou can change the order of the port declaration rows in the table by selecting arow (or rows)
and dragging it to a new position with the Right mouse button.

Y ou can enable manual ordering in the tabular 10 view by choosing Switch to Manual from
the popup menu in the (&) cell (or Manual from the Port Ordering cascade of the Table
menu). This modeisindicated by an ®) icon.

When manual ordering is enabled, you can choose Update Generation Order from the Port
Ordering cascade of the Table or popup menu to update the declaration order to be the same as
the row order. Alternatively, choose Show Generation Order to re-order the table rowsin
declaration order.

The new order is preserved on the symbol and in the generated HDL.

Note
D Manual ordering isautomatically set if you synchronize component interface ports with a

text view to preserve the port ordering specified in the text view.
Manual ordering is also used when diagrams are created by HDL2Graphicsin order to
preserve the order (and any in-line comments) from the source HDL code.

If you choose Switch to Automatic from the popup menu in the ®) cell (or Automatic from
the Port Ordering cascade of the Table menu, the original ordering is discarded and the
declarations are sorted automatically by mode and alphanumeric name.
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Propagating Port Changes

When you edit a port declaration in the tabular 1O or symbol view, you can choose whether the
changes are applied only to the interface or are propagated to connected netsin the views
hierarchically below the symbol.

Y ou can set Hierarchical or Non Hierar chical as the Scope for Changes from the popup
menu or from the Ports cascade of the Table menu in the tabular 10 view or the Diagram menu
in the symbol view.

If hierarchical scopeis set, the Net Propagation Options dialog box is displayed after you apply
changes to the port properties for you to choose how the changes are propagated to netsin other
views.

Refer to “ Propagating Net Changes’ on page 158 and “Inserting and Removing Nets’ on
page 161 for more information about propagating new signals and changes to the properties of a
net.

Updating Instances

If you save a component interface after you have changed a port declaration or any of the
symbol properties, you are prompted whether to update any instances where the component is
used. If you answer Y es to the prompt, the Search page of the Where Used wizard is displayed:

H} Where Used - Search B3

Pleaze zpecify the scope for the updates:

— Loak ir:
" The libraries containing the specified objects anly O hds_package_library ;I
' The default library only O renoir_package_library
€ Al project libraries | SCRATCH_LIB
* Specified libraries [ Sequencer_vhd
Sequencer_vlg _I
O TIMER_whdl
O TIMER_vlog
O usrT
M HART T%T Ll
Start... | Cancel | Help |

%

The Search page alows you to specify the search scope for referenced components.

Y ou can choose to search for referencesin the same libraries as the selected objects, the default
library only, al librariesin the current project or in specified libraries.
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If you choose to specify libraries, the selection list is enabled and allows you to choose from any
of the available libraries mapped for the current project.

The specified libraries are searched when you use the Start button and the Update Where Used
dialog box is displayed listing any occurrences where an instance of the component is
instantiated:

H[j Update Where Used B3

|lpdate

& |nterface
™ |nterface and Graphics
= Fram Symbal

[Double click on the Diagram or Instance items in
the lizt below to cross reference ta that item.

LIB: Sequencer_vlg

ARCH: fibgen/fibgen
INSTAMCE: acc_A
INMSTAMCE: acc_B
INSTAMCE: acc_sum

Apply | [one | Help

Y ou can choose to update the interface only or also update any changes to the symbol graphics
while preserving the symbol size and port positions. Y ou can aso choose to update all changes
from the symbol. This option does aliteral replacement of the symbol and nets may be moved if
any ports have been moved on the symbol.

Adding Attributes to a Port Declaration

Y ou can add attributes to a port declaration in atabular 10 view by choosing Attributesfrom
the popup when one or more port rows are selected in the table matrix.

Y ou can add attributesto a port declaration in the symbol view by choosing Attributesfrom the
popup menu when the port or its declaration is selected.

Refer to “ Setting Attributes and Embedded Constraints’ on page 157 for more information.

Adding Comments to a Port Declaration

Y ou can add comments to a port declaration in the tabular 10 view by choosing Comments
from the popup menu when the port declaration row is selected.

Y ou can add comments to a port declaration in the symbol view by choosing Comments from
the popup menu when the port or its declaration is sel ected.
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A free-format entry Comments dialog box is displayed which alows you to add asingleline
comment at the end of the declaration or you can enter a multi-line comment to be included
before or after the declaration.

Comment characters for the current hardware description language (VHDL or Verilog) are
automatically inserted if the Add comment char acter s check box is set. When thisoption is
unset, the comments must be valid HDL statements and are automatically syntax checked if
checking is enabled.

The comments are displayed in the port declarations list in the symbol view. If adeclaration is
deleted, the corresponding comments are also deleted.

& gingle line comment can be added at the end of the declaration line.
tultiple-line comments can be added beforeafter the declaration.
Comment characters will be added when appropriate.

E nd-of-line [zingle ling comment]:

Before [multi-line comment]: v Add comment characters
-
-
< E
After [rmulti-ine comment]: v &dd comment characters
-
-
< E

(] I Cancel | Help |

%

Although multi-line comments can be added to a tabular 10 using the dialog box, these
comments are not displayed in the table. However, end-of-line comments can be edited directly
in the Comment column for the port declaration row.

Editing Symbol Generic or Parameter Declarations

A separate page in the interface view can be used to declare Verilog parameters (if the language
IsVerilog) or VHDL generics (if the language is VHDL). These pages can be opened from the
diagram browser or by choosing Generics or Parameter s from the Diagram menu in the
symbol view.

Note
The Generics page is available if you are using VHDL or the Parameters pageis

availableif you are using Verilog.
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To set anew declaration, enter a name, type (not required when the language is Verilog) and
default valuein the table cells.

For example, the following picture shows VHDL generics width and delay defined in the
Generics page:

A ] C o] E F Structure Hawi.. ]
Group Harne Type Walue | Pragma Cornrmert £1 Interface -
i _I :B Symbol
1 widk integer i 15 M E“m
= | delay tme x| ® MO ", Declarations
3 = P]Package List

The width generic is used to specify the upper bounds for the output bus and delay specifies a
variable value for an internal signal used within the component.

The new declarations are shown as a text object anchored to the symbol body in the symbol
view. For example:

VHDL Verilog

Generic Declarations Parameter Declarations

delay titme 5 ns
width integer 15

Note
D The default value specified for a declaration can be a discrete value or an expression.

Note that the time type used in the example above may not be supported by some
compilers (for example, Synopsys Design Compiler).

Note that you can choose from a pulldown list of standard VHDL typesin the Type column.

Refer to “ Generics and Parameters’ on page 166 for more information about using VHDL
generics and Verilog Parameters.
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Editing Symbol/Interface Object Properties

Y ou can edit s and graphical properties for acomponent interface in the tabular 10 or symbol

view by using the [g] button, Alt + shortcut or choosing Object Properties from the
Edit menu.

The Symbol Object Properties dialog box is displayed with tab options for setting s, comment
Text properties and Symbol body properties.

Note
D The Text tab isavailable in the symbol view when comment text is present on the
diagram. The Symbol tab is only available in the symbol view.

Refer to “ Editing Text Properties’ on page 58 for information about editing comment text
properties in the symbol view.

Editing Symbol User Declarations

Y ou can use the Declar ations tab of the Symbol/Interface Properties dialog box to add or edit
User Declarations in the symbol or tabular 10 view.

The dialog box can also be displayed directly by double-clicking on an existing declaration in
the symbol view or by choosing Edit Declar ations from the Table menu or from the popup
menu when a complete port row is selected in the tabular 10 view.

Hla Symbol/Interface Properties B3
Te:-:tl Symbol  Declarations |

Euternal: Inzerted before Module statement

o o

|nternal: Inserted immediately after kModule statement

o o

[+ align In Caolumns

(] Cancel Apply | Help
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Y ou can aso edit the statements directly on the symbol view by clicking to select the text and
clicking again to edit the text.

Y ou can enter declarations in the dialog box using free format. The statements are added to the
Declarations list on the diagram when you use the Apply button.

The syntax is automatically checked for the hardware description language of the active view.
However, syntax checking can be disabled by unsetting a preference. If you change the
language for the current view, syntax errors are reported when you edit a statement.

When you are using VHDL, there isa single entry box for declarations which are included as
entity declarations in the generated VHDL entity.

When you are using Verilog, the dialog box has separate sections for external and internal
declarations. The external declarations are inserted in the generated HDL before the Verilog
modul e statement. The internal declarations (typically used to declare interface parameters) are
inserted immediately after the module statement.

Y ou can set or unset the Align in Columns option to control how the declarations are formatted
on the diagram. Note that a monospace font must be used for the this option to be effective.

Editing Symbol Body Properties

Y ou can edit the properties for a symbol body in the symbol view by using the Symbol tab of
the Symbol/Interface Properties dialog box.

The dialog box displays the library and component names as read-only text fields and provides
options to control how the symbol is displayed in the symbol view or when it isinstanced on a
block diagram.

Y ou can use the Port Display button to control how port properties are displayed in the symbol
view as described in “ Changing the Display of Port Properties’ on page 198.

Y ou can use the Change Shape button to choose from alist of alternative standard shapes as
described in “ Choosing a Standard Shape” on page 221.

Y ou can enable Custom Symbol editing and choose whether to automatically add whiskersto
signals as described in “ Customizing a Symbol” on page 307.

If the Show portswhen attached to a signal option is set, ports are displayed when a
component instance is connected on a block diagram. (Unconnected ports are always visible but
are automatically hidden when asignal is connected if this option is not set.)
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The Show library name and Show design unit name options control whether the library name

and design unit names are displayed on each instance.

Hla Symbol/Interface Properties B3

Test  Symbol | Deu:laratiu:unsl

— Symbaol
Library: SCRATCH_LIB

Component: kduiltiplier

[~ Custom Symbal [T Eutot hisker

Part Dizplay... |

Change Shape... |

— Symbaol Inztance Dptiohz

W Show port when attached ta a Signal

W Show libram name

v Show design urit narne
Part test wigibility:

' Same az Symbol
" Specify

Eart Miemlam..

Controlz port and test vizibility for instances of thiz Symbal;

0K

Cancel

Apply Help

If the Same as symbol option is set, the port text visibility for an instance displays the same
properties that are visible in the symbol view.

Alternatively, you can set the Specify option and use the Port Display button to set the default
visibility of port properties text displayed for an instance of the symbol on a block diagram.

0 Tip: You can change the display of port propertiesfor a selected component instance on a
block diagram by using the Port Display button in the Components tab of the block
diagram Object Properties dialog box (or by choosing Port Visibility from the popup

menu).
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Setting Interface Preferences

Y ou can set preferences for the interface views by choosing I nterface from the M aster
Pr efer ences cascade of the Options menu in the design manager to display the Interface
Master Preferences dialog box

The dialog box has separate pages for setting Gener al, Default Settings, I nterface Table and
Symbol preferences.

The master preferences take effect on the next interface you create. However, you can apply the
current master preferences for the symbol appearance and background to the active view by
choosing Apply to New Objectsor Apply to New and Existing Objects from the M aster

Pr efer ences cascade of the Options menu in the diagram.

Y ou can set the symbol appearance and Interface table preferences for the active symbol by
choosing Diagram Pr efer ences from the Options menu in the symbol/Interface view.

When you edit these preferences for the active diagram, the dialog box allows you to choose
whether the preferences are applied to new objects or to both new and existing objects in the
diagram.

Y ou can save the preferences for the active diagram as master preferences by choosing Update
from Diagram in the Master Preferences cascade of the Options menu.
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The General page allows you to set miscellaneous preferences for the interface and symbol

view:

"Blnterface Master Preferences

E| Default Settings

Werilog
; Default Properties
E| Interface Table
: Appearance
= Syrbol
El [Mzplay Sethngs
- [Object Yisibility
-~ WHOL Part Dizplay
- Werlog "35 Port Dizplay
- Werilog 2005 Port Display
Appearance
Background

x|

v Check syntax on entry

v Prompt On Update Where Uzed

Fort Orderifig

" Automatic " Manual

o]

Cancel | Help |

7

Y ou can set an option to check the HDL syntax of declarations and embedded HDL text objects

on entry.

Note

Checks are also performed for unsynthesizable constructs when Common synthesis
checks are set in the Checks tab of the Main Settings dialog box.

Y ou can choose whether to automatically open the Where Used wizard when editsto the logical

interface are saved.
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Y ou can al so specify whether port declaration ordering is automatic (by mode and a phanumeric
name) or if manual ordering is allowed and choose whether the interface view for asymbol is

opened as atabular 10 interface or as a graphical symbol.
x|

- General

=l Diefault Settings

' - WHDL Header Cells
‘o Werilog Port Fow

Group Fow

oo Diefault Properties Froperties Column

E| Interface Table

RS APpearance
B Symbaol
E| Dizplay Settings
i L Object Visibility
- WHOL Part Dizplay
- wenlog "95 Port Dizplay
‘ - Werilog 2005 Port Display
----- Appearance
L B ackaround

— Calor

Faont Colar: - j

Cell Calor: I j

Fill Style: |i j
—Fant

T ahaoma Mormal 10 paint Set..
— Alighment

Cell Text Alignment: IEenter vl

o]

Cancel | Help )l/
o

The Interface Appear ance page allows you to set default visual attributes for the font and cell
colorsin thetabular 10 view. Y ou can also set thefill style, default text font and cell text

alignment.
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The appearance options are described in the description of the Cell Edit Appearance dialog box
which can be used to change the appearance on individual cells. Refer to “ Setting Visual
Attributesin the Tabular IO View” on page 304 for more information.

Hla Interface Master Preferences

-+ General
E| Default Settings
L wHDL
- Werlog
i o Default Properties
E| |nterface Table
. Appearance
B Symbal
E| Dizplay S ettings
. L Object Visibility
WHOL Part Display

Werlog "35 Paort Dizplay

Camment Box
Comment Text
Component Port
Component Port Buffer
Component Part Test
Declarative Block Port
Declarative Black Text
Declarative Black Title
Generic Interface Text
FPackage List
Fackage List Label
Panel Box

Panel Text

Symbol Body

Symbol Body Text

Xl
— Color Style
Fareground I—j Fill Style Iij
Backaground I—j Line Style ;j
Line Colar - j Lirie width |: j
— Faont
Set .
Ok I Cancel | Help ‘L
7

The Symbol Appearance page allows you to set default visual attributes for individual objects

in the symbol view

The attributes that can be set include the foreground and background colors, line color and style,
fill style and line width, and the text font. However, some attributes are not always available.
For example, the line style, width and color attributes are not available for atext object.

The appearance options are described in the description of the Edit Appearance dialog box
which can be used to change the appearance of individual objectsin adiagram. Refer to
“Setting Visual Attributes’ on page 78 for more information.

When accessed from the editor, you can choose whether to apply the symbol appearance
changes to new objects only or to al new and existing objects on the diagram.
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The Default Settings page allows you to change the port and group namedefaults.

Hﬂlnterfal:e Master Preferences x|

o Werilog
Lo Default Properties
= Interface Table
b Appearance
= Symbol
E Dizplay Settings
¢ e Obiject Visibility
o YHOL Port Display
(. Wenlog '35 Port Digplay
' Werilag 2008 Port Display
----- Appearance
e Background

— Component Port Mames
Fort In ™

Part Dut: IEIutU
Part InQut: IInDulU
Part Buffer: IEuffErU

r— Group Mame

Group Mame: IG[DUDD

0k, I Cancel Help
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Separate VHDL and Verilog sub-pages can be used to set the default constraints, type and
bounds for VHDL and Verilog ports. For example, the following picture shows the Verilog sub-
page:

«
. Deteh [oloobsedsslrs ]
EI [_)efault Settings
o= WHD Werilog

qilog p ; -
Detault Properties Toee I e J
= Interface Table Bounds: |15 : Iu
i e Appearance
=8 Symbal
E| Dizplay Settings
i e Object Visibility

- WHOL Part Display

- Werilog "95 Port Dizplay

- Werilog 2005 Part Display
o Appearance

(. B ackaround

0k I Cancel | Help I

g

The bounds can be entered as arange (for example, 15 DOWNTO 0or 0 TO 75in VHDL or 0:7

in Verilog) or you can use the first bounds entry box as an index for asingle element in an array
leaving the second entry empty.

For VHDL, you can a so use the first bounds entry box to enter a user specified constraint such
as an enumerated or integer type name or you can enter an array name or type of the form:

<array>' RANGE or <array>'" REVERSE RANGE
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Y ou can use the Default Properties sub-page to define default properties for tabular 1O

interface views.

“Blnterface Master Preferences

-~ General
= Diefaul Settings
. e wWHDL

----- Werlog
R [ fault Propeities
E| Interface Table
o Appearance
= Symbal

E| Dizplay Settings

¢ e Dhject Visibility
WHDL Port Display
Werilog "398 Port Digplay

----- Appearance
" Background

- Werilog 2005 Port Dizplay

Specity default propertiez in the table below
It ig ot necezzan to specify a Clazs for uzer-entered properties.

x|

Class Mame

Value

[ [

]

Cancel I Help |

g

Refer to the HDL Designer Series User Manual for information about “Using View Property

variables’.
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The Inter face sub-page provides additional preferences which apply only to the interface view:

“lalnterface Master Preferences

~ General
E| Default Settings
© Lo WHDL
- erilog
- Default Properties
E Interface T able
o Appearance
B Syrmbal
EI Dizplay Settings
© e Dbject Visibility
- WHDL Part Display
Yerilog '35 Port Dizplay
e Werilog 2005 Port Display
----- Appearance
e Background

- nterLce

x|

¥ Enable Drag Fil
v Enable Single Click E dit

¥ Highlight &ctive R ow/Column

WHOL Shart Farm
v Edit Shaort Farm

¥ Display Shart Faorm

o]

Cancel | Help |

P

Y ou can enable drag fill and enable single click editing in the interface view. Y ou can enable an
option to highlight the active row and column when atable cell is selected.

Y ou can aso choose whether to edit or display VHDL range constraints using short form
notation.
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The Object Visibility sub-page allows you to set the default object visibility for multi-line text
objects on the diagram. Refer to “Changing Text Visibility” on page 63.

H[j Interface Master Preferences x|
- Default Settings
) e Declarations
P e D:flanugllt Froperties Package List [VHDL
E| Interface Table Compiler Directives [Werlog)
o bppearance
=l Symbol

(=) Dizplay Settings
Object Wisibility
- WHDL Part Display

- Werilog "985 Port Display
o e Menilog 2005 Port Display
Appearance
. Background

QK I Cancel | Help |

.

The VHDL Port Display and Verilog Port Display sub-pages buttons alow you to set default
port display properties. For example, the following picture shows the Verilog Port Display
page:

The port display properties can be set separately for VHDL and Verilog when you edit the
master preferences or for the language used by the active symbol when accessed from the
editor. Refer to “Changing the Display of Port Properties’ on page 198 for more information.
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H[} Interface Master Preferences | =l
- Default Settings
---- WHDL Contrals the format and wisibility of usage and declaration information attached to Portl0's e.q. name,
e Werilog type and constraints.

.. Default Properties
E| Interface T able
L. hppearance
= Symboal

EI Dizplay Settings

. & Object Visibility

----- Appearance
‘- Background

e Werilog 2005 Port Display

r— Fields to dizplay
¥ Portl0 Mame

¥ Tupe Constraint
[~ Tupe Name

W Dizplay Portl] and Declaration infarmation on the same line

— Misc

¥ Selectable Test [allows tewt bowes on gymbol bo be individually selected)

Format Presiewe |my_portlo : [7:0]

o]

Cancel Help
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The Background page alows you to control the diagram background color and grid attributes

used in the symbol view.

-~ General

Default Settings

- Default Properties
Interface Table

|
— Gird
V¥ Show Grid
Calar

i Mppearance
B- Symbol
E| Dizplay Settings
¢ Object Visibility
WHDL Port Display
“Werlog '35 Port Digplay

Appearance
B B ackoround

e Yerilag 2005 Part Display

Dizplay horizontal grid every

Diizplay vertical grid eveny

|1 paint
|1 poirit

— Diagram

Background calor

I'W'hite 'I

]

Cancel | Help

These preferences are described in “ Setting Background Preferences’ on page 50.

Refer to the “Default Preferences’” appendix in the HDL Designer Series User Manual for lists
of the default preferences which are set when you invoke aHDL Designer Seriestool for the

first time.
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Chapter 8
Flow Chart Editor

This chapter describes how a design process can be described by a flow chart in terms of
graphical action boxes, decision box, wait boxes case boxes and |oops connected by flows. This
technique can be used to describe adesign unit view of any leaf-level block or component in a
block diagram or IBD view.

Flow Chart Notation . .. ... ... e 330
Flow Chart Toolbar . ... e 332
Adding ObjectsonaFlow Chart ......... ... ... i 333
AddingaStart POINt . ... ... 335
Adding an ACtioON BOX .. ..ot 336
Adding aDeCiSIoN BOX. . ... .o 337
AddiNg aWait BOX . . . ..ot 338
AddiNg aloop . ..o 338
Adding aCase BoX . . ..ot 339
Adding aFlow. . ... 341
Addingan ENd POINt. . .. ...t 342
Adding Other ObjectsonaFlow Chart .......... ... ... . . 342
Hierarchical Flow Charts. ... ... e 342
Concurrent Flow Charts. .. ... .o 344
AddingaConcurrent Flow Chart . . . ... 345
OpeningaConcurrent Flow Chart . ........ ... e 345
RenamingaConcurrent Flow Chart. . ... ... ... . e 345
DeletingaConcurrent Flow Chart . . ... e 346
Editing Flow Chart Object Properties. ... 346
Editing Action Box Object Properties . ... 346
Editing Decision Box Object Properties. . . ... 348
Editing Wait Box Object Properties. .. ... 350
Editing Loop Object Properties . ... 352
Editing Case Object Properties. .. ... e e 353
Setting Flow Chart Properties . .. ... e e e e 354
Setting Flow Chart Generation Properties . . ... e 355
Editing Architecture or Module Declarations. . .. ........... ... ... 359
Editing Concurrent Statements. . . ... ... 360
Editing Processor Local Declarations . . ... ... 362
Setting Flow Chart Preferences . . ... e 363
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Flow Chart Notation

The notation used for flow chart objects is show below.

Table 8-1. Flow Chart Notation

There must be one and only one start point
which is always named Start.

An action box containsHDL statementswhich
are executed when the box is entered from a
flow. There must be one input flow and one
output flow.

A hierarchical action box represents a child
flow chart describing action logic.

A decision box represents if-then-else
statements and has two outputs: A True flow
which isfollowed when its condition is
satisfied or a False flow otherwise.

A wait box definesaHDL wait or delay
statement.

A loop comprises start loop and end loop
objects.

Theloop will continue for ever if no control
properties are associated with the start loop
object.

Any number of other objects can be included
in the flow between the start and end loop.

A decision box represents if-then-else
statements and has two outputs: A True flow
which isfollowed when its condition is
satisfied or a False flow otherwise.
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There must be at |east one end point.

The % on flow chart objects indicates ports where flows can be connected.

A flow chart may contain any combination of objects connected by flows but must contain one

start point and one (or more) end points.

A flow chart istypically used for the input stimulus and output checking blocks in atest bench.

For example:

Initialization

stop="0";
start=="0";
reset<='0";
d=="0000000000";

L]

RjINI:ITI:IQ

d_war="0000000000";

d_wanji="1";

ASSERT (high=b_warHND(low=b_war ;
b_war=unsignedib_warH1;

End Loop

Ched_Suspend

Lecoder

thigh=high_temp)

Fackage List

LIBRARY ieee;

USE ieee.std_logic_1164. all;
USE ieee.std_logic_arith.all;

Architecture Declarations
COMSTANT clh_prd : time = 100 ns;
ShizMAL iclk : std_logic;
SlizMNAL high_temp @ std_logic_wectona DOVINTO OY;
ShENAL low_temp @ std_logic_wectons DOWVINT O OY;
FROCEDURE wait_clodCOMSTANT clk_ticks:integen 15
WARIABLE i : integer:=0;
BEGIM

FOR i INO TO clk_ticks LOOP

WRAIT UNTIL rising_edgediclk);

EWD LOOF;

EMD wait_clock;

Concurrent Statements
clk <= jclk;

Sensitiwity List
< Automatic »

AMD (lowslow_te mpy

Fas=

F ail

k J

ASSERT false
REFORT "Count suspended correcthy"
SEVERITY note;

ASSERT false
REFORT "Count did not suspend"
SEVERIT" warning;

or 200 ns ;

Frocess Declarations
WARIABLE d_war: std_logic_wectom® DOWWNTO O ;= "0O000000000";
WARIABLE b_war: std_logic_wectona DOWVWNTO O3 ;= "0O000";
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Flow Chart Toolbar

The following commands are available from the Flow Chart Tools toolbar:

Table 8-2. Flow Chart Toolbar

I con Description

Select text or objects

Ak Select text only
Select objects only

Add or modify comment text

Pan the window

EEEE

Add a new concurrent flow chart

4

Open a named concurrent flow chart

ﬁaﬁ

Delete a named concurrent flow chart

Add an action box

Add a hierarchical action box

Add adecision box

(=]

(@] Add await box
(] Add a start point
(5] Add an end point
(] Add a start loop
(] Add an end loop
= Add a case box
Add a case port
Add aflow

Add a panel

Note

[

The fg,|v| and 7fg,|v| buttons have pulldown menus which allows you to choose from a
list of concurrent flow chart names.

Refer to the HDL Designer Series User Manual for general information about toolbars and the
HDL Designer Series user interface.
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Refer to Diagram Editor Windows in Chapter 2 or information about selecting objects, resizing
objects, adding comment text or graphics, panning the window, adding a panel and additional
tool bars which are common to the other diagram editors.

Adding Objects on a Flow Chart

Y ou can add objects on aflow chart using the Add menu or one of the buttonsin the Flow Chart
Tools toolbar. Some objects can also be added using a shortcut or mnemonic key.

You can find alist of supported Graphical Editor Shortcut Keysin the Quick Reference I ndex
which is displayed using the -help switch.

The cursor changesto a cross-hair which allows you to add the object by clicking at the required
location on the diagram.

When you add any object (except a start point) on aflow chart, aflow is automatically
connected to the nearest unconnected port on an existing object.

The ghosting shows which port the object will connect to. If there are several available ports,
the ghost flow snaps between them as you move the cursor.

This automatic connection mode can be set or unset by choosing AutoConnect from the
Diagram menu. The current setting is saved as a preference.

After adding an object, the command normally repesats until you use the Esc key (or Right
mouse button) to terminate the command. However, you can set a preference for the command
to remain active or activate only once and you can toggle this mode for the current command by
using the Ctrl key.

If you move the cursor over an existing flow while you are adding an object, the cursor changes
to =+ and the object isinserted into the flow between the existing objects.
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If the new object is too close to the object above it, it will automatically snap to a position in
free space bel ow the object. Any existing objects bel ow the new object are automatically moved

down to make space.

This automatic insertion mode can be set or unset by choosing Autol nsert from the Diagram

menu. The current setting is saved as a preference.

The following example shows aloop being inserted into the flow between a start point and a

decision box:

Note

reset = 1

D Automatic insert mode works only for vertical flows.

If an object isresized so that it overlaps the next object in aflow, the next object is

automatically moved down to make space.

334

Graphical Editors User Manual, V2008.1
September 18, 2008



Flow Chart Editor
Adding Objects on a Flow Chart

Adding a Start Point

Y ou can add a start point to aflow chart using the EI button, Shift + F8 or S shortcut keys or
by choosing Start Point from the Add menu.

There must be one (but only one) start point on aflow chart.

The default name for a start point can be changed by setting a preference.
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Adding an Action Box

Y ou can add an action box to aflow chart using the button or T shortcut key or by choosing
Action Box from the Add menu.

Y ou can add a hierarchical action box to aflow chart using the [E] button, Shift + F2 or H
shortcut keys or by choosing Hierar chical Action Box from the Add menu.

Y ou can change the name of an action box (and the enclosed actions) by clicking to select the
text and clicking again to edit the text in-line.

Alternatively, you can double-click on the action box, use the button or choose Object
Propertiesfrom the Edit menu, to display the Action Boxestab of the Object Properties dialog
box as described in “ Editing Action Box Object Properties” on page 346.

If you do not change the name of an action box, each new action box is given a unique name by
adding an integer to the default name (for example: a0, al, a2...). The default actions can be
changed by setting preferences. Action boxes and hierarchical action boxes have the same
default base name (a).

The default actions defined in your preferences are placed in the action box. The actions may
overlap the action box outline but can be independently moved away from (or into) the action
box. If you want to contain al your actionsinside the box, it may be necessary to resize the
object.

I nitialization
stop=0,
start=0;
reset=0;
d=4'h0;
weait_clock(2];
reset=1,
weait_clock(B);
reset=0;

The actions syntax is automatically checked for the hardware description language of the active
diagram. However, flow chart syntax checking can be disabled by unsetting a preference.

Note
D Verilog system functions such as $display or $stop can be used in an action box.
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Adding a Decision Box

Y ou can add a decision box to aflow chart using the button, F3 or D shortcut keys or by
choosing Decision Box from the Add menu.

Y ou can change the name or condition by clicking to select the text and clicking again to edit
the text. Alternatively, you can double-click on the decision box, use the button or choose
Object Propertiesfrom the Edit menu, to display the Decision Boxes tab in the Object
Properties dialog box as described in “Editing Decision Box Object Properties” on page 348.

If you do not change the name of an decision box, each new decision box is given aunique
name by adding an integer to the default name (for example: dO, d1, d2...). The default base
name for new decision boxes, the default condition text or default labels for the True and False
flows can be changed by setting preferences.

Y ou can exchange the position of the output flows by choosing Swap True and False from the
Diagram or popup menu when a decision box is selected.

The condition text is placed inside the decision box and after editing may overflow the box but
can be moved independently away from (or into) the box. If you want to contain the whole
condition inside the box, it may be necessary to resize the object.

When you enter a condition, the syntax is automatically checked for the hardware description
language of the active diagram. However, flow chart syntax checking can be disabled by
unsetting a preference.

A decision box correspondsto an If statement in HDL. Y ou should not connect the output flows
from two or more decision boxes directly together as this would generate invalid HDL. If
necessary, copy the same action box and connect separately to both output flows. Y ou can then
recombine the flows using aflow join. End if statements will then be correctly generated for
each decision arm.

Correct Incorrect
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Adding a Wait Box

Y ou can add await box to aflow chart using the \El button, F4 or W shortcut keys or by
choosing Wait Box from the Add menu.

Y ou can change the name of await box by clicking on the name to select the text and clicking
again to edit the text. Similarly, you can change the wait statement by clicking on the wait
statement text.

Alternatively, you can double-click on the wait box, use the |Er| button or choose Obj ect
Properties from the Edit menu, to display the Wait Boxes tab in the Object Properties dialog
box as described in “Editing Wait Box Object Properties” on page 350.

When you enter wait statements, the syntax is automatically checked for the hardware
description language of the active diagram. However, flow chart syntax checking can be
disabled by unsetting a preference.

If you do not change the name of an wait box, each new wait box is given a unique name by
adding an integer to the default name (for example: w0, wl, w2...). The default base name for
new wait boxes and the default wait statement text can be changed by setting preferences.

B T2
S watt (fhigh==4'd0& & lowe==4'd0T, - -

The wait statement text is normally offset overlapping the wait box but can be moved
independently away from (or into) the box. If you want to contain the whole statement inside
the box, it may be necessary to resize the object.

Adding a Loop

Y ou can add a start loop to aflow chart using the @ button or L shortcut key or by choosing
L oop from the Add menu to place a start |oop object.

Any combination of flow chart objects (including other loops) can be added below the start
loop.

To complete the loop, you must add an end loop object using the @ button or O shortcut keys
or by choosing End L oop from the Add menu.

Note
D If AutoConnect is enabled in the Diagram menu, the loop back flow is automatically

connected to the nearest unconnected start loop.

Y ou can change the name of aloop by clicking on the name to select the text and clicking again
to edit the text. However, you cannot change the loop control text directly.
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To edit the control text (or the loop name), double-click on the wait box, use the button or
choose Object Properties from the Edit menu, to display the L oops tab in the Object
Properties dialog box as described in “Editing Loop Object Properties’ on page 352.

If you do not change the name of aloop, each new loop is given a unique name by adding an
integer to the default name (for example: (10, 11, 12...). The default base name for new |oops and
the default labels for the start and end loop objects can be changed by setting preferences.

The loop control text is normally placed to the right of the start loop object but can be moved
independently away from (or into) the object. If you want to contain the whole of the control
text inside the loop object, it may be necessary to resize the object.

Breaking Out of a Loop

Y ou can break out of aloop by using adecision box to set a"breakout” condition whichis
connected below the end loop using a flow join as shown below:

Note

D If there are multiple break-out conditions, these must be combined using a single break-
out decision box. For example, in the example above, the loop is exited when the loop is
on itsthird iteration if the signal b hasthe value '1'. Otherwise, the loop is exited
normally after completing eight iterations.

Adding a Case Box

Y ou can add a case box to aflow chart using the @ button, F6 or C shortcut keys or by
choosing Case from the Add menu.
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The start case box is added at the cursor location and an associated end case object with the
same name is automatically added vertically below.

Any combination of other flow chart objects (including other case boxes) can be added between
the start and end case objects.

A new start case box has a single output port (with a name which can be set as a preference) but
you can add any number of unconnected case ports using the button, Shift + F6 or P
shortcut keys or by choosing Case Port from the Add menu or Add Port from the popup menu
when the case box is selected or simply by adding flows with their origin over the start case
object.

Y ou can delete a case port by using the Del key or by choosing Delete from the Edit or popup
menu while the port is selected.

Y ou can change the case name, case expression or the value for an existing case port by clicking
on the name to select the text and clicking again to edit the text.

Alternatively, double-click on the case box or any case port, use the button or choose
Object Propertiesfrom the Edit menu to display the Cases tab in the Object Properties dialog
box as described in “Editing Case Object Properties” on page 353.

When you enter a case expression or case port name, the syntax isautomatically checked for the
hardware description language of the active diagram. However, flow chart syntax checking can
be disabled by unsetting a preference.

If you do not change the name of a case, each new case object is given aunique name by adding
an integer to the default name (for example: 0, c1, c2...). The default case expression and port
values for new case boxes can be changed by setting preferences.
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The expression is normally placed inside the start case object but can be moved independently
away from (or into) the object. If you want to contain the whole of the expression inside the case
box, it may be necessary to resize the object.

Adding a Flow

Y ou can add aflow to a flow chart using the button, F7 or F shortcut keys or by choosing
Flow from the Add menu.

The cursor changes to a cross-hair which allows you to add aflow by clicking the L eft mouse
button with the cursor over a source and destination plus any number of route points.

Flows can only be connected between the connect ports shown by = on each flow chart object.
However, you can move the loop back points on aloop object to the opposite side by dragging
them with the mouse. Similarly, you can move the True and False flows from a decision box to
an aternative vertex.

Note
Y ou can dynamically create a port on a case box by adding aflow with its origin over the

start case object.

A flow cannot originate on another flow but can be terminated on a flow (creating aflow join).

For example, the following constructs using flow joins are functionally equivalent and generate
the same HDL.:

Note that if you delete an object (such as an action box) which has one input flow and one
output flow, aflow is automatically connected between the objects immediately above and
below the deleted object.

All flow chart objects (except case ports) must be connected before you can generate HDL for a
flow chart. Any unconnected case port is assigned aNULL statement by HDL generation.
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Note
D Y ou cannot create aloop by connecting an output directly to the input of a previous

object on the flow chart since this could create unreachable nodes. Use a start and end
loop as described in “ Adding aLoop” on page 338.

Adding an End Point

Y ou can add an end point to aflow chart using the EI button, F8 or C shortcut keys or by
choosing End Point from the Add menu. There must be at least one end point on aflow chart.
The default name for a start point can be changed by setting a preference.

Adding Other Objects on a Flow Chart

Y ou can also add other objects such as atitle block, comment text, comment graphics and
panels on aflow chart.

Hierarchical Flow Charts

A large flow chart can be decomposed into a hierarchy of smaller more manageable hierarchical
flow charts which are embedded below hierarchical action boxesin their parent flow chart. The
child chart is connected to the hierarchical action box in the parent flow chart by its start point
and end point.

Y ou can open down into achild flow chart by double-clicking on ahierarchical action box or by
choosing Open Down from the Open cascade of the File menu (or popup menu) to explicitly
open the selected hierarchical action box.

The child flow chart is opened for in the existing window. A new child flow chart comprises a
start point, a single action box and an end point connected by flows. Y ou can edit a hierarchical
chart in the same way as any other flow chart including more hierarchical action boxes as well
as any other flow chart objects.

Y ou can choose Open Up from the File menu or select the name of the parent diagram in the
diagram browser to open the parent of the currently active flow chart.

Child flow charts are saved as part of the parent flow chart and named after the parent
hierarchical action box by adding the name of the parent hierarchical action box to the
concurrent flow chart name.
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For example, the following picture shows a flow chart for atest bench which includes a
test_status, test_ xmit, test_rcv hierarchical action boxes represented by child flow charts:
TAUART /tester/How [tester_top] ™ (Flow Chart

File Edit M“iew HDL Diagram Tasks add  Simulate  Animation  Options

= |O) =
Window  Help

[(B-«2ma-ldEQ =B v fFwePLeos

[ B-AMBEBBE<® T & eec vl [0|&

cs 4= '1"

nB <= "0";

addr <= 000"

sin 4= "1

rst <='0°, "' AFTER 2 * CLE_PRD;

datin <= "000000OO0" AFTER CLE_PRD;

assert false
report “Uart Testing Complete”
sewerty failure;

Z
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The parent flow chart is named: tester_top and the child is named tester_top/test_status:

Hla UART /tester/flow [tester_top/test_status] * {Flow Chart)
File Edit Wiew HOL Diagram Tasks Add  Simolate  Animation  Options  Window  Help

g - BEHE D o oo B 2L DS
NCAD BB e T eSS L O]
SRE BB R
=) 2
uart_readifi; g

read_data = "D0000000™

neat_ger

assert false
report “Status MOT zem”
sewerty failure;

Ready

Concurrent Flow Charts

Any number of concurrent flow charts can be created from within an existing flow chart with
the same interface.

The package list and any VHDL architecture declarations, Verilog module declarations or
concurrent statements are shared by the concurrent flow charts but the sensitivity list and
process declarations or local declarations can be set separately.

Each concurrent flow chart is given a unique name by adding an integer to the default name (for
example: process0, processl, process2...) and identified in thetitle bar by appending this name
and its position in the set of concurrent flow charts to the leaf flow chart name. For example, if
you create three concurrent flow charts for the flow chart DES GNS\ConcFC\flow the resulting
set of four flow charts would be identified as follows:

DES GNS\ConcFC\flow ['processO' 1 of 4]

DES GNS\ConcFC\flow ['processl’ 2 of 4]

DES GNS\ConcFC\flow ['process2' 3 of 4]

DES GNS\ConcFC\flow ['process3' 4 of 4]
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A set of concurrent flow chartsis treated as a single design object and all concurrent charts
(including any hierarchical diagrams) are saved when any flow chart is saved. When HDL is

generated for concurrent flow charts, separate VHDL processes (or always blocksin Verilog)
are generated for each chart.

Note
D Object names must be unique within the set of concurrent flow charts.

Adding a Concurrent Flow Chart

Y ou can create a concurrent flow chart from within an existing flow chart using the button
or the Ctrl + F2 shortcut keys or by choosing Concurrent Flow Chart from the Add menu. A
new flow chart is created in the existing window with the same interface as the current chart.

The package list and any VHDL architecture declarations, Verilog modul e declarations or
concurrent statements are shared by the concurrent flow charts but the sensitivity list and
process declarations or local declarations can be set separately.

Each concurrent flow chart is given a unique name by adding an integer to the default name (for
example: process0, processl, process2...). However, the base name for anew flow chart can be
set as a preference in the Default Valuestab of the Flow Chart Preferences dialog box.

Opening a Concurrent Flow Chart

Y ou can open an existing concurrent flow chart from within an existing chart by using the @
button or choosing Open Flow Chart from the Diagram menu and selecting from the menu of
concurrent flow chart names. The concurrent flow chart is opened in the existing window. Y ou
can also open a concurrent flow chart by selecting it in the diagram browser.

Renaming a Concurrent Flow Chart

Y ou can change the name of the active concurrent flow chart by choosing Rename Flow Chart
from the Diagram menu to display a Rename dialog box. The nameis also shown in the
window title for the flow chart. Thisnameis used to uniquely identify concurrent flow chartsin
the generated HDL but can also be specified when there are no concurrent flow charts defined.
If not specified, the name defaults to the value set in the flow chart preferences.

InaVerilog flow chart, the concurrent flow chart nameisused to label theinitial or always code
for each chart and can be used (for example, by a disable statement) to reference this code.
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Deleting a Concurrent Flow Chart

Y ou can delete a concurrent flow chart from a set of concurrent flow charts by using the
button or choosing Delete Flow Chart from the Diagram menu and sel ecting from the menu of
concurrent flow chart names.

When you select the name of a concurrent flow chart in thislist, you are prompted for
confirmation that the chart should be deleted. If you delete an open chart its window is closed.
Thetitlesfor al other chartsin the set of concurrent flow charts are updated. However, the
design explorer view is not updated until you save the flow chart.

Note
D Y ou cannot delete the last concurrent flow chart in the set.

Editing Flow Chart Object Properties

Y ou can edit the properties for an object (or objects) on aflow chart by using the button or
choosing Object Properties from the Edit or popup menu. An Object Properties dialog box is
displayed with separate tabs for Action Boxes, Decision Boxes, Wait Boxes, L oops, Casesand
Text objects.

Y ou can also edit most text properties (including object names, conditions and actions) directly
on the diagram by clicking to select the text and clicking again to edit the text.

Editing Action Box Object Properties

Y ou can edit the properties of one or more selected action boxes by using the button or
choosing Object Properties from the Edit menu or popup menu to display the Action Boxes
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tab of the Object Properties dialog box. Y ou can also display the tab directly by double-clicking
on an existing action box on the diagram.

H[} Object Properties E3

Action Boxes | [MecEion Baxes | whalt Baxes | [Loops | [Eazes | ext |

Mumber of selected action boxes: 1

M ame
’7 | mitialization v Wizible

™ Hierarchical

—Actiohz

# Hodify v “isible

ghopg="0"; LI

starks="0";
resets="0";
d«="0000000000";
wait_clock[2];
reseto="";
wait_clock(B];

resets="0"; -
Kl ¥

(] Cancel Apply Help L

The action box name must be unique and can only be applied to a single selected action box.

If you change a hierarchical action box to a non-hierarchical action box, the child flow chart
diagram (if it exists) and its contents are discarded. However, you can undo this change to
recover the hierarchical action box and its child flow chart. If you change an action box to a
hierarchical action box, any existing actions are transferred to a default action box in the child
flow chart.

Y ou can add or edit actions defined in the action box. If more than one action box is selected,
you can use the Modify check box to choose whether the actionsin the dialog box are applied to
al the sdlected action boxes.

Note

D An expression builder dialog box is automatically displayed when you begin to enter an
action. Refer to “Building aHDL Expression” in the State Machine Editors User Manual
for more information.

When you enter actions, the HDL syntax is automatically checked for the language of the
diagram you are using (VHDL or Verilog). However, flow chart syntax checking can be
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disabled by unsetting a preference. Note that you must include a terminating semi-colon for
each statement although line breaks and indents can be used to improve legibility.

Y ou can choose whether the action box name and actions are displayed or hidden on the
diagram.

Editing Decision Box Object Properties

Y ou can edit the properties of aone or more selected decision boxes) by using the button or
choosing Object Propertiesfrom the Edit menu or popup menu to display the Decision Boxes
tab of the Object Properties dialog box. Y ou can also display the tab directly by double-clicking
on an existing decision box on the diagram.

H[} Object Properties E3

Sction Bores  Decision Boxes | it Biores | [ oops | Cazes | Text |

Mumber of selected decizion boxes: 1

I ame
“Eheck_ﬁ Lzpend v Wizible

¥ Generate ELSIF [as appropriate]

— Canditian
v Maodify v Wizible
Thigh=high__temp] Al

AMD [low=low_temp)

o o

(] Cancel Apply | Help |
o

The decision box name must be unique and can only be applied to a single selected decision
box.

By default, if your flow chart uses nested decision boxes, combined ELSF (VHDL) or elseif
(Verilog) statements are generated for the false branch if the decision box is the first and only
statement on the false branch of another decision box.
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For example, c2 and c3 in the following example:

VHDL:

IF c1 THEN
actioni;
ELSIF c2 THEN
actionz;
ELSIF ¢c3 THEN
action3;
END | F;

Verilog:

if (cl) begin
actioni;

end

else if (c2) begin
action2;

end

else if (c3) begin
action3;

end

If your downstream tool does not support combined else and if, you can unset this option in the
dialog box or change the default behavior by unsetting the preference in the Miscellaneous tab
of the Flow Chart Preferences dialog box. However, these options are ignored and separate
instrumented else and if statements are always generated when the I nstrument for Animation
option is set in the Generation tab of the Flow Chart Properties dialog box.

Y ou can add or edit the condition defined in the decision box. If more than one decision box is
selected, you can use the Modify check box to choose whether the condition isapplied to all the
selected boxes.
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Note

D An expression builder dialog box is automatically displayed when you begin to enter a
condition. Refer to “Building aHDL Expression” in the State Machine Editors User
Manual for more information.

When you enter a condition, the HDL syntax is automatically checked for the language of the
diagram you are using (VHDL or Verilog). However, flow chart syntax checking can be
disabled by unsetting a preference.

Y ou can choose whether the decision box name and condition are displayed or hidden on the
diagram.

Editing Wait Box Object Properties

Y ou can edit the properties of one or more selected wait boxes by using the button or
choosing Object Propertiesfrom the Edit menu or popup menu to display the Wait Boxestab
of the Object Properties dialog box. Y ou can also display the tab directly by double-clicking on
an existing wait box on the diagram.

H[} Object Properties E3

Lctioh Bu:u:-:esl [ecizion Boges  ‘Wait Boxes | Lu:u:upsl Easesl Te:-:tl

Mumber of selected wait boxes: 1

—Mame

IWa'rH W isible

— Statement

# Hodify v “isible

wait until [[high="0000")AM D [love="0000"]) for G000 ns ; ;I

[

Examplez

wait [on SengtivityLizt] [untl Condition] [for TimeE sprezsion);
wait unkil clk ="1";

wait; - wait foreser

wait on clk until clk ='0%;

wait for 25 ng;

(] Cancel Apply Help

%

The dialog box allows you to enter any valid HDL statements for the current hardware
description language. Some examples of wait statements for the current language are given in
the dialog box.

350 Graphical Editors User Manual, V2008.1
September 18, 2008



Flow Chart Editor
Editing Flow Chart Object Properties

VHDL:

wait [on SensitivityList] [until Condition] [for Ti meExpression];
wait until clk ="1";

wait; -- wait forever

wait on clk until clk ="'0";

wait for 25 ns;

These can be inserted as templates by clicking on the required example with the L eft mouse
button.

The basic template for VHDL alows you to combine on, until and for clauses which may also
include valid arithmetic operators.

For example:

wait until ((high="000")AND(| ow="0000")) for 6000ns;
In Verilog, you can also use the @ operator to specify an event or # to specify atime delay:

wai t ( Expression);

@\arre;

@ event Expr essi on) ;

#Unsi gnedNunber ;

#Par amet er Nane;

#Const ant M nTypMaxExpr essi on;
#(M nTypMaxExpr essi on);

For example:

wait ((hi gh==4"'d0) &&(| on==4" d0));
@ posedge cl k);

#12;

#cl k_prd;

Note
D The default wait statement (wait;) corresponds to await for user interaction.

Verilog system functions such as $stop cannot be used in await box but can be used in an

action box.

When you enter await statement, the HDL syntax is automatically checked for the language of
the diagram you are using (VHDL or Verilog). However, flow chart syntax checking can be
disabled by unsetting a preference.

Y ou can choose whether the wait box name and statement are displayed or hidden on the
diagram.
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Editing Loop Object Properties

Y ou can edit the properties of one or more selected loops by using the button or choosing
Object Properties from the Edit menu or popup menu to display the L oops tab of the Object
Properties dialog box. Y ou can aso display the tab directly by double-clicking on an existing
wait box on the diagram.

By default, aloop will repeat forever. However, you can clear this option in the dialog box and
enter a specific loop control clause. Example clauses for repeat (if you are using Verilog), for
and while loops are given in the dialog box.

VHDL.:
FORi INO TO 15
VWHI LE i <16
Verilog:
repeat (n)
for (i=0;i<16;i=i+1)
while (i)

These can be inserted as templates by clicking on the required example with the L eft mouse
button.

H[3 Object Properties E3
Gtiom Baxes | [MecEion Baxes | Yl Boges  Loops | [Fazes | Tiext |
Mumber of selected loops: 1
—Mame
|L1 W Visible
— Loop Control
= Farever ¥ Specify V¥ Wisible
FORjIMNOTOS
Examples:
FORIINOTO1S
WHILE i<16
(] Cancel Apply Help
g
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When you enter aloop statement, the HDL syntax is automatically checked for the language of
the diagram you are using (VHDL or Verilog). However, flow chart syntax checking can be
disabled by unsetting a preference.

Y ou can a'so choose whether the loop name and loop control clause are displayed or hidden on
the diagram.

Editing Case Object Properties

Y ou can edit the properties of one or more selected case boxes by using the button or
choosing Object Propertiesfrom the Edit menu or popup menu to display the L oops tab of the
Object Properties dialog box. Y ou can also display the tab directly by double-clicking on an
existing case box on the diagram.

H[} Object Properties B3
Action Boxes | [Mecizion Boxes | Wiait Boxes | Logps ~ Cases | Text |
Murnber of zelected caszes: 1
I ame
“cﬂ v isible
Type of case: Il:ase vI
¥ Inzert Pragma: I.-".-" pragma parallel_caze full_case j
— Expreszion
W Madify W Wisible
addresz ;I
Walues:
1]
1
234
default
(] Cancel Apply Help
5

The case box name must be the same as the corresponding end case object and otherwise unique
on the diagram.
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If you are using Verilog, you can choose to use casex or casez comparison as an alternative to
the default bit comparison case style and you can insert the following pragmas to specify full
case or parallel case statements:

full _case All possible branches have been specified, any missing
branches cannot occur and a default branch need not be
generated.

paralel_case Branches are mutually exclusive.

parallel_casefull _case All possible branches have been specified and are mutually
exclusive.

Y ou can specify a case expression which can comprise any valid HDL statements entered as
free-format text (using multiple lines if required).

The dialog box also lists the existing output port names which should correspond to possible
values for the evaluated expression. These values can be edited by double-clicking over the
existing name in the dialog box to display a Rename dialog box.

Mew Caze Branch Mame:

[1

ak I Eancell

When you enter an expression or port name, the HDL syntax is automatically checked for the
language of the diagram you are using (VHDL or Verilog). However, flow chart syntax
checking can be disabled by unsetting a preference.

Y ou can aso choose whether the case box name and expression are displayed or hidden on the
diagram.

Setting Flow Chart Properties

There are anumber of properties associated with aflow chart which can be accessed from the
Flow Chart Properties dialog box. The following properties are shown as text objects on the
flow chart (or on the top-level diagram of ahierarchical flow chart):

Architecture or Module A list of user defined VHDL architecture declarations or
Declarations Verilog module declarations.

Concurrent Statements A statement block containing alist of concurrent statements
that are included in the generated HDL.
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Sensitivity List A list of signals which cause the corresponding process to
execute if any of the signals change.

Process or Local A list of statementswhich areincluded as process declarations

Declarations in the generated VHDL or aslocal declarationsin the

generated Verilog.

Concurrent statements and architecture or module declarations are applied to all concurrent
flow charts. However, process or local declarations and the sensitivity list are set separately for
each diagram in a set of concurrent flow charts.

Y ou can edit the flow chart properties by choosing Flow Chart Properties from the Diagram
menu to display adialog box with tab options for:

Generation
Architecture Declarations (VHDL only) or Module Declarations (Verilog only)
Process Declarations (VHDL only) or Local Declarations (Verilog only)

Setting Flow Chart Generation Properties

Y ou can set the HDL generation properties by choosing Flow Chart Propertiesfrom the
Diagram or popup menu and then selecting the Generation tab in the Flow Chart Properties
dialog box.
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For example, the following dialog box is displayed when you are using Verilog:

H[} Flow Chart Properties B3
Gieneration | todule Declarations | Concurrent Statements | Local Declarations |
— FlowChart —Reszet
* Sequential = Combinatarial Rieset Actions:
— Clock. w=2'b00 ; ;l
M ame: IEIk j
Fuolarity IHising j -
4 k
[Eamdition; I
& High M ame: Bzt -
— Sensitivity List = Low
" Specify: &+ Auto ¥ “isible  Specity Conditian:
< Automatic > LI  Mane Sersitivity
v [ Add Pragma
i _PI—I tode
— Block Tupe ’71[" Sunchronous % Asunchronous
i+ always = initial o
— Anirnation
@ begin/end " tark/jain [ Instument HOL For animation
(] Cancel | Apply Help
5

Note

[

Separate generation properties can be specified for each diagram in a set of concurrent
flow charts.

Sequential and Combinatorial Diagrams

Y ou can specify whether the flow chart is sequential or combinatorial.

A sequential flow chart changes state on active clock edges. An optional reset signal can be
used to perform specified reset actions.

A combinatorial flow chart operates independently of any clock and is typically used for
applying stimulus and testing resultsin atest bench.
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Clock Signal

When the sequential option is selected, you can enter the clock signal or choose from a
dropdown list of available input signals.

Y ou can also set the clock edge sensitivity.

For aVerilog view, you can choose Rising or Falling corresponding to posedge or negedge
sensitivity.

For aVHDL view, you can choose Rising, Falling, Rising Last, Falling Last. These options
generate the following VHDL clock edge expressions:

Rising clkEVENT AND clk ='1'
Falling clkEVENT AND clk ='0'
Rising Last clkEVENT AND clk ='1' AND clk'LAST_VALUE ="0'
Falling Last clkkEVENT AND clk ='0' AND clk'LAST_VALUE="1'

Alternatively for either language, you can choose Specify to enter any other valid edge
condition.

Reset Signal

When the sequential option is selected, you can enter alist of reset actions and enter a
synchronous or asynchronous reset signal (or choose from a dropdown list of available input or
internal signals). Y ou can choose to trigger the reset on aHigh or Low level signal (or choose
Soecify to enter any other valid reset condition).

If you have specified aVerilog reset condition, you must also specify any additional signals
required in the sensitivity list. (Multiple signals should be separated by an OR operator.)

Y ou can optionally set pragmas (sync_set_reset _local or async_set reset_local) which identify
the name of the currently specified synchronous or asynchronous reset signal.

Note
The pragmas are entered using the keyword (pragma, synopsys or exemplar) preference
set in the Style tab of the VHDL or Verilog Options dialog box.

Sensitivity List

Y ou can also specify a sensitivity list of signals which cause the corresponding process to
execute if any of the signals change. Multiple signals should be separated by the comma
character for VHDL and by an or when using Verilog.
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Y ou can choose whether the sensitivity list is visible or hidden on the diagram. If the user-
entered list isvisible, it can also be edited by direct text editing on the diagram.

If the sengitivity list is not specified it is shown as <Automatic> in the dialog box and is
automatically created during HDL generation using to the following rules:

Sequential with synchronous or no reset <clock name>

Sequentia with asynchronous reset <clock name>, <reset name>

Combinatorial All input and internal signals
Block Type

For Verilog designs, you can specify whether initial or always style code is generated. Y ou can
also choose whether the generated code is contained between begin and end statements or using
fork and join statements.

Animation

Y ou can choose to instrument the HDL for animation. When this option is enabled, activity
information is available for flow chart animation. Thisis achieved by additional code included
in the generated HDL. The additional code is surrounded by translation control pragmas which
ensure that it isignored by downstream synthesis tools.

The HDL generated for nested decision boxes on aflow chart is normally created with ELSI F
statements for each decision box. However, separate EL SE and | F statements instrumented by
animation pragmas are generated when you choose the I nstrument HDL for Animation
option. Y ou should regenerate HDL with the animation option unset if you want to use the
generated HDL for synthesis.

Note

Note that you cannot instrument the generated HDL for animation when aflow chart is
used to define an embedded view in ablock diagram.

The new flow chart properties are set when you confirm the dialog box.

Note

[

The generation properties (other than the sensitivity list) are not normally shown on the
diagram. However, you can set preferencesin the Header stab of the VHDL and Verilog
Options dialog boxes to include the generation properties as comment text after the
header in the generated HDL..
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Editing Architecture or Module Declarations

Y ou can edit architecture declarations (when using VHDL) or module declarations (when using
Verilog) by choosing Flow Chart Properties from the Diagram or popup menu or by double-
clicking over the Architecture Declarations (VHDL) or Module Declarations label (Verilog) on
the diagram.

The Architectur e Declar ations (or the M odule Declar ations) tab of the Flow Chart Properties
dialog box is displayed which allows you to enter any valid HDL statements for the current
hardware description language in afree-format entry box.

Signal declarations, constants, variables, comments, procedures, functions or type definitions
can be included in the declaration.

Typicaly aVHDL declaration, comprises a keyword (signal, constant or variable) followed by
aname, type and value. The specified type must be one of the standard predefined types or a
type defined in aVHDL package. An initial valueis required when the declaration is a constant
but is optional when you declare asignal or variable.

A typical Verilog declaration, comprises a keyword followed by appropriate parameters as
given below:

Table 8-3. Verilog Declarations

Keyword Parameters

'define name value

parameter name value

reg range (optional)! name array (optional)
integer name array (optional)

real name

time name array (optional)

wire range (optional) name array (optional)

1. Verilog range and array parameters should be entered in the format [m:n].
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For example, the following picture shows the Flow Chart Properties dialog box being used to
enter an architecture declaration:

H[} Flow Chart Properties E3
Generation | Architecture Declarations T Concurrent Statements T Procesz Declarations ]

Architecture Declarations:

v Wizible

COMSTAMNT clk_prd : time =100 ns; ;I
SIGMAL iclk : std_logic;

SIGHAL high_temp : stel_logic_vectar[3 DOWMTO 0);

SIGMAL low_temp : std_logic_vector[3 DOwWMTO O);

PROCEDURE wait_clock[COMSTAMT clk_ticksinteger] 15
WARIABLE i : integer:=10;
BEGIM
FORiIM OTO clk_ticks LOOP
WAl T UMTIL rizing_edaeliclk);
EMD LOOF;
EMD wait_clock;

o o

(] Cancel Apply | Help

%

The declarations are inserted at the top of the VHDL architecture or Verilog modulein the

generated HDL in the order they are listed and apply to al diagramsin a set of concurrent flow
charts.

The syntax is checked and the declarations are added as a text object on the flow chart (or the
top level diagram when you are editing a hierarchical flow chart) when you confirm the dialog
box.

Y ou can choose whether the declarations are visible or hidden on the diagram.

Note

D Architecture declarations or module declarations cannot be set when aflow chart is used
to define an embedded view in ablock diagram or IBD view. However, any declarations
required by the embedded view can be set on the parent view.

Editing Concurrent Statements

Y ou can edit concurrent statements by choosing Flow Chart Properties from the Diagram or
popup menu or by double-clicking on an existing Concurrent Statements label on the diagram.

The Concurrent Statementstab of the Flow Chart Properties dialog box provides afree-format
entry box for you to add or edit these HDL statements.
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Y ou can also choose whether the concurrent statements are visible or hidden on the diagram (or
on the top level diagram when you are editing a hierarchical flow chart).

H[j Flow Chart Properties E

Generation T Architecture Declarations T Concurrent Statements T Procesz Declarations ]

Concurrent Statements;

v Wizible

ClockGen : PROCESS
BEGIM

iclk <="0";

WelT FOR clk_prd/2:

iclk <="1";

WelT FOR clk_prd/2:
EMD PROCESS ClockGen;

=

clk <= iclk;
4] _>I_I
(] Cancel Apply | Help |
p
Note

D An expression builder dialog box is automatically displayed when you begin to enter a
concurrent statement. Refer to “Building aHDL Expression” in the Sate Machine
Editors User Manual for more information.

The edited statements are added to the diagram when you confirm the dialog box.

When you enter statements, the syntax is automatically checked for the hardware description
language of the active diagram. However, flow chart syntax checking can be disabled by

unsetting a preference.

Concurrent statements are included in the generated HDL at the end of the VHDL architecture
or Verilog module and are applied to all diagramsin a set of concurrent flow charts. They are
executed concurrently with al of the processes (or always blocks) in the flow chart and are
typically used for additional datapath operations or specialized clocking.

Y ou can also edit the statements directly on the diagram by clicking on the action to select the

text and clicking again to edit the text.
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Editing Process or Local Declarations

Y ou can add or edit flow chart process declarations (when using VHDL) or local declarations
(when using Verilog) by choosing Flow Chart Properties from the Diagram menu or by
double clicking on the Process Declarations (VHDL) or Local Declarations (Verilog) label on
the flow chart.

The Process Declar ations (or L ocal Declar ations) tab of the Flow Chart Properties dialog box
allows you to add or edit declaration statements within a\VVHDL process or within alocal
Verilog initial or always block. These tabs are typically used to declare constants and
parameters (or for 'define statements when using Verilog).

H[} Flow Chart Properties E3

Generation T Architecture Declarations T Concurrent Statements T Procesz Declarations ]

Processz Declarations: ¥ “isible

WARIABLE d_war : std_logic_wector[3 DOWMNTO 0] ;= "0000000000"; ;I
WARIABLE b_war : std_logic_vector[3 DOWMNTO 0] := "0000";

(] Cancel Apply | Help |

Y ou can aso choose whether the declarations are visible or hidden on the diagram.

For aVHDL flow chart, process declarations are placed at the beginning of the process
immediately before the BEGIN keyword in the generated HDL.

For aVerilog flow chart, local declarations are placed after theinitial (or always) keyword in
the generated HDL.. (Y ou can choose whether initial or always code is generated using the
Generation tab of the dialog box.)

Separate process declarations can be specified for each diagram in a set of concurrent flow
charts.

The edited statements are added to the flow chart when you confirm the dialog box.
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Y ou can also edit the statements directly on the diagram by clicking to select the text and
clicking again to edit the text.

The syntax is automatically checked when you enter VHDL statements. However, flow chart
syntax checking can be disabled by unsetting a preference.

Setting Flow Chart Preferences

Y ou can set flow chart preferences by choosing Flow Chart from the M aster Preferences
cascade of the Options menu in the design manager.

The Flow Chart Preferences dialog box has separate pages for Gener al, Default Settings,
Object Visbility, Appearance and Background preferences.

Note

D The general, default settings and object visibility preferences take effect on the next flow
chart you open and can only be edited when the dialog box is displayed from the M aster
Pr efer ences cascade in the design manager Options menu. These pages are not available
when you choose Diagram Preferencesin aflow chart window.

The Appear ance page allows you to set default visua attributes for individua flow chart
objects.

Hla Flow Chart Preferencesz - Untitled [procesz0]

Action Box Actions — Color — Style

Action Baox N .
EES'E”F-DT ame Foreground | j Fill Style |i j

Caze Port Walue

Comment Box i

e o Background I j Line Style l:j
Decizion Box
Decizion Box Condition Line Calar <l | Line width .
Decizion Box Mame -J ;J
Decizion Box True/Falze Label
End Caze

End Caze Label [
End Loop

End Loop Label
End Paint

End Paint Label —Apply Changes to
E:Ex Connect i+ Mew Objects = Mew and Existing Objects
Flows Join

Hier. Action Box
Hier. Action Box Marne LI

— Fant

Changes apply to objectz in thiz diagram only

The master preferences can be acceszed from the Design Browser k. Cancel Help
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The attributes include the foreground and background colors, line color and style, fill style, line
width and the text font. Some attributes may not always be available. For example, line style,
width and color attributes are not available for atext object.

Refer to “ Setting Visual Attributes’ on page 78" for more information.

This page can also be edited by choosing Diagram Pr efer ences from the Optionsmenuin a
flow chart. When you edit preferences for the active diagram, the dialog box allows you to
choose whether the preferences are applied to new objects or to both new and existing objectsin
the flow chart (including concurrent or hierarchical diagrams).

Y ou can save the appearance preferences set on the active diagram as master preferences by
choosing Update from Diagram in the Master Prefer ences cascade of the Options menu or
you can apply the master preferences to the active diagram by choosing Apply to New Objects
or Apply to New and Existing Objects.

The General page allows you to set other flow chart options:

HlaFIuw Chart Master Preferences
General
= Default Settings
Default Properties General Info
Object Visibility W Check syntax on ety
Appearance
Backaround [v Generate ELSIF

Default zave name: {fow

k. | Cancel Help

These options include syntax checking, an option to generate EL SIF statements and the default
save name for flow charts.
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The Default Settings page allows you to set flow chart default values:

HlaFIuw Chart Master Preferences
General Drefault Settings
=g [ efault Settings
Default Properties Crefault [nfa
Object Visibility Decizion box condition: ||:|:|n|:|iti|:|n
Appearance ;
Background Case expression: |e:-:pressiu:un

Case port value: |valuelj

Concurrent flow chart name: |p,,:,,3333|:|

Action boy best

actions; J

o

k. | Cancel | Help |

Y ou can set default names for decision box conditions, case expressions and port values, the
concurrent flow chart name and the default actions used in an action box.

Y ou can use the Default Properties sub-page to define default properties for flow chart views.

HlaFIuw Chart Master Preferences o
General Drefault Properties
= Default Settings

Drefault Properties
Object Yigibility
Appearance
Backaround

Specify default properties in the table below

Class MHarme Yalue

k. | Cancel Help

Refer to the HDL Designer Series User Manual for information about “Using View Property
Variables’.
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The Object Visibility allowsyou to set the default object visibility for multi-line text objects on
the diagram.

HlaFIuw Chart Master Preferences

General Object Wisibility
= Default Settings

Default Properties Architecture Declarations [YHDL)

/izibility Compiler Directives [Verlog)
Appearance Concurrent Statements
Backaround

Local Declarations [Verlog)
Module Declarations [Verlog)
Package List YHDL)
Process Declarations [WHOL)
Sensitivity Lisgt

k. | Cancel Help

Refer to “ Changing Text Visibility” on page 63 for more information.

The Background page allows you to control the diagram background color and grid attributes
used by the flow chart editor.

HlaFIuw Chart Master Preferences

General Backaround
= Default Settings

Default Properties [ Gnd

DbiECt l"."IISI|:II|I'£_|r| [V Show Grid
Appearance

Background Cilor _ j

Digplay horizontal grid even 1 puoirt
Dizplay vertical and ewvery 1 puoirt

Driagram

B ackaground colar white -
k. | Cancel | Help

These preferences are described in * Setting Background Preferences’ on page 50.

Refer to the “ Default Preferences’ appendix in the HDL Designer Series User Manual for lists
of the default preferences set when you invoke a HDL Designer Seriestool for the first time.
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Chapter 9
Truth Table Editor

This chapter describes how a design function can be represented as a matrix of true or false
input signals and their resultant output signal (or signals). This truth table can be used to
describe adesign unit view of any block or component in ablock diagramor IBD view and HDL
can be generated from the truth table.

Truth Table Notation. . . ... . e 369
Comparison OPEIELOrS . . . ...ttt ettt e e e e e e e 370
Truth TableToolbars ... ... e e e 370
EditingaTruth TableCel . ... ... e 370
AddingaColumn Or ROW . . . ..o e e 371
Deletinga Column or ROW . ... ... o 371
Setting Truth Table Properties. . . ... e 371
Setting Truth Table Generation Properties. . ...t 372
Editing Architecture or Module Declarations. .. .......... ... ... . ... 376
Editing Concurrent Statements. . .. ... ..o 377
Editing Processor Local Declarations . . ... ... oo 377
Editing Global ACtioNns. . ... ... 378
Cascand IF StyleTruth Tables . ... e 379
Setting Truth Table Preferences. . . ... ..o i e e 381

A truth table may typically be used to convert between digital and analog data input signalsto
describe a decoder or multiplexor function.

The truth table editor is implemented as a spreadsheet which supports extended behavioral and
comparison functions as well as simple combinatorial or sequential truth tables.

A sequential truth table can be defined by setting clock and reset information as generation
properties which are added to the VHDL process (or Verilog module) when HDL is generated
for the truth table.

The syntax and semantics of the truth table are checked during HDL generation and the cells
corresponding to any errors encountered are highlighted on the truth table.

When you create a new truth table as a child view from within a block diagram or IBD view, an
input column is automatically created for each input port and an output column for each output

Graphical Editors User Manual, V2008.1 367
September 18, 2008



Truth Table Editor

port. Alternatively, you can set preferences for the initial number of columns and rowsin anew
truth table which has no parent view.

Hla Sequencer_vlg/accumulator /thl * {Truth Table) =]
File Edit “iew HDL Table Tasks Options ‘Window Help

[B-«2aEH&E 4/ = _2o «
|8 £ U|= P
|[&-W -7 -@- -9 -
| » | n | c |

Id ine ap

ap+1
ap

ENEEEE
.

-
=
|Jasmmg mmﬁnm' |:

i

Ready

In the following example, the output ser_if data is assigned the value of the xmitdt, recvdt or
status input registers depending on which enable signal is set. For any other inputs, the output is
assigned the value "00000000".

A B C (1]
1_ =mitdt_en status_en recwvdt_en ser_jf_data
? ' wmitdt
? 1 status
T Bk recrdt
? "oooaoooo”
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Truth Table Notation

The truth table editor displays a spreadsheet containing input and output columns. The columns
are numbered using al phabetic characters and rows using numeric characters so that any cell can
be uniquely referenced. (For example, C4 references the cell in column C, row 4.)

Inputf“-.l:"ariables Outputf"-.-"ariable
& g~ c [ b | £ | F |

BETHE R ratprat
2 o o 0
B 0t gl 1 Ot
N = o g Caolumn
] 5
B
7w 0 0
B ; 1 Bitemal="0 1
E R / 1 Eitemal=Y 4 Additional
o ] o S 2 Etemale=1] Action
11 EE
- by KX

Input Columns Additional Conditions

The first row is aheader row which contains the names of input and output variables (typically
an input, output or bidirectional net name). Subsequent rows may contain avalue for the
variable (which assumes the equality operator), an expression preceded by a comparison
operator or a more complex expression.

For example, the scalar VHDL value'1' corresponds to the default expression <input variable>
= true.

The output column (or columns) typically contain an expression defining the value of an output
variable (or variables). An empty row of input cells (such asrows5 or 11 in the picture above)
represents the OTHERS condition which assigns output values when none of the input
expressions are true.

Y ou can use an empty row of input and output cells (such asrow 6 in the picture above) to
separate groups of cells. These cells are described by separate If or Case statements when HDL
is generated for the truth table.

Additional conditions (for example, an expression using an internal signal or variable name) can
be added in one or more unnamed input columns and additional actions added in unnamed
output columns. The conditions or actions are generated in the order of the columns.

All values, expressions, conditions and actions must be valid for the hardware description
language. If any syntax errors are encountered during HDL generation, an error message is
issued and the corresponding cells are highlighted on the truth table.
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Truth Table Toolbars

There is no toolbar specific to the truth table. However the standard, HDL tools, tasks and
format text toolbars are available.

Refer to the HDL Designer Series User Manual for general information about these toolbars
and general information about the HDL Designer Series user interface.

Editing a Truth Table Cell

Y ou can add text to atruth table editor cell by ssmply selecting the cell and typing the required
expression. Any existing text is overwritten or you can double-click in a cell to explicitly add
new or edit existing text characters.

VHDL scalar values should be entered in single quotes (for example: ‘0" or '1'; VHDL array
values should be entered in double quotes (for example: "00000000" or "101"). Verilog scalar
values should be entered without quotes (for example: 0 or 1; VHDL array non-decimal values
should be entered with a width and base prefix (for example: 3'b101, 8'b00000000 or
15'h107d).

By default, you can add or edit asingle line in each cell. However, you can allow multiple lines
in any cell by choosing Change To Multi-line from the Table or popup menu or return to
single line mode by choosing Change To Single-line. Multi-line cells are outlined to
distinguish them from single-line cells and are highlighted with a red background when
selected.

Note

D The[ % | key isdisabled and the key creates anew line when multi-line mode

isenabled. If you change amulti-line cell to single-line, the cell contents are concatenated
on oneline.

Refer to “ Table Editor Windows’ on page 81 for information about selecting, editing and
resizing table cells.

Comparison Operators

When you enter avalue in atruth table input column, the equality operator is assumed by
default. However, any of the following operators can be used:

Operator VHDL Verilog
equal (default) = ==or ===
not equal /= I=or!l==
less than < <
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greater than > >
less than or equal <= <=
greater than or equal >= >=

Note
D Expressions using the === or !== operators are not synthesizable.

Adding a Column or Row

Y ou can add a column to atruth table by choosing Add Column from the Table or popup
menul.

If more than one cell is selected, the corresponding number of new columns are added to the | eft
of the selected column(s). If the selected cells are input columns, the new columns are added as
input columns. If the selected cells are output columns, the new columns are added as output
columns. If the selected cellsinclude both input and output columns the new columns are added
as input columns.

Y ou can add arow to atruth table by choosing Add Row from the Table or popup menu.

If more than one cell is selected, the corresponding number of new rows are added above the
selected row(s). However you cannot add rows when the header row is selected.

Deleting a Column or Row

Y ou can delete a column or group of selected columns from atruth table by choosing Delete
Column from the Table or popup menu. However, you cannot delete all the columns. All truth
tables must contain at least one input column and one output column.

Y ou can delete arow or group of selected rows from atruth table by choosing Delete Row from
the Table or popup menu. However, you cannot del ete the header row and there must be at least
one row for input comparison and output assignment.

Setting Truth Table Properties

Y ou can edit the truth table properties by choosing Truth Table Properties from the Table
menu to display the Truth Table Properties dialog box with tab options for:

Generation Y ou can specify a sequential or combinatorial truth table
generated with If or Case statements and specify the
sengitivity list.
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Architecture or Module A list of user defined declarations which are included at the

Declarations start of the VHDL architecture or Verilog module in the
generated HDL.

Concurrent Statements A list of concurrent statements that are included at the end of
the VHDL architecture or Verilog module in the generated
HDL.

Process or Local A list of statements which are included at the start of the

Declarations process in the generated VHDL or at the start of the local

always code in the generated Verilog.

Global Actions Common actions that are always performed when the truth
tableis evaluated.

Note
D Y ou can set preferencesin the Header stab of the VHDL and Verilog Options dialog

boxes to include the generation properties as comment text after the header in the
generated HDL.

Setting Truth Table Generation Properties

Y ou can set the HDL generation properties by choosing Truth Table Properties from the
Table menu and then selecting the Generation tab in the Truth Table Properties dialog box.

372 Graphical Editors User Manual, V2008.1
September 18, 2008



Truth Table Editor
Setting Truth Table Properties

For example, the following dialog box is displayed when you are using Verilog:

H[} Truth T able Properties B3

Generatian | Madule Declarations | Concurent Statements | Local Declarations | Global Actions |

e

— Table —Reset
& Sequential ¢ Combinatorial Rieset Actiors:
~HDL Style = 2h00: B
& " Case [ooe j
¥ | Generate default for Caze P . | N
— Clock " High  Mame: IHSt j
Mame: IEIk j &L
* Low
Folarity: IHising =] (" Specily Cordiion I
Earditiar I ® 0 Seniviy I
[ Add Pragma
— Sensitivity Ligt i ode
& futo " Specify ’7(' Spnchronous % Asynchronous
<AUTOMATICS 2l

— Full/Parallel Caze
[ Insert Pragma:

I A pragma full_case j

—Azzighment bpe:

I Blocking j

Sequential and Combinatorial Diagrams

Y ou can specify whether the truth table is sequential or combinatorial.

A sequential truth table changes state on active clock edges. An optional reset signal can be
used to perform specified reset actions.

A combinatorial truth table operates independently of any clock and is typically used for

decoding an address bus.

HDL Style

Y ou can specify whether HDL is generated using If or Case styles. When Case style is selected
you can choose to generate a default Others condition when not this condition is not specified

by an empty input row in the truth table.
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When using Verilog, you can also choose to use casex or casez comparisons as an alternative to
bit comparison (case).

Note

D If you choose Case style, and invalid cells are encountered during HDL generation, a
warning isissued and generation is attempted using If style. If the truth table contains
multiple blocks of cells, any cell blocks which are not valid for Case style may be
generated using If style resulting in generated HDL which contains both If and Case
constructs.

Refer to “ Case and IF Style Truth Tables’ on page 379 for more information.

Clock Signal

When the sequential option is selected, you can enter the clock signal or choose from a
dropdown list of available input signals.

Y ou can also set the clock edge sensitivity.

For aVerilog view, you can choose Rising or Falling corresponding to posedge or negedge
sensitivity.

For aVHDL view, you can choose Rising, Falling, Rising Last, Falling Last. These options
generate the following VHDL clock edge expressions.

Option Expression

Rising CclkkEVENT AND clk ="1'

Falling CclkkEVENT AND clk ='0r

Rising Last clkkEVENT AND clk ="' AND clk'LAST_VALUE="0'
Falling Last clkkEVENT AND clk ='0' AND clk'LAST_VALUE="1'
Rising edge rising_edge(clk)

Falling Edge falling_edge(clk)

Alternatively for either language, you can choose to specify any other valid edge condition.

Reset Signal

When the sequential option is selected, you can enter alist of reset actions and enter a
synchronous or asynchronous reset signal (or choose from a dropdown list of available input or
internal signals). Y ou can choose to trigger the reset on aHigh or Low level signal (or choose
Soecify to enter any other valid reset condition).
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If you have specified a Verilog reset condition, you must also specify any additional signals
required in the sensitivity list. (Multiple signals should be separated by an OR operator.)

Y ou can optionally set pragmas (sync_set reset_|local or async_set_reset_local) which identify
the name of the currently specified synchronous or asynchronous reset signal.

Note
The pragmas are entered using the keyword (pragma, synopsys or exemplar) preference

set in the Style tab of the VHDL or Verilog Options dialog box.

Sensitivity List

Y ou can also specify a sensitivity list of signals which cause the corresponding process to
execute if any of the signals change. Multiple signals should be separated by the comma
character for VHDL and by an or when using Verilog.

If the sensitivity list is not specified it is shown as <Automatic> in the dialog box and is
automatically created during HDL generation using to the following rules:

Sequential with synchronous or no reset <clock name>
Sequentia with asynchronous reset <clock name>, <reset name>
Combinatorial All input and internal signals

Full/Parallel Case

When you are using Verilog, you can insert pragmas to specify full case or parallel case
statements:

full _case All possible branches have been specified, any missing
branches cannot occur and a default branch need not be
generated.

paralel case Branches are mutually exclusive.

parallel_casefull _case All possible branches have been specified and are mutually
exclusive.

Assignment Type

When you are using Verilog, you can also choose whether Blocking assignments, specified by
the = operator or Non Blocking assignments specified by the <= operator are used in the
generated HDL..
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Editing Architecture or Module Declarations

Y ou can edit architecture declarations (when using VHDL) or modul e declarations (when
using Verilog) by choosing Truth Table Properties from the Table menu.

The Architectur e Declar ations (or the M odule Declar ations) tab of the Truth Table
Properties dialog box is displayed which allows you to enter any valid HDL statements for the
current hardware description language in a free-format entry box.

For example, the following picture shows the Truth Table Properties dialog box being used to
enter an architecture declaration:

H[} Truth T able Properties B3

Generation  Architecture Declarations | Concurrert Statements | Process Declarations | Global Actions |

Architecture Declarations:

SIGMAL decodex:std_logic_wectar[3 DOWMTO 0); ;I

o o

ak I Cancel | Help |

%

Terminating semi-colons should be included for all statements entered in the dialog box. No
syntax checking is performed when the dialog box is applied to the truth table. However, syntax
and semantic checks are performed when you generate HDL for the truth table.

Note

D Architecture declarations or module declarations cannot be set when atruth table is used
to define an embedded view in ablock diagram or IBD view. However, any declarations
required by the embedded view can be set on the parent view.

For more information about declarationsrefer to “ Editing Architecture or Module Declarations”
on page 359 in the Flow Chart Editor chapter.
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Editing Concurrent Statements

Y ou can edit concurrent statements by choosing Truth Table Properties from the Table
menul.

The Concurrent Statements tab of the Truth Table Properties dialog box provides afree-
format entry box for you to add or edit free-format HDL statements.

H[} Truth T able Properties B3

Generation | Architecture Declarations  Concurrent Statements | Process Declarations | Global Actions |

Concurrent statements:

int_clk <= nat int_clk AFTER clk_prd / 2; ;l
clk <= int_clk;

o o

ak I Cancel | Help |

%

Terminating semi-colons should be included for all statements entered in the dialog box. No
syntax checking is performed when the dialog box is applied to the truth table. However, syntax
and semantic checks are performed when you generate HDL for the truth table.

Concurrent statements are included in the generated HDL at the end of the VHDL architecture
or Verilog module. They are executed concurrently with all of the processes (or always blocks)
in the truth table and are typically used for additional datapath operations or specialized
clocking.

Editing Process or Local Declarations

Y ou can add or edit truth table process declarations (when using VHDL) or local declarations
(when using Verilog) by choosing Truth Table Properties from the Table menu.
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The Process Declar ations (or L ocal Declar ations) tab of the Truth Table Properties dialog box
allows you to add or edit declaration statements within a VHDL process or within alocal
Verilog always block.

These tabs are typically used to declare constants and parameters (or for 'define statements
when using Verilog). For example, the following picture shows the Truth Table Properties
dialog box being used to enter a constant process declaration:

H[} Truth Table Properties B3

Generation | Architecture Declarations | Concurrert Statements  Process Declarations | Global Actions |

Procesz Declarations:

COMSTAMT zer_data : std_logic_vectorf DOWMNTO 0] ="110011710"; ;I

< _*ILI
ak I Cancel | Help |

%

For aVHDL truth table, process declarations are placed at the beginning of the process
immediately before the BEGIN keyword in the generated HDL..

For aVerilog truth table, local declarations are placed after the always keyword in the generated
HDL.

Terminating semi-colons should be included for all statements entered in the dialog box. No
syntax checking is performed when the dialog box is applied to the truth table. However, syntax
and semantic checks are performed when you generate HDL for the truth table.

Editing Global Actions

Y ou can add or edit the global actions for atruth table by choosing Truth Table Properties
from the Table menu to display the Truth Table Properties dialog box.
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The Global Actionstab of the dialog box allows you to add or edit HDL statements which are
included in the generated HDL for the truth table as default actions which are always
performed.

H[} Truth Table Properties B3

Generation | Architecture Declarations | Corcurent Statements | Process Declarations  Global Actions |
Global Actions:

we="0] ;I

c="1"

o o

ak I Cancel | Help |

%

Terminating semi-colons should be included for all statements entered in the dialog box.

No syntax checking is performed when the dialog box is applied to the truth table. However,
syntax and semantic checks are performed when you generate HDL for the truth table.

Case and IF Style Truth Tables

The HDL generated for atruth table is usually described using If-Then-Else constructs but you
can optionally set the generation properties to use Case style code.

Case statements can often be more efficiently synthesized because the Case statement does not
imply priority between the available choices.

When you use an If statement, priority isimposed by the order in which conditions are
specified.

When you are using If-Then-Else style code, individual input cellsin the truth table matrix can
be left empty and are treated as "Don't Care" values by HDL generation.

In aCase styletruth table, values must be assigned for al input cellsin the matrix (although you
can use a specific "Don't Care" character if one is supported by your downstream tools).
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However, each separate block of cells (which correspond to separate Case statements) may
include empty columns.

A Case styletruth table (or block of cells representing a Case statement) may contain asingle
input expression or multiple input expressions.

If the generation properties are set to Case style and invalid cells are encountered during HDL
generation, awarning isissued and generation is attempted using If-Then-Else constructs.

If the truth table contains multiple blocks of cells, any cell blocks which are not valid for Case
style are generated using If-Then-Else style (if valid) resulting in generated HDL which contains
both If and Case constructs.

Note
Case style HDL cannot be generated when additional conditions have been entered in the

truth table.

Case Style with a Single Input Expression

For asingle input expression, possible values of the input expression are entered in asingle
column and the corresponding output values entered under each output column.

The resulting CASE construct is based purely on the values of this input expression.

An option Others (or Default) can be specified using a blank input value with output values
specified. If not specified, the default VHDL valueis"null".

Blank input expression cells are not allowed except for the Others row. Any type of input
expression is allowed as for If-Then-Else style.

Case Style with Multiple Input Expressions

For multiple input expressions, possible values of each input expression are entered under each
input column and the corresponding output val ues entered under each output column.

All scalar input expressions must be of the SAME type and either:

std_l ogic
std_ul ogic

All array input expressions must be of the SAME type and either:

std_ul ogi c_vector
std_l ogi c_vector
si gned

unsi gned
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In VHDL, acase expression must be an enumeration, integer, physical or aone dimension array
and locally static. Hence, alocal variable is required to contain the concatenation of the input
expressions being considered for agiven block of cells.

The name of thislocal variable must have the form:

<bl ockname>_<i nput expression 1> <input expression N> ...

The resulting name must be avalid VHDL identifier, so care must be taken to modify any
characters which may be legal in and expression but not in the concatenated name.

The type of the concatenated variable will be either:

std_ulogic_vector if al inputs are std_ulogic or std_ulogic_vector
std_logic_vector if inputs are amix of std_logic_vector and std_ulogic_vector
std_logic_vector if all inputs are scalar and of type std_logic

or the type of the inputs buses, if there are any.

Y ou cannot mix std_ulogic, std_ulogic_vector with signed or unsigned.

Note
D If scalar values (in single quotes) are concatenated with other scalar values or with array

values (in double quotes) the result is always an array value (in double quotes).

The size of the concatenated variable is the sum of the individual sizes (ranges) of the input
expressions being concatenated for that particular block of cells. However, thisis not
necessarily the width of the ports or input declarations since the input expression can be any
expression.

Verilog does alow direct concatenation within the case expression itself, hence a concatenation
variableis not required. However, the concatenated values must be prefixed with the total
width, for example: 4'b 0101

Setting Truth Table Preferences

Y ou can set truth table preferences by choosing Truth Table from the Master Preferences
cascade of the Options menu in the design manager.

The Truth Table Preferences dialog box has separate pages for setting the default table Gener al
options, Default Properties and Appear ance.
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Note
D The general and default preferences take effect on the next truth table you open and can

only be edited when the dialog box is displayed from the Master Prefer ences cascade in
the design manager Options menu. These pages are not available when you choose
Diagram Preferencesin atruth table window.

The Appear ance page allows you to set default visual attributes for individual truth table
objects.

Hla Truth Table Preferences - Sequencer_vlg/accumulator /thi
GEEENEE  |Appearance

Input Colurnn

|hput Expreszion

Output Calumn Fareground ~| Background -

Output Expresgion 2 J 2 J

Teut Fant

Set...
Apply Changes to
* Mew Objects © Mew and Existing Objects
Changes apply to objectz in thiz diagram only
The master preferences can be acceszed from the Desgign Browser k. | Cancel Help

The attributes include the foreground and background colors, line color and style, fill style, line
width and the text font. Some attributes may not always be available. For example, line style,
width and color attributes are not available for atext object. Refer to “* Setting Visual
Attributes’ on page 78" for more information.

When you are setting master preferences, you can also set the highlight color for syntax errors.
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The General page allows you to set the column width and the row height. Y ou can also set the
initial number of columns and rows for a new truth table which has no parent view. There must
be at least two columns which are split evenly between input and output columns.

I"laTrul:h Table Master Preferences

General
Default Properties

Appearance LayOut

Colurnn ‘Width: 100 Row Height: a0
MNurmber OF Colurns: g MNurmber OF Rows: |5

[+ Show Emors On HDL Generation

k. | Cancel Help

Note

[

Note that when atruth tableis created as achild view from ablock diagram, IBD view or
symbol, an input column is created for each input signal and an output column for each
output, buffer or bidirectional signal.

The HDL syntax in atruth table is not checked on entry. However, you can set a master
preference to specify that the syntax is checked during HDL generation. If thisoptionis
enabled, cells with syntax errors are highlighted when HDL is generated for the view.

The Default Properties page alows you to define default user properties for truth table views.

I"laTrul:h Table Master Preferences

General Default Properties

Drefault Properties

Appearance

Specify default properties in the table below

Class MHarme Yalue

k. | Cancel Help

Refer to the HDL Designer Series User Manual for information about “Using View Property
Variables’.
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The appearance and default properties preferences can also be edited by choosing Diagram
Pr efer ences from the Options menu in atruth table.

The diagram preferences dialog box allows you to set the background color for each type of cell
in the truth table and the foreground color and font used for cell text.

Note
D The foreground color for cells and background color for text isignored.

When you edit preferences for the active diagram, the dialog box allows you to choose whether
the preferences are applied to new objects or to both new and existing objectsin the truth table.

Diagram preferences effect the active truth table view only. The master preferences take effect
on the next truth table you open but do not effect any truth tables that are already open.

Y ou can save the appearance preferences set on the active diagram as master preferences by
choosing Update from Diagram in the M aster Prefer ences cascade of the Options menu or
you can apply the master preferences to the active diagram by choosing Apply to New Cellsor
Apply to New and Existing Cells.

Refer to the “ Default Preferences’ appendix in the HDL Designer Series User Manual for lists
of the default preferences set when you invoke a HDL Designer Seriestool for the first time.
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This chapter describes how you can convert HDL text viewsto editable graphical views. You
can also choose to visualize any HDL individual view as agraphical view.
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Design Extraction

The HDL Designer Seriestools incorporate HDL2Graphics technology which can read any
VHDL, Verilog (or mixed VHDL and Verilog) design and convert the structure of the source
design code to amore easily maintainable hierarchy of design unit views while fully preserving
the original behavior.

The HDL Designer Series can read HDL source files which fully comply with the VHDL
(IEEE-1076-1987 and |EEE-1076-1993) or Verilog (IEEE-1364-1995 and | EEE-1364-2001)
standards but may fail if non-standard HDL is encountered.

Many tools support translate_on and translate_off pragmas which can be used to segregate
application specific sections of HDL code. For example, -- synopsys translate_off, -- exemplar
trandlate off or -- pragma translate off.

Graphical Editors User Manual, V2008.1 385
September 18, 2008



Graphical Rendering
Design Extraction

HDL 2Graphics attempts to convert all HDL code including comments and code enclosed
between these pragmas. However, you can isolate code you do not want converted by using the
specia pragmas -- hdstranslate_off and -- hds translate_on. All pragmas must include the
appropriate comment characters (-- in VHDL or // in Verilog).

Recovering Design Structure

The structure of the source HDL is recovered as a hierarchy of design unit views representing
the relationship between design units.

Top level design units are recovered as components and marked with a & marker. Child design
units are recovered as unmarked components.

Hierarchy descriptions in the HDL can be recovered as graphical views defined by a block
diagramor IBD view. Primitive |leaf level views defined as state machinesin the HDL can be
recovered as graphical state diagrams and other leaf-level code represented as graphical flow
charts.

All diagram types can be recovered when you are using the HDL Detective or HDL Designer
tools but are not automatically available when you are using HDL Author. However, if you
attempt to use HDL2Graphics technology with HDL Author, adialog box is displayed which
allowsyou to acquire atemporary floating license for HDL Detective or HDL Designer if oneis
available. Thislicense is released when the conversion to graphics operation has been
completed.

Any concurrent HDL fragments within a hierarchy description are recovered as embedded
blocks. Leaf-level HDL can optionally aso be recovered as embedded blocks on a non-
hierarchical block diagram. These embedded blocks are defined by embedded views which
usually contain HDL text but if the HDL is recognized as a state machine can optionally be
recovered as an embedded state diagram.

Each occurrence of a concurrent VHDL process or ablock of Verilog always code is recovered
in a separate embedded block connected by the signals used in the HDL fragment. All other
concurrent HDL (such as assignments or generate statements) are recovered in asingle
embedded block which is unconnected to other objects in the recovered view.

Any required Verilog compiler directives or VHDL package references are automatically set on
the graphical views.

If adesign unit interface usesaVHDL generic or Verilog parameter declaration which requires
port mapping it isinstantiated in the parent view using a port map frame. Generate or Block
keywords and other conditional HDL structures are recovered using a generate frame.

If a VHDL entity has multiple VHDL architectures, then all architectures are recovered as
design unit views and the aphabetically last architecture nameis set as the default view of the
recovered design unit.
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Any configuration information included in the HDL source (either as embedded declarations or
as separate configuration specifications) is used to automatically recover multiple libraries and
identify the instantiation of different views for a design unit. However, multiple libraries or
multiple views cannot be recovered for Verilog designs.

A VHDL configuration definesthe HDL library for a given entity and the architecture which is
bound to a given instance within a structural architecture. For example, the following
configuration statement specifies that instance i0 of the counter component is bound to
architecture fsm of entity counter, in library timer_vhdl:

for i0: counter
use entity timer_vhdl.counter(fsn);
end for;

The configuration may also specify additional port mapping and VHDL genericsfor aninstance
to those defined by the component instantiation. When multiple configurations exist for the
same entity, only one configuration will be recovered. If aconfiguration is used in the source
HDL to bind a component instantiation to alternative entities, thisinformation is not recovered.

If aVerilog source file references an instance for which no corresponding Verilog moduleis
provided, the port mapping does not indicate the mode or type of the ports for the instance.
HDL import will guess the missing port information and recover a black box instance. This
allows the recovered view to show the connectivity between the undefined instances.

The layout and routing for recovered block diagrams is determined by the default Document
and Visualization options. However, you can change these options and run the diagram layout
or autorouting commands interactively on any block diagram. Once changes have been made,
the new options are saved as preferences and used the next time that you run a conversion to
graphics operation.

The Verilog source code may contain many Verilog modules in the samefile.
Compiler directives before the first module keyword are recovered as Pre-Modul e directives.

Compiler directives after a module keyword but before the first lexical token other than a
comment or white space are recovered as Post-Modul e directives for the Verilog module.

Compiler directives after the last endmodule keyword in the file are recovered as End-Module
directives.

Compiler directives between two Verilog modules are recovered as End-Module directives for
the previous module if they occur before a “nounconnected_drive or “endcelldefine directive,
otherwise they are recovered as Pre-Module directives for the next Verilog module.
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Recovering Verilog Parameters

If aVerilog parameter is used in the declaration of an interface signal, it isrecovered in the
external declarations at the top of the Verilog module.

Other Verilog parameters which occur before syntactic text in the source Verilog are declared in
the internal declarations for the Verilog module except parameters which are used for
enumerated state encoding in a state machine.

Any other Verilog parameters are declared in the view declarations.

Any parameter on an instance with an overridden value isincluded in the Verilog parameter
mapping shown on the instantiated block or component.

Recovering State Machines

When state machine recovery is enabled, a state diagram is created for each behavioral (leaf-
level) HDL description below an instance in the recovered structure that is recognized as an
explicit state machine and can be described by a state diagram.

Note

[

Implicit algorithmic state machines are not recovered. However, an agorithmic state
machine can be recovered as a flow chart with clock conditions specified at the start of
each action box representing a state.

An explicit state machine is implied when ablock of HDL code contains:

A state variable, which specifies the current state of the machine.

A clock and optional synchronous or asynchronous reset condition (for synchronous
machines only).

Specification of state transitions.

Specification of outputs.

A separate concurrent state machine is created for each state machine defined in the same
VHDL architecture or Verilog module.

The recovered states are placed in a clockwise direction around acircle with the start state at the
top. However, when there are only two states, they are placed horizontally with the start state on
the left. The placement sequence is determined by the connections between states (not their
order of occurrenceinthe HDL code).

388
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Recognizing State Machines

When you enable the State Diagram option in the Convert to Graphics View Style Options, the
HDL parser searches for HDL code with characteristics which represent an explicit state
machine.

The following algorithm is used to analyze the HDL code:

Find any clocked processes (which must have a sensitivity list).

Thefirst body statement must be IF (but can be preceded by declarations) which must
contain a condition. For example: IF <condition> THEN.

If thereisno ELSE or ELSF, then assume that the I F is testing the clock condition and
extract this clock condition.

If there are ELSE or ELSF branches, then assume the first IF contains the reset
condition and check the ELSE or ELSF to get the clock condition.

The reset condition must have the form <condition> THEN <actions>
and must include areset signal in the condition. For example: rst="0" or rst/="0". There
must also be an assignment (signal or variable) to a state variable.

The clock condition must have the form <condition> THEN <actions> and must
include a clock signal in the condition. For example: clk'event AND ... or
rising_edge(clk). If the first statement is an assignment, it must assign asignal or
variable to a state variable. If the first statement is CASE, then it must test the state
variable.

Find transition (next state) processes for each clocked process, (clocked and transition
processes may be combined) and find a process which assigns to the next state.

Find output processes for each clocked process and the output process which assignsto
anon state variable output signal.

Build the state machine structure from the process information.
Store the first clock that was identified.

Store the first reset that was identified.

Store the state variable info for this process.

Store the state encoding, if it isnot aready stored.

Store target of WHEN OTHERS transition as recovery state
Ensure the reset strings are valid characters.

All assigned signalsin the clocked process are tagged as registered.

Recovering Flow Charts

When flow chart recovery is enabled in the Convert to Graphics View Style Options, a flow
chart is created for each behavioral (leaf-level) HDL description below an instance in the
recovered structure. A separate concurrent flow chart is created for each VHDL process or
Verilog procedure (where a procedure is any section of code represented by Verilog always or
initial statements).
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Note
After recovery, you can choose whether the Verilog regenerated from the graphical flow

chart usesinitial or always statements.

For VHDL, concurrent flow charts are named after the process, or if the processis unnamed, a
name is generated using the format: process<n> where nisan integer starting from 1. Verilog
procedures are not normally named in the source HDL and each concurrent flow chart isgiven a
name using the format: procedure<n>.

Architecture declarations and process declarations (in VHDL) or module declarations and local
declarations (in Verilog) are included in the corresponding flow chart as text blocks. Any
concurrent statementsin the recovered code relate to all concurrent diagrams for the same block
instance and are included as text blocks on all the concurrent flow charts. A text block showing
the signals sensitivity list for each concurrent flow chart is also created.

The objectsin each concurrent flowchart are laid out from top to bottom with al flows (except
for loopback flows) pointing downwards.

Conditional (IF) statements) are recovered as decision boxes with a true and false branch. If the
conditional statement includes ELSIF (or Verilog elseif) constructs these are represented by
multiple cascaded decision boxes.

The choices (values) of a CASE statement are recovered as ports arranged on the bottom edge
of astart case box from left to right as encountered in the code with the port values placed in the
standard position relative the port. (For Verilog, casex and casez statements are recovered as
start case objects with appropriate object attributes.)

L oops are represented with the continue and break statements shown to the right of a start loop
and end loop pair. The loopback flow is connected between the left sides of these objects.

Wait statements are recovered as wait boxes with the appropriate delay statement. In Verilog,
timing controls using the wait keyword are recovered as wait boxes but the # or @ timing
controls are included in action box text.

Any other statements are treated as action statements and recovered into an action box. The
action box contains as many statements as possible. For example, a section of code containing
100 lines none of which is adecision, case, loop or wait statement, is recovered into asingle
action box. The action box is automatically sized to contain the HDL text (with default padding
added).

Comments within action statements or declarations are included on the flow chart but
comments associated with if, case or loop statements are not recovered. In particular, the HDL
tranglation pragmas synopsys parallel_case and synopsys full _case are not recovered.
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Incremental Recovery

Convert to Graphics will normally attempt to recover the entire design described by the source
HDL. However, the source HDL may be incomplete or may reference design units which have
been previously recovered and already exist.

If an incomplete design is recovered, dummy design units are created in the database for
undefined instances in the source HDL.

If the source HDL has been updated and you choose to reconvert the design, any new views are
added (and dummy views overwritten). When adesign unit is updated by incremental recovery,
itsinterface to child or parent views in the database may also be changed.

In general when a design unit already exists, the following rules are followed:

Existing Unit New Unit Rules Applied

component component Add or overwrite views. If interface has changed,
overwrite symbol.

component block Add or overwrite views. If interface has changed,
overwrite symbol.

component component Add or overwrite views, convert block to component,
update parent view.

block block If parent design units are unchanged, add or overwrite
views. If parent design units changed, convert block
to component and update parent view.

VHDL package package Add or overwrite package.
Note
D Aninterface is considered to have changed if aport, VHDL generic or Verilog parameter
has changed.

If the Overwrite option is set, you are not prompted before aview is overwritten. If not set,
there isa single confirmation prompt for all views which will be overwritten. If asymbol is
overwritten, you are warned that instances of the component will need to be reconciled.

Using the Convert to Graphics Wizard

Y ou can convert any existing HDL text views to editable graphical source views by selecting
the views (or design units if the default views are HDL text views) in the design explorer and
using the ﬁl button or by choosing Single L evel from the Convert To Graphics cascade of
the HDL or popup menu.
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If the HDL text isastructural view which contains hierarchy descriptions, you can use the
button or choose Hierar chy Through Components from the HDL or popup menu to
convert all views in the hierarchy below the selected view.

The Convert To Graphics wizard is displayed indicating the number of hierarchy descriptions
and leaf level descriptionsin the selected HDL files. For example, the hierarchy of the uart_tb
test bench in the example UART_TXT library contains four hierarchy descriptions and six |eaf
level descriptions.

Setting Convert to Graphics View Styles

The first page of the Convert to Graphics wizard allows you to set the required graphical view
styles:

Hla Convert To Graphics Wizard - Yiew Styles

Specify the graphical view styles for the comversion,

— Hierarchy Dezcriptions
Convert theze 3 hierarchy descriptions as:

[+ Block Diagram
[ IED

— Leaf Level Descriptions
Convert theze 5 leaf level descriptions as:

[+ State Diagram

[+ If a State Machine cannot be recognized, create a Flow Chart
[ Flow Chart
[~ Block Diagram

[~ Create Symbal &bways
Create a symbol even if no view styles are selected.

Meut » I Finizh | Cancel Help

Hierarchy descriptions can be recovered as block diagram or IBD views.

If afinite state machine is recognized in aleaf-level description it can be recovered as a state
diagram. Otherwise, the leaf level description can be saved as aflow chart or asablock diagram
with the leaf level HDL codes represented by embedded HDL text views on the diagram.

Y ou can also choose to create a symbol even when no other graphical view styles are selected.
If thisoption is set, symbols are created although all views remain as HDL text. If unset,
symbols are only created for the design units converted to graphic views.
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Setting Libraries for Black Box Components

If you use the Next and the HDL code includes instantiations for components which are not
defined in the current library (or in alibrary specified by aVHDL configuration) the Black Box
Components page is displayed listing these black box instances.

For example, the following page is displayed when converting a HDL view which contains
undefined black box components for the design units address_decoder, clock divider,
cpu_interface and serial _interface:

H{ Convert To Graphics Wizard - Black Box Components x|

The zource HOL containg the following black box components.

If theze components already exist as design units,

zpecify the libraries containing them below;

— Black box components — Libraries
address decode Set Librar.. | Up
clock_divider

cpu_interface [Elear Litbrary | [

zenal_interface
Hemoyve

I

Add...

¢ Back I Meut I Finizh | Cancel | Help |

%

Y ou can usethe Set Library button to set a specific library by choosing from alist of existing
libraries in the active project or the Clear Library button to clear a specific library
specification.

Alternatively, you can use the Add button to create alist of libraries to search for matching
components. The list can be ordered by using the Up and Down buttons or libraries removed
from the list using the Remove button.

Components are automatically removed from the list of black box componentsiif they exist in
one of the librariesin the search list.
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The following example shows the cpu_interface component has been explicitly assigned to the
UART _TXT library while the other components are located by searching the Test_Lib,
SCRATCH_LIB and UART_TXT libraries:

H{ Convert To Graphics Wizard - Black Box Components x|

The zource HOL containg the following black box components.

If theze components already exist as design units,

zpecify the libraries containing them below;

— Black box components — Libraries

LART_TeT.cpu_interface St Librany... | Test_Lih
i SCRATCH_LIB
[Clear Libran | UART W

¢ Back | Meut | Finizh | Cancel | Help |
g

If you confirm the wizard while there are unassigned black box components, you are prompted
to return to the wizard and specify the remaining libraries. If you override this prompt, the
components are instantiated as black box components in the graphical view.

Setting Convert to Graphics Wizard Options

The last page of the wizard allows you to set additional options to overwrite existing graphical
views and display verbose messages in the log window during conversion.

If you choose to overwrite an existing view, you can choose to make a copy of the previous
view. (For example, if you overwrite a block diagram view named struct, the previous view is
saved as Copy_of_struct.)
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Y ou can also choose to set the new graphical views as the default views or use the Advanced
button to display the Documentation and Visualization Options dialog box.

Hla Convert To Graphics Wizard - Advanced B3

—additional Dptiohz
& number of optionz are available to modify the way that views are

created and alzo contral the operation of Cornvert To Graphics.

[ Owepsrite
Ouvenarite existing views.

[~ Copy on Ovensrite
Copy exizting views before ovenariting them.

[~ “erbose

Digplay additional information during conversion.

¥ Set Default Views
Set graphical views as default.

Advanced... |

¢ Back | Finizh | Cancel | Help L
5

When you confirm the wizard, the selected HDL files are read and the graphics views created.

Progress messages (including any errorsif problems are encountered) are written to the Task
Log window.

When conversion is complete a completion message is issued with areport of the number of
design units saved and the number of components, block diagrams, state machines and flow
charts that have been created.

Note
Note that afile name clash with the original source HDL file may occur if you generate

HDL from agraphical view. Y ou should rename one of these views if you want to keep
both the graphical and HDL text views.

Setting Convert to Graphics Options

Convert to Graphics options can be set by using the Advanced button in the Convert to
Graphics wizard or by choosing Documentation and Visualization from the Options menu in
the design manager to display the Documentation and Visualization Options dialog box.

The options are saved and used as defaults the next time you convert or render HDL code as
graphics.
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Block Diagram Options

The Block Diagram Node allows you to set options for text visibility, embedded blocks and
instances on the recovered diagrams.

HlaDucumental:iun and Yisualization Options

- HTML Settings
‘.. Graphics Settings  The fallowing options except for the text visibility sectian
will apply for bath Block Diagram and 1BD.

Sowssebmew o omewabeen

----- Yizualization Ophions
El- Graphics Appearance

= Stiuctural Diagram QR

. Placement Settings b odify the wisibility of text on zome Block Diagram objects.

. . Block Diagram preferences are uzed if these options are not chozen.

----- Routing Settings
v Diagram: Inu:une j
¥ Met: Ipu:urt 1/0 anly j
| Compaonent port: Inu:une j

— Embedded Blocks

These optionz are only specific for vizualization.
Chanaging the Embedded Blocks options for HDL To Graphicz can be done through
the Corvert Tao Graphics wizard -» Advanced options.

¥ Estract embedded state machines

Embed State Machines, if recoghized.
[ Estract concurent assignments

Create separate embedded blocks for concurrent aszignments.

Sumbal shape: rectangle j
v Connect embedded blocks

Create gignals between embedded blocks

— Instances

[ Instance limit: 100
b aimumn number of instances allowed.

[T Use default view:
Apply to inztances in preference to a specified view.

(] I Cancel | Help |

Note
D Hiding text helps to optimize automatic routing and placement for compact layout. If the

text objects are hidden, instances can be placed closer together to minimize the size of the
recovered diagrams.
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Routing Options

The Routing node allows you to set options which control whether nets are connected on a
recovered block and how these nets are routed.

HlaDucumental:iun and Yisualization Options

owsseDmew o PoangSees

o HTHL Sethi
. i |ng!s —Autoroute modes
¢ Graphics Settings
- Wisualization Options " Connect by name

= Graphics Appearance
- Structural Diagram
----- Placement Settings - Autoroute options

i+ Explicit connection

Routing Settings

[ Cannection limit; 10
b aximum number of connections allowed for a net.

— Bundle Settings

These optionz are only specific for vizualization.
Chanaging the Bundle optionz for HOL To Graphics can be done through
the Corvert Tao Graphics wizard -» Advanced options.

v Bundle signals; Idireu:t j
Bundle signalz bebween nodes.

Iv Bundle limit; Z
kirirmurn fumber of signalz allowed in a bundle.

[ Bus reconstuction;

Reconstiuct buzes for zignal zlices.

v Align ports:
Align part 140 with connections.

v Global connectars:

Create global connections for global zignals.

v tove component parks:

Allow connector end paoints ko mowve during routing.

(] I Cancel | Help

4
Note
The routing options are also available from the Block Diagram Layout and Routing
Options dialog box.
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Placement Options

The Placement node allows you to control the placement of instances on the recovered block

diagrams.

HlaDucumental:iun and Yisualization Options

=1~ WWebsite Options
- HTML Settings
_ - Graphics Settings
----- "izualization O ptions
= Graphics Appearance
----- Structural Diagram

" Routing Settings

S Placement Settings

I Placement Limit: |5|:I

b aimum number of auto-placed instances.

[ Preserve placement

Prezerve placement of exizting diagrams.

W |nstance auto-size; width and height j

Size component inztances tao fit the visible text.

(] I Cancel | Help |

Note

The placement options are also available from the Block Diagram Layout and Routing

Options dialog box.
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Updating a Graphics View from Generated HDL

If agraphical view is older than its generated HDL, you can select the generated file in the
design explorer HDL Files view and choose Update Graphics from the popup menu to run
Convert to Graphics and overwrite the graphical view.

Y ou are prompted whether to retain a copy of the existing view (as Copy_of<view>) and
whether to preserve the placement of objects from the existing view.

For example:

Hg HDL Designer | x|

|Ipdate 'Sequencer_vhd. fibgen(ztruct. bd)'

[T Copy existing view

" Preserve placement

(] I Eancell

Z

Visualizing HDL Text as Graphical Views

You can visualize aHDL text view as agraphical view by selecting the view (or adesign unit if
the default view of the design unit isaHDL text view) in the design explorer and using the
-Eﬁﬂ button.

A pulldown palette on the button allows you to choose a block diagram , IBD view
state diagram or flow chart view.

Alternatively you can choose Block Diagram, IBD, State Diagram or Flow Chart from the
Visualize Code As cascade of the HDL or popup menu.

Although you can only perform non-logical editsto visualized views, the simulation, animation
and cross-probing facilities described in “ Simulation and Animation” on page 405 are fully
functional.

Block Diagram Layout and Routing

Layout and routing is performed automatically when ablock diagram is created from aHDL
text view using the current layout and routing options or when you show a block diagram from
an I1BD view with the Update L ayout option.

Block diagram layout and routing options can be set using a tabbed dialog box which is
displayed by choosing L ayout/Routing Optionsfrom the Diagram menu in ablock diagram to
display the Block Diagram Layout/Routing Options dial og box.
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Tip: The Routing tab can aso be accessed by choosing Autor oute Options from the
Autoroute cascade of the Diagram or popup menu.

The dialog box provides access to the same options as provided in the Documentation and
Visualization Options dialog box shown in “Placement Options” on page 398 and “ Routing
Options” on page 397.

Refer to the descriptions of the Layout Options and Routing Options which can be accessed
using the Help buttons on each tab of this dialog box. These options are saved as preferences
and used as defaults the next time you use the layout and routing commands.

Changing the Layout of a Block Diagram

Y ou can automatically update the placement of blocks and components on a block diagram by
choosing L ayout Diagram from the Diagram menu or by using the Ctrl + L shortcut.

The placement algorithm attempts to rearrange the diagram, reducing empty space while
preserving aleft-to-right design flow. This command can be used in conjunction with the
Autor oute command to optimize the diagram readability.

The placement algorithm is designed to reduce the number of feedback |oops and reduce the
complexity of the signal paths while showing association by placing ports on blocks as close as
possible to their source.

The placement algorithm and block diagram layout options are used automatically to arrange
diagrams recovered from HDL text views. However, the layout for a diagram may often be
improved by using the L ayout Diagram command after changing layout options.

Note
Note that any Non-autoroute panels on the diagram are deleted but Regular or Sheet
panels are preserved.

Automatic Routing

Y ou can re-route the nets on a block diagram by using the Autor oute cascade of the Diagram
or popup menu and choosing Autor oute, Autoconnect, Autobundle or Connect By Name.
Note that the Autor oute command can aso be executed by using the Ctrl + R shortcut.

If nothing is selected, all connections on the diagram are re-routed. However if objects are
selected, the selected nets and all nets connected to other selected objects are re-routed.

Y ou can exclude parts of a diagram from the automatic routing commands by adding a panel
around an area and setting the Non-autor oute panel property as described in “ Adding a Panel”
on page 73.
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The percentage complete is indicated in the status bar while autorouting a large design.

Therouting algorithm and current block diagram routing options are used automatically to route
diagrams recovered from HDL text views. However, the routing for a diagram may be
improved by using the Autor oute command after changing the routing options. For example, a
complex diagram can often be ssmplified by enabling the options to automatically group signal
nets into bundles or reconstruct a bus from bus slices.

Autoroute

The Autor oute command uses the current options set in the Routing tab of the Block Diagram
L ayout/Routing dialog box.

Autoconnect

The Autoconnect command attempts to re-route the nets using simple routes which comprise
the minimum number of vertical and horizontal segments to connect the source and destination
but avoid other objects (or unselected nets).

If no route isfound, or the source or destination is on another net, adirect line is drawn with no
route points between the origin and destination. This command is equivalent to using
Autoroute with Explicit connection set (but Keep existing connectivity, Bundle signals and
Connection limit unset) in the routing options.

Autobundle

The Autobundle command automatically groups signal nets into bundles. This command is
equivalent to using Autor oute with Explicit connection set (but K eep existing connectivity
unset) and Bundle signals set. (The Bundle limit is set to the current number specified in the
routing options.)
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When you set the Bundle signals option, you can choose whether to use direct or indirect
connection. For example, the following illustration shows the same two blocks connected using
indirect and direct bundles:

Indirect Direct

1 1
(zigl £igl gig2 sig3)

(zigl £igl gig2 sig3)

Declarations

wrire sigll
wrire £igl
wrire £igd
wrire £ig3

When direct bundling is set, bundles are automatically created for any group of signals (which
may include buses) between the same nodes.

For indirect bundling, the individual signals are shown as stubs with a common bundle
connecting them across the diagram.

Y ou can set abundle limit to prevent buses being created with less than a specified number of
signals. The most compact diagram layout is achieved when thislimit is set to zero.

When the signals are connected to a component and direct bundling is set, the bundleis
connected to the ports on the component using a port map frame. If two bundles have same
contents, they are not connected but connections between the contained signalsisimplied by
name.

Automatically created bundles are given aname derived from the source and destination nodes.
For example, the bus 10_I1 connects between instances 10 and 11 in the illustrations above.

Connect by Name

The Connect By Name command reduces all nets to stub signals with all the connections
implied by name. This command is equivalent to using Autor oute with Connect by name set
in the routing options.

Bus Reconstruction

Y ou can enable ablock diagram layout option to reconstruct buses from slices of asignal with
the same name. When set, automatic bus reconstruction is performed when you render a new
block diagram or when you use the Autor oute command in an existing block diagram.
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When you set the Bus reconstr uction option, you can choose whether to use direct or indirect
connection. However, reconstructed buses connected to signal stubs on a block are always
connected indirectly since direct connections to a block would modify the block interface. The
following example shows slices sSigA(0), SigA(1), sigA(2:3) and sigA(4:7) combined into a
single 8-hit bus sigA then deconstructed into slices sigA(0: 1), sigA(2: 3), sigA(4:5) and
SIgA(6:7).

sigh[l] .
L e ]

sighfa:3]

sighd:7]

sighf2:3]
sigdh[4:5]
sigdh[:7]
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Chapter 11
Simulation and Animation

This chapter describes procedures for driving ssmulation from a graphical diagram and
animating the state diagrams and flow charts in your design.

Simulator Cross-Probing. . ... ... 405
Simulation Toolbar . . . ... . 406
Adding Signalsto Simulator Windows . ... 408
Removing Signalsfrom Simulator Windows. . . ... 408
Adding Signalstothe Simulator LOg . . ......cciv i 409
Highlighting SignalsintheSimulator ........... ... .. .. . . 409
Reporting Signal INformation. . . ... 409
Adding and Removing BreakpointS . .. ...t 409
Enabling and Disabling Breakpoints . . ... e 410
Reporting Breakpoint SEatUS. . . . . . ..ot e 410
Adding and Removing Simulation Probes . . .. ... ..o 411
Choosingthe Simulation Instance ... e 414
Setting the Simulator Environment. . . ... 415
Runningthe SImulator . ........... . e e 416
Displaying Simulator Windows . . . ... e 417
Restartingthe SImulator . . . ... .. 417
Usingthe ModelSIm Source Window . ... 417
Cross-Probing fromModelSim. . ... ... 418

State Diagram and Flow Chart Animation . .............. .. 421
ANMation TOOIDAr . . . ... 422
Enabling DataCapture . . .. ... oot 423
Settingthe Activity Trall . ... e 424
Graphical Highlighting . . . ... 425
RevIiewing ANIMation. . . .. ..ottt 426
Linking Diagramsfor Animation . . ... i e 427
Mixed Language ANIMation. . . ... ...ttt e e 427

Simulator Cross-Probing

When you are using a supported simulator, an additional Simulate menu and toolbar are
available in the block diagram,flow chart and state diagram windows which allow direct cross-
probing between the simulator and the source design objects.

The features described in this chapter have been developed primarily for use with the ModelSm
EE, SE or PE (version 5.5 or later) simulator. However, many of the features are also available
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when you have invoked the NC-Sim (version 3.0 or later) simulator. Simulator cross-probing is
not available when you are using VCS or VCSI.

Refer to “ Tasks, Toolsand Flows” in the HDL Designer Series User Manual for information
about setting up the smulator and other downstream tools.

The ssimulator should normally be invoked on adesign unit at or above the level to be simulated.
However, you can change the simulator environment to alower level design unitand it is
possible to synchronize with Model Sm when the simulator has been invoked on aroot design
which includes lower level design units.

Simulation Toolbar

The Simulation toolbar which isautomatically displayed in the graphical state diagram and flow
chart views when a supported simulator has been invoked and supports the following
commands

Table 11-1. Simulation Toolbar Commands in State Diagram and Flow Chart
Views

I con Description

Zl Run for a specified time
Ed Run forever

ER Continue

Run until next event

Step over the current HDL line

Step into procedure calsin the current HDL line

Step over HDL in the selected object (state diagram only)
Add a breakpoint to the selected object
Remove a breakpoint from the selected object

| & ] 2] (=] =] e

il Remove all breakpoints
[y Disable breakpoints
[ Disable all breakpoints
Enable breakpoints
Enable all breakpoints
Highlight signal in simulator corresponding to selected object
Elf Restarts the simul ator
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Note

The = button allows you to change the default timestep used by the

Al

1

button by

choosing from a pulldown list. The button is available in the state diagram only.

The following additional commands are avail able from the Simulation toolbar which is

displayed in the graphical block diagram.

Table 11-2. Simulation Toolbar Commands in Block Diagram Views

I con Description

Add the selected signals to the simulator Wave window

Remove the selected signals from the ssmulator Wave window

Add the selected signals to the simulator List window

Remove the selected signals from the simulator List window

Reports signal information to the main Model Sm window

Add a probe to the selected signal

Delete a probe from the selected signal

Delete all probes

Enable or disable cursor tracking for probes

Set probe properties

N E

Choose instance for simulation

The following additional commands are avail able from the Simulation toolbar which is

displayed in the graphical state diagram:

Table 11-3. Simulation Toolbar Additional Commands in State Diagram

I con Description

Add the current state to the smulator Wave window
Remove the current state from the simulator Wave window
Add the current state to the ssmulator List window
Remove the current state from the simulator List window
B Enable or disable cursor tracking for state machines

Note

D The button is permanently dimmed in the Simulation toolbars if you are using

Model Sm PE which does not support this integration feature.
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The toolbar is normally displayed at the bottom of the diagram window but can be undocked,
moved, docked or hidden in the same way as the other toolbars.

The toolbar can be displayed or hidden by setting the Simulation T ools option in the Toolbars
cascade of the View menu.

Refer to “ Toolbars’ on page 20 for more information about toolbars.

Adding Signals to Simulator Windows

You can add sngnals to the simulator Wave window by selecting them on the block diagram
using the |E&| button from the Simulation toolbar or by choosing Add Wave from the Display
cascade of the Simulate menu.

Y ou can add selected signalsto the simulator List window by using the button from the
Simulation toolbar or by choosing Add List from the Display cascade of the Simulate menu.

Note
D If ablock or component is selected, all the connected signals are added to the simulator

window.
The Wave window is automatically displayed if it is not already open.

If you are using ModelSm, the and buttons (or commands in the Simulate menu) can
be used in a state diagram to add a signal defining the current state of the state machine to the
Wave or List windows.

For Verilog, avirtua signal showing the enumerated state is derived from the bit value. For
VHDL, the signal represents the instance path of the state machine.

Y ou can set these signals to track the Model Sm Wave window cursor by using the |25 button
or choosing Track Cursor from the Display cascade. (The button is shown with al |ght
background |28 when cursor tracking is enabled or a superimposed cross (B4 when disabled.)

Removing Signals from Simulator Windows

Y ou can remove a selected signal from the Wave window by using the button or by
choosing Delete Wave from the Display cascade of the Simulate menu.

Y ou can remove signals from the List window by using the button or by choosing Delete
List from the Display cascade of the Simulate menu.

The and buttons (or commands in the Simulate menu) can be used in a state diagram
to remove the current state signal from the Wave or List windows.
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Adding Signals to the Simulator Log

Y ou can add one or more signals to the ssmulator log by selecting the required signals on the
block diagram and choosing Add L og from the Display cascade of the Simulate menu.

Signals added to the simulator log in thisway are not be displayed but their simulation activity
is recorded and can be added to the Wave or List window for later analysis.

Y ou can remove one or more selected signals from the simulator log by choosing Delete L og
from the Display cascade of the Simulate menu.

Highlighting Signals in the Simulator

Y ou can highlight the signal or signals in the simulator windows corresponding to a selected
object in ablock diagram, flow chart or state diagram by using the button from the
Simulation toolbar or by choosing Highlight Object from the Display cascade in the Smulate
menul.

All occurrences of the selected signal in the Model Sm Structure, Source, Signals, List and
Wave windows are highlighted.

Reporting Signal Information

Y ou can report information about one or more selected signals by using the button from the
Simulation toolbar or by choosing Signal 1 nfo from the Simulate menu in a block diagram.

The Model Sm examine, describe and drivers commands are used to report current information
about the current value, type information and alist of drivers to the main Model S m window.

Adding and Removing Breakpoints

Y ou can add breakpoints for any object which is referenced by the generated HDL from a block
diagram, flow chart or state diagram by selecting the object and using the @ button from the
Simulation toolbar or by choosing Add from the Breakpoints cascade of the Simulate menu.

Breakpoints can be added to any object which corresponds to a executable line in the generated
HDL. For example, a state or transition in a state diagram, an action box, decision box or wait
box in aflow chart and asigna or busin ablock diagram.

If multi-line text (such as declarations or concurrent statements) is selected the breakpoint is
added to the first line of the selected text.

Note
D Line breakpoints may be corrected by up to ten lines if the selected object does not
correspond to an executable line in the simulator.
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If you select an object which has no corresponding executable HDL code, you are prompted to
select another object.

Breakpoints are shown by an @ icon on adiagram.

Breakpoints added to aHDL line in the Model Sm Source window are automatically added to
the corresponding source object in the graphical view.

Note
D If you set a breakpoint on a state name, HDL line breakpoints are added to all transitions

which set the state as the next state.

For ahierarchical state machine, these transitions may be in another state diagram but

will be shown when the diagram is displayed.

Y ou can remove breakpoints from the selected object by using the button or by choosing
Delete from the Breakpoints cascade of the Simulate menu.

Y ou can remove all breakpoints by using the button or by choosing Delete All from the
menul.

All breakpoints are automatically cleared when the ssmulator is closed.

Enabling and Disabling Breakpoints

Y ou can disable breakpoints at any time during a simulation run for the selected signals by
using the button or by choosing Disable from the Break points cascade of the Simulate
menu and disable all breakpoints by using the button or choosing Disable All.

The breakpoint icon for a disabled breakpoint is redrawn with no fill color.

Y ou can enable breakpoints for the selected signals by using the button or by choosing
Enable from the menu.

Y ou can enable all breakpoints by using the button or by choosing Enable All.

Reporting Breakpoint Status

Y ou can display information in the main Model Sm window about all currently set breakpoints
by choosing Report from the Break points cascade of the Simulate menu when you are using
ModelSm.
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Adding and Removing Simulation Probes

Y ou can add simulation probes to signals on a block diagram by selecting one or more signals
and using the button from the Simulation toolbar or by choosing Add from the Probes
cascade of the Simulate menu.

If one or more instances are selected, probes are added to all the signals connected to the
Instances.

Y ou can also add probes by using the button in the Model Sm Wave window or by
choosing Add Probe from the Probes menu in the Model Sm Wave, List or Signals windows.

A simulation probe displays the current value of the associated signal.

Simulation probes are added on a block diagram as yellow icons with associated text on agrey
background adjacent to the signal name. However, you can move the probe independently and
its associated signal is connected by an anchor.

Y ou can set probe properties which control how each probe is displayed including an optional
name, probe expression, display radix, previous value, time of change and visible anchor
connecting it to the net.

The probesin the following example show a new value for the data_out and addr signals but
the sout and sin signals have the same value as the last time the simulator stopped:

int > addel P3: 101400819 450 ns
data_in
UART V
sou P1: St1/St0@9 450 -
Sout@ @9 450 ns }Smr sin P4: SH/S10@0 ns
M
data outll P2: 11001110
- F Cs

LT

Probes P1, P3 and P4 in the example have been set to display the current/previous values and
the time of the last change.

A breakpoint has also been attached to the sout signal.

The Probes and Breakpoints columns can be hidden or displayed by setting optionsin the View
menul.
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Note
The block diagram is automatically made read-only when a probe has been added and all
probes must be removed before you can edit the view. All probes are automatically
cleared when the view is closed and when you exit from the simulator.

The probes are updated whenever the simulator stops (at a breakpoint, forced stop or the end of
arun). If the change indicator option isset and asignal has changed since the previous simulator
step, the probe is shown as ared icon on a block diagram. Note that there is no color change if
the signal value is the same although there may have been signal transitions during the
simulation run and the signal has returned to its previous value.

Y ou can remove probes from a selected signal by using the button or by choosing Delete
from popup menu or the Probes cascade of the Simulate menu and remove all probes by using
the @ button or by choosing Delete All from the menu.

If you are using Model Sm SE, you can set probes to track the Model Sm Wave window cursor
by using the button or choosing Track Cursor from the popup menu or from the Probes
cascade of the Simulate menu. (The button has a light background when cursor tracking is
enabled or a superimposed cross when disabled.)

When cursor tracking is enabled for probes, the probe values track the current position of the
active cursor in the Model Sm Wave window.

Note

D Simulation probes are re-initialized if you restart the simulator but they are NOT
automatically updated if you execute the Model Sm restore command in the simul ator
window. However, the probes are updated when the next run or step command is
executed.
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Setting Probe Properties

Y ou can set simulation probe properties by using the button in the Simulation toolbar or by
choosing Probe Properties from the popup menu or the Probes cascade of the Simulate menu
when one or more probes are selected to display the Probe Properties dialog box:

H[} Probe Properties E3

Frobe M arne: ||:~-|

Signal/E spreszion; I

Yalue [Forced): IW IDefauIt j Force Yalue |

Dizplay Fadis: IDefauIt j

— Contents
[v Probe Name

Presiew:

W Previous Valus high: 000/000@2,100 ris
¥ Time OF Last Change

¥ Dizplay Anchor Set &g Defaults

(] Cancel Apply Help

Z

The dialog box allows you to specify the name of the probe and choose how it is displayed on
the diagram.

Y ou can optionally specify an expression if you want the probe to display a value other than the
current signal value. For example, dat_in(9:0) would display only bits 9 DOWNTO of the
multi-bit bus dat_in.

The properties specified in the dialog box are applied to the selected probe or changes to the
properties can be applied to all selected probes with unchanged properties remaining <AS |S>.

The current probe properties for display radix and contents can be saved as defaults in your
preferences using the Set as Defaults button.

Forcing Signal Values

Y ou can force signal values for simulation by adding a probe and entering the required value in
the Probe Properties dialog box using the For ce Value button to force the required value.

Y ou can also force asignal value by directly editing the value of asignal in a probe on a block
diagram.

The signal isforced using the default strength currently set in Model Sm or you can choose the -
freeze, -drive or -deposit drive strength arguments from a drop down list.
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When the value of a signal has been forced, the probe is shown as a blue icon on a block
diagram.

Choosing the Simulation Instance

When you send a command to the simulator, the signal or process is identified by a pathname
that uniquely identifiesits location in the design hierarchy.

This path is referenced relative to the component from which the current simulation was
invoked. For example, if you have invoked simulation from the block diagram
DES GNSam2909/stack, references will be relative to this path.

If your design hierarchy contains more than one occurrence of acomponent, you can open down
into this component from each separate instance. When driving simulation from within such a
component, it is necessary to specify the ssmulator hierarchy path in order to uniquely identify
the signals and blocksit contains.

It isalso possible to open separate windows on each instance in which case each instance can be
animated separately.

Note
D If the instance has not been selected, you are prompted to choose the instance when you
use a command which requires the full hierarchy path.

Y ou can display the Instances dialog box to set the ssmulator hierarchy path in aflow chart or
state diagram by using the button in the Animation toolbar or by selecting Choose
I nstance from the Animation menu.

In ablock diagram, you can choose the button in the Simulation toolbar or select Choose
I nstance from the Simulate menu.

For example, if there are four instances (10, 11, 12 and 13) of acomponent and simulation has
been invoked from the parent block diagram, you can simulate any of the four instances by
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setting the appropriate hierarchy path. Y ou can also open block diagram windows for each
instance and set a hierarchy path for each window.

— Limit Elaboration

£ Show no mare than: I inztances
& Show Al Instances
|lpdate |

Istackso
Istacksi
Istacksz
Istacks3

Istackso

ak I Cancel |

%

The hierarchy path is also used when you add a breakpoint to an instance of a component which
is used several timesin the same diagram.

There can be many instances on adiagram (particularly if your design contains nested FOR
generate frames) and the dialog box isinitially empty. Y ou can choose to show al available
instances or specify a maximum number of instances to display in the dialog box.

This elaboration limit is saved as a preference and used when the dialog box is next displayed.
The avail able instances determined by this limit are listed in the dialog box when you use the
Update button.

The dialog box also allows you to explicitly enter a hierarchy path. For example, when your
design contains many instances and you want to change the selected instance by simply
incrementing its instance number.

Thisisalso useful if a FOR generate frame has bounds which are not literal integers. Such a
frameistreated as a single instance with an index of 0 and a warning message is issued when
you select an instance path. However, you can then choose to accept the default index of O or
explicitly edit the instance path to the required value.

Setting the Simulator Environment

Theinitial simulator environment is determined by the selected design unit in the source
browser or the active view when you started the simulator. However, you can change the
simulator environment to any lower level without having to re-invoke the simulator.
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The following commands are available from the Environment cascade of the Simulate menu:

Selected Set environment to the selected block or component instance in a block
diagram.

Diagram Set environment to the active block diagram, flow chart or state diagram
view.

Top Set environment to the top level of simulation.

Report Reports the current simulator environment level. The pathname for the

current smulator environment is reported in a popup dialog box.

Running the Simulator

Y ou can run the simulator from a block diagram, flow chart or state diagram by using
commands from the Simulation toolbar or the Run and Step cascades of the Simulate menu.

Running a Simulation

Y ou can run the simulator using the following Run commands:

For Time n the simulator for the last specified time or you can use the
| button to display a pulldown list. A pulldown list allows you
to choose from the four most recently used timesteps, enter a
time interval by displaying adialog box or reset the default time
step specified in the ssmulator. When you enter atime interval,
the new interval replaces one of the default time stepsin the

pulldown list.
E}  Forever Run the until there are no more events schedul ed.
Continue Continue the ssmulation run after a step command or breakpoint.
To Next Event Run the simulator until the next event.

Stepping Through a Simulation
Y ou can step through a simulation using the following Step commands:
[ Over Line Stepsto the next HDL statement skipping any VHDL

procedures, functions or Verilog tasks by treating them as ssimple
statements instead of tracing each HDL line inside them.

8 IntoLine Steps into the next HDL statement.

Over Object Stepsto the next HDL statement representing a new graphical
object (for example, the next state) by stepping over HDL lines
for the current object. This command is availablein a state
diagram only.
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Displaying Simulator Windows
Y ou can open any simulator window by choosing one of the following options from the View
cascade of the Simulate menu:
Source Displays the smulator Source window

Structure Displays the ssimulator Structure window
Variables Displays the ssmulator Variables window

Signals Displays the simulator Signals window
List Displays the smulator List window
Process Displays the ssmulator Process window
Wave Displays the simulator Wave window

Dataflow Displays the ssmulator Dataflow window
All Displays al simulator windows

The Wave and List windows can also be opened automatically when you add signals as
described in “ Adding Signalsto Simulator Windows” on page 408.

Restarting the Simulator

Y ou can restart the simulator by using the button or by choosing Restart Simulator from
the Simulate menu in ablock diagram, flow chart or state diagram.

When you restart the simulator, the design hierarchy is reloaded in the smulator, all captured
data and animation views are cleared and the simulation time is reset to zero.

Using the ModelSim Source Window

If you have invoked ModelSmfrom aHDL Designer Seriestool, the Model Sm Source window
displays the source HDL files used for simulation.

The Source window is normally displayed in read-only mode.

If you need to make changes to aview which is described by agraphical view, the source design
object should be modified in the HDL Designer Series tool and the ﬁl button used to
regenerate, compile and restart simulation. However, if you want to directly modify aview
which is described by atext source object, you can toggle the Model Sm Source window to
editable mode from the Edit menu.

If you want to open aHDL text view of an embedded block from the HDL Designer Series tool
you can choose Send to Editor from the popup menu over the HDL text or by double-clicking
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over the embedded block. If ModdlSmisinvoked, this command sendsthe HDL text fileto the
Model Sm Source window instead of to the HDL Designer Series text editor.

Cross-Probing from ModelSim

If you have invoked ModelSmfrom aHDL Designer Series tool, the simulator toolbars and
Debug menu provide additional commands which support cross-probing with the graphical
views.

The following commands are provided in the main Model S m window:

Table 11-4. ModelSim Main Window Commands

Button Debug Menu Description

none Debug Detective Enabled | Enable or disable Debug Detective mode
none Use Source Window Enable Source window for HDL text views
Trace TOHDS Open selected object as agraphical view

The following command is provided in the Model Sm Source window:

Table 11-5. ModelSim Source Window Commands

Button Debug Menu Description
E Trace ToHDS Open view corresponding to HDL line

The following commands are provided in the Model Sm Wave window:

Table 11-6. ModelSim Wave Window Commands

Button Debug Menu Description

-@ Trace TOHDS Open view where selected signal is declared
Add Probe Add a probe to the selected signal
E3 Cause Show animation step at cursor time

The following command is provided in the Model Sm Structure window:

Table 11-7. ModelSim Structure Window Commands

Button Debug Menu Description
-\Tﬂ Trace TOHDS Open selected object as agraphical view
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The following menu commands are provided in the Model Sm List window:

Table 11-8. ModelSim List Window Commands

Debug Menu Description

Trace TOHDS Open view where selected signal is declared
Add Probe Add a probe to selected signal

Cause Show animation at cursor time

The following menu commands are provided in the Model Sm Signals window:

Table 11-9. ModelSim Signals Window Commands

Debug Menu Description
Trace TOoHDS Open view where selected signal is declared
Add Probe Add a probe to selected signal

If the Use Sour ce Window as Text Editor option is set in the Debug menu for the main
Model Smwindow, all HDL text views are displayed in thiswindow. If this option is unset, the
HDS text editor is used.

A button is added to the toolbar and a Trace To HDS command to the Debug menu in the
M odel Sm Source window which can be used to open the source design object corresponding to
the line of HDL code under the cursor.

The Trace To HDS command is also available in the Debug menu for the Model Sm Wave,
List and Signals windows (or using the button in the Wave window). It can be used in
these windows to display the source object where the selected signal isdeclared. (Typically, this
will be the test bench or top level block diagram for the design being simulated.) Y ou can also
trace asignal to HDS from the Wave or Signals windows by double-clicking on the signal.

A Trace ToHDS command isaso added in the Debug menu and a button to the toolbar in
the main Model Sm window and the Model Sm Structure window. They can be used in these
windows to open the source object corresponding to the selected instance.

If the HDS source is atext file (and Debug Detective led is set in the Model Sm Debug
menu or the Simulate menu in any graphical view) the button or Trace To HDS command
can be used to display an Open As dialog box which allows you to render the source text file as
agraphics view.
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The Open As dialog box is also displayed when you double-click over ablock or component
instance in ablock diagram, if the instance is described by a HDL text view.

— Show Test View Az Graphics

The HD'S zource is a test view
(]

ShowAs [ Default View Style =l
Cancel

[ Abways use this view style

Z

Y ou can choose to open the view using the default view style, or as a block diagram, state
diagram, flow chart or text view. (The default view style is used if the specified view cannot be
rendered.)

These views allow limited editing but fully support the simulation cross-probing and animation
features.

Note

D If you set the Always use this view style option in the dialog box, the dialog box is not
displayed and HDS attempts to always render HDL text views using the last selected
style.

Y ou can add simulation probes to the active graphical block diagram view by using the
button in the Model Sm Wave window or by choosing Add Probe from the Debug menu in the
ModelSmWave, List or Signalswindows. Refer to “ Adding and Removing Simulation Probes’
on page 411 for more information about using probes on graphical diagrams.

When you have invoked ModelSmfrom aHDL Designer Seriestool, a Q button is added to
the Model Sm toolbar and a Cause command to the Debug menu in the simulator Wave
window.

This command can be used to update al currently open animation windows to the simulation
step or event immediately preceding the time marked by the Wave window cursor for the
currently selected signal. If thereis no cursor in the Wave window, the ssimulation time is set to
zero.

If cursor tracking is enabled in a block diagram the values displayed by simulation probesin
these views track the simulation time under the Wave window cursor. If cursor tracking is
enabled in a state diagram and an animation view is displayed, the state machine animation
tracks the cursor.
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Note
D The cursor tracking feature is not available if you are using Model Sm PE.

A Cause command is also added to the Debug menu in the ssmulator List window and can be
used to update all open animation windows to the simulation step or event corresponding to the
selected line in the List window.

Model Sm uses the drivers command to determine the driver of the signal. If the signal isdriven
from an instance which corresponds to a diagram that can be animated and which has data
capture enabled, it is opened (or popped to the front if already open).

If the selected signal isavector, the driver of the first element in the vector is chosen. This may
be incorrect if the vector has more than one driver.

If the instance corresponds to a state machine or flow chart with concurrent diagrams, the
default concurrent state machine or flow chart is opened although the process driving the signal
may be contained in one of the other concurrent diagrams. The last view of the diagram is
displayed and may not include the current animation state or action (especialy if itisina
hierarchical diagram).

State Diagram and Flow Chart Animation

The state diagram and flow chart viewsin aVVHDL or Verilog design can be animated if a
ModelSmor NC-Sim simulator is available.

Animation exercises the generated HDL for your design and displays simulation behavior
graphically on the source diagrams as well asin the monitoring windows provided within the
simulator.

Y ou can animate individual flow charts and state machines, one or more diagramsin a
hierarchical branch of your design or the entire design. For example, you can invoke simulation
from atest bench block diagram and simultaneously display animation for the flow chart which
controls the test bench and state diagrams within the design under test.

Note
D If you enable animation in a concurrent or hierarchical diagram, al the flow charts or

state diagrams are animated. Flow chart or state diagram views describing an embedded
block can be animated but you cannot animate an embedded view which is contained
within aFOR generate frame.

The views can be animated in three usage modes:

* Animation of one or more diagrams or an overall system with simulation stimuli
provided by aHDL test bench. The test bench runs scenarios which are selected at run
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time by setting HDL signals and variables in the test bench. In this mode, smulation is
initiated by arun command.

* Animation of one or more diagrams with simulation stimuli provided by a "dofil€"
which contains force, breakpoint and run commands.

* Interactive animation of asingle diagram using single stepping or run simulation
commands controlled from the simulator command entry window. Forces and
breakpoints are applied interactively.

The Enable Communication with HDS option must be set in the Simulator Invoke Settings
dialog box if you want to use the simulation cross-probing or animation facilities.

Animation Toolbar

The Animation toolbar is automatically displayed in the state diagram and flow chart views
when a supported simulator has been invoked and supports the following commands:

Table 11-10. Animation Toolbar

I con Description

Step backward through animation history

Step forward through animation history

Sets review mode to step by states

Sets review mode to step by simulation events

Moves to a specified simulation time

Moves to a specified simulation time

Moves to the start of ssmulation time

Moves to latest smulation time

Enables capture of animation data

e Clears the animation data for the current instance

=

Displays animation view

Sets up the activity trail for capture and display

Moves ModelSm Wave and List windows to current animation time

Choose instance for simulation

FEaE

Links all currently animated diagrams

Note that the [P@l7], [P¥] or [Pl buttons display a pulldown menu which allows you to
change the mode. When one of these options is chosen the button changes to indicate the
selected mode.
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Y ou can also step backward or forward through the animation by using the Ctrl + Shift + < or
Ctrl + Shift + > shortcuts.

Thetoolbar is normally displayed at the bottom of the diagram window but can be undocked,
moved, docked or hidden in the same way as the other toolbars.

The toolbar can be displayed or hidden by setting the Animation Tools option in the Toolbar s
cascade of the View menu.

Refer to “ Toolbars” on page 20 for more information about toolbars.

Enabling Data Capture

Animation data capture can be enabled for any graphical state machine or flow chart within the
current hierarchy being ssmulated. However, if you want to apply stimulus to a hierarchy of
diagrams, you must invoke simulation from a structural HDL view at the appropriate level.

In order to animate aflow chart, the flow chart must have been generated with the Instrument
HDL for Animation option enabled in the Generation tab of the Flow Chart Properties dialog
box.

In order to fully animate a state diagram, the state machine must have been generated with the
Instrument HDL for Animation option enabled in the Generation tab of the State Machine
Properties dialog box. If this option was not enabled, the animation will show changes of state
but full animation (for example, transitions taken and moving by clock cycle) is not available.

The extraHDL code generated for animation is enclosed between translation pragmas so that it
can be ignored by downstream tools which recognize the pragmas.

If you invoke the simulator from within aflow chart or state diagram, you are prompted whether
to enable data capture and show animation. If you confirm this dialog box, data capture is
enabled and the animation view is displayed.

Alternatively, if the ssimulator is aready invoked, you can use the [tafl| button in the Animation
toolbar or choose Data Captur e from the Animation menu to enable animation for the active
state diagram. The button is shown pressed when data capture is enabled.

The animation view is automatically selected when you enable data capture but can be toggled
by using the EI button or choosing Show Animation from the Animation menu. The buttonis
shown pressed when the animation view is displayed.

When data capture is enabled, simulation datais stored to capture animation activity. When the
animation view is displayed, the diagram is set to be read-only and the graphics are updated
directly from the simulation data whenever the simulator stops at a breakpoint or at the end of a
run.
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Y ou can enable animation for all instances in the current simulation hierarchy by choosing
Global Capture On from the Animation menu (or from the Animation cascade of the
Options menu in the design manager). An animation view is automatically shown for any state
diagrams or flow charts which are opened after this option has been set.

Data capture can be stopped for al diagrams by choosing Global Capture Off from the
Animation menu (or from the Animation cascade of the Options menu in the design manager)
and you can stop the capture of animation data for the active diagram by unsetting the |faf
button or by clearing the Data Captur e option in the Animation menu.

The stored data is cleared when the smulator is restarted or reloaded and when the session is
exited. In addition, you can clear the animation data at any time by using the button or by
choosing Clear Captured Events from the Animation menu.

Setting the Activity Trail

The current and previous steps (for aflow chart animation) or the current and previous states
plusthe last transition (for a state machine animation) are normally highlighted in the animation
view.

The activity trail allows you to control how much additional animation activity is displayed
relative to a particular time in the ssmulation history or at a particular clock cyclein simulation
history.

Y ou can set the activity trail to highlight all visited stepsin aflow chart or visited states and
transitions in a state machine, a specified length (number of steps or transitions) or no activity
trail.

Y ou can change the activity trail settings by using the button or choosing Activity Trails
from the Animation menu to display the Activity Trail Settings dialog box.

If you are using Model Sm, you can specify the maximum number of simulation events captured
for each diagram during an animation run. When thislimit is exceeded, old events are discarded
to reduce the total amount of stored data.
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For a state machine, you can also choose whether to capture data about evaluated conditions or
active clock edges. If all the capture options are unset, no datais saved, however, the animation
Is updated with the latest simulation data when the simulator stops.

H[} Activity Trail Settings

— Capture — Dizplay
b amirnurn number of events % From Start
[10000 © From Time |
[T Conditions when evaluated " Fived Length I
[T &ctive Clock Edges (il
[ Mark conditions when evaluated anly

(] I EanceIJ/

e

Y ou can specify the length of the displayed activity trail in terms of the simulation time or the
number of visited objects (an object corresponds to avisited state in a state machine).

If you choose the From Start option, all objects visited since data capture was enabled are
highlighted. Y ou can also hide the activity trail except for the last step (or last state and
transition) by selecting the Off option.

For a state machine, you can also choose whether conditions evaluated to be true but not
followed are highlighted in the activity trail. This may occur if acondition is evaluated to be
true but reverts to false before the next clock edge which would cause the transition to be
completed.

Y our activity trail choices are saved as preferences and re-used for the next animation run.

The initial data capture preferences for events captured, evaluated conditions and active clock
edges are shown as a comment in the main simulator window which is repeated if the activity
trail settings are modified.

For example, hds_ani m prefs 8000 O 1 indicatesthat up to 8000 events can be
captured, evaluated conditions are ignored but events on active clock edges are included.

Graphical Highlighting
The following color conventions are used in an animated flow chart:

red fill: Current step

yellow fill: Previous step
bluefill: Previously visited steps
white fill: Unvisited objects
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The following color conventions are used in an animated state diagram:

red fill: Current state or last transition taken
yellow fill: Previous state or transitions

bluefill: Previously visited states and transitions
green fill: Transitions evaluated but not followed
white fill: Unvisited objects

Reviewing Animation

Y ou can use the animation view to investigate the cause and effect of animation events by
moving to a specified point in the animation.

In an animated flow chart, you can you can move forwards or backwards to display the
preceding and following steps by using the E or |E buttons from the Animation toolbar or
choosing Goto Next or Goto Previous from the Animation menu.

In an animated state diagram, you can choose whether to M ove By States, Move By Eventsor
Move By Clocks by selecting options in the Animation menu or by using the | P& v|, | }!H or
buttons on the Animation toolbar.

Y ou can change the current setting of these buttons by using the El icon to pulldown achoice
menu. The current setting of these buttons isindicated on the button.

Note
D The Move By Clocks option is not available unless the Active Clock Edges option is

enabled in the Activity Trail Settings dialog box to capture events associated with active
clock edges.

For each of these options, you can move forwards or backwards to display the preceding and
consequential events (change of state, clock cycle or other animation event) by using the or

buttons from the Animation toolbar or choosing the Goto Next or Goto Previous option
(Clock, State or Event) from the Animation menu.

Y ou can also usethe Ctrl + Shift + < shortcut to Goto Previous or the Ctrl + Shift + > shortcut
to Goto Next.

Y ou can use the button (or choose Goto Time from the menu) to view a specified
animation time, the | M] button (or Goto Start from the menu) to return to the start of the
animation or choose the |E button (or Goto L atest from the menu) to view the latest
animation event.

If you choose Goto Time, adialog box is displayed for you to enter an absol ute animation time:
When you execute the dialog box, the animation time is set to the specified absolute time (or the
time of the closest preceding event if no event occurred at the specified time).
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When you use any of these commands, the animation status is redrawn and the activity trail is
shown relative to the new animation time. The current animation timeis displayed on the status
line at the bottom of the animated window and an indication when you are at the start or end of
an animation run.

When you are using Model Sm, you can use the "2 button or choose Cause from the
Animation menu to move the Wave window cursor to the current animation time. (The current
animation time should also be highlighted in the Model Sm List window.)

Linking Diagrams for Animation

You can link all open state diagrams and flow charts in the simulation hierarchy which are
currently being animated by using the button or choosing Link Diagramsfor the
Animation menu in any animated diagram.

When this command is enabled, al animation review commands executed in one diagram, also
animate the linked diagrams.

The button is shown pressed and the link closed | when diagrams are linked.

Mixed Language Animation

Mixed language animation is supported when you are using the Model Sm simulator. Note
however, that VHDL is case-insensitive and case sensitive Verilog names (for example,
different instances named 12 and i2) may cause problemsin a mixed language design. You are
advised to avoid using names that differ only by case in Verilog designs that need to co-exist
with VHDL.

Y ou can animate a mixed language design using the NC-Sim simulator but you cannot display
animation views for both languages in the same simulation run. If the top level view isVerilog,
you can instrument the generated HDL for all VHDL and Verilog views but can only display
animation for the Verilog diagrams. If the top level view isVHDL, error messages are issued if
the design includes any instrumented Verilog views and the design cannot be loaded.
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Chapter 12
Using a Test Bench

This chapter describes how you can create a graphical test bench to validate your designs.
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Test Benches

A test bench alows you to apply stimuli to your design and ensure that it fully meets the
specified requirements.

The input stimuli and corresponding output waveforms are just as important as the design
description itself. If made available early in the design cycle, they can be used to test all phases
of the design including behavioral, RTL and gate level designs.

A set of test stimuli available at the start of the design process reduces the number of design
iterations by allowing the designer to check resultsfor each level of abstraction and to verify the
consistency of the design between levels.

Y ou can implement atest bench by instantiating your design as a component in ablock diagram
or IBD view. Then connect the component to a block (or blocks) implementing the stimulus and
output checking circuits.

These blocks can be described directly using VHDL or Verilog HDL text views or graphically
by using block diagrams, IBD views, state diagrams, truth tables or flow charts.
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For example, the test bench in the graphical design tutorial uses asingle block Timer_tester
described by aflow chart which provides both the test stimuli and output checking logic.

alam’
TUTORIAL o
Timer_tester high (20
1 U

Tai © (30

Creating a Test Bench

Y ou can automatically create atest bench by choosing Test Bench from the New cascade in the
File menu of any graphic editor window that represents a component. This command is also
available in the design explorer when a component design unit or component design unit view
IS selected.

The Create Test Bench dialog box is displayed with adefault name for the test bench created by
adding the suffix _tb to the design unit name. Y ou can change this name and choose alibrary to
contain the test bench.

Y ou can also create atester unit to test your design unit by checking the Tester checkbox. The
tester moduleiscreated with a default name adding the suffix _tester to the design unit name.
Y ou can change this name and choose alibrary to contain the tester unit.

HOL Designer can generate a Test Bench for the selected Dezign Unit, graphical [Block Diagram] or purely textual.

View of Uit Under Test: IDefauIt j
Type: " Graphical " Textual Libran:  [scRaTCH_LE j
Language: ¢ Verilog * YHDL
— Test Bench v Tester
Dresign Lnit name: Istatus_registem_th Design Unit name: Istatus_registers_tester
Yiew name: Iru Yiew namme: I,t|

— Textual instance labels naming method

&+ Numbered: U_<instance number: " Prefized: I <desigr unit names
| 0K I Cancel Help

,
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When you confirm the dialog box, ablock diagram is created containing an instance of the
component under test and atester block with ports corresponding to each port on the component
which are implicitly connected to the component ports by name.

The tester block can be used to provide input stimulus and output checking signals by opening
down to create a child view. This view can be any valid design unit view. For example, it may
be ablock diagram, IBD view, HDL text view, sequential flow chart or state machine.

Any required VHDL packages (for example, if the interfaces to the component are custom
defined) are automatically included on the test bench block diagram.

Defining Stimulus

The HDL Designer Series ModuleéWare library includes a number of waveform generator parts
which can be instantiated in ablock diagram, IBD view or HDL text view are used to generate
stimulus waveforms for your test bench.

Y ou can also define stimulus using concurrent and sequential processesin aflow chart or state
machine or by writing aHDL text view using standard techniques such as lookup tables and
TextlO.

When you are using VHDL, the std_devel oper skit standard library contains a number of
procedures and functions which may be useful when you are designing atest harness. For
example, these can be used to build Typical or Maximum timing into models, convert VHDL
typesto strings for usein File 1/O and ASSERTS, perform arithmetic on unlimited length
register sets and build memories of any size and program them from ASCI| files.

Using ModuleWare Stimulus Generator Parts

The ModuleWare library Stimulus category provides a number of parameterized generators
which can be used to setup clock, pulse and constant, random value or counter based
waveforms.

Refer to the ModuleWar e Reference Guide for afull description of these parts.

Refer to “Instantiating a ModuleWare Component” on page 110 for information about using
ModuleéWare parts in ablock diagram or IBD view.

Refer to the DesignPad Text Editor User Guide for information about instantiating
ModuleWare partsin aHDL text view.

Defining Stimulus on a Flow Chart

Stimulus generation within atest bench is predominantly sequential in nature.
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Although separate processes are likely to be used for clock and reset generation, most of the
code to generate stimuli islikely to be contained in a single process.

This process can conveniently be represented as a flow chart and separate action boxes can be
used to represent procedures and functions for generic operations (such as ‘write to register’) or
to separate out distinct blocks of code.

Theresult isarelatively short, top-level process which sequentially calls a series of procedures
and functions to perform the main tasksin turn.

There are a number of techniques which can be used to define stimulus on aflow chart
including Wait, Loop and Case statements.

Wait Statements

Wait statements can be used for results analysis where signal values are checked relative to one
another or particular values are expected at certain times.

The VHDL WAIT command has four variants:

WAIT causes an indefinite suspension of aprocess, for example,
after an initial trigger pulse.

WAIT FOR <time> suspends the process for the specified time.

WAIT UNTIL <condition> suspends the process until a specified condition becomes
true.

WAIT ON <signal> suspends the process until an event occurs on the
specified signal(s).

Y ou can combine FOR, UNTIL and ON clauses which may also include valid arithmetic
operators.

For example:

wait until ((high="000")AND(I|ow="0000")) for 6000ns;

In Verilog, you can use wait statements and al so use the @ operator to specify an event or # to
specify atime delay.

For example:

wait ((hi gh==4"d0) &&(| ow==4"'d0));
@ posedge cl k);

#12;

#cl k_prd;
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Loop Statements

L oops can be used to apply repeating patterns, read and apply values from tables or files and
progressively increment or decrement values. For example, aloop variable can be used to
assign avalue using a function:

VHDL Verilog
FORJ INO TO 7 LOOP for (j=0;j<=7;j=j+1)
x <= conv_funct (J); x = conv_function(J);
WAI T FOR 20 ns;
END LOCP;

Case Statements

If stimulusisto be applied at different specific times, acounter can be used as an index within a
Case statement to count clock cycles and determine which stimuli set is applied. For example:

CASE el apsed_counter |S
WHEN 13 => x <= '1’;

y <: 3 O) ;

WHEN 27 => x <= ‘0’;
END CASE;

Defining Stimulus using Lookup Tables

A lookup table containing arrays or records can be defined using CONSTANTS in the
declarations on adiagram or in a separate VHDL package. Such atable can be sequenced
through or used to apply particular values depending on the value of other index signals.

L ookup tables exploit the power of HDL and can be easily related to the required results.
However, recompilation is necessary if any changes are made to the code.

In the following example, the procedure write_table performs a series of write operations to
load internal data tables and simulate the operation of an external microprocessor.

CONSTANT sys clk : tinme := 50 ns;
CONSTANT row : | NTEGER : = 4;
CONSTANT col : |INTEGER : = 4;

TYPE table is ARRAY(1 TOrow, 1 TO col) OF | NTEGER,
CONSTANT | ookup_table : table := (

( 1, 2, 3, 4),

( 5 6, 7, 8),

( 9,10,11,12),

( 13, 14,15,16 )

)
PROCEDURE write_ tabl e(
SIGNAL Wite : QUT slv_0do;
SI GNAL Address_Bus : OUT slv_4do;
SIGNAL Data_Bus : OUT slv_7d0) IS
BEG N
FORi IN1 TO row LOOP
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FORj IN1 TO col LOOP
Wite <="'1" ;
Address_Bus <=
to_stdlogicvector((((i-1)*4)+(j-1)),5);
Data Bus <=
to_stdl ogi cvector(l ookup_table(i, j), 8) ;
WAIT FOR sys_cl k ;
Wite <='0" ;
WAIT FOR sys_clk ;
Wite <= '1" ;
WAI T FOR sys_cl k ;
Address_Bus <= (OTHERS => '0') ;
Dat a_Bus <= (OTHERS => '0') ;
WAIT FOR sys_clk ;

END LOOP ;

END LOOP ;
END wite table ;

Note
D Nested For loops are used to sequence through each row and column of the table. The

values for Address Bus are calculated from the row and column indices. All bits of each
busareset to ‘0’ between write cycles by assigning (OTHERS =>‘0").

we  f N/ S
Address_Bus X "O0000" >\ /< — }\
X )

Data_Bus 00000001 " x /< "0000004 0"

|-¢—D-| zyvs_clk =50 ns

Defining Stimulus using TextlO

TextlO provides a mechanism to read stimulus filesinto atest bench at run time. This makesit
easier to change values and does not need recompilation. In thisway, atest bench can be made
genera purpose. For example, the same test bench can be used for a number of variants of the
same basic design.

The VHDL 93 standard adds a number of enhancements to the basic TextlO capability,
allowing files to be opened and closed for read or write at run time. The addition of pointers
allows navigation within afile.

In the following example, afile ctrl_registers.txt contains values to be loaded into the three
control registers RT1, RT2 and RT3. The procedure write_ctrl_registers reads the data from the
file and simulates the microprocessor writing values into the internal control registers.
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FILE ctrl _file : TEXT IS IN "ctrl _registers.txt"

PROCEDURE wite ctrl _registers(
SIGNAL Wite : QUT slv_0do;
SI GNAL Address _Bus : QUT slv_4do;
SIGNAL Data Bus : QUT slv_7d0) IS

VARI ABLE good : BOCLEAN ;
VARI ABLE RT : | NTEGER ;
VARI ABLE ctrl _line : LINE;

BEG N
| F NOT ENDFI LE(ctrl _file) THEN
READLI NE(ctr!l _file, ctrl _line) ;
FORi INO TO 2 LOOP
READ(ctrl _line, RT, good) ;
| F good THEN
Wite <= "'1' ;
Address_Bus <= to_stdlogicvector((16 + i), 5)
Data_Bus <= to_stdl ogi cvector(RT, 8) ;
WAIT FOR sys_clk ;

Wite <= '0" ;
WAI T FOR sys_cl k ;
Wite <= "1' ;

WAIT FOR sys_cl k ;
Address Bus <= (OTHERS => '0') ;
Data Bus <= (OTHERS => '0') ;
VWAIT FOR sys_cl k ;
END I F ;
END LOOP ;
ELSE
ASSERT fal se REPORT "END OF FI LE reached"
SEVERI TY NOTE ;
END | F ;
END wite ctrl _registers ;

The ctrl_registers.txt file contains the following data:

-- ctrl_registers.txt
-- RT1 RT2 RT3
1 2 3
4 5 6

Thefileisdeclared and aline isread from the file into the variable ctrl_line. A loop then reads
each of the three fieldsin turn into the variable RT. Variable good is the status returned by the
read operation. The Address Bus value is calculated from the loop index and the value of RT is
assigned to the Data_Bus.

The Textl O function ENDFILE indicates when the end of the file has been reached. In this
example, an ASSERT statement issues a note to that effect.
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Defining Stimulus using a State Machine

A state machine can be used to apply a sequence of stimuli values, either on each clock or when
certain conditions are true.

In the following example, an internal signal test_counter_int is created and used to count the
clocks to the state machine. The count value is assigned to the test_counter output signal which
can be used for stimulusin the test bench.

Glohal Actions

test_counter == test_counter_int ;
test_counter <= test_counter +'1';

state 1
out0=="1";
outl=="0";

Stop_Start="1" Stop_Start="1'

start state

out0=="0";
outl=="0";

state 2

out0=="0";
outl=="1";

Stop_Start="1'

Stop_Start="1'

state 3
out0=="1";
outl=="1";

Generating a Clock using HDL Statements

A clock or repeating waveform can be generated using concurrent or sequential statements.

If your test bench isimplemented as a flow chart, these statements can be included as
concurrent statements on the diagram. Alternatively, the statements could be included inaHDL
text view defining a clock generator block on a block diagram.

When you are using VHDL, arepeating clock waveform can be generated using concurrent
statements. For example, the following architecture declarations and concurrent statements are
used to generate a 10MHz clock by inverting theint_clk signal AFTER half the clock period:

Architecture Decl arations
CONSTANT clk_prd : time := 100 ns;
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SIGNAL int_clk : std logic :="'0";

Concurrent Statenents
int_clk <= not int_clk AFTER clk_prd / 2;
clk <= int_clk;

Alternatively, you can use a sequential VHDL process. For example, the following architecture
declarations and sequential statements are used to generate a 10MHz clock by looping around
four sequential statements which aternately assignthevalues‘0’ and ‘1’ toiclk after aWAIT of
half the clock period:

Architecture Decl arations
CONSTANT clk_prd : time := 100 ns;
SIGNAL iclk : std_logic;

Concurrent Statenents
cl ock_gen : PROCESS
BEG N
iclk <= '0";
VWAIT FOR cl k_prd/ 2;
iclk <= "1';
WAIT FOR cl k_prd/ 2;
END PROCESS cl ock_gen;

clk <= iclk;

When you are using Verilog, arepeating clock waveform can be generated using initial and
always statements.

For example, the following module declarations and concurrent statements are used to generate
a10MHz clock by inverting theint_clk signal after half the clock period:

Modul e Decl arati ons
reg int_clk;
paraneter clk_prd = 100 ;

Concurrent Statenents

initial

begin

int_clk = 0;

forever #(clk_prd/2) int_clk = ~int_clk;
end

al ways @int_cl k)
clk = int_clk;

Analyzing Results

The output checking logic in atest bench can perform analysis on the outputs from the design
under test. It can also give a Pass or Fail indication for the design and provide messages
indicating where results differ from those expected.
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When you are using VHDL, ASSERT statements can be used to display messages in the main
simulator window if atest condition is false. Assertions have three severity levels: Error,
Warning or Note and you can specify what severity causes the simulator to stop.

The std_iopak package in the std_developerskit library contains string concatenation functions
which can be used to include simulation values in messages as shown in the following example:

ASSERT f al se

REPORT "DRis " & to_string(DR "%l") & " clks w de"
SEVERI TY not €;

ASSERT (DR = DR_REF)

REPORT "DR width incorrect!™

SEVERI TY ERROR;

When you are using V erilog, messages can be displayed using the Verilog $display() function.
For example:

$di splay("DR wi dth incorrect!");

For a control dominated system, the behavioral model used to generate the expected results can
be represented by a state machine. For example, when using a master counter to count clock
cycles and apply stimuli at certain counter values, the counter signal can also be fed to the
results analysis process.

A state machine may be used to perform specific checks depending on the value of the counter
or other sets of conditions on inputs.

In the same way that |ookup tables can be used as a source of input stimuli, they can also be
used to store reference values.

TextlO can be used to read in values corresponding to the expected results from ASCII files
which were created manually, or from abehavioral model. It can also be used to write out
results or errorsto afile for subsequent analysis or documentation.

Re-using a Test Bench

A test bench can be re-used to verify different stages of your design. For example, to check that
the RTL version of your design performs identically with theinitial behavioral version.

The design under test can be updated by changing the default view of the component
representing the design under test or by instantiating a new test design into an existing test
bench. If the interface signals correspond to those used in the test bench, you can add signal
stubs to the test component and use connection by name to avoid having to re-connect signals
between the test harness and the design under test.
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For example, the following block diagram with explicit connections:

oithas

_cutbus2” L TEST
Cratpuat_Checker
12

TEST
Input_Generator
I1

is functionally equivalent to the following diagram which is connected by name:

L e
o

TEST
Input_Generator
I1

TEST
Cratpuat_Checker
I2
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HDL Designer Series Glossary

This glossary defines the standard terminology used in the HDL Designer Seriestools.
— A —

action box
A named object on aflow chart or ASM chart containing actions which are executed when the
box is entered by aflow. Each action box must have one input flow and one output flow. See adso
case box, decision box and wait box.

action
An operation performed by a state machine, flow chart or truth table which modifies its output
signals. In astate diagram, there can be transition actions executed when an associated
condition occurs or state actions executed when a state is entered. In aflow chart, the actions are
executed when a flow entering the action box is followed. In atruth table, actions are generated
from the values assigned to a variable in an output column or can be explicitly entered as
additional actionsin an unnamed output column. See also global actions.

activity trail
A summary of simulation activity (states visited and transitions taken) displayed on an animated
state diagram.

anchor
An anchor attaches atext element to its parent object. For example, the name and type of asignal
in ablock diagram or the transition text and its transition arc in a state diagram. An anchor is
also used to attach a simulation probe to its associated signal.

architecture declarations
User-specified VHDL statements which can be entered in a state diagram, flow chart or truth
table and are declared for the corresponding VHDL architecture in the generated HDL.
Architecture declarations are typically used to define local signals or constants. See also entity
declarations and process declarations.

ASIC
ASIC stands for Application Specific Integrated Circuit.

ASM
An algorithmic state machine describes the behavior of a system in terms of a defined sequence
of operations which produce the required output from the given input data. These sequential
operations can be represented using flow chart stye notation as an ASMI chart.
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ASM chart
A graphical representation of an algorithmic state machine which uses flow chart style objectsto
represent states, conditions and actions.

asynchronous
An asynchronous process is activated as soon as any of its inputs have any activity on them
rather than only being activated on a clock edge. See also clocking.

— B —

black box
A view which has HDL trandlation pragmas set so that it is not analyzed or optimized for
synthesis. See also don’t touch.

black box instance
An instance of acomponent on ablock diagram or IBD view which has no corresponding design
unit. A black box instance may exist in a partial design which instantiates a view which has not
been defined.

block
The representation of afunctional object on ablock diagram or IBD view. Also the design unit
that contains the object definition. A block has a dynamic interface defined by the signals
connected to it on the diagram and istypically defined by a child block diagram, IBD view, state
diagram, flow chart, truth table or HDL text view. See also embedded block and component.

block diagram
A diagram editor view which defines a design unit view in terms of lower level blocks and
components connected by signals. See also IBD view.

bottom-up design
The process of designing a system starting from the primitive or leaf-level views and progressing
up through parent views until the design is completed. See also top-down design.

bounds
The range of possible values for asignal with integer, floating, enumeration or physical type.
Also used to specify the index constraint for an array type. A VHDL range is normally shownin
theformat (15 DOANTO 0) or (0O to 7).A Verilograngeisshown intheformat [ 15: 0]
or[0:7].

breakpoint
A breakpoint can be used to interrupt the progress of asimulation at a specific point in the
generated HDL. For example, you could set a breakpoint on asignal to interrupt the ssmulation
when the signal changes value or on a state to interrupt the simulation when the state is entered.

bundle
A group of signals and/or buses with different types drawn as a composite line on a block
diagram.
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bus
A named vector signal with atype and bounds drawn as a composite line on a block diagram.
See also net and bundle.

_C—

case box
A named object which represents a CA SE statement on a flow chart or ASM chart. When used
for decoding action logic each Case has an associated End Case object. A case box has one input
flow and one or more output flows corresponding to the possible values for an evaluated CASE
expression. See also action box, decision box, if decode box and wait box.

child
A view instantiated below its parent in the design hierarchy. A component or block on a block
diagramor IBD view typically has achild design unit view which may be another block diagram,
IBD view, state diagram, flow chart, truth table or aHDL text view. Also used for the embedded
view representing a hierarchical state or “hierarchical state box” on page 450 in a hierarchical
state machine or a hierarchical action box in a hierarchical flow chart or ASMI chart.

clocked signal
A signal in a state machine whose value is assigned to an internal signal by the clocked process.
Thisinternal signal is continuously assigned to the real output signal. No default value need be
specified. Typically used for an internal counter whose value is also required as an output. See
also combinatorial signal and registered signal.

clocking
The timing aspects of behavior can be asynchronous or synchronous (explicitly clocked).

clock point
An object on an ASM chart which displays the clock signal name and condition. See also enable
point and reset point.

clone window
A duplicate view of agraphical editor window. All select, highlighting and edit operations are
made in both windows. However, you can display different parts of the diagram or table in each
window.

combinatorial signal
A signal in a state machine whose value is directly assigned to the output port. See also clocked
signal and registered signal.

comment graphics
Annotation graphics which can be used for illustration on a block diagram, state diagram, flow
chart or symbol.
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comment text
Annotation text on a block diagram, state diagram, flow chart or symbol which can optionally be
attached to an object and included as comments or HDL code in the generated HDL for the
diagram.

compiled library
A repository within alibrary containing downstream compiled objects usually created by
compiling the HDL filesin adesign data library.

compiler directive
An instruction to the Verilog compiler. Typically used to define library cells or define a macro
which controls conditional compilation. Also used to include specified Verilog file or define the
simulation time units. The directive is effective from the place it appearsin the Verilog code
until it is superseded or reset.

complete transition path
The sequence of one or more partial transitions going from one state to another state (or itself)
in astate machine. The conditionsin the transition path are the collection of al the conditionson
theindividual transitions. The action in the transition path are the collection of all the actions on
the individual transitions plus the actions of the origin state. When tracing the transition path,
links are resolved to the referenced start state, state or junction. See also partial transition.

component
A design unit that contains a re-usable functional object definition or the instantiation of this
object on ablock diagram or IBD view. A component has a fixed interface and may be defined
by achild block diagram, IBD view, state diagram, flow chart, truth table, ModuleéWare, HDL
text, external HDL or foreign view. See also embedded block, block and port map frame.

component browser
The component browser is a separate floating window which can be used to browse for
components available in the current library mapping. Components can be instantiated in an
editor view by copy and paste or drag and drop.

concurrent events
Occurrence of two or more events in the same clock cycle.

concurrent statements
Statements which can be entered in a state diagram, flow chart or truth table and areincluded in
the generated HDL at the end of the VHDL architecture or Verilog module. Concurrent
statements are applied to all diagramsin a set of concurrent state machines.

condition
A condition in astate machine is a boolean input expression which conformsto HDL syntax, and
when it evaluates to TRUE, causes atransition to occur. The expression usually consists of a
signal name, arelational operator and avalue. In aflow chart, conditions are used in adecision
box to determine which output flow is followed. In atruth table, conditions are generated from
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the values assigned to a variable in an input column or can be explicitly entered as additional
conditions in an unnamed input column. See also transition priority.

configuration
A definition of the design unit views that collectively describe a design by listing the included
VHDL entities and architectures. A configuration may also include specification of the values
for VHDL generics associated with components in the design. See also VHDL configuration.

connectable item
A nodein ablock diagram, flow chart or state diagram that can be the source or destination of a
signal, flow or transition.

current view
The design unit view of ablock or component that is currently used. Thiswill be the default view
unless aloaded configuration specifies otherwise.

—D—

decision box
A named object on aflow chart or ASM chart containing a condition. Each decision box has one
input flow and two output flows (corresponding to the TRUE and FAL SE conditions for an IF
statement). See also action box, case box and wait box.

default view
The design unit view used in hierarchical operations, open commands and HDL generation
(unless a loaded configuration specifies otherwise). See also current view.

design data library
A repository within alibrary containing source design data objects. There are usually different
library mappings for graphical editor or HDL text source views. See also compiled library.

design explorer
The source browser design explorer windows can be used to browse the content and hierarchy of
the source design data using user-defined viewpoints displayed in tree or list format.

design manager
Themain HDL Designer Serieswindow which isused for library management, data exploration,
design flow and version control. The design manager includes a shortcut bar, project manager,
design explorer, side data browser, downstream browser, task manager and template manager.

design unit
A subdirectory within a design data library which is represented by an icon in the design
explorer. Design units may be blocks, components or unknown design units.

design unit view
A description of a design unit. Multiple views of block or component design units can describe
alternative implementations. These can include block diagram, IBD view, state diagram, flow
chart, truth table or HDL text views.
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DesignPad
The built-in VHDL and Verilog sensitive editor and viewer for HDL text views.

destination
The connectable item at the end of asignal, transition or flow. See also source.

diagram browser
The diagram browser is an optional sub-window which displays the structure and content of the
active diagram editor view.

diagram editor
An editable block diagram, state diagram, flow chart or symbol window which represents a
design unit view using graphical objects. See also graphical editor and table editor.

don’t touch
A control placed on adesign unit or design unit view which disables specified downstream
operations. See aso black box.

downstream browser
The downstream browser displays the contents of the compiled library for the design data
library currently open in the active design explorer. See also source browser, side data browser
and resource browser.

downstream only library
A library which has library mappings defined only for downstream compiled data.

— E—

embedded block
The representation of an embedded view on a block diagram or 1BD view which has a dynamic
interface defined by the signals connected to it but unlike a block or component does not add
hierarchy to the design.

embedded view
An embedded view describes concurrent HDL statements on ablock diagramor IBD view and is
represented by an embedded block which can be defined by a state diagram, flow chart, truth
table or HDL text.

enable point
An object on an ASM chart which displays an enable signal name and condition. See also clock
point and reset point.

end point
A flow chart must have at least one end point which is always named end. See also start point.
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entity declarations
User-specified VHDL statements which can be entered as propertiesin a symbol and are added to
the corresponding VHDL entity declarations in the generated HDL . See also architecture
declarations and process declarations.

entry point
A connector on achild state diagram which connects to a source in the parent state diagram. See
also exit point.

exit point
A connector on a child state diagram which connectsto a destination in the parent state diagram.
See also entry point.

explicit clock
A net on ablock diagramor IBD view which isused asaclock signal by the instantiated views of
blocks, embedded blocks or components. See also clocking.

external HDL
A HDL description which was not created by a HDL Designer Seriestool (for example, user-
written VHDL or Verilog, gate-level HDL models created by synthesis, Inventra, FPGA or 3Soft
core models). A port interface must exist for the referenced model asaVVHDL entity or Verilog
module. See also HDL view and foreign view.

— F—

flow
An orthogonal line connecting objects on aflow chart. A flow can end on another flow (by
creating aflow join) but cannot start from a flow.

flow chart
A diagram editor view which represents a process in terms of action boxes, case boxes, decision
boxes, wait boxes and |oops connected by flows. A flow chart must also contain one start point
and one or more end points.

flow join
A connection between flows shown as a solid dot where the flows mest.

foreign view
A non-HDL description (for example, a C or C++ view) with aregistered file type which
requires an external HDL generator. See also external HDL.

formal
A signal or bus associated with a port on a component. Typically, aformal port is connected to
an actual signal or bus on the parent view which has the same properties but may have a different
name. Formal ports and actual signals with different properties can be connected using a port
map frame.
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FPGA
FPGA stands for Field Programmable Gate Array.

functional primitive
A block or component that is not further decomposed but fully defined by its own views.
However, there may be both a block diagram or IBD view which describes its behavior in terms
of lower level blocks or components and, for example, aHDL text view which fully definesits
behavior. In this case, the current view determines whether the block or component isa
functional primitive.

— G —

generate frame
An optional outline which can be used to replicate structure using a FOR frame or conditionally
include structure using an IF frame (and EL SE frame in Verilog). Also used in VHDL to cluster
concurrent objectsusing aBLOCK frame.

global actions
Explicit action in a state diagram or truth table which are always performed. In a state machine,
global actions are executed on registered signals at an active clock edge or concurrently at a
transition event on unregistered signals and are used to ensure that default output values are
assigned for transitions with no explicit actions defined. See also state actions and transition
actions.

global connector
Any signal, bus, or bundle connected to a global connector is considered to be connected (as an
input) to every block in the block diagram or IBD view. It istypically used to connect clock or
reset signals.

global net
A global net isasignal which can be used on ablock diagramor IBD view but is declared
externally in a VHDL package or Verilog include file. A global net can not be connected to a
block, external port or global connector.

graphical editor
An editable window which displays a diagram editor or table editor view of adesign unit. See
block diagram, 1BD view, state diagram, flow chart, symboal, truth table and tabular 10.

— H—

HDL
HDL stands for Hardware Description Language and is used in the documentation as a generic
term for the VHDL or Verilog languages. It may also refer to any other language (for example, C)
which is being used to describe the behavior of hardware.

HDL2Graphics
HDL 2Graphicsisautility program used by HDL Designer Seriestoolsto create graphical block
diagram, state diagram, flow chart or IBD view from source VHDL or Verilog code.
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HDL Author
HDL Author is an advanced environment for HDL design which supports design management,
HDL text editing using the integrated DesignPad text editor, re-usable ModuleWare library,
version management, and downstream tool interfaces. HDL Author includes graphical editors
for maintaining the structure of adesign as graphical block diagram or I1BD views and a symbol
or tabular 10 editor for editing design unit interfaces. It also includes editors for state diagram,
flow chart, truth table, symbol and tabular 1O views which allow an entire design to be
represented graphically. A simulation analyzer interface supports error cross-referencing and
animation facilities to assist with design de-bug operations.

HDL Designer
The HDL Designer tool includes all the facilities provided by the HDL Author tool plus
HDL2Graphics import which can automatically create editable diagrams from imported HDL
code. HDL Designer supports the creation of block diagram, state diagram, flow chart and IBD
views.

HDL Designer Series

The HDL Designer Series (HDS) is afamily of tools for electronic system design using the
VHDL and Verilog hardware description languages. See also HDL Detective, HDL Author and
HDL Designer .

HDL Detective
HDL Detective isthe HDL Designer Series visualization tool which allows you to import any
complete or partial HDL text based design and convert the design into a hierarchy of graphical
views. The design structure can be represented as graphical block diagrams or IBD views.
Primitive leaf-level views can be viewed as block diagram, state diagram, flow chart or HDL
text views. A design manager can be used to explore the relationship between individual design
units.

HDL text
A textual HDL description of a design object. A HDL text design unit view may contain
structural HDL or define the behavior of aleaf-level block or component design unit. HDL text
may also be used by an embedded view on a block diagram or IBD view to contain concurrent
HDL statements which are included in the generated structural code. See also HDL view.

HDL text editor
The tool used to edit or view HDL text views. The HDL Designer Seriestools areinitially
configured to use the built-in DesignPad editor but can be set to use many other popular editors.

HDL view
A design unit view defined by structural or behavioral HDL text. See Verilog module, VHDL
entity and VHDL architecture. Also the VHDL package header and VHDL package body views
of aVHDL package.
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HDM
The Hierarchical Data Model isthe internal representation of design data used by the HDL
Designer Series which allows design objects to be located anywhere in the hierarchy below a
physical directory specified in the library mapping.

hierarchical action box
The representation on aflow chart or ASMI chart of an embedded child diagram which describes
action logic. See also action box.

hierarchical state
The representation on a state diagram of an embedded child diagram which describes state
transitions. See also simple state.

hierarchical state box
The representation on an ASM chart of an embedded child diagram which describes state
transitions. See also state box.

IBD view
A design unit view described using Interface-Based Design which represents the interfaces
between instantiated blocks, embedded blocks and components as one or more inter connect
tables showing the signal connections between them. See also block diagram.

if decode box
A named object which represents an I F statement on an ASM chart. When used for decoding
action logic each If has an associated End If object. An if decode box has one input flow and one
or more output flows each corresponding to an evaluated conditional expression. See also action
box, case box,decision box and wait box.

interconnect cell
A cell at the intersection of arow and a columnin an IBD view. The interconnect cells specify
ports connecting signals or buses (defined by the rows) and blocks, embedded blocks,
components, external HDL or ModuleWar e instances (defined by the columns).

interconnect table
A table editor view which represents the connections between one or more blocks, embedded
blocks, components or ModuleéWare instances in an IBD view. May be abbreviated as ICT.

Interface-Based Design
A methodology which defines the structure of adesign in terms of the interfaces between lower
level blocks and components. See also IBD view.

interrupt condition
A condition associated with atransition from an interrupt point which appliesto every statein
the state diagram and has a higher transition priority than any other transitions.
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interrupt point
A node on a state diagram or ASM chart that isimplicitly connected to all states on the same
diagram. Any transition from an interrupt point is treated as an interrupt condition from every
other state in the diagram. A transition from an interrupt point in the top level diagram istreated
as global interrupt condition and appliesto all statesin a hierarchical state machine. See also
junction and entry point.

S,

junction
A connector on a state diagram that enables a set of transitions between states to be replaced by
asimpler set of partial transitions between the same states. See also interrupt point and entry
point. Also used for a net connector joining two nets with the same properties on a block
diagram.

— K —

No entries
— L —

leaf view

An undefined view of a block which has been added on a block diagram or I1BD view but has not
been defined by a design unit view.

library
A repository for source design data and compiled objects that has been assigned alogical name.
See also library mapping, regular library, protected library and downstream only library.

library mapping
The mapping of alogical library nameto physical locations. There are typically different
mappings for the design data library containing graphical editor and HDL text source views and
the compiled library containing downstream objects.

link
A connector used on a state diagram or ASM chart (or between child diagramsin the same
hierarchy) to avoid long transition arcs or flows. A link isimplicitly connected to the state or
junction(on a state diagram) or to the state box (on an ASM chart) with the specified name. See
also exit point.

local declarations
User-specified Verilog statements which can be entered as properties for a flow chart or truth
table. These statements are declared at the top of the always code in the generated HDL for a
truth table. When concurrent flow charts are defined, these declarations are local to each of the
individual concurrent flow charts and you can choose whether they are inserted in the initial or
always code. See also module declarations.
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loop
A loop on aflow chart is defined by a start loop and stop loop object connected by aflow. A loop
isused to repeat a set of sequential statements and can have Repeat, For, While or Unconditional
control properties.

LPM
A library of parameterizable modules which can be instantiated as components. to implement
common gate, arithmetic, storage or pad functions.

M —

Mealy notation
A Mealy notation state machine is defined as a sequential network whose output is a function of
both the present state and the inputs to the network (conditions). In Mealy notation, outputs
(action) are associated with the transitions between states. See also Moor e notation and
transition actions.

module declarations
Locally defined Verilog statements which can be entered as propertiesin a state diagram, flow
chart, truth table or symbol and are declared for the corresponding Verilog module in the
generated HDL. Module declarations are typically used for 'define, parameter, reg, integer, real,
time or wire declarations. See also local declarations.

ModuleWare

A library of technology-independent, synthesis-optimized HDL generators which can be used to
implement many common logic, constant, combinatorial, bit manipulation, arithmetic, register,
sequential, memory or primitive functions as instantiated VHDL or Verilog models.

Moore notation
A Moore notation state machine is defined as a sequential network whose outputs (action) are a
function of the present state only. In Moore notation, actions are associated with the states. See
also Mealy notation and state actions.

— N —

net
A set of signals or buses which have the same name and type. The net represents connections
between objects in the design structure and has a value determined by the net's drivers. See also
wire.

netlist
An ASCII representation of acircuit that lists all of the content of a design and shows how they
are interconnected. Typically used for agate level description asthe input to asimulator or place
and route tool.

net connector
A net connector can be used on a block diagram to join nets which have the same properties. It
can also be used as an implicit on-page connector between nets with the same properties on the
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same diagram or as a dangling connector to terminate nets which are left deliberately
unconnected. See also global connector, junction and ripper.

node
A connectable item on ablock diagram, state diagram, ASM chart or flow chart. On a block
diagram, it can be a block, embedded block, component, port map frame, global connector, port,
ripper or net connector. On a state diagram, it can be a state, start state, hierarchical state,
junction, interrupt point, link and an entry point or exit point in achild hierarchical state diagram.
On aflow chart, it can be a start point, action box, loop, decision box, case box, wait box or end
point.

— 00—

object
A general term used for a selectable item or selectable group of closely related items.

object tip
A popup window which displays information about the object under the cursor.

— P —

package list
A list of VHDL packages referenced by adesign unit view. The package list isdisplayed as atext
object on a block diagram, state diagram, flow chart or symbol.

panel
A defined and named area on a block diagram, flow chart, state diagram or symbol which
facilitates viewing or printing the area.

parent
The view immediately above its child in the design hierarchy. A design unit view appears as a
block or component on its parent block diagram or I1BD view. Also used for the view containing
the hierarchical state or hierarchical action box or hierarchical state box representing a
hierarchical state diagram, ASM chart or flow chart.

partial condition
The condition associated with a partial transition.

partial transition

Any transition arriving at or leaving ajunction or interrupt point on a state diagram. Also the
transitions connected to an entry point or exit point in achild hierarchical state diagram. See also
complete transition path.

polyline
A series of connected straight lines joining one or more points. Polylines may be orthogonal
(horizontal and vertical lines only) or may include diagonals. See also spline.
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port
The external connectionsfor adesign unit and their representation on asymbol, tabular 10, block
diagramor IBD view. Also the connections to an instantiated block, embedded block or
component on a block diagram or IBD view. The signals connected to ports may be inputs,
outputs or bidirectional or (for VHDL) buffered. The connection points on objects in an ASVI
chart or flow chart are also described as ports.

port map frame
An optional outline around a component on a block diagram which allows mapping between
actual signals on a block diagram and formal ports which have different properties.

probe
A probeis atext object which can be used to monitor the simulation activity of asignal on a
block diagram. Although a probe can be moved independently, it is permanently attached to its
associated signal by an anchor.

process declarations
User-specified VHDL statements which can be entered on aflow chart, state machine or truth
table and are included at the beginning of the corresponding processin the generated HDL .
When concurrent flow charts are defined, these declarations are local to each of the individual
concurrent flow charts. See also entity declarations and architecture declarations.

project
The collection of library mapping information that the HDL Designer Series uses to locate and
manage your designs.

project manager
The source browser project manager window can be used to set up a project and to define, load
and configure the library mapping for your designs.

protected library
A library containing re-usable objects (such as standard VHDL type definitions or shared
components) which cannot be edited, generated or compiled.

properties
A mechanism for storing additional information in the data model.

PSL
PSL is a Property Specification Language for the verification of VHDL or Verilog RTL designs.

_Q_

No entries
—R —

range
The maximum and minimum bounds for an integer, floating, physical or enumeration type.
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recovery state point
A node on an ASMI chart that indicates the flow to the recovery state used when there is no other
valid state assignment.

registered signal
A signal in astate machine whose valueisheld asan internal signal whichisthen assigned to the
output port by the clocked process. A default value should be specified to avoid creating latches
during synthesis. See also combinatorial signal and clocked signal.

regular expression
A regular expression is a pattern to be matched against a text string. When found, a string which
matches the expression can optionally be replaced by another text string.

regular library
A library used for design creation which has library mappings for graphical and HDL text
source design objects.

re-level
An operation available in the state diagram editor to add or remove hierarchy by moving states
into or from a child diagram which is represented by a hierarchical state on the parent diagram.

requirement traceability
The process of tracking a requirement through a design to ensure that it is satisfied.

reset point
A node on an ASM chart that displays the reset signal name and condition. See also clock point
and enable point.

resource browser
The resource browser provides atask manager for configuring and invoking tasks and atemplate
manager for maintaining templates. See also source browser, side data browser and downstream
browser.

ripper
A ripper can be used on a block diagramto split or combine nets which have the same name and

bounds but represent a different slice or element. It can also be used to add or remove nets from
abundle. See also net connector.

route point
One of aseries of points specifying the path of anet in ablock diagram (or atransitionarcina
state diagram). Route points can be connected using polylines or splines.

S

selection set
A set of selected objects which are acted on by subsequent operations.
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sensitivity list
A list of signalswhich can be entered in aflow chart or truth table and are used as the sensitivity
list in the generated HDL. The signals defined in the sensitivity list cause the corresponding
process to execute when any of the signals changes.

shortcut bar
A customizable control panel which provides shortcuts to viewpoints, tasks and ModuleWare
components.

shortcut key
A keyboard key or key combination that invokes a particular command (also referred to as an
accelerator key. See also toolbar.

side data
Supplementary source design data (such as EDIF, SDF and document header files) or user data
(such as design documents or text files) which is saved with a design unit view and can be
viewed using the side data browser.

side data browser
The side data browser displays an expandable indented list showing design and user data
associated with the design unit view selected in the design explorer. See also source browser,
resource browser and downstream browser.

signal
A connection or transfer of information between blocks or components which is represented as a
polyline or spline (with a name and type) on ablock diagram. A set of signals with the same
nameis called anet. See also bus.

signals status
A list of the output and locally declared signalsin a state machine or ASMI chart which shows the
type (VHDL only), scope (output or local), default value, reset value and status (combinatorial,
registered or clocked).

simple state
The representation on a state diagram of a state which has no child state diagram. See aso
hierarchical state and wait state.

slice
A dliceis used to access a set of contiguous elements within an array type (such as
std_logic_vector). Theleft and right limits of the slice must be consistent with the bounds of the
object.

source
Source design data contained in alibrary as graphical editor or HDL text views. Also the
connectable item at the start of asignal, bus, transition or flow on a diagram editor view. See
also destination.
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source browser
The source browser provides a project manager window and any number of design explorersfor
browsing source design objects. See also side data browser, resource browser and downstream
browser.

spline
A curved line connecting two or more points. See also polyline.

start point
There is one and only one start point in aflow chart which is always named start. See al'so end
point.

start state
Theinitial state of a state machine. The start state represents the status of the state machine
before any transitions occur.

Sstate
A state isaresting mode of a state machine. Also the representation of astate on a state diagram.
Encoding information is shown if manual encoding is enabled and the state may have associated
actions. See also hierarchical state, smple state, start state, wait state, transition and condition.

State actions
The actions associated with a state on a state diagram which are executed when the state is
entered. See also transition actions and global actions.

state box
A state box isthe representation of a state on an ASM chart. A state box may have associated
entry, state and exit actions. See also hierarchical state.

state diagram
A diagram editor representation of a state machine. A state diagram typically consists of a
number of states, junctions, interrupt points or links connected by transitions. The diagram may
also include text blocks containing global actions, concurrent statements, local declarations and
comment text. A hierarchical state machine may also include hierarchical states, entry pointsand
exit points.

state machine
A design unit view of ablock or component which definesits behavior in terms of afinite state
machine (FSM). Thisis amathematical model of a system. The system is represented by afinite
number of states with afinite number of associated transitions between pairs of states. The state
machine is represented graphically as a state diagram. State machines drawn using Mealy
notation and Moore notation or a mixture of Mealy and Moore notation are supported.

state register statements
User entered statements which can be entered in a state diagram and are included in the
generated HDL to replace the default state assignment for the state machine before the state
decode statements at the beginning of a VHDL process or Verilog always code.
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state variable
The name of a signal whose value that defines the current state of a state machine.

status bar
An area at the bottom of the design manager, HDL text editor or graphical editor window that
displays information about the current command.

Ssubtree
All objects directly or indirectly below a given object in the design hierarchy.

symbol
A diagrameditor view which uses graphical objectsto definethe signal interface of a component
and its representation when the component is instantiated on a block diagram. See also tabular
0.

synchronous
A synchronous process is activated on the next explicit clock edge rather than being activated
only if any of itsinputs are changed. See also clocking.

synthesis
The automatic generation of ASIC, FPGA or CPLD designs (circuits) from HDL descriptions.

system
Something that performs a specific function or set of functions with defined inputs and outputs.
Typically, a self-contained electronic subsystem.

T —

table editor
An editable truth table, IBD view or tabular 10 window which represents a design unit view
using atabular matrix of cells. See also diagram editor and graphical editor.

tabular 10
An aternative table editor view showing the interface of a symbol.

task
A customizable downstream tool or design flow which can be configured and invoked using the
task manager.

task manager
The task manager window can be used to create, modify or run atask.

template manager
The template manager window can be used to create and modify the templates used for new
graphical editor or HDL text views.

test bench
A test harness which alows a standard set of stimuli to be applied to a design.
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toolbar
A group of buttons which provide shortcuts to commonly used commands. The HDL Designer
Series design manager and graphical editor windows typically have several undockable toolbars
each supporting a set of related commands. See also shortcut key.

tooltip
A small pop-up window that provides descriptive text for atoolbar button.

top-down design
The process of designing a system by identifying its mgjor parts, decomposing them into lower
level blocks and repeating the process until the desired level of detail is achieved. In electronic
design automation, this processis applied to the top-down design of ASIC, FPGA and CPLD
circuits using a hardware description language such as VHDL or Verilog. See also bottom-up
design.

transition
A change of state within a state machine. The transition occurs when an associated condition is
satisfied. A transition may have associated transition actions which are executed when the
transition takes place. A transition is represented by atransition arc with associated transition
text in a state diagram. See also transition priority.

transition actions
The action associated with atransition in a state machine which are executed when the transition
occurs. A transition action is the consequence of a condition. See also state actions.

transition arc
A polyline or spline representing part of atransition between states on a state diagram. The
direction of the transition is normally shown by an arrow head at its destination and the
transition text is attached to the arc by an anchor.

transition order
The order in which CASE style transitions leaving a state are generated. CASE style transitions
in VHDL are mutually exclusive and the order isignored but the order is significant in Verilog
since the first match in the generated code is taken.

transition priority
When there are more than one IF style transitions leaving a state, the associated conditions are
evaluated in the order of their priority. The transition priority is shown by an integer on the
transition arc adjacent to the source state. However, atransition with the condition OTHERS is
always evaluated last.

transition text
The condition text (in a Moore notation transition) or the condition and action text (in aMealy
notation transition) which is attached to the transition arc by an anchor.

truth table
A table editor view which represents one or more output signals by the logical state of one or
more input signals.
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type
Specifies the characteristics and allowed values of anet. In VHDL, all signals, buses, variables
and constants have a specific VHDL type definition which is defined in a package list. In
Verilog, anet may havewire, tri, wor, trior, wand, triand, tri0, tril, supplyO, supplyl, reg, trireg,
real, integer, time or realtime type. The values for a bus may also be limited by a bounds
constraint.

—U—

universe
Thetotal area available for adiagram.

unknown design unit
A design unit which is not defined as a block, component or package list.

unknown design unit view
A design unit view representing data that is not defined as a graphical editor, HDL text or other
registered view. Typically contains atext description and is treated as atext view for open, print
or other file operations.

user directory
On UNIX, thisisthe home directory used when you login which contains your startup files and
isnormally located by the HOME environment variable. On a PC, an application data directory
is created when you use atool for the first time. On Windows NT, thisis created in the profiles
directory. For example:
C:\Winnt\Profiles\< user>\Application Data\HDL Designer Series\
On aWindows XP machine, the application data directory is located below the Documents and
Settings directory. For example:
C:\Documents and Settings\< user>\Application Data\HDL Designer Series\ Typically, the user
directory will contain your preferences and library mapping files unless you have explicitly
saved these filesin alternative locations.

—V —

Verilog
A hardware description language (compliant with |EEE standard 1364-1995) that can be used to
design, model and simulate electronic circuits. Verilog is aregistered trademark of Cadence
Design Systems Inc. See also HDL and VHDL.

Verilog include
A Verilog file containing global declarations or other Verilog code which can be included by
reference using the “include compiler directive.

Verilog module
A design unit view of ablock or component which defines its behavior using Verilog source
code.
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Verilog module body
Describes the boundaries and content of a Verilog logic block in structural, dataflow and
behavioral constructs.

Verilog parameter
A Verilog parameter is a constant value used to parameterize a Verilog design description.
Verilog parameters are used in asimilar way to VHDL generics.

VHDL
VHDL standsfor VHSIC (Very High Speed Integrated Circuit) Hardware Description
Language. VHDL is adesign and modelling language (compliant with |EEE standards 1076-
1987 and 1076-1993) which was specifically created to describe (in machine and human-
readable form) the organization and function of digital hardware systems and circuit boards. See
also HDL and Verilog.

VHDL architecture
A design unit view of a block or component which defines its behavior using VHDL source code.

VHDL architecture body
Declaresthe items available inside aVVHDL design entity and specifies the relationships between
inputs and outputs. An architecture body describes the organization and operations performed
inside the design entity. Y ou can choose to store the VHDL architecture body in the samefile or
in a separate file from the VHDL entity.

VHDL configuration
A declaration which specifies the VHDL architecture body used to define a VHDL design entity.
See also configuration.

VHDL design entity
A VHDL design entity isthe primary abstraction level of a VHDL hardware model which
typically represents a cell, chip, board or subsystem. A VHDL design entity comprisesaVHDL
entity declaration and a VHDL architecture body.

VHDL entity
Declares the interface between a VHDL design entity and its external environment. An entity
declaration contains definitions of inputs to and outputs from the VHDL design entity. VHDL
entity declarations can optionally be stored in the same file or a separate file from the associated
VHDL architecture body.

VHDL generic
A VHDL generic is aconstant value used to parameterize a VHDL design description. VHDL
generics are used in asimilar way to Verilog parameters.

VHDL package
A VHDL object that contains procedural definitions and declarations used by design unit views
of blocks or components. Typically contains type and subtype definitions. Usually comprises a
separate VHDL package header containing declarations and a VHDL package body containing
any functions or procedures declared in the package header.
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VHDL package body
The part of a VHDL package which defines the implementation of objectsin the package. It
contains data used when the design is evaluated. The package body typically contains constant
definitions and function bodies.

VHDL package header
The part of a VHDL package which declares the objects defined in the package. It is referenced
by block and component views.

viewpoint
A set of user-defined rules which examine particular aspects of adesign.

VITAL
VITAL standsfor the VHDL Initiative Towards ASIC Libraries which is an |EEE standard
(IEEE1076.4) for ASC library design.

W —

wait box
A named object on aflow chart containing a conditional wait statement which controls the delay
before an event occurs on asignal in the sensitivity list. See also action box, case box and
decision box.

wait state
A wait state has similar properties to a simple state but introduces a delay of two or more clock
cycles.

whisker
A line that extends between a port on the boundary of a customized block or component symbol
and the body of the block or component symbol.

wire
A segment of anet on a VHDL or Verilog block diagram. A wire may have signal or bus style
and scalar or vector type and should not be confused with the Verilog wire type.

working directory
On UNI X, the directory from which you invoked the application. On a PC, the working directory
defaults to the user directory or can be set using the Start 1 n option when you define the
properties for a short cut to your application. Do not set aworking directory using the Start In
shortcut option if you want to use object linking and embedding (OLE) to import objectsinto a
documentation tool as the application will not be able to access library mapping information
from this location.

workspace
A working environment which allows common design data to be shared between multiple users.
Typically, aproject comprises one or more shared workspaces and a private workspace (often
described as a sandbox) for each engineer working on the project.
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— X —

Xdefaults
A set of resources which can be used to set the default display characteristics on X server
window systems.

— Y —

No entries

7

No entries
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Index
state diagram, 421
—A— ASM chart
Action box editor, 18
object properties, 346 Attributes
Actions in port declarations, 157
action box, 336 in signal declarations, 157
syntax, _347 setting, 157
Actmty trail Autoshape
Setting, 424 see comment graphics
Adding Ports, 248
Anchor — B —
comment text, 57 Backup
simulation probe, 411 automatic, 31
text object, 62 file, 31
Animation Black box
activity trail, 424 setting, 44, 267
cause, 420, 427 Block
clear captured events, 424 automatic instance name, 105
data capture, 423 autowhiskers, 221
enabling, 423 changing the shape, 220
flow chart, 421 customizing, 220
global capture, 423 definition of, 194
goto latest, 426 instantiating, 105
goto next, 426 open down, 185
goto previous, 426 renaming, 105
goto start, 426 updating the interface, 122
goto time, 426 Block diagram
graphical highlighting, 426 adding hierarchy, 164
highlight colors, 426 automatic routing, 400
instrument for, 423 bus reconstruction, 402
link diagrams, 427 changing the layout, 400
linking diagrams, 427 definition of, 192
mixed language, 427 editor, 18
move by clocks, 426 layout and routing options, 399
move by events, 426 notation, 193
move by states, 426 preferences, 223
notation, 426 re-level, 164
preferences, 425 text visibility, 64
reviewing, 426 toolbar, 203
showing the animation view, 423 Breakpoints
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adding, 409
disabling, 410
enabling, 410
graphical, 410
removing, 409
reporting, 410
Browser
diagram, 86
content, 89
columns, 91
grouping, 92
sorting, 92
structure, 87
Bundle
adding on a block diagram, 209
adding signals, 210
definition of, 196
highlight color, 217
ripping abundle, 211
ripping a bus, 211
ripping asignal, 210
Bus
adding on a block diagram, 205
definition of, 196
endpoint, 205
ripping adlice, 207
ripping an element, 207

—C—
Case box
expression
syntax, 354
object properties, 353
Cell
autofit, 84
copying contents, 83
cut and paste, 83
deleting contents, 83

Command
auto-repeat, 22
Command Auto-repeat, 22
Comment graphics
adding, 67
adding a bitmap, 71
adding acircle, 70
adding aline, 69
adding a polygon, 70
adding a polyline, 69
adding arectangle, 70
adding an arc, 69
adding an ellipse, 70
adding arrowheads, 69
autoshape, 221
edit vertices, 67
grouping, 55
layering, 55
loading a bitmap, 71
Comment text
adding, 56
after file header, 57
after object, 57, 98, 155, 312
a fileend, 57
at file start, 57
attaching, 57
before object, 57, 98, 155, 312
detaching, 57
editing, 57, 58
end of line, 57, 98, 155, 312
formatting, 58
grouping, 55
hiding, 58
in block interface, 57
in port declarations, 155, 311
in signal declarations, 155
including in HDL, 57
internal variables, 58

editing, 83 Kanji, 58
resizing a.column or row, 84 Iayeri’ng 55
selecting, 83 _ _ object properties, 58
Changing the Display of Signal Properties, 200 properties, 58
Column _ showing, 58
collapsing, 255 Compiler directive
expanding, 255 recovery, 387
moving, 256
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setting, 26

Component
automatic instance name, 105
definition of, 194
drag and drop, 106
instantiating, 106
open down, 185
updating an instance, 121
where used, 310

Component browser

instantiating a component, 106
instantiating a ModuleWare part, 110

Condition

syntax, 350
Constrained

move, 52

resize, 53
Copy

object, 34

picture, 34

to clipboard, 34
Cursor tracking

probes, 412, 420

state machine, 408, 412, 420
CVE models

source VHDL, 115

—D—
Dataflow window
displaying, 417
Decision box
object properties, 348
Declarations
alignin columns, 314
entity, 314

external module declarations, 314
internal module declarations, 314

module, 314
symbol, 314
Verilog parameter, 312
Verilog signals, 146
VHDL generic, 312
VHDL signals, 144
Default view
Setting, 187
DesignPad

HDL text editor, 18
Diagram
saving, 29
Diagram editor
default font, 48
template title block, 49
visible anchors, 49
Dialog box
Activity Trail Settings, 425
Add External IP, 116
Add Hierarchy, 165
Add Signal Stubs, 209, 213
Attributes, 157

Block Diagram Layout and Routing

Options, 399

Block Diagram Master Preferences, 223,

270

Block Diagram Preferences, 224, 270

Appearance, 235, 271
Background, 236
Default Values, 224, 225

Default Properties, 227

Verilog, 226
VHDL, 226
Display Settings, 231

ModuleWare Display, 233
ModuleWare Params, 228

Object Visibility, 232
Verilog PortlO, 233
Verilog Signals, 233
VHDL PortlIO, 233
VHDL Signals, 233
Cell Edit Appearance, 304
Choose Instances, 414
Choose Panel to Delete, 76
Choose Panel to Show, 75
Choose Panel to View, 75
Choose Shape, 221
Color Selection, 78, 80
Comments, 98, 155, 312
Convert To Graphics, 392
Create Embedded View, 119
Create Test Bench, 430

Design Checking Options, 125

Diagram Master Preferences
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Background, 50 ModuleWare Object Tips Visibility, 82
Documentation and Visualization Options, ModuleWare Parameter Visibility, 114
395 ModuleWare Preview, 112
Edit Appearance, 78 Name Block, 186
File Creation Wizard, 186 Net Highlighting Options, 218
Filter Controls, 300 Net Insert Options, 161
Filter Settings, 174 Net Insert/Remove Parameters, 162
Find and Replace Net Propagation Options, 158
Find, 35 Net Remove Options, 163
Replace, 37 Object Properties, 32
Flow Chart Preferences, 363 Action Boxes, 347, 348, 350, 352, 353
Appearance, 363 Components, 127
Background, 366 Embedded Blocks, 137
Default Values, 365 Frames, 292
Default Properties, 365 Text, 58
Miscellaneous, 364 Open As (rendered view), 419
Object Visibility, 366 Package List, 24
Flow Chart Properties, 354 Panel Object Properties, 74
Architecture Declarations, 359 Port Display Control, 199
Concurrent Statements, 360 Port Map Settings, 274
Generation, 355 PortlO Display Control, 198
Module Declarations, 359 Probe Properties, 413
Process Declarations, 362 Reconcile Interface, 123
Font Select, 78 Reconcile Interface Options, 124
Found, 37, 38 Rename, 345
Frame Declarations, 292 Rip Bug/Slice From Bundle, 211
Generation File Clash, 43 Rip Element From Bus, 207
Interface Master Preferences, 317 Rip New Bundle, 211
Interface Preferences Rip Signal/Element From Bundle, 210
Default Values, 321 Rip Slice From Bus, 207
Default Properties, 323 Save As Design Unit View, 29
Verilog, 322 Show Columns, 99, 299
VHDL, 322 Signal Display Control, 201
Interface Appearance, 319 Symbol Master Preferences, 317
Miscellaneous Symbol Object Properties, 314
Interface, 324 Text, 58
Object Visibility, 325 Symbol Preferences
Verilog Port Display, 325 Background, 327
VHDL Port Display, 325 Miscellaneous, 318
Symbol Appearance, 320 Symbol/Interface Properties
Main Settings Declarations, 314
Diagrams, 48, 62, 72, 73 Symbol, 315
Generd, 22, 23 Truth Table Preferences, 381
Save, 31 Appearance, 382
Tables, 82 Default Properties, 383
468 Graphical Editors User Manual, V2008.1

September 18, 2008



ABCDEFGHI

JKLMNOPQRSTUVWXY Z

Truth Table Properties, 371
Architecture Declarations, 376
Concurrent Statements, 377
Generation, 372
Global Actions, 378
Module Declarations, 376
Process Declarations, 378

Update Where Used, 311

Update/Replace Foreign Component, 118

Verilog Compiler Directives, 26

Where Used wizard, 310

— E—
Embedded block
adding, 118
definition of, 195
renaming, 119
Embedded constraints
setting, 157
Embedded HDL text
adding, 120
editing, 58
Embedded view, 195
flow chart, 119
HDL text, 119
opening, 119
state diagram, 119
truth table, 119
Environment variables
CVE_HOME, 115
Export
comma separated value (CSV) file, 85
tab separated value (TSV) file, 85
table, 85
External HDL
instantiating, 114
soft pathnames, 117
updating or replacing, 118

— F—
Find
class expression, 36
match case, 36
match word, 36
regular expression, 36
replace, 37

select al, 37

select object, 37

text, 35

wrap search, 36

Flip
object, 55
ripper, 208
Flow chart

adding a case box, 339

adding a concurrent chart, 345

adding a decision box, 337

adding aflow, 341

adding aloop, 338

adding a start point, 335

adding await box, 338

adding an action box, 336

adding an end point, 342

adding objects, 333

animation, 421

automatic connection mode, 333

automatic insertion mode, 334

breaking out of aloop, 339

concurrent, 344

deleting a concurrent chart, 346

editor, 18

hierarchical, 342

opening a concurrent chart, 345

properties
architecture declarations, 354, 359
begin and end, 358
clock, 357
combinatorial, 356
concurrent statements, 354, 360
fork and join, 358
generation characteristics, 355
initial or always style code, 358
instrument for animation, 358
local declarations, 355, 362
module declarations, 354, 359
process declarations, 355, 362
reset, 357
sengitivity list, 355, 357
sequential, 356

renaming a concurrent chart, 345

text visibility, 66
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— G —
Generate frame
adding, 278
BLOCK, 249, 250, 278, 286
block, 250, 286
declarations, 292
editing properties, 292
ELSE, 278
FOR, 278, 279, 288
IF, 278
nested, 288
object properties, 292
Generic declarations
editing, 312
Global connector
adding on a block diagram, 214
Graphical views
opening, 419
Grid
preferences, 51
snapping, 80
visibility, 80
— H—
HDL
bulk parsing, 43, 267
convert to graphics, 391
generating from graphical views, 41
setting the language, 23
show as graphics, 399
VHDL and Verilog, 23
viewing generated HDL, 44
HDL 2Graphics, 387
compiler directives, 387
flow chart recovery, 389
state machine recovery, 388, 389
structure recovery, 386
Verilog parameter, 388
HDL 2Graphics,compiler directives, 387
Highlight
color, 217
net, 217

IBD view
adding hierarchy, 164

editor, 18
expanding and collapsing, 255
moving rows or columns, 256
remove hierarchy, 164

Icons
Animation toolbar, 422
Appearance toolbar, 79
Arrange Object toolbar, 53
Block Diagram Tools toolbar, 203
breakpoint, 410
Comment Graphics toolbar, 67
diagram browser

notation, 87, 88, 89, 90, 91, 93

Format text toolbar, 27
Simulation toolbar, 406
Standard toolbar, 20
Tabular 10 toolbar, 300

IF Frame
using, 288

Intellectual property
instantiating, 114

Interface
enforce consistent case, 124
enforce consistent port ordering, 124
preferences, 317
reconciling, 122

Internal variable
in comment text, 58

Inventra models
source HDL, 115

— K —
Kanji text
in comment text, 58

— L —
Library mapping
standard packages, 23
List window
adding signals, 408
displaying, 417
L og window
Task log, 43, 267
Logic function
notation, 219
Loop
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object properties, 352
statement
syntax checking, 353

— M —
Mixed language
external HDL, 116
using, 187
ModelSim
Debug menu, 418
List window, 408, 409, 419
Main window, 418
Signals window, 409, 419
Source window, 409, 410, 418
Structure window, 409, 418
Wave window, 408, 409, 418
ModuleWare
default parameter visibility, 228
editing parameters, 111
instantiating, 110
object tips, 228
parameter visibility, 114
port polarity, 113, 223
resizing, 113
stimulus generators, 431
Mouse
strokes, 22

— N —
Net

adding anet slice on an IBD view, 248

adding on a block diagram, 204
connecting, 214

connecting to ablock or component, 215
connecting to a port map frame, 217

highlight color, 217
highlighting, 217
inserting, 161
propagating, 161
propagating changes, 158
removing, 161
report if unconnected, 126
routing, 204
Net connector
change to ripper, 208
Notation

action box, 330
block, 193
block diagram, 193
BLOCK generate frame, 250, 286
bundle, 193
component, 193
decision box, 330
diagram browser
content
ASM chart, 91, 93
block diagram or IBD view, 90
flow chart, 90
state diagram, 91
structure
block diagram, 87

concurrent and hierarchy views, 87

symbol, 88

text objects, 89
EL SE generate frame, 250, 282, 285
embedded block, 193
end point, 331
FOR generate frame, 249, 279
global connector, 193
hierarchical action box, 330
|F generate frame, 250, 282
logic functions, 219
loop, 330
net connector, 193
port, 193
port map frame, 273
ripper, 193
start point, 330
symbol bidirectional port, 305
symbol buffer port, 305
symbol clock port, 305
symbol input port, 305
symbol inverted port, 305
symbol output port, 305
truth table, 369
wait box, 330

— 00—
Object

aligning, 54
deleting, 34
Distributing, 54
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flipping, 54
moving, 51

moving to next grid point, 51

resizing, 53
rotating, 54
selecting, 33
selecting shapes, 33
selecting text, 33

Object properties

2 dimensiona bounds, 145
2 dimensional dlice, 145
action box, 346
anchored panel, 74
array bounds, 146
attributes, 157

block, 133

block diagram, 127
block port ordering, 134
BUS keyword, 145
case box, 353

charge strength, 146
comment bounding box, 58
comment text, 58
comments, 155
component, 127
decision box, 348
editing, 32

embedded block, 137
embedded constraints, 157
expansion, 146
generate frame, 292
IBD view, 127

loop, 352

net bounds, 145

net type, 144
non-autoroute panel, 74
panel, 74

panel visibility, 74
Register keyword, 145
regular panel, 74

sheet panel, 74

signa declarations, 144
symbol, 314

text, 58

vector bounds, 146

VHDL net declarations, 144
wait box, 350
Object tip
displaying, 72
OLE
object linking and embedding, 38
opening an OLE view, 41
using drag and drop, 40
Opening Block and Component Views, 185

— P —
Panel
adding, 73
anchored, 74
deleting, 76
displaying, 75
hiding, 75
non-autoroute, 74
object properties, 74
OLE, 41
printing, 76
protecting, 75
sheet, 74
showing, 75
viewing, 75
Panning
window, 81
Parent view
editing, 28
opening, 28
Paste
here, 34
object, 34
special, 34
Polyline
see comment graphics
Port
active high, 223
active low (Not), 223
adding in the signalstable, 96
adding in the symbol editor, 306
adding in the tabular 10 editor, 301
adding on a block diagram, 212
adding to anet, 213
changing the mode, 213, 306
display properties, 198
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edge triggered (Clock), 223
falling edge clock, 223
mapping, 273

naming, 197

ordering, 309

polarity control, 223
propagating, 310
properties, 315

diagram background color, 236, 327, 366
editing diagram preferences, 49

editing master preferences, 49
elaboration limit, 415

embedded block name, 225

generate in-line ModuleWare code, 224
global connector name, 225

grid, 236, 327, 366

rising edge clock, 223 grid display, 51

rotating, 214 includetitle block in new diagrams, 49, 72
spacing, 307 instance name, 225
visibility, 222 interface appearance, 319
Port map frame interface default values, 321
editing the mapping, 274 interface visual attributes, 319
enabling, 273 layout, 400
example, 276 net width label, 231
Pragma object tips, 72

async_set_reset_local, 357, 375
dc_script_begin, 158 open as tabular 10, 319

dc_script_end, 158 port constraints, 322

hds, 386 port display control, 233, 325
sync_set_reset_local, 357, 375 port names, 321

synopsys full_case, 390 port ordering, 319

synopsys parallel _case, 390 reconcile enforce consistent case, 124
trandate off, 385 reconcile enforce consistent port ordering,

open as symbol, 319

trandlate_on, 385 124
Preference recovery file, 31

net width label, 196 routing, 400

view type, 194 setting diagram background preferences,
Preferences 50

animation, 425 show anchors, 49, 62

appearance, 235, 271

applying master preferences, 50
automatic completion in table cells, 82
auto-update signal style, 231

backup file, 31

block diagram, 223

show signal attributes, 231

signal constraints, 226

signal display control, 233

signal name, 225

snap to grid, 51

symbol appearance, 320

block diagram default values, 225 symbol visua attributes, 320

block diagram HDL types, 226 take display settings from component port,
bundle name, 225 231

bus name, 225 title block location, 49, 72

check syntax on entry, 318 update HDL view when symbol is saved,
create component declarations, 44 32

default font for diagram editor views, 48 updating master preferences, 50

default font for table editor views, 82 use closest matched fonts, 49
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use scalable fonts, 48
use symbol visua attributes for
components, 231

wrap bundle contents, 231
Print

panel, 76
Probes

adding, 411

removing, 411

setting properties, 413

tracking the Model Sim cursor, 412
Process window

displaying, 417

— R —
Recovery
file, 31
Redo
last undone command, 33
Regular expression
class expression, 36
searching for, 35
tagged expression, 38
Replace
see Find
Ripper
change to net connector, 208
flip direction, 208
Rotating
objects, 54
text, 307
Route point
adding, 77
removing, 77
Row
collapsing, 255
expanding, 255
moving, 256
sorting in atabular 10 view, 301
sorting in the signals table, 101

Search
see Find
Setting Background Preferences, 50
Setting Compiler Directives, 26
Setting Package References, 23
Setting Preferences for Diagram Views, 48
Setting Preferences for Table Views, 82
Setting Visual Attributes, 78
Shapes
selecting, 33
shared.hdp, 23
Shortcuts
in-line text editing, 60
mnemonic Keys, 22
Signal
adding in the signalstable, 97
adding on a block diagram, 205
adding stubs on a block diagram, 209
adding the current state to simulator
windows, 408
adding to abundle, 210
adding to simulator windows, 408
adding to the simulator log, 409
definition of, 196
display properties, 201
endpoint, 205
forcing, 413
highlighting in the ssimulator, 409
ordering, 163
reporting information, 409
rotating text, 214
Signalstable
displaying, 94
filtering, 99
grouping, 99
notation, 95
Signals window
displaying, 417
Simulation
choosing the simulation instance, 414

—S— continue, 416

Save driving, 408
automatic, 31 forcing signals, 413

Seamless models Model Sim cursor tracking, 408, 412, 420
see CVE models removing probes, 412
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reporting signal information, 409
restarting, 417
run for time, 416
run forever, 416
run to next event, 416
running, 416
step into line, 416
step over line, 416
step over object, 416
stepping, 416
Simulator environment
reporting, 416
setting, 415
Simulator windows
displaying, 417
Source window
displaying, 417
speedCHART models
source HDL, 115
State diagram
animation, 421
editor, 18
text visibility, 65
Strokes
enabling, 49
mouse shortcuts, 22
Structure window
displaying, 417
Symbol
autowhiskers, 307
changing the shape, 307
customize, 307
editing declarations, 314
lock, 307
notation, 305
text visibility, 65
Syntax
checking, 347, 350, 351, 353, 354
Synthesis
black box, 44, 267

— T—
Table
non-scrolling area, 298
panning, 84
scrolling, 84

sorting rows, 101, 301

Table editor

default font, 82

Tabular 10

editor, 18

filtering columns, 299

grouping, 302

hiding columns, 298

VHDL range constraint format, 324

Test bench

analyzing results, 437

creating, 430

defining stimulus on aflow chart, 432
defining stimulus on a state machine, 436
defining stimulus using lookup tables, 433
defining stimulus using textl O, 434
definition of, 429

generating aclock, 436

re-using, 438

Text

alignment, 27
anchor, 57, 62
editing on adiagram, 59
editor, 18

embolden, 27
finding, 35

finish al edits, 61
finish edits, 61

font size, 27
formatting, 27
italicize, 27

moving, 62

pattern matching, 35
regular expression, 35
replacing, 37
searching, 35
selecting, 33

send to editor, 61
setting font, 78
underline, 27
visihility, 64

TextlO

defining stimulus, 434

The Diagram Browser, 86
Title block
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adding, 71
creating, 71
saving, 71
template, 71
Toolbar
Animation, 422
Appearance, 79
Arrange Object, 53
auto-repeat, 22
Block Diagram Tools, 203
Comment Graphics, 67
Format Text, 27
HDL Tools, 20
Simulation, 406
SM Signals Tools, 95
Standard, 20
Tabular 10 Tools, 300
Tasks, 20
Version Management, 20
Travel log
window history, 29
Truth table
adding a column or row, 371
Case style, 379
comparison operators, 370
deleting a column or row, 371
editor, 19
If-Then-Else style, 379
notation, 369
preferences, 381
properties
architecture declarations, 372, 376
clock, 374
combinatorial, 373
concurrent statements, 372
generation, 371
generation properties, 372
global actions, 372, 378
local declarations, 372, 377
module declarations, 372, 376
process declarations, 372, 377
reset, 374
sengitivity list, 375
sequential, 373

—U—
Undo
last command, 32
Using the Convert to Graphics Wizard, 391

—V —
Variables window
displaying, 417
Verilog
arrays, 147
Verilog compiler directives
setting, 26
Verilog parameter
declaration, 312
recovery, 388
usage example, 167
using, 166
VHDL
component declarations, 44
VHDL generic
declaration, 312
usage example, 167
using, 166
VHDL package
setting references, 23
View
al, 81
area, 81
diagram, 81
opening parent, 28
pan, 81
scroll, 81
zoomin, 81
zoom last, 81
zoom out, 81
Visual attributes
background color, 78
fill pattern, 78
foreground color, 78
line color, 78
line style, 78
line width, 78
setting, 78
setting color, 80
setting in the tabular 10 view, 304
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text font, 78

— W —
Wait box

object properties, 350
Wait statement

syntax, 351
Wave window

adding signals, 408

displaying, 417
Where used

component, 310
Window

back, 29

forward, 29

panning, 81

refreshing, 32

re-using, 29

saving position and size, 32

scrolling, 81

single, 29

travel log, 29

zooming, 81

— 7 —
Zoom
window, 81
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End-User License Agreement

The latest version of the End-User License Agreement is available on-line at:
www.mentor.com/terms_conditions/enduser.cfm

IMPORTANT INFORMATION

USE OF THIS SOFTWARE IS SUBJECT TO LICENSE RESTRICTIONS. CAREFULLY READ THIS
LICENSE AGREEMENT BEFORE USING THE SOFTWARE. USE OF SOFTWARE INDICATES YOUR
COMPLETE AND UNCONDITIONAL ACCEPTANCE OF THE TERMS AND CONDITIONS SET FORTH

IN THIS AGREEMENT. ANY ADDITIONAL OR DIFFERENT PURCHASE ORDER TERMS AND
CONDITIONS SHALL NOT APPLY.

END-USER LICENSE AGREEMENT (*Agreement”)

Thisis a legal agreement concerning the use of Software between you, the end user, as an authorized
representative of the company acquiring the license, and Mentor Graphics Corporation and Mentor Graphics
(Ireland) Limited acting directly or through their subsidiaries (collectively “Mentor Graphics’). Except for license
agreements related to the subject matter of this license agreement which are physically signed by you and an
authorized representative of Mentor Graphics, this Agreement and the applicable quotation contain the parties
entire under standing relating to the subject matter and supersedeall prior or contemporaneous agreements. | f you
do not agree to these terms and conditions, promptly return or, if received electronically, certify destruction of
Softwar e and all accompanying items within five days after receipt of Software and receive a full refund of any
license fee paid.

GRANT OF LICENSE. The software programs, including any updates, modifications, revisions, copies, documentation
and design data (“ Software”), are copyrighted, trade secret and confidential information of Mentor Graphics or its
licensors who maintain exclusive title to all Software and retain all rights not expressly granted by this Agreement.
Mentor Graphics grants to you, subject to payment of appropriate license fees, a nontransferable, nonexclusive license to
use Software solely: (a) in machine-readable, object-code form; (b) for your internal business purposes; (c) for the license
term; and (d) on the computer hardware and at the site authorized by Mentor Graphics. A site is restricted to a one-half
mile (800 meter) radius. Mentor Graphics' standard policies and programs, which vary depending on Software, license
fees paid or services purchased, apply to the following: (a) relocation of Software; (b) use of Software, which may be
limited, for example, to execution of asingle session by a single user on the authorized hardware or for arestricted period
of time (such limitations may be technically implemented through the use of authorization codes or similar devices); and
(c) support services provided, including eligibility to receive telephone support, updates, modifications, and revisions.

EMBEDDED SOFTWARE. If you purchased a license to use embedded software development (“ESD”) Software, if
applicable, Mentor Graphics grants to you a nontransferable, nonexclusive license to reproduce and distribute executable
files created using ESD compilers, including the ESD run-time libraries distributed with ESD C and C++ compiler
Software that are linked into a composite program as an integral part of your compiled computer program, provided that
you distribute these files only in conjunction with your compiled computer program. Mentor Graphics does NOT grant
you any right to duplicate, incorporate or embed copies of Mentor Graphics' real-time operating systems or other
embedded software products into your products or applications without first signing or otherwise agreeing to a separate
agreement with Mentor Graphics for such purpose.

BETA CODE. Software may contain code for experimental testing and evaluation (“Beta Code"), which may not be used
without Mentor Graphics' explicit authorization. Upon Mentor Graphics authorization, Mentor Graphics grants to you a
temporary, nontransferable, nonexclusive license for experimental use to test and evaluate the Beta Code without charge
for alimited period of time specified by Mentor Graphics. This grant and your use of the Beta Code shall not be construed
as marketing or offering to sell alicense to the Beta Code, which Mentor Graphics may choose not to release
commercialy in any form. If Mentor Graphics authorizes you to use the Beta Code, you agree to evaluate and test the
Beta Code under normal conditions as directed by Mentor Graphics. Y ou will contact Mentor Graphics periodically
during your use of the Beta Code to discuss any malfunctions or suggested improvements. Upon completion of your
evaluation and testing, you will send to Mentor Graphics a written evaluation of the Beta Code, including its strengths,
weaknesses and recommended improvements. Y ou agree that any written evaluations and all inventions, product
improvements, modifications or developments that Mentor Graphics conceived or made during or subsequent to this
Agreement, including those based partly or wholly on your feedback, will be the exclusive property of Mentor Graphics.
Mentor Graphics will have exclusive rights, title and interest in all such property. The provisions of this section 3 shall
survive the termination or expiration of this Agreement.
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4. RESTRICTIONS ON USE. You may copy Software only as reasonably necessary to support the authorized use. Each
copy must include all notices and legends embedded in Software and affixed to its medium and container as received from
Mentor Graphics. All copies shall remain the property of Mentor Graphics or its licensors. Y ou shall maintain arecord of
the number and primary location of all copies of Software, including copies merged with other software, and shall make
those records available to Mentor Graphics upon request. Y ou shall not make Software available in any form to any
person other than employees and on-site contractors, excluding Mentor Graphics competitors, whose job performance
requires access and who are under obligations of confidentiality. Y ou shall take appropriate action to protect the
confidentiality of Software and ensure that any person permitted access to Software does not disclose it or useit except as
permitted by this Agreement. Except as otherwise permitted for purposes of interoperability as specified by applicable
and mandatory local law, you shall not reverse-assemble, reverse-compile, reverse-engineer or in any way derive from
Software any source code. Y ou may not sublicense, assign or otherwise transfer Software, this Agreement or the rights
under it, whether by operation of law or otherwise (“attempted transfer”), without Mentor Graphics' prior written consent
and payment of Mentor Graphics' then-current applicable transfer charges. Any attempted transfer without Mentor
Graphics prior written consent shall be amaterial breach of this Agreement and may, at Mentor Graphics option, result in
the immediate termination of the Agreement and licenses granted under this Agreement. The terms of this Agreement,
including without limitation, the licensing and assignment provisions shall be binding upon your successors in interest
and assigns. The provisions of this section 4 shall survive the termination or expiration of this Agreement.

5. LIMITED WARRANTY.

5.1. Mentor Graphics warrants that during the warranty period Software, when properly installed, will substantially
conform to the functional specifications set forth in the applicable user manual. Mentor Graphics does not warrant
that Software will meet your requirements or that operation of Software will be uninterrupted or error free. The
warranty period is 90 days starting on the 15th day after delivery or upon installation, whichever first occurs. Y ou
must notify Mentor Graphics in writing of any nonconformity within the warranty period. This warranty shall not be
valid if Software has been subject to misuse, unauthorized modification or improper installation. MENTOR
GRAPHICS ENTIRE LIABILITY AND YOUR EXCLUSIVE REMEDY SHALL BE, AT MENTOR GRAPHICS
OPTION, EITHER (A) REFUND OF THE PRICE PAID UPON RETURN OF SOFTWARE TO MENTOR
GRAPHICS OR (B) MODIFICATION OR REPLACEMENT OF SOFTWARE THAT DOES NOT MEET THIS
LIMITED WARRANTY, PROVIDED YOU HAVE OTHERWISE COMPLIED WITH THIS AGREEMENT.
MENTOR GRAPHICS MAKES NO WARRANTIES WITH RESPECT TO: (A) SERVICES; (B) SOFTWARE
WHICH IS LICENSED TO YOU FOR A LIMITED TERM OR LICENSED AT NO COST; OR
(C) EXPERIMENTAL BETA CODE; ALL OF WHICH ARE PROVIDED “ASIS.

5.2. THE WARRANTIES SET FORTH IN THIS SECTION 5 ARE EXCLUSIVE. NEITHER MENTOR GRAPHICS
NOR ITS LICENSORS MAKE ANY OTHER WARRANTIES, EXPRESS, IMPLIED OR STATUTORY, WITH
RESPECT TO SOFTWARE OR OTHER MATERIAL PROVIDED UNDER THIS AGREEMENT. MENTOR
GRAPHICS AND ITS LICENSORS SPECIFICALLY DISCLAIM ALL IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT OF
INTELLECTUAL PROPERTY.

6. LIMITATION OF LIABILITY. EXCEPT WHERE THIS EXCLUSION OR RESTRICTION OF LIABILITY
WOULD BE VOID OR INEFFECTIVE UNDER APPLICABLE LAW, IN NO EVENT SHALL MENTOR GRAPHICS
OR ITSLICENSORS BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES
(INCLUDING LOST PROFITS OR SAVINGS) WHETHER BASED ON CONTRACT, TORT OR ANY OTHER
LEGAL THEORY, EVEN IF MENTOR GRAPHICS OR ITS LICENSORS HAVE BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL MENTOR GRAPHICS OR ITS LICENSORS
LIABILITY UNDER THIS AGREEMENT EXCEED THE AMOUNT PAID BY YOU FOR THE SOFTWARE OR
SERVICE GIVING RISE TO THE CLAIM. IN THE CASE WHERE NO AMOUNT WAS PAID, MENTOR
GRAPHICS AND ITS LICENSORS SHALL HAVE NO LIABILITY FOR ANY DAMAGES WHATSOEVER. THE
PROVISIONS OF THIS SECTION 6 SHALL SURVIVE THE EXPIRATION OR TERMINATION OF THIS
AGREEMENT.

7. LIFE ENDANGERING ACTIVITIES. NEITHER MENTOR GRAPHICS NOR ITS LICENSORS SHALL BE
LIABLE FOR ANY DAMAGES RESULTING FROM OR IN CONNECTION WITH THE USE OF SOFTWARE IN
ANY APPLICATION WHERE THE FAILURE OR INACCURACY OF THE SOFTWARE MIGHT RESULT IN
DEATH OR PERSONAL INJURY. THE PROVISIONS OF THIS SECTION 7 SHALL SURVIVE THE
EXPIRATION OR TERMINATION OF THISAGREEMENT.

8. INDEMNIFICATION. YOU AGREE TO INDEMNIFY AND HOLD HARMLESS MENTOR GRAPHICS AND ITS
LICENSORS FROM ANY CLAIMS, LOSS, COST, DAMAGE, EXPENSE, OR LIABILITY, INCLUDING
ATTORNEYS' FEES, ARISING OUT OF OR IN CONNECTION WITH YOUR USE OF SOFTWARE AS



10.

11.

12.

13.

14.

DESCRIBED IN SECTION 7. THE PROVISIONS OF THIS SECTION 8 SHALL SURVIVE THE EXPIRATION OR
TERMINATION OF THIS AGREEMENT.

INFRINGEMENT.

9.1. Mentor Graphics will defend or settle, at its option and expense, any action brought against you alleging that
Software infringes a patent or copyright or misappropriates a trade secret in the United States, Canada, Japan, or
member state of the European Patent Office. Mentor Graphics will pay any costs and damages finally awarded
against you that are attributable to the infringement action. Y ou understand and agree that as conditions to Mentor
Graphics' obligations under this section you must: (a) notify Mentor Graphics promptly in writing of the action;
(b) provide Mentor Graphics all reasonable information and assistance to defend or settle the action; and (c) grant
Mentor Graphics sole authority and control of the defense or settlement of the action.

9.2. If an infringement claim is made, Mentor Graphics may, at its option and expense: (a) replace or modify Software so
that it becomes noninfringing; (b) procure for you the right to continue using Software; or (c) require the return of
Software and refund to you any license fee paid, |ess a reasonable allowance for use.

9.3. Mentor Graphics has no liability to you if infringement is based upon: (&) the combination of Software with any
product not furnished by Mentor Graphics; (b) the modification of Software other than by Mentor Graphics; (c) the
use of other than a current unaltered release of Software; (d) the use of Software as part of an infringing process, (€) a
product that you make, use or sell; (f) any Beta Code contained in Software; (g) any Software provided by Mentor
Graphics' licensors who do not provide such indemnification to Mentor Graphics' customers; or (h) infringement by
you that is deemed willful. In the case of (h) you shall reimburse Mentor Graphicsfor its attorney fees and other costs
related to the action upon afina judgment.

9.4. THIS SECTION IS SUBJECT TO SECTION 6 ABOVE AND STATES THE ENTIRE LIABILITY OF MENTOR
GRAPHICS AND ITS LICENSORS AND YOUR SOLE AND EXCLUSIVE REMEDY WITH RESPECT TO
ANY ALLEGED PATENT OR COPYRIGHT INFRINGEMENT OR TRADE SECRET MISAPPROPRIATION
BY ANY SOFTWARE LICENSED UNDER THIS AGREEMENT.

TERM. This Agreement remains effective until expiration or termination. This Agreement will immediately terminate
upon notice if you exceed the scope of license granted or otherwise fail to comply with the provisions of Sections 1, 2, or
4. For any other material breach under this Agreement, Mentor Graphics may terminate this Agreement upon 30 days
written notice if you are in material breach and fail to cure such breach within the 30 day notice period. If Software was
provided for limited term use, this Agreement will automatically expire at the end of the authorized term. Upon any
termination or expiration, you agree to cease all use of Software and return it to Mentor Graphics or certify deletion and
destruction of Software, including all copies, to Mentor Graphics' reasonable satisfaction.

EXPORT. Software is subject to regulation by local laws and United States government agencies, which prohibit export
or diversion of certain products, information about the products, and direct products of the products to certain countries
and certain persons. Y ou agree that you will not export any Software or direct product of Software in any manner without
first obtaining all necessary approval from appropriate local and United States government agencies.

RESTRICTED RIGHTS NOTICE. Software was developed entirely at private expense and is commercial computer
software provided with RESTRICTED RIGHTS. Use, duplication or disclosure by the U.S. Government or a U.S.
Government subcontractor is subject to the restrictions set forth in the license agreement under which Software was
obtained pursuant to DFARS 227.7202-3(a) or as set forth in subparagraphs (¢)(1) and (2) of the Commercial Computer
Software - Restricted Rights clause at FAR 52.227-19, as applicable. Contractor/manufacturer is Mentor Graphics
Corporation, 8005 SW Boeckman Road, Wilsonville, Oregon 97070-7777 USA.

THIRD PARTY BENEFICIARY. For any Software under this Agreement licensed by Mentor Graphics from Microsoft
or other licensors, Microsoft or the applicable licensor is athird party beneficiary of this Agreement with the right to
enforce the obligations set forth herein.

AUDIT RIGHTS. You will monitor access to, location and use of Software. With reasonable prior notice and during
your normal business hours, Mentor Graphics shall have the right to review your software monitoring system and
reasonably relevant records to confirm your compliance with the terms of this Agreement, an addendum to this
Agreement or U.S. or other local export laws. Such review may include FLEXIm or FLEXnet report log files that you
shall capture and provide at Mentor Graphics' request. Mentor Graphics shall treat as confidential information all of your
information gained as aresult of any request or review and shall only use or disclose such information as required by law
or to enforce its rights under this Agreement or addendum to this Agreement. The provisions of this section 14 shall
survive the expiration or termination of this Agreement.



15.

16.

17.

CONTROLLING LAW, JURISDICTION AND DISPUTE RESOLUTION. THIS AGREEMENT SHALL BE
GOVERNED BY AND CONSTRUED UNDER THE LAWS OF THE STATE OF OREGON, USA, IF YOU ARE
LOCATED IN NORTH OR SOUTH AMERICA, AND THE LAWS OF IRELAND IF YOU ARE LOCATED
OUTSIDE OF NORTH OR SOUTH AMERICA. All disputes arising out of or in relation to this Agreement shall be
submitted to the exclusive jurisdiction of Portland, Oregon when the laws of Oregon apply, or Dublin, Ireland when the
laws of Ireland apply. Notwithstanding the foregoing, all disputesin Asia (except for Japan) arising out of or in relation to
this Agreement shall be resolved by arbitration in Singapore before a single arbitrator to be appointed by the Chairman of
the Singapore International Arbitration Centre (“SIAC”) to be conducted in the English language, in accordance with the
Arbitration Rules of the SIAC in effect at the time of the dispute, which rules are deemed to be incorporated by reference
in this section 15. This section shall not restrict Mentor Graphics' right to bring an action against you in the jurisdiction
where your place of businessis located. The United Nations Convention on Contracts for the International Sale of Goods
does not apply to this Agreement.

SEVERABILITY. If any provision of this Agreement is held by a court of competent jurisdiction to be void, invalid,
unenforceable or illegal, such provision shall be severed from this Agreement and the remaining provisionswill remainin
full force and effect.

PAYMENT TERMS AND MISCELLANEOUS. You will pay amounts invoiced, in the currency specified on the
applicable invoice, within 30 days from the date of such invoice. Any past due invoices will be subject to the imposition
of interest charges in the amount of one and one-half percent per month or the applicable legal rate currently in effect,
whichever is lower. Some Software may contain code distributed under a third party license agreement that may provide
additional rights to you. Please see the applicable Software documentation for details. This Agreement may only be
modified in writing by authorized representatives of the parties. Waiver of terms or excuse of breach must be in writing
and shall not constitute subsequent consent, waiver or excuse.

Rev. 060210, Part No. 227900
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